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Configurazione del sistema TI-Nspire™ CX Navigator™
Il sistema TI-Nspire™ CX Navigator™ fornisce gli strumenti hardware e software
necessari per configurare una rete wireless per la classe che permette di:

• Utilizzare Test rapido per inviare test agli studenti, riceverne le risposte e rivedere i
risultati con gli studenti.

• Utilizzare Cattura schermo per acquisire gli schermi dei palmari degli studenti o dai
computer automaticamente o a intervalli prestabiliti.

• Utilizzare Live Presenter per visualizzare il lavoro mentre viene svolto sullo
schermo del palmare dell'insegnante o sugli schermi dei palmari degli studenti.

• Utilizzare Area di lavoro Revisione per ritirare e rivedere gli elaborati degli
studenti, vedere i risultati delle risposte degli studenti in tempo reale e analizzare i
dati di tutta la classe o di singoli studenti.

Informazioni sull'hardware

In base ai requisiti della classe, il sistema TI-Nspire™ Navigator™ può includere il
seguente hardware, utilizzato per creare una rete di comunicazioni wireless che
permette al computer di comunicare con i palmari degli studenti:

Nome hardware Immagine Utilizzi

Scheda di rete
wireless TI-
Nspire™

Si collega ai palmari TI-Nspire™ CX e
TI-Nspire™ CX CAS per abilitare la
comunicazione wireless su una banda
da 2,4 GHz.

Scheda di rete
wireless TI-
Nspire™ CX – v2

Si collega ai palmari TI-Nspire™ CX e
TI-Nspire™ CX CAS per abilitare la
comunicazione wireless su una banda
da 2,4 GHz o 5 GHz.

Punto di accesso
a TI-Nspire™
Navigator™

Si collega al computer dell'insegnante
per offrire un collegamento per la
comunicazione wireless su 2,4 GHz.

Configurazione del sistema TI-Nspire™ CX Navigator™ 1



2 Configurazione del sistema TI-Nspire™ CX Navigator™

Nome hardware Immagine Utilizzi

Punto di accesso
a TI-Nspire™ CX
Navigator™

Si collega al computer dell'insegnante
per offrire un collegamento per la
comunicazione wireless su 2,4 GHz o 5
GHz.

Prima di cominciare
Quando si avvia per la prima volta una nuova versione di TI-Nspire™ CX Premium
Teacher Software con un punto di accesso collegato o selezionandoWindow > Enable
TI Nspire CX Navigator (Finestra > Attiva TI Nspire CX Navigator), si apre la procedura
guidata TI-Nspire™ CX Navigator™ System Startup (Avvio del sistema TI-Nspire™ CX
Navigator™) che guida l’utente attraverso il processo automatico per configurare la
classe wireless. Prima di cominciare il processo di configurazione wireless:

• Accertarsi di aver installato e attivato TI-Nspire™ CX Premium Teacher Software
sul computer.

Nota: se si stanno utilizzando schede di rete TI-Nspire™ wireless, non occorre
caricarle. Le schede di rete wireless sono alimentate dai palmari.

• Scollegare il punto di accesso di TI-Nspire™ Navigator™ o TI-Nspire™ CX
Navigator™ dal computer.

Avvio automatico del sistema

Quando si avvia il software, la procedura guidata Startup (Avvio) guida l’utente
attraverso le fasi necessarie per:

• Aggiornare tutti i palmari degli studenti e delle classi all’ultima versione del
sistema operativo (SO). Il SO sui palmari deve corrispondere alla versione del
software installata sul computer.

Importante! Quando si aggiorna il SO, i palmari devono essere collegati al
computer utilizzando un cavo USB o una TI-Nspire™ CX Docking Station.

• Denominare la rete della classe.

• Se necessario, selezionare un canale per il punto di accesso.

• Aggiungere i client wireless alla rete.

• Creare una copia di backup della configurazione della rete della classe.



Aggiornamento del sistema operativo del palmare
Se si installa o si aggiorna TI-Nspire™ CX Premium Teacher Software con un punto di
accesso collegato o selezionandoWindow > Enable TI Nspire CX Navigator (Finestra >
Attiva TI Nspire CX Navigator), si apre la finestra di dialogo Startup (Avvio) quando si
avvia il software per la prima volta. È necessario aggiornare tutti i palmari degli
studenti e delle classi all'ultima versione del sistema operativo.

Completare i seguenti passaggi per accertarsi che tutti i palmari siano aggiornati.

1. Scollegare il punto di accesso se questo è collegato al computer.

2. Collegare i palmari al computer.

È necessario collegare i palmari utilizzando un cavo USB o collegando più palmari
utilizzando le TI-Nspire™ docking station.

3. Fare clic su Rileva SO del palmare.

• Se il SO per tutti i palmari collegati corrisponde alla versione del software,
viene visualizzata la finestra di dialogo Aggiornamento SO del palmare che
informa l'utente che tutti i palmari sono aggiornati. Fare clic su Chiudi per
tornare alla finestra di dialogo Avvio.

• Se il SO sui palmari collegati non è aggiornato, viene visualizzata la finestra di
dialogo Handheld OS Update Required (Aggiornamento SO palmare
necessario). Fare clic su Aggiorna SO.

La finestra di dialogo Aggiungi all'elenco di trasferimento si apre.
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4 Configurazione del sistema TI-Nspire™ CX Navigator™

I file del SO corrispondenti vengono trasferiti ai palmari collegati. È possibile
aggiornare i palmari TI-Nspire™ CX e TI-Nspire™ CX II contemporaneamente. Se
non è possibile collegare tutti i palmari contemporaneamente, collegare quanti
più palmari possibile e aggiornare il SO. Dopo il completamento
dell'aggiornamento del SO, scollegare i palmari e ripetere il processo di
aggiornamento del SO fino all'aggiornamento di tutti i palmari. Il software
rileverà il SO necessario e comincerà il trasferimento quando si collegheranno i
palmari.

• Fare clic su Fatto per interrompere il processo di trasferimento quando tutti i
palmari sono aggiornati.
- La finestra di dialogo Aggiungi SO all'elenco di trasferimento si chiude.
- Viene visualizzata la finestra di dialogo Avvio.

4. Selezionare la casella di controllo All handhelds are updated to OS version 5.0
(Tutti i palmari sono aggiornati alla versione di SO).

5. Fare clic su Avanti.

Si apre la finestra di dialogo Connect Access Point (Collega punto di accesso).

Collegamento del punto di accesso a TI-Nspire™ Navigator™
Quando l'aggiornamento del sistema operativo è completo su tutti i palmari, la fase
successiva nel processo di avvio del sistema prevede il collegamento al punto di
accesso. Quando si collega il punto di accesso al computer, viene acceso e pronto a
comunicare con le schede di rete wireless e gli alloggiamenti.



1. Collegare il punto di accesso al computer utilizzando un cavo USB.

a) Collegare l'estremità piccola del cavo USB al punto di accesso.

Collegare il punto di accesso direttamente al computer. Non collegare il punto
di accesso a un hub USB o a una docking station.

b) Collegare l'altra estremità del cavo alla porta USB del computer.
c) Accertarsi che la spia del punto di accesso sia accesa. La luce di alimentazione

indica che il punto di accesso riceve corrente dal computer. La luce di
segnalazione indica attività del link wireless.

Punto di accesso a TI-Nspire™Navigator™ Punto di accesso a TI-Nspire™CXNavigator™

Nota: se il software non rileva un punto di accesso collegato entro un minuto, si
visualizza un messaggio di errore. Chiudere il messaggio di errore e quindi
scollegare e ricollegare il punto di accesso.

2. Fare clic su Avanti.

Il software rileva i tipi di punto di accesso e controlla la versione del firmware sul
punto di accesso. Se è disponibile una versione più aggiornata del firmware, il
software aggiorna il firmware.

Nota:  il software potrebbe impiegare fino a 60 secondi per la rilevazione del punto
di accesso.
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6 Configurazione del sistema TI-Nspire™ CX Navigator™

Importante! Non interrompere il processo di aggiornamento né scollegare il punto
di accesso fino al completamento dell'aggiornamento del firmware.

Quando l'aggiornamento è completo, il software controlla il punto di accesso per
individuare una rete della classe configurata.

• Se è presente una rete della classe, il software ricorda all'utente che è
possibile mantenere la configurazione attuale o apportare delle modifiche.

• Se non sono presenti reti della classe, il software guida l'utente nella
procedura guidata Configurazione della rete della classe.

3. Selezionare Backup della rete della classe per salvare una copia della
configurazione della rete della classe.

Le informazioni di rete salvate includono l'elenco di ID client wireless, il nome della
rete e il canale e il paese selezionati sul punto di accesso.

Il salvataggio di una rete consente di ricaricare la configurazione in un secondo
tempo utilizzando Gestione reti. Per impostazione predefinita, il file è salvato nella
cartella Documenti/TI-Nspire/Navigator Network.

Per terminare senza salvare una copia di backup, selezionare Salta il backup.

4. Fare clic su Fine per completare l'installazione.

Nota:  è possibile configurare una rete alla volta o modificare una rete esistente,
utilizzando Gestione reti.

Risoluzione dei problemi

Se l'aggiornamento del firmware non avviene correttamente, si apre la finestra di
dialogo Attenzione SO .



Per risolvere il problema, scollegare e ricollegare qualsiasi cavo collegato al punto di
accesso e il software avvierà automaticamente il processo di aggiornamento. Se
questo non risolve il problema, contattare l'Assistenza clienti.

Conferma della versione del SO del palmare
Se i palmari non sono stati aggiornati durante l'avvio, la procedura guidata chiede di
confermare che i palmari della classe e degli studenti siano aggiornati all'ultima
versione del SO. La versione del SO sui palmari deve corrispondere alla versione del
software prima che sia possibile configurare la rete della classe.
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8 Configurazione del sistema TI-Nspire™ CX Navigator™

Per controllare la versione del SO su un palmare:

1. Premerec per accendere il palmare.

2. Selezionare Impostazioni > Stato per aprire la finestra Stato palmare.



3. Accertarsi che il SO sul palmare corrisponda alla versione del software sul
computer.

• Se la versione del SO è aggiornata, selezionare Sì.
• Se la versione del SO non è aggiornata, selezionare No.

4. Fare clic su Avanti.

• Se la versione del SO non è stata aggiornata, si visualizza la finestra di dialogo
Aggiornamento SO palmare necessario. Fare clic su Aggiorna SO per aprire lo
Strumento di trasferimento per l'aggiunta del SO  e aggiornare i palmari.

• Se la versione del SO è aggiornata, si apre la finestra di dialogo Nome della
rete della classe ed è possibile continuare il processo per configurare la rete
della classe.

Attribuzione di nome alla rete della classe
Quando viene visualizzata la finestra di dialogo Nome della rete della classe,
completare i passaggi seguenti per attribuire un nome alla rete della classe.

1. Digitare il nome da assegnare alla rete della classe nel campo TI-NAV-N.

Utilizzare un nome che sia unico, facile da ricordare e da identificare. Il nome della
rete della classe può contenere fino a 22 caratteri. I nomi possono essere costituiti
da lettere, numeri, spazi ma non possono contenere ? " $ \ ! [ ] +.

2. Fare clic su Avanti per configurare il punto di accesso senza alcuna modifica.

—oppure—

3. Fare clic su Avanzate per selezionare una banda o un canale operativo diverso.
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10 Configurazione del sistema TI-Nspire™ CX Navigator™

• Se il punto di accesso a TI-Nspire™ Navigator™ è collegato, è
possibile selezionare un canale operativo diverso.

• Se il punto di accesso a TI-Nspire™ CX Navigator™ è collegato, è
possibile selezionare una banda 2,4 GHz o una banda 5 GHz e selezionare un
canale operativo diverso.

Nota: i canali operativi disponibili per la selezione sono determinati dalla versione
di software installata.

Importante! Se si utilizzano schede di rete wireless TI-Nspire™ CX – v2, è possibile
selezionare la banda 2,4 GHz o 5 GHz. Se si utilizza una combinazione di reti di
schede wireless, è necessario selezionare la banda 2,4 GHz.

4. Fare clic su Fatto.

La finestra di dialogo Configurazione del punto d'accesso si apre e il software
configura il punto di accesso e applica il nome della rete della classe.

Importante! Non scollegare il punto di accesso durante la configurazione.



Quando il processo di configurazione è completo, è possibile associare i client wireless.

Aggiunta di client wireless alla rete
Dopo aver assegnato un nome alla rete della classe e aver configurato i punti di
accesso, è necessario associare i client wireless (schede wireless e alloggiamenti
wireless) alla rete. Il modo in cui completare questo processo dipende dalla
disponibilità di docking station che permettono di operare con più palmari e client
wireless contemporaneamente.

• Se si possiede una docking station, collegare le schede ai palmari e quindi inserire i
palmari in una docking station che sia collegata al computer. È possibile unire altre
due docking station alla docking station collegata.

• Se non si possiede una docking station, collegare le schede o gli alloggiamenti
wireless ai palmari.
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12 Configurazione del sistema TI-Nspire™ CX Navigator™

1. Seguire le istruzioni sullo schermo per collegare i palmari alle rispettive schede
wireless, agli alloggiamenti e/o alle docking station e quindi fare clic su Avanti.

Si visualizza la finestra di dialogo Aggiunta client wireless alla rete della classe.

Il punto di accesso trova i client disponibili e li elenca nella casella Client
disponibili. Il punto di accesso può impiegare fino a sei minuti per trovare tutti i
client disponibili. Controllare il numero di client disponibili per assicurarsi che tutti i
client siano elencati.



2. Seguire i passaggi a, b e c su tutti i palmari TI-Nspire™ che non sono inseriti in una
docking station.

a) Accendere ogni palmare.
b) Nello schermo principale del palmare, selezionare Impostazioni > Rete. Il

palmare elenca le reti disponibili che sono entro la portata.
c) Selezionare il nome assegnato alla rete della classe e fare clic su Connetti.

3. Nella schermata Aggiungi client wireless alla rete della classe, selezionare i client
wireless da aggiungere.

• Per aggiungere tutti i client disponibili, fare clic su Aggiungi tutti.
• Per aggiungere client specifici, selezionare un ID client alla volta e quindi fare

clic su Aggiungi.

Importante! I client non fanno parte della rete della classe fino al completamento
del passaggio per aggiungerli.

4. Fare clic su Avanti per associare i client wireless alla rete della classe.
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Il software associa i client wireless collegati alla rete della classe. Quando il
processo è completo, si apre la finestra di dialogo Installazione completata.

5. Selezionare Backup della rete della classe per salvare una copia della
configurazione della rete della classe.

Le informazioni di rete salvate includono l'elenco di ID client wireless, il nome della
rete e il canale e il paese selezionati sul punto di accesso.

Il salvataggio di una rete consente di ricaricare la configurazione in un secondo
tempo utilizzando Gestione reti. Per impostazione predefinita, il file è salvato nella
cartella My Documents/TI-Nspire/Navigator Network.

Per terminare senza salvare una copia di backup, selezionare Salta il backup.

6. Fare clic su Fine per completare l'installazione.



Nota: è possibile aggiungere più schede o alloggiamenti wireless alla rete della classe
in un secondo tempo utilizzando Gestione reti.

Collegamento dei palmari alle schede wireless
Le schede di rete wireless funzionano con i palmari TI-Nspire™ CX e TI-Nspire™ CX CAS.
Per collegare il palmare a una scheda wireless, attenersi alla procedura seguente:

1. Posizionare la scheda wireless sopra il palmare in modo che il connettore di questa
sia allineato al connettore che si trova nella parte superiore del palmare.

À Connettore

Á Guide per l'allineamento al palmare

Â Scanalature per l'allineamento della scheda
wireless

2. Far scorrere la scheda in posizione, accertandosi che le guide ai lati della scheda
scorrano nelle scanalature predisposte sul palmare.

3. Premere con decisione sulla scheda per inserirla in posizione.
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Creazione e gestione dell’account insegnante
Creare l’account insegnante nella sezione Teacher Preferences (Preferenze insegnante)
di TI-Nspire™ CX Premium Teacher Software. L’account insegnante consente di
accedere alla rete TI-Nspire™ Navigator™ dal palmare dell’insegnante. Dopo aver
creato un account insegnante, l'insegnante può successivamente cambiare la password
o il nome utente.

Creazione dell'account insegnante

1. Utilizzare il selettore dell'area di lavoro per scegliere l'area di lavoro Classe.

2. Fare clic su File > Settings > Teacher Preferences (File > Impostazioni >
Preferenze insegnante).

Viene visualizzata la finestra di dialogo Preferenze insegnante.



3. Digitare un nome utente.

4. Digitare una password.

5. Selezionare o eliminare la preferenza per la visualizzazione dell'icona
dell'insegnante nella vista della classe.

Se si seleziona questa preferenza, l'icona dell'insegnante apparirà nella vista della
classe e l'insegnante sarà incluso come destinatario delle funzioni Invia alla classe,
Ritira dalla classe ed Elimina dalla classe Lo schermo del palmare dell'insegnante
verrà catturato assieme agli altri schermi della classe.

6. Selezionare o eliminare le opzioni per catturare gli schermi in ordine casuale e per
individuare il palmare dell'insegnante.

• Ordine casuale in Cattura schermo. Selezionando questa opzione si catturano e
si visualizzano gli schermi degli studenti in ordine casuale, non nell'ordine
dell'elenco della classe. Ciò consente agli studenti di concentrasi sugli elaborati
senza preoccuparsi di chi è lo schermo che si sta visualizzando.

• Individua palmare insegnante in Cattura schermo. Selezionando questa opzione
lo schermo dell'insegnante viene evidenziato rispetto agli altri schermi
catturati.

7. Fare clic su OK.

Modifica della password dell’account insegnante

1. Accertarsi che il proprio palmare non sia connesso alla rete TI-Nspire™ Navigator™.

2. Fare clic su File > Settings > Teacher Preferences (File > Impostazioni >
Preferenze insegnante).

Viene visualizzata la finestra di dialogo Preferenze insegnante.
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3. Fare clic su Reset.

La password corrente viene cancellata da TI-Nspire™ Premium Teacher Software.

4. Digitare una nuova password.

5. Fare clic su OK.

Modifica del nome utente dell’account insegnante

1. Accertarsi che il proprio palmare non sia connesso alla rete TI-Nspire™ Navigator™.

2. Fare clic su File > Settings > Teacher Preferences (File > Impostazioni >
Preferenze insegnante).

Viene visualizzata la finestra di dialogo Preferenze insegnante.



3. Immettere un nome utente nuovo.

4. Fare clic su OK.

Connessione al sistema TI-Nspire™ CX Navigator™ dal palmare
Il sistema per l'apprendimento per la classe TI-Nspire™ CX Navigator™ utilizza sia il
computer sia i palmari degli studenti. Per far sì che l'insegnante e gli studenti
comunichino tramite la rete TI-Nspire™ Navigator™, gli studenti devono connettersi
alla rete dal proprio palmare.

Nota: l'insegnante non deve connettersi per comunicare con i palmari degli studenti,
ma può usare lo Strumento di trasferimento per eliminare o inviare file e sistemi
operativi ai palmari degli studenti. Tuttavia, se desidera partecipare con il proprio
palmare alla sessione della classe di TI-Nspire™ Navigator™, l'insegnante deve
connettersi alla rete TI-Nspire™ Navigator™ dal suo palmare.

Per ulteriori informazioni sull'uso di un palmare, fare riferimento alle guide dei
palmari disponibili presso education.ti.com/guides.

Prima di connettersi accertarsi che siano stati completati i seguenti passaggi:

• È stato creato l'account insegnante nella sezione Preferenze insegnante
• È stata avviata una sessione della classe sul computer dell'insegnante.

• Il palmare TI-Nspire™ è pronto per connettersi. (L'icona  lampeggia).

Prima che gli studenti si connettano, accertarsi di completare i seguenti passaggi:

• Creare degli account studente.

• Fornire agli studenti il nome della rete della classe, i loro nomi utenti e, se
necessario, le password.

Connessione alla rete TI-Nspire™ Navigator™

1. Per connettersi, eseguire una delle seguenti operazioni:

Configurazione del sistema TI-Nspire™ CX Navigator™ 19



20 Configurazione del sistema TI-Nspire™ CX Navigator™

• Nello schermo principale del palmare TI-Nspire™, selezionare 5:Impostazioni >
5:Connetti.

• In uno schermo diverso dallo schermo principale, premere~ > 8:Connetti.

L'ultima rete a cui il client wireless è stato associato appare sullo schermo del
palmare.

Nota: se il palmare è collegato al computer con il cavo USB, sullo schermo non
appare alcun nome della rete ed è possibile continuare l'accesso.

2. Se il nome della rete che appare è corretto, continuare con l'accesso. Se la rete non
è corretta, fare clic su Rete.

Le schermate del palmare mostrano tutte le reti a cui è stato collegato e mostra
inoltre le altre reti.

3. Selezionare la rete dall'elenco e fare clic su Connetti.

Lo schermo di login mostra lo stato di connessione e il nome della rete quando la
connessione è corretta.

4. Digitare il proprio nome utente e la password.

5. Selezionare Connetti.



Viene visualizzato lo schermo di conferma della connessione.

6. Fare clic su OK.

Icone di stato connessione del palmare TI-Nspire™

Le icone degli schermi dei palmari TI-Nspire™ CX, TI-Nspire™ CX CAS, TI-Nspire™, e TI-
Nspire™ CAS indicano lo stato delle comunicazioni tra il palmare e il punto di accesso,
la scheda wireless, l'alloggiamento wireless o la rete TI-Navigator™. Le icone indicano
lo stato nel seguente modo.

Icona Barra Descrizione

Nessuna
icona

Se non compaiono icone, il palmare non sta
cercando un punto di accesso. Scollegare e
ricollegare la scheda o l'alloggiamento wireless.

Lampeggiante Il palmare sta cercando un punto di accesso.

Fissa Il palmare ha trovato un punto di accesso.

Fissa Il palmare non sta comunicando con la scheda o
l'alloggiamento. Scollegare il palmare dalla
scheda o dall'alloggiamento, attendere che
l'icona scompaia, quindi ricollegare il palmare
alla scheda o all'alloggiamento.

Lampeggiante Il palmare è collegato alla rete ed è pronto per
connettersi.

Fissa Il palmare è connesso alla rete.
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Conservazione delle schede wireless
Quando si caricano i palmari durante la notte, non occorre togliere le schede di rete
wireless dai palmari prima di inserirli nella TI-Nspire™ CX Docking Station. Quando la
mattina successiva si ricomincia a utilizzare i palmari, questi saranno completamente
carichi e con la scheda pronta per l'uso.

È possibile rimuovere la scheda wireless dal palmare e riporla nell'apposito
contenitore durante la notte.

Se si prevede di non utilizzare le schede wireless per più di due settimane, rimuoverle
dal palmare e conservarle nell'apposito contenitore. Riporre il contenitore in un luogo
fresco e asciutto.

Utilizzo di TI-Nspire™ Network Manager (Gestione reti TI-Nspire™)

Accesso a TI-Nspire™ Network Manager (Gestione reti TI-Nspire™)

▶ Fare clic su Tools > Network Manager (Strumenti > Gestione reti).

Si apre TI-Nspire™ Network Manager (Gestione reti TI-Nspire™).

Nota: Fare clic su Refresh (Aggiorna) in qualsiasi momento per aggiornare la
finestra TI-Nspire™ Network Manager (Gestione reti TI-Nspire™).

Apertura dell'Installazione guidata della rete

È possibile installare o modificare una rete della classe in qualsiasi momento
utilizzando l'Installazione guidata della rete.



▶ Nella finestra TI-Nspire™ Network Manager (Gestione reti TI-Nspire™), fare clic su
Network Setup Wizard (Installazione guidata della rete).

La procedura guidata conduce l'utente attraverso il processo di installazione di una
rete della classe, incluso:

• Aggiornare tutti i palmari degli studenti e delle classi all’ultima versione del
sistema operativo (SO). Il SO sui palmari deve corrispondere alla versione del
software installata sul computer.

• Collegare il punto di accesso e, se necessario, aggiornare il firmware del punto
di accesso.

• Denominare la rete della classe.

• Se necessario, selezionare un canale per il punto di accesso.

• Aggiungere i client wireless alla rete.

• Creare una copia di backup della configurazione della rete della classe.

Verifica dello stato della rete

Lo stato della rete è mostrato nella barra laterale della finestra TI-Nspire™ Network
Manager (Gestione reti TI-Nspire™).

Nota: se la barra laterale è nascosta, fare clic su View > Sidebar (Visualizza > Barra
laterale). Fare clic su Aggiorna per aggiornare lo stato se la Gestione reti è già aperta.

Lo stato della rete mostra le seguenti informazioni:

• Punto di accesso. Mostra se il punto di accesso è collegato o scollegato.

• Nome della rete. Il nome assegnato alla rete durante la configurazione.

• Canale. Il canale operativo del punto di accesso per la rete attuale.

• Banda. Il collegamento di comunicazione selezionato.

• Firmware. La versione del punto di accesso.
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• Indirizzo MAC L'indirizzo di Media Access Control che identifica il punto di accesso.

Dopo aver configurato la rete, tutte le schede aggiunte compaiono nella finestra TI-
Nspire™ Network Manager (Gestione reti TI-Nspire™). Se la scheda wireless viene
caricata e collegata a un palmare TI-Nspire™ acceso, TI-Nspire™, TI-Nspire™ Network
Manager (Gestione reti TI-Nspire™) riporta lo stato collegato. Possono essere
necessari 30 secondi perché il client wireless venga riconosciuto e venga visualizzato il
suo stato "collegato". La finestra di stato visualizza inoltre lo stato della batteria e la
potenza del segnale.

Se la scheda non è collegata a un palmare TI-Nspire™ acceso, TI-Nspire™ Network
Manager (Gestione reti TI-Nspire™) riporta lo stato scollegato. TI-Nspire™ Network
Manager (Gestioni reti TI-Nspire™) ricorda gli ID della scheda aggiunti e la prossima
volta che si accende un palmare collegato a quella scheda, TI-Nspire™ Network
Manager (Gestione reti TI-Nspire™) lo riconosce.

Aggiunta manuale di client wireless

È possibile aggiungere manualmente schede wireless in qualsiasi momento.

Quando si aggiunge manualmente una scheda wireless, questa compare
immediatamente nella finestra TI-Nspire™ Network Manager (Gestione reti TI-
Nspire™).

1. Nella finestra TI-Nspire™ Network Manager (Gestione reti TI-Nspire™), fare clic su
Manually Add Wireless Client(s) (Aggiungi client wireless manualmente).

Si apre la finestra di dialogo Aggiungi client wireless per Numero ID.



2. Per ogni scheda wireless da aggiungere, trovare il numero ID sul retro della scheda
e digitarlo nella casella Wireless Client ID (ID client wireless). L'ID è costituito dalle
ultime sei cifre del numero da otto cifre (ignorare i primi due zeri).

3. Inserire un nickname nella casella Nickname client wireless (opzionale).

I nickname possono contenere lettere, spazi e numeri. Un nickname deve essere
composto da almeno 1 carattere e può contenere fino a 64 caratteri.

4. Fare clic su Add Next (Aggiungi successivo) per aggiungere un’altra scheda se ci
sono più client wireless da aggiungere.

5. Dopo aver aggiunto tutte le schede, fare clic su Finish (Fine).

Dopo aver aggiunto manualmente i client wireless, è necessario associarli alla rete
utilizzando i palmari.

6. Accendere ogni palmare TI-Nspire™.

7. Collegare la scheda wireless a ogni palmare. (Vedere le istruzioni per collegare
schede wireless a palmari TI-Nspire™).

8. Nella schermata Home del palmare TI-Nspire™ selezionare5:Settings > 6:Network
(5:Impostazioni > 6:Rete).

Il palmare elenca le reti disponibili che sono entro la portata.
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9. Selezionare la rete aggiunta ai client wireless e fare clic su Connetti.

I client wireless ora sono associati al punto di accesso.

Modifica del canale operativo

1. Nella finestra TI-Nspire™ Network Manager (Gestione reti TI-Nspire™), fare clic su
Change Operating Channels (Modifica canali operativi).

La finestra di dialogo Opzioni avanzate del punto di accesso si apre.



Importante! Se si utilizzano schede di rete TI-Nspire™ CX Navigator™ - v2, è
possibile selezionare la banda 2,4 GHz o 5 GHz. Se si utilizza una combinazione di
reti di schede wireless, è necessario selezionare la banda 2,4 GHz.

2. Selezionare un canale diverso dalla casella a discesa.

3. Fare clic su Fatto.

La finestra di dialogo Configurazione del punto d'accesso si apre e il software
configura il punto di accesso.

Salvataggio della configurazione di una rete

Il salvataggio della configurazione di una rete consente di ricaricare la configurazione
in un secondo tempo utilizzando TI-Nspire™ Network Manager (Gestione rete TI-
Nspire™). Le informazioni di rete salvate includono l'elenco di ID client wireless, il
nome della rete e il canale e il paese selezionati sul punto di accesso. Per
impostazione predefinita il file viene salvato nella cartella My Documents/TI-
Nspire/Navigator Network.

1. Nella finestra TI-Nspire™ Network Manager (Gestione reti TI-Nspire™), fare clic su
Actions > Save Network Setup (Azioni > Salvare configurazione della rete).

Viene visualizzata la finestra di dialogo Salva.

2. Assegnare un nome alla rete e fare clic su Salva. È possibile salvare il file in
un'altra posizione, se lo si desidera.

Riutilizzo di una rete salvata

Il riutilizzo di una rete salvata permette di ricaricare la configurazione di una rete
salvata. Il riutilizzo di una rete consente di risparmiare tempo perché non è necessario
configurare nuovamente la rete.

1. Nella finestra TI-Nspire™ Network Manager (Gestione reti TI-Nspire™), fare clic su
Actions > Apply Saved Network Setup (Azioni > Applicare l’installazione della rete
salvata).

Viene visualizzata la finestra di dialogo Applicare una rete.

2. Selezionare la rete e fare clic su Applica una rete.

3. Il punto di accesso viene configurato con la configurazione della rete salvata.

Identificazione di client wireless

Per identificare i client wireless che non rispondono, completare i passaggi seguenti.
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1. Nell’elenco dei componenti hardware visualizzato nella finestra TI-Nspire™
Network Manager (Gestione reti TI-Nspire™), fare clic per selezionare i client
wireless. Per selezionare più client wireless, tenere premuto il tastoMAIUSC o
CTRL (Mac®: tasto “), quindi fare clic sugli elementi da selezionare.

2. Fare clic su Actions > Identify Selected (Azioni > Identifica selezionato).

3. Osservare la classe.

• Se si utilizza una docking station, entrambi i LED sulla docking station
lampeggeranno rapidamente in verde.

È possibile identificare i client wireless che non funzionano perché i loro LED non
lampeggiano.

Una volta identificati, i client wireless possono essere nuovamente aggiunti alla rete.

Rimozione di client wireless

Per rimuovere schede di rete dalla rete di una classe, completare i passaggi seguenti.

1. Nella finestra TI-Nspire™ Network Manager (Gestione di reti TI-Nspire™),
selezionare le schede wireless da rimuovere dalla rete.

2. Fare clic su Actions > Removed Selected (Azioni > Rimuovi selezionati) oppure fare

clic su .

3. Quando richiesto, fare clic su Rimuovi.

I client wireless selezionati sono rimossi dall'elenco.

Ripristino delle impostazioni predefinite in fabbrica per il punto di accesso

1. Nella finestra TI-Nspire™ Network Manager (Gestioni reti TI-Nspire™), fare clic su
Actions > Set Default Factory Settings to Access Point (Azioni > Impostare le
impostazioni predefinite in fabbrica per il Punto di accesso).

Il punto di accesso viene riconfigurato alle impostazioni predefinite in fabbrica.

2. Fare clic su OK quando viene visualizzato il messaggio di conferma.

Risoluzione dei problemi
Questa sezione descrive alcuni problemi che si possono riscontrare e offre
suggerimenti sulla loro risoluzione.

Per maggiore assistenza, contattare l'Assistenza clienti.



Il software non rileva tutti i palmari collegati.

La tecnologia USB 3.0 limita il numero di palmari che possono essere rilevati da un
computer.

Per scoprire se si dispone di una porta USB 3.0:

• Su Windows®, andare in Device Manager nel Pannello di controllo.

• Su Mac®, andare su Apple > Informazioni su questo Mac > Più informazioni >
Resoconto di Sistema, e quindi selezionare Hardware > USB nel riquadro a sinistra.

È possibile collegare e aggiornare un palmare alla volta utilizzando un cavo USB , o un
massimo di 10 palmari contemporaneamente utilizzando una TI-Nspire™ CX Docking
Station.

Durante l'installazione del software, l'aggiornamento del punto di accesso non è
riuscito.

Scollegare e ricollegare qualsiasi cavo collegato al punto di accesso. Il software riavvia
automaticamente il processo di aggiornamento.

Il sistema operativo aggiornato non viene installato sul palmare.

Verificare che il palmare sia completamente carico prima di avviare un aggiornamento
del SO .

Il software non ha accettato il nome della rete della classe.

Il nome della rete della classe può contenere fino a 22 caratteri. I nomi possono essere
costituiti da lettere (A...Z, a...z), (0...9), e spazi ma non possono contenere caratteri
speciali come ? " $ \ ! [ ] +. Utilizzare un nome che sia unico, facile da ricordare e da
identificare. Ad esempio: Ms. Smith Math Rm 65

Il punto di accesso riscontra problemi di connessione.

Verificare che non vi siano altri oggetti vicino al punto di accesso quando questo è
acceso.

Il canale operativo o la banda del punto di accesso può compromettere la connessione.

Importante! Verificare sempre con l'amministratore IT prima di cambiare i canali del
punto di accesso.

• Se il punto di accesso di TI-Nspire™ CX Navigator™ è collegato e si stanno
utilizzando schede di rete wireless TI-Nspire™ CX – v2, è possibile selezionare una
banda 2,4 GHz o una banda 5 GHz e selezionare un canale operative diverso.
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• Se si utilizza una combinazione di reti di schede wireless, è necessario selezionare
la banda 2,4 GHz.

Il canale operativo predefinito per 5 GHz negli Stati Uniti, in Canada e China è il 36.
Il canale operativo predefinito per 5 GHz in altri paesi è il 149.

Per selezionare una banda o un canale operativo diverso, andare su Strumenti
> Gestione reti e fare clic suModifica canale operativo.

La rete wireless non funziona.

Il SO sui palmari deve corrispondere alla versione del software TI-Nspire™ sul
computer per utilizzare la rete wireless.



Guida introduttiva a TI-Nspire™ CX Premium Teacher
Software
Esplorazione del TI-Nspire™ CX Premium Teacher Software
Se si utilizza il software per la prima volta, l'area di lavoro Contenuto è aperta per
default. Le aree di lavoro sono trattate in dettaglio in seguito.

Gli strumenti descritti di seguito sono disponibili in tutte le aree di lavoro del TI-
Nspire™ CX Premium Teacher Software. Per ulteriori informazioni su altre aree di
lavoro del software, vedere il capitolo per ogni area di lavoro.

À Barra del titolo. Mostra il nome del documento corrente e il nome del software e
include, nell'angolo a destra, i pulsanti di riduzione a icona, ingrandimento e
chiusura.

Á Barra dei menu. Fornisce gli strumenti per lavorare con i documenti nell'area di
lavoro corrente e modificare le impostazioni di sistema.

Â Selettore dell'area di lavoro. Utilizzare queste schede per spostarsi tra le aree di
lavoro Contenuto, Classe, Documenti, Revisione e Portfolio.

Nota: alcune attività in corso possono impedire il cambio immediato dell'area di
lavoro. Se una finestra di dialogo è in attesa di una risposta, digitare la risposta e
successivamente cambiare area di lavoro.
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Ã Menu Strumenti. Visualizza gli strumenti di uso frequente in ogni area di lavoro. Ogni
area di lavoro dispone di icone Test rapido, Cattura schermo e Formato nome
studente. Altre opzioni del menu studenti cambiano in base all'area di lavoro aperta.
Ogni strumento è trattato nel rispettivo capitolo.

• Il Formato nome studente permette di scegliere la modalità di visualizzazione
dei nomi degli studenti: per Cognome, Nome, Nome utente, Nickname, ID
studente o nascosto.

• Lo strumento Cattura schermo consente di catturare un'immagine di un
documento attivo sul computer o di catturare la schermata di uno o tutti i
palmari collegati. È possibile catturare più immagini e copiarle/incollarle e
salvarle Per ulteriori informazioni, consultare Cattura Schermo.

• Lo strumento Test rapido consente di inviare un test agli studenti, che viene
immediatamente ricevuto sui loro palmari, e di ricevere le risposte degli
studenti. Per ulteriori informazioni, vedere Test degli studenti.

Ä Elenco classi. Elenca le classi attualmente disponibili.

Å Pulsante Azioni di classe. Utilizzare questo pulsante per iniziare, mettere in pausa,
riprendere o terminare una classe (lezione).

Esplorazione delle aree di lavoro
TI-Nspire™ CX Premium Teacher Software utilizza le aree di lavoro per consentire di
accedere facilmente alle attività eseguite più frequentemente. Il software dispone di
cinque aree di lavoro predefinite. Ogni area di lavoro è trattata in dettaglio nel
rispettivo capitolo.

• Area di lavoro Contenuto. Utilizzare quest'area di lavoro per trovare e gestire
contenuto dal computer, link ai siti web, palmari collegati o contenuto web di
Texas Instruments.

• Area di lavoro Classe. Utilizzare questo spazio di lavoro per gestire classi e
studenti, utilizzare il pannello Registrazione della classe e scambiare file con gli
studenti. Come nelle versioni precedenti v5.0 consente di utilizzare i palmari TI-
Nspire™ CX e TI-Nspire™ CX CAS in combinazione nella stessa classe. Il software
per gli insegnanti deve essere v5.0e i palmari devono avere la versione v5.0 del
sistema operativo del palmare. Si noti che aggiornato alla v4.0, il software non
supporta una combinazione di palmari TI-Nspire™ e TI-Nspire™ CX.

• Area di lavoro Documenti. Utilizzare quest'area di lavoro per creare documenti e
mostrare concetti matematici.

• Area di lavoro Revisione. Utilizzare questo spazio di lavoro per rivedere una serie di
documenti ritirati, contrassegnare, mostrare o nascondere le risposte degli
studenti, passare tra le viste dati e organizzare dati.

• Area di lavoro Portfolio. Utilizzare quest'area di lavoro per salvare, archiviare,
rivedere e gestire elaborati degli studenti.

Nota: se Navigator non è stato abilitato, vengono visualizzate solo le aree di lavoro
Contenuto e Documenti. Per abilitare Navigator, selezionare Window > Enable TI-Nspire



CX Navigator (Finestra > Abilita TI-Nspire CX Navigator). Inoltre l’area di lavoro
Revisiona viene visualizzata solo quando un elemento è aperto per la revisione.

Esplorazione della barra di stato
Alcune informazioni nella barra di stato cambiano in base all'area di lavoro aperta.

In tutte le aree di lavoro, la barra di stato fornisce informazioni sullo stato della rete e
sullo stato di connessione degli studenti.

Lo stato della rete mostra quante schede di rete wireless TI-Nspire™ sono attualmente
collegate al sistema. È possibile fare clic qui per aprire la finestra Gestione rete.

Lo stato di connessione degli studenti mostra quanti studenti sono attualmente
collegati alla classe e quanti sono assegnati alla classe corrente.

Nell'area di lavoro Documenti, la barra di stato offre informazioni aggiuntive.

À Dimensioni pagina. Mostra le dimensioni pagina del documento come Palmare o
Computer. È possibile utilizzare il menu File di TI-Nspire™ per convertire un
documento da una dimensione pagina a un'altra.

Á Contatore attività/pagina. Etichetta il numero dell'attività e il numero di pagina
della pagina attiva. Ad esempio, un'etichetta 1.2 identifica l'attività 1, pagina 2.

Â Impostazioni. Fare doppio clic per visualizzare o modificare le impostazioni del
documento per il documento attivo o per modificare le impostazioni del documento
predefinite.

Ã Modalità angolo. Mostra un'abbreviazione della modalità angolo (Gradi, Radianti o
Gradi centesimali) in uso. Passare con il puntatore sull'indicatore per visualizzare il
nome completo.

Ä Zoom. Attivo solo nell'anteprima Palmare (fare clic su Anteprima documento sulla
barra degli strumenti e selezionare Palmare). Fare clic ▼ e selezionare un valore di
ingrandimento oppure fare clic sul pulsante di adattamento alla finestra per fare
in modo che l’anteprima del palmare si regoli automaticamente alla dimensione
della finestra.

Å Nitidezza. Attivo solo nell'anteprima Palmare (fare clic su Anteprima documento
sulla barra degli strumenti e selezionare Computer). Fare clic su▼ e selezionare un
valore per aumentare o ridurre la nitidezza del testo e di altri elementi.
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Nell'area di lavoro Revisione, le informazioni della barra di stato cambiano, in base
alla vista nell'Ordinatore pagine.

• Nella vista Documento, la barra di stato fornisce le stesse informazioni della barra
di stato dell'area di lavoro Documento.

• Nella vista Risposte degli studenti, la barra di stato dispone di icone vista Dati.
Utilizzare le icone per passare tra le viste diagramma a barre, tabella e grafico.

À Grafico

Á Istogramma

Â Tabella

Nell'area di lavoro Classe, la barra di stato dispone di icone vista Studenti. Utilizzare le
icone per alternare tra la vista disposizione studenti e la vista elenco studenti.

À Disposizione studenti

Á Elenco studenti

Cambio della lingua
Utilizzare questa opzione per selezionare una lingua preferita. È necessario riavviare
l'applicazione per rendere effettiva la modifica.

1. Fare clic su File > Impostazioni > Cambia Lingua.

Viene visualizzata la finestra di dialogo Scegliere una lingua.

2. Fare clic su¤ per aprire l'elenco a discesa per selezionare una lingua.

3. Selezionare la lingua desiderata.

4. Fare clic su Chiudi ora per chiudere immediatamente il software. Verrà richiesto di
salvare tutti i documenti aperti. Al riavvio del software, il cambio di lingua diventa
effettivo.

—oppure—



Fare clic su Chiudi dopo per continuare a lavorare. La nuova lingua non viene
applicata fino a quando non si chiude e non si riavvia successivamente il software.
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Monitoraggio e reportistica dell'uso del sistema
Gli istituti scolastici che partecipano a programmi di ricerca o che ricevono fondi da
iniziative di finanziamento sono tenuti a monitorare l'uso dei sistemi TI-Nspire™
Navigator™ e a riportarne l'attività a scopo di verifica.

Per monitorare automaticamente l'uso di TI-Nspire™ Navigator™ da parte degli
studenti, viene creata una cartella denominata "Log di sessione" all'interno
dell'appropriata cartella software di TI-Nspire™ Navigator™ sul computer
dell’insegnante quando il software viene installato. Il software genera i file necessari
per monitorare i tipi di attività, la partecipazione, le informazioni relative alla classe e
le attività svolte durante una sessione. I file sono interdipendenti e devono essere
riuniti nella cartella Log di sessione in modo che le informazioni riguardanti l'uso siano
monitorate e riportate in modo accurato.

Il sistema acquisisce automaticamente i dati sull'uso del sistema e aggiunge le
informazioni per ogni nuova sessione della classe nel file pertinente. Se il sistema non
trova una cartella Log di sessione, i dati non vengono monitorati.

Gestione dei Log di sessione
Il sistema genera automaticamente i seguenti file delimitati da virgole (csv) e li
archivia nella cartella Log di sessione. A ogni avvio del software TI-Nspire™, i log
vengono aggiunti al log del giorno precedente per mantenere un registro completo.

• Activities.csv file. In questo file sono registrate le attività svolte durante le sessioni
della classe.

• ActivityTypes.csv file. Questo file è la tabella di ricerca a cui il sistema fa
riferimento durante la creazione di un rapporto sull'uso.

• Attendance.csv file. In questo file sono registrate le informazioni riguardanti ogni
studente che accede a una sessione.

• ClassSession.csv file. In questo file sono registrate le informazioni riguardanti ogni
sessione della classe.

Utilizzo del file Activities (Attività)

Il sistema registra le informazioni riguardanti le attività che si svolgono durante la
sessione della classe in questo file. Informazioni incluse:

• ClassSessionID. Il numero univoco di ID della classe per il programma di
finanziamento.

• ClassName. Nome della classe così come definito nel software.

• ActivityTypeID. Il tipo di attività svolta durante la lezione. L'ID corrisponde ai tipi di
attività definiti nel file Activity Type (Tipo di attività).

• ActivityDetail. Dati aggiuntivi riguardanti il tipo di attività, se disponibili.

• ActivityStart. Ora in cui è stata avviata l’attività.

• ActivityEnd. Ora in cui è stata conclusa l’attività.

• NumStudent. Numero di studenti che partecipano a questa attività.



Utilizzo del File ActivityTypes (Tipi di attività)

Il file ActivityTypes è una tabella di ricerca che include codici per l'identificazione dei
tipi di attività e una breve descrizione di ogni attività.

ID attività Descrizione

SC Cattura schermo

CF Raccogli file

DF Elimina File

SF Invia file

RD Ridistribuisci

SP Salva in Portfolio

CM Raccogli mancanti

SM Invia mancanti

US Invio non richiesto

LP Live Presenter

QP-MC Test rapido - A scelta multipla

QP-OR Test rapido - A risposta aperta

QP-EQ Test rapido - Equazioni

QP-CE Test rapido - Espressione chimica

QP-EX Test rapido - Espressioni

QP-IL Test rapido - Immagine con etichette

QP-IP Test rapido - Immagine con punto/i

QP-CP Test rapido - Coordinate di punti

QP-LS Test rapido - Foglio elettronico

Utilizzo del File Attendance (Partecipazione)

Il sistema registra le informazioni per ogni studente che ha effettuato l'accesso a una
sessione nel file Attendance. Informazioni incluse:

• Class ID. Il numero univoco di ID della classe per il programma di finanziamento.
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• Class Name. Nome della classe così come definito nel software.

• Last Name. Cognome dello studente.

• First Name. Nome dello studente.

• Date and Time. Data e ora in cui lo studente ha effettuato l'accesso. Le
informazioni sono utilizzate per identificare gli studenti che hanno effettuato
l'accesso in orario piuttosto che in ritardo.

• Student ID. L’ID dello studente.

Utilizzo del File Class Session (Sessione della classe)

Il sistema registra le informazioni per ogni sessione della classe per ID della classe. Le
informazioni includono:

• ClassSessionID. Il numero univoco di ID della classe per il programma di
finanziamento.

• ClassName. Nome della classe così come definito nel software.

• Start. L'ora di inizio della classe registrata quando l'insegnate seleziona Inizio
classe (Begin Class).

• End. L'ora di fine della classe registrata quando l'insegnate seleziona Fine classe
(End Class).

• NumStudent. Numero di studenti che hanno effettuato l'accesso durante la
sessione della classe.

• ClassSectionName. Nome della sezione della classe.

• QuickPollTotalTime. Quantità di tempo trascorso dagli studenti sui Testi rapidi.

Operazioni con i file di log

I file di log di sessione vengono gestiti automaticamente in base alla dimensione
ogniqualvolta viene disattivato TI-Nspire™. Se la dimensione di uno qualsiasi dei file è
superiore a 1 MB durante la chiusura della sessione, viene creato un backup di ogni file
nella cartella Log di sessione con i seguenti nomi:

• Activities-bak.csv

• ActivityTypes-bak.csv

• Attendance-bak.csv

• ClassSession-bak.csv

Nota: se un backup è già presente, verrà sovrascritto con una versione più recente.

La volta successiva in cui verrà attivato TI-Nspire™, verranno creati quattro nuovi file di
log vuoti.

Creazione del pacchetto e invio dei log di sessione
A intervalli regolari, l'amministratore del distretto deve riportare i dati relativi all'uso
alla fonte di finanziamento a scopo di verifica. Quando i file vengono richiesti, gli
insegnanti possono facilmente creare il pacchetto dei file della sessione in un file



compresso e inviarlo all'amministratore. Il file compresso preserva il formato e le
dipendenze dei file delle attività e include un nome file predefinito che identifica il file
compresso per l'amministratore.

Completare i passaggi seguenti per creare il pacchetto dei file nella cartella Log di
sessione in un file compresso e inviare il file all'amministratore.

1. Dall'Area di lavoro Contenuto, fare clic su File > Pacchetto log di sessione.

Nota: questa voce del menu è disponibile unicamente se è stata creata la cartella
Log di sessione.

Il log della sessione precedente viene salvato. I dati della sessione successiva
verranno aggiunti ai file esistenti nella stessa cartella delle sessioni precedenti.

Il software crea il pacchetto dei file in un file compresso e assegna un nome
predefinito (TI_PKG_SessionLogs_MMDDYYYY). Viene visualizzata la finestra di
dialogo del pacchetto Log.

2. Fare clic su Sì per navigare nel percorso in cui è stato salvato il file compresso.

Viene visualizzato Esplora risorse di Windows® (o il Finder). Il file zip viene salvato
nella stessa posizione della cartella Log di sessione.

PC:
...\Documenti\TI-Nspire CX CAS Premium Teacher Software\

Mac®:
.../Documenti/TI-Nspire CX CAS Premium Teacher Software/

3. Inviare via email il file compresso all'amministratore.

I dati vengono aggiunti al file esistente a ogni avvio di una nuova sessione. Se i file
inviati all'amministratore non sono più necessari, rimuoverli dalla cartella Log di
sessione e conservare il file compresso. Il sistema genererà dei nuovi file al
prossimo avvio di una nuova sessione.
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Utilizzo dell'area di lavoro Contenuto
L'area di lavoro Contenuto consente l'accesso e la navigazione a cartelle e file
memorizzati su computer, rete e dischi esterni, permettendo di aprire, copiare e
trasferire file agli studenti.

Esplorazione dell' area di lavoro Contenuto

À Riquadro Risorse. Selezionare qui il contenuto. È possibile selezionare cartelle
e collegamenti sul computer, unità di rete, unità esterne o contenuti web. Se
si utilizza un software che supporta i palmari TI-Nspire™ CX, l'intestazione
Palmari collegati è visibile quando i palmari sono connessi.
Nota: è possibile aggiungere nuovi collegamenti ai siti Web preferiti nella
sezione Collegamenti. Si può accedere a questi nuovi collegamenti nel
riquadro Contenuti. I nuovi collegamenti non possono essere aggiunti alla
sezione contenuti web.

Á Barra di navigazione. Navigare in qualsiasi posizione del computer facendo clic
su un elemento nel percorso della barra di navigazione. Quando si seleziona
una risorsa, le opzioni mostrate sono specifiche della risorsa.

Â Riquadro Contenuto. Per impostazione predefinita, sono visualizzate le
cartelle del desktop. Utilizzare questo spazio per individuare e visualizzare i
file presenti sul computer. È possibile individuare e accedere ai file su un
palmare collegato se si utilizza un software che supporti palmari. Utilizzare la
metà superiore dell'area di lavoro come una finestra di gestione file. Il
riquadro Contenuto è in grado di mostrare i contenuti di solo un elemento
selezionato alla volta. Evitare di selezionare più di un elemento alla volta.

Ã Riquadro Anteprima. Visualizza dettagli sul file o la cartella selezionata.



Esplorazione del riquadro Risorse
Utilizzare il riquadro Risorse per individuare i documenti su un computer, accedere a
contenuti web e lavorare con palmari collegati se si utilizza un software TI-Nspire™
che supporta i palmari collegati.

À Contenuto del computer. Consente la navigazione a tutti i file su un computer,
unità di rete e unità esterne. Contenuto del computer si espande e collassa per
fornire l'accesso ai collegamenti predefiniti seguenti:
• Disco locale
• Unità esterne
• Unità di rete
• Desktop
• Documenti
Quando si seleziona un elemento in Contenuto del computer, nel riquadro
Contenuto viene visualizzata la struttura del file. Quando si seleziona una
cartella o un file supportato, il riquadro Anteprima ne visualizza i dettagli.

Á Collegamenti. Per impostazione predefinita, sono elencati i collegamenti a siti
utili di Texas Instruments. Quando si fa clic su Collegamenti, viene visualizzato
un elenco di link nel riquadro dei contenuti. Se si clicca su uno di questi
collegamenti, esso viene lanciato nel web browser. È possibile aggiungere link
personali a questa sezione. Quando si effettua l’aggiornamento, vengono
aggiunti i link dell’ultima versione del software TI-Nspire™.
Gli utenti residenti negli Stati Uniti possono cercare standard o testi scolastici
USA selezionando l'opzione Cerca da Link.
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Â Contenuto web. Elenca i link ai siti di Texas Instruments che contengono
attività supportate da TI-Nspire™. Contenuto web è disponibile se si è connessi
a Internet. È possibile salvare sul proprio computer il materiale trovato in
questi siti e condividere elementi tramite il riquadro Contenuto del computer
o Palmari collegati se si utilizza un software che supporta i palmari. Non è
possibile salvare link a siti web nella sezione Contenuto web.

Nota: il contenuto web disponibile varia a seconda dell'area geografica. Se
non ci sono contenuti online, questa sezione non è visibile nel pannello
Risorse.

Quando si seleziona un elemento in Contenuto web, l'elenco delle attività
viene visualizzato nel riquadro Contenuto, con un'anteprima dell'attività
selezionata nel riquadro Anteprima.

Ã Palmari collegati. Elenca le Informazioni relative ai palmari collegati al
computer. Per vedere cartelle e file di uno specifico palmare, fare clic sul suo
nome.
Il nome di ogni palmare è visualizzato con un’icona di stato:

• Un simbolo di connessione ( ) indica che uno studente è connesso al
palmare e il palmare non è in modalità Premere per Test.

• Un simbolo lucchetto ( ) Mostra che il palmare è stato messo in
modalità Premere per Test con il comando Prepara i palmari. Se il
lucchetto è combinato con un simbolo di avviso ( ), il palmare è in
modalità Premere per Test, ma non è stato messo in tale modalità con
il comando Prepara i palmari.

• Un simbolo di avviso singolo ( ) indica che la versione del SO del
palmare non corrisponde alla versione del software dell’insegnante.

Per aprire una finestra di aiuto contenente i dettagli relativi allo stato,
soffermare il puntatore del cursore sull’icona di stato.
Nota:i palmari collegati non sono mostrati in caso di assenza di palmari
collegati.

Utilizzo del riquadro Anteprima

À Anteprima in miniatura di cartella, file .tns, icona tipo di file o unità didattica
selezionati. Fare doppio clic sull'icona tipo di file per aprire il file nella sua



applicazione associata.

Nota: Se un'unità didattica è vuota e questo spazio è vuoto, si ha la
possibilità di aggiungere file.

Á Se un documento TI-Nspire™ è formato da più pagine, utilizzare la freccia

avanti per visualizzare l'anteprima della pagina successiva. La freccia
indietro diventa attiva così che è possibile spostarsi indietro tra le pagine. Se si
lavora su un'unità didattica, con questo metodo è possibile scegliere di
visualizzare l'anteprima di un documento TI-Nspire™ che fa parte dell'unità.

Â Se si seleziona un'unità didattica, viene visualizzata la finestra di dialogo File
sopra la finestra Dettagli con l'elenco dei file che compongono l'unità
didattica. Fare doppio clic su qualsiasi file in un'unità didattica per aprire il file
nella sua applicazione associata.

Ã Se si seleziona una cartella, la finestra Dettagli visualizza il nome e il percorso
della cartella e la data dell'ultima modifica.
Per i file documento e i file delle unità didattiche, la finestra Dettagli mostra il
nome, la data dell'ultima modifica, la dimensione e se il file è di sola lettura.

Accesso a Contenuto del computer
Contenuto del computer fornisce l'accesso a tutte le informazioni memorizzate sul
vostro computer, rete ed unità esterne.

Utilizzo della barra di navigazione

La barra di navigazione del riquadro Contenuto fornisce gli strumenti necessari per
individuare cartelle e file.

À Opzioni Fare clic su¤ per aprire il menu che consente di accedere alle
opzioni necessarie per lavorare con i file e le cartelle.

Á Percorso corrente: Contiene un percorso di navigazione cliccabile della
posizione corrente. Cliccare sul percorso di navigazione per navigare in
qualsiasi sezione del percorso.

Â Cerca. Inserire una parola chiave da cercare e premere Invio per trovare tutti i
file nella cartella selezionata che la contengono.

Filtraggio di Contenuto del computer

Utilizzare questa opzione di filtraggio per un facile accesso e per la selezione dei
contenuti di insegnamento. È possibile selezionare mostra solo contenuti TI-Nspire™ o
mostra tutti i contenuti.

1. Selezionare una cartella nel Contenuto del computer nel riquadro Risorse.

2. Dalla barra dei menu, selezionare Visualizza> Filtra per.
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3. Scegliere una delle seguenti opzioni:

• Mostra solo contenuti TI-Nspire™

• Mostra tutti i contenuti

Mappatura di un'unità di rete

Completare la seguente procedura per mappare un'unità di rete.

1. Selezionare Contenuto del computer dalla lista Risorse.

2. Fare clic su e quindi fare clic su Crea collegamento.

La finestra di dialogo Aggiungi collegamento a Contenuto si apre.

3. Fare clic suSfoglia.

Nota: è inoltre possibile digitare il percorso completo per l'unità di rete.

Viene visualizzata la finestra di dialogo Seleziona collegamento cartella.

4. Selezionare l'unità di rete.

5. Fare clic su Seleziona.

6. Fare clic suAggiungi posizione.

Viene visualizzata la finestra di dialogo Inserire credenziali disco di rete.



7. Digitare il nome utente e la password fornite dal proprio amministratore di
sistema.

8. Fare clic su Accetta.

La cartella viene aggiunta all'elenco delle cartelle sotto Contenuto locale nel
riquadro Risorse.

Accesso a un'unità di rete protetta

Se l'accesso a un'unità di rete richiede l'autenticazione, completare la seguente
procedura per accedere alla rete protetta.

1. Fare clic sull'unità a cui si desidera accedere nel pannello Risorse.

Viene visualizzata la finestra di dialogo Inserire credenziali disco di rete.

2. Digitare il proprio nome utente e la password.

3. Fare clic su Accetta.

Utilizzo dei collegamenti
Utilizzare questa opzione per aggiungere all'elenco Contenuti del computer cartelle o
unità didattiche contenenti file di uso frequente.

Aggiunta di un collegamento

Per aggiungere un collegamento a una cartella contenente i file a cui si accede spesso:

1. Spostarsi sulla cartella in cui è ubicato il file.

2. Fare clic su e quindi fare clic su Crea collegamento.
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La cartella viene aggiunta all'elenco delle cartelle sotto Contenuto del computer
nel riquadro Risorse.

Eliminazione di un collegamento

Per eliminare un collegamento:

1. Nell'elenco Contenuto del computer, selezionare la cartella da eliminare.

2. Fare clic con il pulsante destro del mouse sulla cartella selezionata e quindi fare
clic su Rimuovi collegamento.

La cartella viene rimossa dall'elenco di collegamenti.

Nota: non è possibile rimuovere i collegamenti predefiniti.

Operazioni con i link
Per impostazione predefinita, l'elenco Link contiene un elenco di link ai siti web di
Texas Instruments. Fare clic su un link per avviare il browser web e accedere al sito
web.

Utilizzo della barra degli strumenti Link

Quando si seleziona Link nel riquadro Risorse, gli strumenti visualizzati nella barra
degli strumenti sono specifici per i link. Utilizzare questi strumenti per aggiungere,
modificare o eliminare link dall'elenco. È inoltre possibile spostare un link in alto o in
basso nell'elenco.

Opzioni. Fare clic su¤ per aprire il menu che consente di accedere
alle opzioni specifiche per i link.

Fare clic su questa icona per aggiungere un link all'elenco.

Selezionare un link esistente e quindi fare clic su questa icona per
modificare gli attribuiti del link. Non è possibile modificare un link di
default.

Fare clic su questa icona per eliminare un link. non è possibile
eliminare un link predefinito.

Selezionare un link e fare clic su questa icona per spostare il link in
alto nell'elenco.



Selezionare un link e fare clic su questa icona per spostare il link in
basso nell'elenco.

Aggiunta di un link

Completare la procedura seguente per aggiungere un link all'elenco Link nel riquadro
Risorse.

1. Fare clic su .

Viene visualizzata la finestra di dialogo Aggiungi link.

2. Digitare il nome del link.

3. Digitare l'URL nel campo Indirizzo.

4. Fare clic su Aggiungi link.

Il link viene aggiunto in fondo all'elenco dei link esistenti.

Modifica di un link esistente

Completare la seguente procedura per modificare un link esistente.

1. Selezionare il link da modificare.

2. Fare clic su .

Viene visualizzata la finestra di dialogo Modifica link.
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3. Apportare le modifiche necessarie al nome del link o all'URL.

4. Fare clic suModifica link.

Le modifiche vengono applicate al link.

Rimozione di un link

Completare la seguente procedura per eliminare un link.

1. Selezionare il link da eliminare.

2. Fare clic su .

Viene visualizzata la finestra di dialogo di conferma.

3. Fare clic su Rimuovi.

Il link viene rimosso dall'elenco.

Nota: non è possibile eliminare un link predefinito.

Spostamento di link in alto o in basso nell'elenco

È possibile modificare l'ordine dei link nell'elenco in base alle esigenze.

▶ Fare clic su per spostare un link selezionato di una posizione in alto
nell'elenco.

▶ Fare clic su per spostare un link selezionato di una posizione in basso
nell'elenco.

▶ Fare clic su , quindi selezionare Sposta all'inizio dell'elenco per spostare un link
selezionato in cima all'elenco.

▶ Fare clic su e quindi selezionare Sposta alla fine dell'elenco per spostare un
link selezionato in fondo all'elenco.

Utilizzo di Contenuto web
Contenuto web fornisce link a materiali online sui siti web di Texas Instruments. È
possibile salvare sul proprio computer il materiale trovato in questi siti e condividere
elementi tramite Contenuto locale e Palmari collegati.

Le informazioni fornite per ciascuna attività includono il nome dell'attività, l'autore, la
data in cui è stata postata l'attività, la dimensione del file e la fonte.



À Barra degli strumenti di spostamento.

Á Titoli delle colonne.

Â Elenco delle attività disponibili.

Ã Elenco dei file contenuti nell'attività.

Ä Dettagli sull'attività selezionata.

Nota: è richiesto il collegamento a Internet per poter accedere ai siti web di Texas
Instruments.

Ordinamento dell'elenco delle attività

Utilizzare i titoli delle colonne per ordinare le informazioni contenute nell'elenco delle
attività. Per impostazione predefinita, l'elenco è visualizzato in ordine alfabetico in
base al nome.

• Fare clic sul titolo Nome per elencare le attività in ordine alfabetico inverso. Fare
clic nuovamente sul titolo per ripristinare l'ordine alfabetico da A a Z.

• Fare clic sul titolo Autore per elencare le attività in ordine alfabetico in base al
nome dell'autore.

• Fare clic sul titolo Data di pubblicazione per elencare le attività in ordine
cronologico, dalla più recente alla meno recente o viceversa.

• Fare clic sul titolo Dimensione per ordinare le attività in base alla dimensione del
file.
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• Fare clic sul titolo Origine per elencare le attività in base all'origine.

• Tasto destro del mouse sull'intestazione della colonna per personalizzare le
intestazioni della colonna visualizzata.

Filtraggio dell'elenco delle attività

Per impostazione predefinita, tutte le attività sono elencate nel riquadro Contenuto. Le
opzioni della barra di navigazione consentono di filtrare le attività in base a soggetto,
argomento e categoria. È anche possibile cercare un'attività utilizzando la ricerca per
parola chiave.

Per trovare tutte le attività collegate a un particolare soggetto:

1. Nel campo Soggetto, fare clic su¤ per aprire il menu a discesa.

2. Selezionare un soggetto.

Vengono visualizzate tutte le attività collegate al soggetto selezionato.

3. Per restringere l'ambito della ricerca, fare clic su¤ nel campo Argomento per
visualizzare e selezionare un argomento collegato al soggetto selezionato.

4. Utilizzare il campo Categoria per restringere ulteriormente la ricerca. Fare clic su
¤ per selezionare una categoria collegata al soggetto e all'argomento selezionati.

Utilizzo di parole chiave per cercare un'attività

Completare la seguente procedura per cercare un'attività utilizzando una parola chiave
o una frase.

1. Digitare una parola chiave o una frase nel campo Filtra per parola chiave.

2. Premere Invio.

Vengono elencate tutte le attività che contengono la parola chiave o la frase.

Apertura di un'attività

1. Selezionare l'attività da aprire.

2. Fare clic su e quindi selezionare Apri.

Viene visualizzata la finestra di dialogo Apri attività con un elenco di tutti i
documenti collegati all'attività selezionata.



È possibile aprire un file .tns o .tsnp nel software TI-Nspire™. Altri file, quali file di
Microsoft® Word e di Adobe® PDF, vengono aperti nelle rispettive applicazioni.

3. Selezionare il file e fare clic su ¢, quindi selezionare Apri.

• Il file .tns viene aperto nell'area di lavoro Documenti.

• Il file .doc o .pdf viene aperto nell'applicazione associata.

Salvataggio di un'attività sul computer

Completare la seguente procedura per salvare un'attività sul computer.

1. Selezionare l'attività da salvare. I dettagli del file vengono visualizzati nella metà
inferiore della finestra.

2. Fare clic su Salva questa attività sul computer nel riquadro Anteprima, per salvare i
suddetti file.

Nota: è anche possibile fare clic con il tasto destro del mouse sull'attività
selezionata e scegliere Salva su computer.

Viene visualizzata la finestra di dialogo Salva file selezionati.

3. Evidenziare la cartella in cui si desidera salvare il file.
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4. Fare clic su Salva.

L'attività viene salvata sul computer come unità didattica.

Copia di un'attività

Completare la seguente procedura per copiare un'attività. Una volta copiata l'attività
negli Appunti, è possibile incollarla in una cartella sul computer, quindi trascinarla
nell'elenco di collegamenti nel riquadro Contenuto locale.

1. Fare clic sull'attività da copiare per selezionarla.

2. Utilizzare uno dei metodi seguenti per copiare l'attività negli Appunti:

• Selezionare l'attività e trascinarla in una cartella nell'elenco Contenuto locale.

• Fare clic su , quindi fare clic su Copia.

• Fare clic con il pulsante destro del mouse su un file nell'elenco File e quindi
selezionare Copia.

• Fare clic su (Copia icona) nella barra degli strumenti.

L'attività viene copiata negli Appunti.

3. Aprire una cartella sul computer, quindi fare clic suModifica > Incolla per copiare
l'attività nella cartella selezionata.

Invio di file a una classe
I file e le cartelle possono essere inviati all'intera classe, ai membri della classe che
sono connessi o a singoli studenti La sessione della classe deve essere attiva per
inviare i file.

Quando si invia un file a tutta la classe, tutti gli studenti correntemente collegati
riceveranno immediatamente il file. Gli studenti che non sono collegati lo riceveranno
non appena effettueranno il collegamento.

Note:

• solo i tipi di file di TI-Nspire™ (.tns) e PublishView™ (.tnsp) si aprono nel software
TI-Nspire™.

• Altri tipi di file (se supportati) come per esempio immagini, elaborazione di testo,
oppure file di foglio elettronico si aprono nell'applicazione che il sistema operativo
ha associato al tipo di file.

Invio di file dalle aree di lavoro Documenti o Contenuto

1. Selezionare il file da inviare alla classe.

• Dall'area di lavoro Contenuto, fare clic sul file nel riquadro Contenuto.
• Nell'area di lavoro Documenti, fare clic sul file in Esplora contenuto.



2. Fare clic su Invia alla classe oppure fare clic su File >Invia a > Invia alla classe.

Viene visualizzata la finestra di dialogo Seleziona studente/i.

3. Selezionare lo studente o gli studenti a cui inviare il file:

• Per inviare il file all'intera classe, fare clic su Classe . Per inviare il file solo

ai membri della classe che sono attualmente connessi, selezionare la casella
Solo studenti connessi.

• Per inviare il file a un solo studente, fare clic su Studenti e quindi fare clic

sullo studente interessato.

Nota: se sono già stati selezionati studenti nella scheda Classe, il software ne
mantiene la selezione.

• Utilizzare l'elenco a discesa Invia a cartella del palmare per selezionare dalla
cartella della classe in corso, la cartella principale sul palmare o le ultime 10
cartelle a cui sono stati inviati i file. (Disponibile solo sul software TI-Nspire™
che supporta i palmari).

4. Fare clic su Fine.

Il trasferimento del file appare nel record della classe nell'area di lavoro Classe.
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Operazioni con i Palmari Collegati
Il software TI-Nspire™ consente di visualizzare contenuto, gestire file e installare gli
aggiornamenti del sistema operativo sui palmari collegati al computer.

Per utilizzare le funzioni descritte in questo capitolo, i palmari devono essere accesi e
collegati tramite uno dei mezzi seguenti:

• TI-Nspire™ Docking Station o TI-Nspire™ CX Docking Station

• Alloggiamento per TI-Nspire™ Navigator™ e punto d'accesso

• Scheda di rete wireless TI-Nspire™ CX Wireless e punto d'accesso

• Scheda di rete wireless TI-Nspire™ CX - v2 e punto d'accesso

• Collegamento diretto tramite cavo USB standard

Nota: le attività descritte in questa sezione possono essere eseguite solo con palmari
TI-Nspire™. Per abilitare la connettività wireless, TI-Nspire™ Premium Teacher
Software e il SO installato sui palmari TI-Nspire™ CX II devono essere della versione
5.0 o successiva. Per palmari TI-Nspire™ CX, il SO deve essere della versione 4.0 o
successiva.

Visualizzazione del contenuto sui palmari collegati
Quando si seleziona un palmare nel riquadro Risorse nell'area di lavoro Contenuto,
tutti i file e le cartelle presenti sul palmare vengono visualizzati nel riquadro
Contenuto. Per visualizzare un'anteprima del documento, selezionare Fare clic qui per
visualizzare l'anteprima del documento nel riquadro Anteprima.

À TI-Nspire™ CX Connected Handhelds (Palmari collegati TI-Nspire™ CX) - Elenca tutti i
palmari collegati e accesi.
Nota: un simbolo di avvertenza accanto al nome del palmare indica che il SO



installato sul palmare non corrisponde alla versione del software installata sul
computer ed è necessario un aggiornamento del SO.

Á Options (Opzioni) - Le opzioni disponibili variano a seconda dell'attività selezionata
in Resources (Risorse).

Â Riquadro Content (Contenuto) - Quando si seleziona Connected Handhelds (Palmari
collegati), nel riquadro Content (Contenuto) vengono visualizzati i seguenti dettagli
dei palmari che sono collegati e accesi:

• Nome

• Battery (Li-ion) (Batteria (Li-ion) - Carica della batteria agli ioni di litio
(ricaricabile) (critica 2%, 25%, 50%, 75%, 100% o "--" per indicare che la
batteria non è presente).

• Battery (AAA) (Batteria (AAA)) - Carica della batteria AAA (critica 2%, 25%,
50%, 75%, 100% o "--" per indicare che la batteria non è presente).

• Storage Size (Dimensione memoria)

• Versione SO

Ã Riquadro Preview (Anteprima) - Fornisce informazioni sul palmare quando si fa clic su
Connected Handhelds (Palmari collegati) nel riquadro Resources (Risorse) e
selezionare un palmare nel riquadro Content (Contenuto). Se si seleziona un file TI-
Nspire™ nel riquadro Contenuto, il riquadro Anteprima mostra un'anteprima
disponibile per quel file.

• Handheld Type (Tipo palmare): Nome dei palmari.

• Product ID (ID prodotto): identificazione prodotto palmare.

• Boot ROM (ROM di avvio): bootstrap interno che esegue operazioni di livello
inferiore per l'avvio del dispositivo.

• Boot Loader (Caricatore di avvio): bootstrap esterno che esegue operazioni di
livello inferiore per l'avvio del dispositivo.

• Operating System (Sistema operativo): il sistema operativo in uso.

• Spazio disponibile: quantità di spazio libero e disponibile sul palmare.

• Battery (Li-ion) (Batteria (Li-ion) - Carica della batteria agli ioni di litio
(ricaricabile) (critica 2%, 25%, 50%, 75%, 100% o "--" per indicare che la
batteria non è presente).

• Battery (AAA) (Batteria (AAA)) - Carica della batteria AAA (critica 2%, 25%,
50%, 75%, 100% o "--" per indicare che la batteria non è presente).

Quando si seleziona un palmare, tutti i file e le cartelle presenti sul palmare vengono
visualizzate nel riquadro Contenuto. Quando si selezionano un file o una cartella, i
dettagli relativi vengono visualizzati nel riquadro Anteprima. Fare clic sull'icona per
visualizzare l'anteprima del documento.
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I dettagli relativi alla cartella o al file selezionato vengono mostrati nel riquadro
Anteprima.

Dettagli della cartella selezionata

Dettagli del file selezionato

▶ Per visualizzare i file contenuti in una cartella, fare doppio clic sul nome della
cartella nel riquadro Contenuto. I file della cartella vengono elencati nel riquadro
Contenuto.

▶ Per visualizzare un'anteprima del contenuto di un file .tns, selezionare Fare clic qui
per visualizzare un'anteprima del documento nel riquadro Anteprima.



Gestione di file su un palmare collegato
Quando si lavora con i file dei palmari collegati nell'area di lavoro Contenuto, utilizzare

il menu Opzioni o il menu contestuale per gestire i file.

Nota: se viene selezionato un tipo di file non supportato dal palmare, alcune selezioni
presenti nel menù Opzioni non sono attive.

Opzione Descrizione

Open (Apri) Apre un file su un palmare collegato:

• Fare clic sul file da aprire.

• Fare clic su Apri. Il documento viene aperto nell'area di lavoro
Documenti.

Salva nel
computer

Salva una copia del file selezionato sul computer:

• Fare clic sul file da salvare.

• Fare clic su Salva sul computer. Viene visualizzata la finestra di
dialogo Salva file selezionati.

• Evidenziare la cartella in cui si desidera salvare il file.

• Fare clic su Salva.

Copia/Incolla Crea una copia di un file:
• Fare clic sul file da copiare.
• Fare clic su Opzioni > Copia per copiare il file negli Appunti.
• Per incollare il file in un'altra cartella, aprire la nuova cartella e

quindi selezionare Opzioni > Incolla.

Nota: Se non si seleziona una nuova posizione, il file copiato
viene inserito con un nuovo nome del tipo "Copia di ...".

Elimina Elimina un file su un palmare collegato:
• Fare clic sul file da rimuovere.
• Fare clic su Elimina.
• Fare clic su Sì nella finestra di dialogo Avvertenza che appare. Fare

clic su No per cancellare.

Aggiorna Per aggiornare l'elenco dei file, fare clic su Opzioni > Aggiorna.

Rinomina Per rinominare un file su un palmare collegato:
• Fare clic sul file da rinominare
• Fare clic su Opzioni > Rinomina.
• Digitare il nuovo nome e premere Invio.

Su un livello Sale di un livello nella gerarchia della cartella. Questa opzione è
disponibile quando si seleziona un file in una cartella

Nuova Crea una nuova cartella:
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Opzione Descrizione

cartella • Fare clic su Nuova cartella.

• Digitare un nome per la nuova cartella.

• Premere Invio.

Aprire Documenti su un palmare Collegato

Per aprire un documento su un palmare collegato nel software TI-Nspire™:

1. Accertarsi che il palmare sia collegato al computer.

2. Fare clic su per aprire Esplora contenuto.

Il nome del palmare collegato è elencato nel riquadro Palmari Collegati.

3. Fare doppio clic sul nome del palmare.

Le cartelle e i file presenti sul palmare vengono elencati.

4. Selezionare il documento che si vuole aprire, quindi fare doppio clic sul nome del
file.

Il documento viene aperto nell'area di lavoro Documenti.

Salvare File in Palmari Collegati

Quando si salva un file dal PC al palmare, i file vengono convertiti in documenti TI-
Nspire™ (file .tns). Per salvare un file dal pc a un palmare collegato:

1. Accertarsi che il palmare sia collegato al computer.

2. Fare clic su per aprire Esplora contenuto.

Le cartelle e i file su pc sono elencati nel riquadro Contenuto.

3. Evidenziare la cartella o il file che si desidera salvare sul palmare.

4. Fare clic sul file per selezionarlo.

5. Trascinare il file a un palmare elencato nel riquadro Palmari collegati.

Il file è stato salvato nel palmare collegato.

Nota: per salvare il file in una cartella presente nel palmare, fare doppio clic sul
nome del palmare per visualizzare le cartelle e i file presenti su di esso, e quindi
trascinare il file nella cartella del palmare.

Se il file è già presente sul palmare, viene visualizzata una finestra di dialogo che
chiede se si vuole sostituire il file. Fare clic su Sostituisci per sovrascrivere il file
esistente. Fare clic su No o Annulla per abbandonare il salvataggio.



Invio di file a palmari
È possibile trasferire attività, cartelle, unità didattiche e file supportati da un computer
ai palmari collegati, da un palmare collegato a un altro o da un palmare collegato a
tutti i palmari collegati.

È possibile trasferire i seguenti elementi:

• Cartelle

• File supportati

.tcc

.tco

.tcc2

.tco2

.tilb

.tns

Invio di un'attività a un palmare collegato

Nell'area di lavoro Contenuto, è possibile inviare un'attività dal link di contenuto web ai
palmari collegati.

1. Utilizzare il selettore dell'area di lavoro per selezionare l'area di lavoro Contenuto.

2. Fare clic su Contenuto web nel riquadro Risorse.

3. Fare clic sull'attività da inviare ai palmari collegati.

4. Utilizzare una delle opzioni seguenti per inviare il file ai palmari selezionati:

• Trascinare il file sull'etichetta Palmari selezionati per trasferire il file a tutti i
palmari collegati. Per trasferire il file su un dato palmare, trascinare il file sul
nome del palmare.

• Per trasferire il file utilizzando lo Strumento Trasferimento:

Nota: non è possibile utilizzare lo Strumento Trasferimento per trasferire file a
palmari durante una sessione della classe.

5. Nella barra degli strumenti, fare clic su e quindi selezionare Invia a palmari

collegati.

-oppure-

Fare clic su e quindi selezionare Invia a palmari collegati.

Viene aperto lo Strumento Trasferimento.
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6. Selezionare il file e quindi fare clic su Avvia trasferimento.

I file e le cartelle selezionati vengono trasferiti ai palmari selezionati.

7. Una volta completato il trasferimento, chiudere lo Strumento Trasferimento.

Invio di file a tutti i palmari collegati

È possibile inviare un file a tutti i palmari collegati quando una classe non è in corso.
Per trasferire file o cartelle da un palmare collegato o da un computer a tutti i palmari
collegati, completare la procedura seguente:

1. Utilizzare il selettore dell'area di lavoro per selezionare l'area di lavoro Contenuto.

2. Selezionare i file o le cartelle da trasferire dal riquadro Risorse.

Nota: è possibile scegliere i file da Contenuto Computer, Contenuto web oppure
Palmari collegati.

3. Fare clic su e quindi selezionare Invia a palmari collegati.

Viene visualizzata la finestra Strumento Trasferimento



4. Fare clic su Avvia trasferimento.

Nota: per aggiungere altri file all'elenco di trasferimento, fare clic su Aggiungi
all'elenco di trasferimento.

I file e le cartelle selezionati vengono trasferiti ai palmari collegati. Per
impostazione predefinita, i file vengono trasferiti ad una cartella sul palmare
chiamata Transferimenti-mm-gg-aa.

Trasferimento di file tra palmari

Se ci sono più palmari collegati, è possibile inviare una cartella o un file da un palmare
a un altro presente nell'elenco Palmari collegati nel riquadro Risorse.

1. Utilizzare il selettore dell'area di lavoro per selezionare l'area di lavoro Contenuto.

2. Nel riquadro Risorse, fare clic sul palmare che contiene i file da trasferire. I file sul
palmare sono elencati nel riquadro Contenuto.

3. Fare clic sulla cartella o file da inviare.

4. Trascinare il file a un altro palmare nell'elenco Palmari collegati.

Nota: è anche possibile copiare e incollare un file da un palmare in un altro.
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Allestimento remoto dei palmari
TI-Nspire™ Premium Teacher Software consente di modificare le impostazioni su
palmari collegati dal computer. I palmari possono essere collegati mediante
connessioni via cavo o wireless.

Non è necessario iniziare una sessione della classe, né richiedere agli studenti di
eseguire l’accesso. È possibile eseguire queste operazioni anche mentre sono in corso
altre attività di trasferimento, ad esempio Test rapido o Presentatore dal vivo.

Cancellazione del blocco note

Questa operazione rimuove tutti i dati del blocco note da ogni palmare collegato,
comprese le pagine della calcolatrice e le pagine Grafici e Geometria del blocco note,
la cronologia e le variabili del blocco note e il contenuto degli appunti. I palmari
possono avere la modalità Premere per Test attivata o disattivata.

AVVISO: questa azione cancella i dati di blocco note e appunti da tutti i palmari
attualmente collegati. L’operazione non può essere limitata a un gruppo selezionato
di palmari.

1. Dal menu Strumenti, selezionare Prepara i palmari > Cancella blocco note.

Sullo schermo appare il messaggio di conferma Cancella blocco note.

2. Per procedere, fare clic su Cancella blocco note.

Un registro di stato visualizza i progressi. Su ogni palmare appare un messaggio di
notifica.

Configurazione delle impostazioni dei documenti

Permette di applicare impostazioni dei documenti come Unità angolare e Modalità
calcolo sui palmari collegati. È anche un modo rapido per mettere tutti i palmari in uno
stato noto. Le configurazioni possono essere salvate per usi futuri. I palmari possono
avere la modalità Premere per Test attivata o disattivata.

Nota: le impostazioni dei documenti sono applicate immediatamente sul blocco note
dei palmari, e vengono salvate come impostazione predefinita per il blocco note e tutti
i nuovi documenti. I documenti aperti o chiusi esistenti conservano le impostazioni
precedenti.

1. Dal menu Strumenti, selezionare Prepara i palmari > Definisci impostazioni dei
documenti predefiniti.



Si apre la finestra di dialogo Impostazioni dei documenti che mostra
l’impostazione che sarà applicata.

2. Fare clic sulle opzioni da modificare, quindi selezionare l’impostazione desiderata.

- Per applicare una configurazione salvata in precedenza, fare clic sull’elenco
Configurazione salvata e selezionare la configurazione desiderata.

- Per ripristinare le impostazioni predefinite di fabbrica, fare clic sull’elenco
Configurazione salvata e selezionare Impostazioni predefinite di fabbrica da TI.

3. (Facoltativo) Per salvare le impostazioni attuali con un nome di configurazione,
fare clic su Salva, digitare il Nome nella finestra di dialogo Salva configurazione e
fare clic su Salva.

4. Fare clic su Invia.

Su ogni palmare appare un messaggio di notifica e un registro di stato visualizza
gli errori e le avvertenze all’insegnante. Fare clic su Fatto per chiudere il registro.

Accesso alla modalità Premere per Test sui palmari

Permette di iniziare una sessione Premere per Test sui palmari collegati e di applicare
lo stesso gruppo di limitazioni a ognuno di essi. Le configurazioni possono essere
salvate per usi futuri.

AVVISO: tutti i palmari attualmente collegati saranno riavviati, compresi quelli che si
trovano già in una sessione Premere per Test. Non è possibile limitare questa azione
a un gruppo selezionato di palmari.

1. Dal menu Strumenti, selezionare Prepara i palmari > Attiva Premere per Test.
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Si apre la finestra di dialogo Configurazione di Premere per Test che mostra le
limitazioni che saranno applicate.

2. Selezionare o deselezionare le limitazioni facendo clic sulla casella di controllo
accanto a ciascuna.

3. (Facoltativo) Per salvare le impostazioni attuali con un nome di configurazione,
fare clic su Salva, digitare il Nome nella finestra di dialogo Salva configurazione e
fare clic su Salva.

4. Fare clic su Attiva Premere per Test.

Un messaggio di avviso elenca gli effetti dell’accesso a una sessione Premere per
Test.

5. Per procedere, fare clic su Attiva Premere per Test.

Ogni palmare conserva i file e le impostazioni attuali, quindi viene riavviato in
modalità Premere per Test. Un registro di stato visualizza gli errori e le avvertenze
all’insegnante. Fare clic su Fatto per chiudere il registro.

Uscita dalla modalità Premere per Test

La sessione Premere per Test sui palmari collegati viene chiusa con il loro riavvio.

AVVISO: tutti i palmari attualmente collegati usciranno dalla sessione Premere per
Test e saranno riavviati. I dati e i file creati durante la sessione Premere per Test
saranno cancellati. Non è possibile limitare questa azione a un gruppo selezionato di
palmari.

1. Informare gli studenti dell’imminente chiusura della sessione Premere per Test sui
loro palmari.

2. Dal menu Strumenti, selezionare Preparare i palmari > Esci da Premere per Test.



Un messaggio di avviso elenca gli effetti dell’uscita dalla sessione Premere per
Test.

3. Per procedere, fare clic su Esci da Premere per Test.

Un registro di stato visualizza i progressi. I palmari vengono riavviati con il
ripristino di file e impostazioni precedenti.

Verificadella disponibilità di un aggiornamento del sistema
operativo
Quando i palmari sono collegati, è possibile verificare la disponibilità di aggiornamenti
del sistema operativo dall'area di lavoro Contenuto o dall'area di lavoro Documenti.

Nota: il computer deve essere collegato a Internet.

1. Mostrare tutti i palmari collegati.

• Nell'area di lavoro Contenuto, fare clic su Palmari collegati nel riquadro Risorse.
• Nell'area di lavoro Documenti, aprire Esplora contenuto e fare clic su Palmari

collegati.

2. Fare clic sul palmare da verificare e quindi selezionare Guida > Controlla
aggiornamento SO del palmare/alloggiamento Lab.

• Se il sistema operativo è aggiornato, si apre la finestra di dialogo Controlla
aggiornamento SO del palmare che specifica che il sistema operativo del
palmare è aggiornato.

• Se il sistema operativo non è aggiornato, il software TI-Nspire™ chiede di
installare il sistema operativo più recente, con la possibilità di scaricarlo sul
computer.
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3. Per disattivare le notifiche automatiche, deselezionare la casella di controllo
Controlla automaticamente gli aggiornamenti.

4. Fare clic su OK per chiudere la finestra di dialogo oppure selezionare Continua e
seguire i suggerimenti per installare il sistema operativo sul palmare.

Installazione aggiornamento del SO
Nota: Per evitare di perdere dati non salvati, chiudere tutti i documenti sul palmare
prima di aggiornarne il sistema operativo (SO). L'aggiornamento del sistema operativo
non sostituisce o rimuove i documenti salvati in precedenza.

Il sistema operativo di un nuovo palmare viene fornito assieme al programma di
installazione, il quale posiziona il sistema operativo nella seguente posizione
predefinita: C:\mydocuments\TI-Nspire\downloads.

Visitare il sito education.ti.com/latest per scaricare i file del sistema operativo più
aggiornati.

Nota: È possibile installare gli aggiornamenti sui palmari collegati dall'Area di lavoro
Contenuto in qualsiasi momento.

Aggiornamento del SO su un singolo palmare

1. Accertarsi che il computer sia collegato a Internet.

2. Mostrare tutti i palmari collegati facendo clic sulla freccia accanto a Palmari
collegati TI-Nspire™ nel riquadro Risorse.

Nota: Unsimbolo di attenzione accanto

al nome del palmare significa:

Il sistema operativo del palmare necessita
di essere aggiornato.
-oppure-
Il palmare dispone di un sistema operativo
più recente rispetto a quello
dell'insegnante.

3. Passare il mouse sopra al Palmare TI-Nspire™ che si desidera aggiornare, quindi
fare clic con il pulsante destro.

4. Fare clic su Controlla aggiornamento SO.

Si apre la finestra di dialogo Controlla aggiornamento SO.

https://education.ti.com/latest


5. Fare clic su Chiudi per annullare l'installazione, oppure fare clic su Continua e
seguire le indicazioni per installare il sistema operativo sul palmare.

Al termine dell'aggiornamento, il palmare si riavvia automaticamente.

Aggiornamento del sistema operativo su più palmari 

Nota: Per evitare di perdere dati non salvati, chiudere tutti i documenti sul palmare
prima di aggiornarne il sistema operativo (SO). L'aggiornamento del sistema operativo
non sostituisce o rimuove i documenti salvati in precedenza.

1. Fare clic su Palmari collegati TI-Nspire™ nel riquadro Risorse.

2. Selezionare tutti i palmari che si desiderano aggiornare nel riquadro Contenuto.

3. Fare clic su Strumenti > Installa SO.

Viene visualizzata la finestra d'installazione del SO.
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4. Fare clic su Aggiungi file SO.

La finestra di dialogo Aggiungi all'elenco di trasferimento si apre.

5. Selezionare i file del SO opportuni.

• Per aggiornare un palmare TI-Nspire™ CX, selezionare TI-Nspire.tco.

• Per aggiornare un palmare TI-Nspire™ CX CAS, selezionare TI-Nspire.tcc.

• Per aggiornare un palmare TI-Nspire™ CX II, selezionare TI-Nspire.tco2.



• Per aggiornare un palmare TI-Nspire™ CX II CAS, selezionare TI-Nspire.tcc2.

• Per aggiornare un palmare TI-Nspire™ CX II-T, selezionare TI-Nspire.tct2.

6. Fare clic su Seleziona.

L'Installazione del SO rivisualizza i file del SO selezionati.

7. Fare clic su Installa SO.

Le informazioni sugli aggiornamenti del SO, e la finestra di dialogo Seleziona File
SO sul palmare vengono rivisualizzate per ulteriori selezioni.

Rinomina Palmari
È possibile rinominare i palmari dall'area di lavoro Contenuto.

Nota: la ridenominazione di un palmare non influisce sulle informazioni di connessione
degli studenti.

1. Fare clic con il pulsante destro del mouse sul nome del palmare nel riquadro
Contenuto.

2. Fare clic su Rinomina.

3. Digitare il nuovo nome.

4. Premere Invio per andare al nome successivo da modificare.

5. Per uscire dalla modalità di modifica, fare clic su un'area dello schermo esterna ai
nomi dei palmari. In alternativa, si esce dalla modalità di modifica dopo aver
premuto Invio sull'ultimo nome modificato.

Utilizzo di Identifica selezionato per individuare palmari
Se si stanno utilizzando TI-Nspire™ Docking Station o TI-Nspire™ CX Docking Station, è
possibile utilizzare questa funzione per individuare palmari.

1. Accertarsi che i palmari siano accesi e che la docking station sia collegata al
computer.

2. Utilizzare il selettore dell'area di lavoro per selezionare l'area di lavoro Contenuto.

3. Fare clic su Strumenti > Identifica palmare/alloggiamento Lab selezionato oppure
fare clic con il pulsante destro del mouse sul riquadro Contenuto.

Entrambi i LED sulla docking station sotto l'alloggiamento del palmare
lampeggeranno per 30 secondi.
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Utilizzo dello Strumento Trasferimento
Se non è attiva alcuna sessione per la classe, è possibile trasferire singoli file o intere
cartelle contenenti file dal computer ai palmari TI-Nspire™ collegati utilizzando lo
Strumento Trasferimento. Con lo Strumento Trasferimento, è possibile trasferire uno o
più file o documenti a uno o più palmari senza richiedere agli studenti di connettersi.

File Estensioni file

Sistema operativo (SO) .tcc (per palmari TI-Nspire™ CX CAS)
.tco (per palmari TI-Nspire™ CX)
.tcc2 (per palmari TI-Nspire™ CX II CAS)
.tco2 (per palmari TI-Nspire™ CX II)
.tct2 (per palmari TI-Nspire™ CX II-T)

Documenti .tilb (unità didattica TI-?Nspire™)
.tns (documento TI-?Nspire™)

Note:

• è possibile trasferire più di un file del sistema operativo alla volta; tuttavia, è
possibile trasferire un solo file di sistema operativo con una data estensione alla
volta. Ad esempio, è possibile trasferire contemporaneamente un file .tcc e un file
.tco, ma solo un file .tcc alla volta.

Interfaccia dello Strumento Trasferimento
La finestra di dialogo Strumento Trasferimento contiene una scheda Impostazione e
una scheda Stato.

Scheda Impostazione

La scheda Impostazione consente di selezionare i file da trasferire e la cartella di
destinazione.



Sono disponibili le seguenti funzioni:

Funzione Descrizione

Aggiungi file… Fare clic sui file o sulle cartelle con i file da aggiungere all'elenco di
trasferimento. L'elenco di trasferimento riporta il Nome file (o il
nome della cartella), la Cartella di destinazione e la Dimensione del
file o della cartella (in KB) da trasferire.

Rimuovi
selezione

Selezionare per rimuovere i file e le cartelle selezionati dall'elenco
di trasferimento. Questa opzione è abilitata quando si aggiungono file
all'elenco di trasferimento.

Eliminare
tutte le
cartelle e i file
prima del
trasferimento

Selezionare per cancellare tutti i file e le cartelle dal palmare prima
di un trasferimento di file.

Modifica
cartella di
destinazione

Selezionare per cambiare la cartella di destinazione dei file da
trasferire.

Scheda Stato

La scheda Stato è attiva solo se è in corso un trasferimento.
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Quando si avvia un trasferimento, lo Strumento Trasferimento attiva automaticamente
la scheda Stato. La scheda Stato consente di visualizzare l'avanzamento e lo stato dei
file durante il trasferimento e fornisce le seguenti informazioni:

Informazioni Descrizione

Nome file Indica il nome e l'estensione del file.

Cartella/ID
palmare

Indica la cartella di destinazione e l'ID del palmare.

Stato Visualizza lo stato completato, la barra di progressione o un eventuale
messaggio di errore. Messaggi di errore include:

• Batteria in esaurimento

• Tipo di palmare sbagliato

• Memoria piena

• Connessione persa

Notes:

• Se non ci sono trasferimenti attivi, viene visualizzato il seguente messaggio:
“nessun trasferimento attivo. Utilizzare la scheda Configurazione per configurare e
avviare il trasferimento."

• Durante un trasferimento, le opzioni della scheda Impostazione non sono
disponibili.

Apertura dello Strumento Trasferimento
Prima di poter usare lo Strumento Trasferimento, è necessario terminare tutte le
sessioni della classe in corso.

Per aprire lo strumento Trasferimento, usare uno dei seguenti metodi:



▶ Fare clic su Strumenti > Trasferimento Strumento.

▶ Fare clic su e quindi selezionare Invia a palmari collegati.

Lo Strumento Trasferimento si apre nella scheda Impostazione.

Aggiunta di file o cartelle all'elenco di trasferimento
È necessario aggiungere file o cartelle all'elenco di trasferimento prima di poter
avviare un trasferimento.

Nota: È possibile aggiungere all'elenco di trasferimento solo una cartella contenente
file.

Per aggiungere file o cartelle all'elenco di trasferimento

1. Nella finestra Strumento Trasferimento, fare clic su Aggiungi all'elenco di
trasferimento.

Lafinestra di dialogo Aggiungi all'elenco di trasferimento si apre.

2. Per aggiungere file all'elenco di trasferimento, accedere alla cartella o alle cartelle
che contengono i file da trasferire.

3. Fare clic su Seleziona per aggiungere i file evidenziati all'elenco di trasferimento.

• Nella scheda File, è possibile vedere sia i file che le cartelle, ma non è possibile
selezionare cartelle. È necessario aprire una cartella e selezionare un file.
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• Per selezionare più file contemporaneamente in una cartella, premere e
mantenere premuto il tasto Ctrl (Mac®: “) mentre si selezionano i file.

4. Per aggiungere cartelle contenenti file, fare clic sulla scheda Cartelle, quindi
evidenziare la cartella da selezionare.

5. Fare clic su Seleziona per aggiungere le cartelle selezionate all'elenco di
trasferimento.

Nota: Per selezionare più file o cartelle contemporaneamente, premere e
mantenere premuto il tasto Ctrl (Mac®: “) mentre si selezionano le cartelle.

I file e le cartelle selezionate appaiono nella finestra Strumento Trasferimento.

Nota: È possibile aggiungere all'elenco di trasferimento un solo tipo di file di
sistema operativo Se si tenta di aggiungere più tipi di file di sistema operativo,
viene visualizzato il seguente messaggio di errore.

Rimozione di file o cartelle dall'elenco di trasferimento
È possibile rimuovere dall'elenco di trasferimento i file e le cartelle che non si vogliono
più trasferire.

Per rimuovere file o cartelle dall'elenco di trasferimento, completare la procedura
seguente:



1. Nella finestra Strumento Trasferimento, selezionare i file o le cartelle da
rimuovere.

Nota: Per selezionare più file o cartelle contemporaneamente, premere e
mantenere premuto il tasto Ctrl (Mac®: “) mentre si selezionano i singoli file o
cartelle.

2. Fare clic su Rimuovi selezionati.

I file o le cartelle vengono rimossi dall'elenco di trasferimento.

Modifica della cartella di destinazione
Eccetto nel caso di un file di sistema operativo, è possibile modificare la cartella di
destinazione di qualsiasi file o cartella nell'elenco di trasferimento.

Per impostazione predefinita, lo Strumento trasferimento crea la cartella di
destinazione “Trasferisci dati.” Il formato della data si basa sull'impostazione di lingua
preferita e sul luogo dell'utente. Ad esempio, il formato data predefinito degli Stati
Uniti è mm-gg-aa. Se si modifica l'impostazione della lingua preferita, si modifica
anche questo formato di data predefinita.

Per modificare la cartella di destinazione:

1. Cliccare un file o cartella

2. Eseguire una delle seguenti azioni:

• Dall'elenco a discesa Modifica cartella di destinazione, selezionare “Livello
superiore del palmare” o una cartella disponibile.

• Nell'elenco a discesa Modifica cartella di destinazione, digitare un nuovo nome
della cartella di destinazione.
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Nota: I nomi di cartella possono contenere caratteri alfanumerici e possono
includere i simboli delle barre ( / e \ ). Non è possibile utilizzare le doppie barre ( 
// e \\) e alcuni caratteri speciali (?? | : * " " < > | ).

3. Fare clic suModifica.

La cartella di destinazione dell'elenco di trasferimento viene modificata per i file o
le cartelle selezionati.

Eliminazione di tutti i file e le cartelle del palmare
È possibile utilizzare lo Strumento Trasferimento per eliminare tutti i file e le cartelle
di un palmare collegato. Utilizzare questa funzione per eliminare file e cartelle per
azzerare i palmari degli studenti e assicurasi che vi siano presenti solo i file necessari
per lavorare.

Per impostazione predefinita, lo Strumento Trasferimento disabilita questa
impostazione. Se selezionata, la nuova impostazione diventa quella predefinita alla
successiva apertura dello Strumento Trasferimento.

Per eliminare tutte le cartelle e i file dai palmari collegati:

1. Nella finestra Strumento Trasferimento, selezionare Eliminare tutte le cartelle e i
file prima del trasferimento.



2. Fare clic su Avvia trasferimento.

Viene visualizzata la finestra di dialogo Conferma.

3. Fare clic su Sì.

Lo Strumento Trasferimento mostra la barra di Stato. Questa barra mostra lo stato
e i progressi dell'eliminazione dei file.

Avvio di un trasferimento
Dopo aver aggiunto tutti i file e le cartelle all'elenco di trasferimento e aver
selezionato eventualmente altre opzioni, è possibile avviare il trasferimento. È
possibile trasferire contemporaneamente file di sistema operativo e documenti.

Avvio di un trasferimento:

1. collegare uno o più palmari TI-Nspire™.

Se i palmari non sono collegati, la scheda Stato visualizza “Nessun palmare
collegato attivo” all'avvio del trasferimento.

2. Per aprire il riquadro Risorse, completare una delle seguenti azioni:

• Per trasferire file a uno o più palmari TI-Nspire™, selezionare i singoli palmari.
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• Per trasferire file a tutti i palmari TI-Nspire™ collegati, selezionare Palmari
collegati (cartella principale).

3. Nella finestra Strumento Trasferimento, fare clic su Avvia trasferimento.

Nella finestra Strumento Trasferimento viene attivata la scheda Stato con le
informazioni sul trasferimento.

• Una volta completato il trasferimento, la barra di progressione scompare.
• Durante un trasferimento, lo Strumento Trasferimento visualizza i palmari

collegati e i file correttamente ricevuti.
• Se un palmare viene scollegato e ricollegato durante un trasferimento, lo

Strumento Trasferimento mostra lo stato dei trasferimenti completati e
riprende il trasferimento degli altri file, se necessario.

Interruzione del trasferimento di file
È possibile interrompere un trasferimento di file in qualsiasi momento.

Per interrompere un trasferimento di file:

1. Nella finestra Strumento Trasferimento, fare clic su Interrompi trasferimento.

Viene visualizzata la finestra di dialogo Conferma.

2. Fare clic su Sì.

Lo Strumento Trasferimento interrompe il trasferimento e ritorna alla scheda
Impostazione.

• Se un palmare collegato ha già ricevuto dei file, quei file rimangono sul
palmare.

• I file rimangono nella scheda Impostazione fino a quando non si chiude lo
Strumento Trasferimento oppure fino a quando non li si rimuove.

Chiusura dello Strumento Trasferimento
Una volta completato il trasferimento di file e cartelle, chiudere lo Strumento
Trasferimento.

▶ Per chiudere lo Strumento Trasferimento, fare clic su Chiudi.



• Non è possibile chiudere lo Strumento Trasferimento se c'è un trasferimento
attivo.

• Una volta chiuso, lo Strumento Trasferimento cancella i file e le cartelle
aggiunte all'elenco di trasferimento.

• Una volta chiuso, lo Strumento Trasferimento mantiene l'ultima impostazione
di Eliminare tutte le cartelle e i file prima del trasferimento.
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Utilizzo dell'area di lavoro Documenti
Utilizzare quest'area di lavoro per creare, modificare e visualizzare documenti TI-
Nspire™ e PublishView™ e per spiegare concetti matematici.

Esplorazione dell'area di lavoro Documenti

À Casella degli strumenti Documenti. Contiene strumenti quali il menu
Document Tools (Strumenti del documento), l'ordinatore pagine, l'emulatore
TI-SmartView™, Utilities (Utilità) ed Content Explorer (Esplora contenuto). Fare
clic su ciascuna icona per accedere agli strumenti disponibili. Quando si lavora
in un documento TI-Nspire™, gli strumenti disponibili sono specifici di quel
documento. Quando si lavora in un documento PublishView™, gli strumenti
sono specifici di quel tipo di documento.

Á Riquadro Casella degli strumenti.. Visualizza le opzioni dello strumento
selezionato. Ad esempio, fare clic sull'icona Strumenti del documento per
accedere agli strumenti necessari per lavorare con l'applicazione attiva.
Nota: in TI-Nspire™ CX Premium Teacher Software, quando si inserisce una
domanda lo strumento per la creazione delle domande viene aperto in
quest'area. Per ulteriori informazioni, vedere Utilizzo di Domanda nel
software per insegnanti.

Â Area di lavoro. Mostra il documento corrente e consente di svolgere calcoli,
inserire applicazioni e aggiungere pagine e attività. È attivo un solo documento
(selezionato) alla volta. Gli altri documenti sono visualizzati come schede.

Ã Informazioni sul documento. Mostra il nome di tutti i documenti aperti.
Quando vi sono troppi documenti aperti da elencare, fare clic sulle frecce
avanti e indietro per scorrere i documenti aperti.

Utilizzo della Casella degli strumenti Documenti
La Casella degli strumenti Documenti, a sinistra nell'area di lavoro, contiene gli
strumenti necessari per lavorare sia con documenti TI-Nspire™ che PublishView™.
Quando si fa clic sull'icona di uno strumento, gli strumenti ad esso associati vengono
visualizzati nel riquadro Casella degli strumenti.



Esplorazione di Strumenti del documento
Nell'esempio che segue, il menu Strumenti del documento è aperto e mostra le opzioni
dell'applicazione Calcolatrice. Nei documenti TI-Nspire™, il menu Strumenti del
documento contiene gli strumenti disponibili per lavorare con un'applicazione. Gli
strumenti sono specifici per l'applicazione attiva.

In un documento PublishView™, il menu Strumenti del documento contiene gli
strumenti necessari per inserire applicazioni TI-Nspire™ e documenti TI-Nspire™ così
come oggetti multimediali, quali riquadri di testo, immagini e link a siti web e file. Per
ulteriori informazioni, vedere Operazioni con documenti di PublishView™.

À Menu della Casella degli strumenti Documenti.

Á Strumenti disponibili per l'applicazione Calcolatrice. Fare clic su ¢ per aprire il
sottomenu di ciascuna opzione.

Â
Fare clic su per chiudere e fare clic su per aprire gli Strumenti del
documento.

Esplorazione dell'Ordinatore pagine
L'esempio che segue mostra la Casella degli strumenti Documenti con l'Ordinatore
pagine aperto. Utilizzare l'Ordinatore pagine:

• Per visualizzare il numero di attività nel documento e la pagina attiva.

• Per passare da una pagina all'altra, fare clic sulla pagina desiderata.
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• Consente di aggiungere, tagliare, copiare e incollare attività all'interno dello stesso
documento o tra documenti.

Nota: quando si lavora in un documento PublishView™, l'Ordinatore pagine non è
disponibile nella Casella degli strumenti Documenti.

À Menu della Casella degli strumenti Documenti.

Á Fare clic sul segno meno per comprimere la vista. Fare clic sul segno + per
aprire la vista e visualizzare le pagine nel documento.

Â Barra di scorrimento. La barra di scorrimento è attiva solo quando ci sono più
pagine di quante ne possa mostrare il pannello.

Esplorazione della funzione TI-SmartView™
La funzione TI-SmartView™ emula il funzionamento del palmare. Nel software per
insegnanti, il palmare emulato facilita le presentazioni in classe. Nel software per
studenti, la tastiera emulata fornisce agli studenti la possibilità di utilizzare il software
come sul palmare.



Nota: il contenuto viene visualizzato nello schermo piccolo di TI-SmartView™ solo
quando per il documento è selezionata la vista palmare.

Quando si lavora in un documento PublishView™, l'emulatore TI-SmartView™ non è
disponibile.

Nota: la seguente figura mostra il pannello TI-SmartView™ nel software per
insegnanti. Nel software per studenti, è mostrata solo la tastiera. Per ulteriori
informazioni, vedere Utilizzo dell'emulatore TI-SmartView™.

À Menu della Casella degli strumenti Documenti.
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Á Selettore palmare. Fare clic su¤ per selezionare il palmare da mostrare nel
riquadro:

• TI-Nspire™ CX II o TI-Nspire™ CX II CAS

Quindi selezionare come visualizzare il palmare:

• Scuro

• Luce

• Profilo
Â Selettore vista. Nel software per insegnanti, fare clic su¤ per selezionare la

vista del palmare:

• Solo palmare

• Tastiera + Schermo affiancato

• Palmare + Schermo affiancato

Nota: è possibile modificare queste opzioni anche nella finestra TI-SmartView™
Options (Opzioni di TI-SmartView™). Fare clic su File> Settings (Impostazioni) >
Opzioni di TI-SmartView™ (Opzioni di TI-SmartView™) per aprire la finestra.
Nota: il selettore vista non è disponibile nel software per studenti.
Se è attiva la vista Solo palmare, selezionare Sempre in primo piano per
mantenere il palmare in primo piano rispetto a tutte le altre applicazioni. (solo
software per insegnanti).

Esplorazione di Esplora contenuto
Utilizzare Esplora contenuto:

• Per visualizzare un elenco dei file presenti sul computer.

• Per creare e gestire unità didattiche.

• Se si utilizza un software che supporta palmari collegati, è possibile:

- Visualizzare un elenco dei file presenti su qualsiasi palmare collegato.
- Aggiornare il SO sui palmari collegati.
- Trasferire file tra un computer e i palmari collegati.

Nota: se si utilizza un software TI-Nspire™ che non supporta palmari collegati,
l'intestazione Palmare collegato non si visualizzerà nel riquadro Esplora contenuto.



À Menu della Casella degli strumenti Documenti.

Á Mostra i file presenti sul computer e il nome della cartella in cui sono memorizzati.
Fare clic su¤ per passare a un'altra cartella sul computer.

Â Elenco di cartelle e di file all'interno della cartella specificata nel campo Cerca in:.
Fare clic con il pulsante destro del mouse su un file o una cartella evidenziati per
aprire il menu contestuale che elenca le azioni disponibili per il file o la cartella.

Ã
Fare clic su per chiudere l'elenco dei file. Fare clic su per aprire l'elenco
dei file.

Ä Menu Opzioni. Fare clic su¤ per aprire il menu delle azioni che si possono
eseguire su un file selezionato:

• Aprire un file o una cartella esistenti.

• Salire di un livello nella gerarchia delle cartelle

• Creare una nuova cartella.

• Creare una nuova unità didattica.

• Rinominare un file o una cartella.

• Copiare un file o una cartella selezionati.

• Incollare un file o una cartella copiati negli Appunti.
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• Eliminare un file o una cartella selezionati.

• Selezionare tutti i file di una cartella.

• Creare pacchetti di unità didattiche.

• Aggiornare la vista.

• Installare SO.
Å Palmari collegati. Elenca i palmari collegati. L'elenco conterrà più palmari se ci sono

più palmari collegati al computer oppure se si utilizzano le TI-Nspire™ Docking
Station.

Æ Nome del palmare collegato. Per mostrare le cartelle e i file di un palmare, fare
doppio clic sul nome del palmare.
Fare clic su¤ per passare a un'altra cartella sul palmare.

Esplorazione di Utilità
Il pannello Utilità fornisce accesso a modelli e operatori matematici, simboli speciali,
elementi del catalogo e librerie necessarie quando si lavora con i documenti.
Nell'esempio che segue, è aperta la scheda Modelli matematici.



À Menu della Casella degli strumenti Documenti.

Á I modelli matematici sono aperti. Fare doppio clic su un modello per inserirlo
in un documento. Fare clic sulla scheda Modelli matematici per chiudere la
vista dei modelli.
Per aprire i simboli, il catalogo, gli operatori matematici e le librerie, fare clic
sulla scheda.

Â Casella di controllo Wizards On (Procedure guidate attive). Selezionare questa
opzione per utilizzare una procedura guidata per inserire gli argomenti di una
funzione.

Ã Schede per l'apertura di viste in cui è possibile selezionare e inserire in un
documento simboli, elementi del catalogo, operatori matematici, elementi
delle librerie. Fare clic sulla scheda per aprire la vista.

Utilizzo dell'area di lavoro
L'area a destra dell'area di lavoro rappresenta lo spazio in cui creare documenti TI-
Nspire™ e PublishView™ e lavorare con essi. Quest'area di lavoro fornisce una vista del
documento in cui è possibile aggiungere pagine, inserire applicazioni e svolgere tutto il
lavoro. È attivo un solo documento alla volta.

Quando si crea un documento, è necessario specificare le sue dimensioni pagina come
Palmare o Computer. Questo mostra come la pagina viene visualizzata nell'area di
lavoro.

• Le dimensioni pagina Palmare sono ottimizzate per gli schermi di dimensioni
ridotte di un palmare. Queste dimensioni pagina possono essere visualizzate su
palmari, schermi di computer e tablet. Il contenuto è scalato quando viene
visualizzato su uno schermo più ampio.

• Le dimensioni Computer sfruttano lo spazio più ampio dello schermo di un
computer. Questi documenti possono mostrare dettagli senza che siano necessari
troppi scorrimenti. Il contenuto non è scalato quando viene visualizzato su un
palmare.

É possibile cambiare l'anteprima di pagina per visualizzare in che modo il documento
apparirà nelle dimensioni pagina diverse.

▶ Per cambiare l'anteprima di pagina, fare clic su Anteprima documento nella barra
degli strumenti e quindi fare clic su Palmare o Computer.

Per maggiori informazioni sulle dimensioni pagina e sull'anteprima del documento,
fare riferimento a Operazioni con i documenti di TI-Nspire™.
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Modifica delle impostazioni documento
Le impostazioni del documento regolano la modalità di visualizzazione di tutti i
numeri, compresi elementi o matrici e liste, nei documenti di TI-Nspire™ e
PublishView™. È possibile modificare le impostazioni predefinite in qualsiasi
momento, nonché selezionare impostazioni per un documento specifico.

Modifica delle impostazioni documento

1. Creare un nuovo documento o aprirne uno esistente.

2. Dal menu File di TI-Nspire™, selezionare Settings (Impostazioni)
> Document Settings (Impostazioni documento).

Viene visualizzata la finestra Impostazioni documento.

Quando si apre questa finestra per la prima volta, vengono visualizzate le
impostazioni predefinite.

3. Premere Tab oppure utilizzare il mouse per spostarsi nell'elenco delle
impostazioni. Fare clic su¤ per aprire l'elenco a discesa e visualizzare i valori
disponibili per ciascuna impostazione.

Campo Valori

Mostra cifre • Float (Mobile)
• Float1 - Float12 (Mobile1 - Mobile12)
• Fix0 - Fix12 (Fissa0 - Fissa12)

Angolo • Radiante
• Grado
• Gradi centesimali

Formato
esponenziale

• Normale
• Scientifica
• Tecnica

Reale o
Complesso

• Reale
• Rettangolare
• Polare

Modalità
calcolo

• Auto
• Esatto
• Approssima

Nota: il modo Auto mostra qualsiasi risultato che non sia un numero
intero in forma frazionaria, a meno che nell'attività sia usato un
decimale. Il modo Esatto (solo CAS) mostra in formato frazionario o
simbolico qualsiasi risultato che non sia un numero intero, a meno
che nell’attività non venga utilizzato un numero decimale.



Campo Valori

Exact
Arithmetic

• Acceso
• Disattivato

Nota: Questa opzione è disponibile solo per i palmari Exact
Arithmetic.

Modalità
CAS

• Acceso
• Exact Arithmetic
• Disattivato

Nota: Questa opzione è disponibile solo per i palmari e il software
CAS.

Formato
vettoriale

• Rettangolare
• Cilindrico
• Sferico

Base • Decimali
• Esa
• Binario

Sistema
unità di
misura

• SI
• ING/US

Nota: Questa opzione è disponibile solo per i palmari e il software
CAS.

4. Fare clic sull'impostazione desiderata.

5. Scegliere una delle seguenti opzioni:

• Per applicare le impostazioni al documento aperto e al Blocco note e salvarle
come valori predefiniti per le nuove applicazioni, fare clic su OK.

• Fare clic su Annulla per chiudere la finestra di dialogo senza effettuare
modifiche.

Modifica delle impostazioni di Grafici e geometria
Le impostazioni di Grafici e geometria regolano la modalità di visualizzazione delle
informazioni nei problemi aperti ed in nuovi problemi successivi. Quando si modificano
queste impostazioni, le nuove selezioni diventano le impostazioni predefinite.

Completare la procedura seguente per personalizzare le impostazioni di grafici e
geometria.

1. Creare un nuovo documento grafici e geometria o aprire un documento esistente.

2. Nella casella degli strumenti Documenti, fare clic su per aprire il menu
dell'applicazione Grafici e geometria.
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3. Fare clic su Impostazioni > Impostazioni.

Viene visualizzata la finestra di dialogo Impostazioni di Grafici e geometria.

4. Premere Tab oppure utilizzare il mouse per spostarsi nell'elenco delle
impostazioni. Fare clic su ¢ per aprire l'elenco a discesa e visualizzare i valori
disponibili per ciascuna impostazione.

Campo Valori
Mostra cifre • Auto

• Float (Mobile)
• Float1 - Float12 (Mobile1 -

Mobile12)
• Fix0 - Fix12 (Fissa0 - Fissa12)

Graphing Angle (Angolo Grafico) • Auto
• Radiante
• Grado
• Gradi centesimali

Geometry Angle (Angolo Geometria) • Auto
• Radiante
• Grado
• Gradi centesimali

5. Selezionare l'impostazione desiderata.

6. Selezionare una casella di controllo per abilitare un'opzione o cancellarne il segno
di spunta per disabilitare la relativa opzione.

Casella di controllo Quando è selezionata

Nascondi
automaticamente le
etichette del

Le etichette del grafico vengono visualizzate solo quando
sono selezionate, afferrate o ci si sofferma sopra con il
puntatore del mouse.



Casella di controllo Quando è selezionata

grafico

Mostra valori finali
assi

Viene visualizzata un'etichetta numerica in corrispondenza
dei valori minore e maggiore visibili su un asse.

Mostra
suggerimenti per la
manipolazione di
funzioni

Mostra informazioni utili mentre si manipolano i grafici
delle funzioni.

Trova
automaticamente
punti di interesse

Mostra gli zeri, i punti di minimo e i punti di massimo di
funzioni e oggetti rappresentati graficamente mentre si
percorrono i grafici delle funzioni.

7. Scegliere una delle seguenti opzioni:

• Per applicare le impostazioni al documento aperto e al Blocco note e salvarle
come valori predefiniti per le nuove applicazioni Grafici e Geometria, fare clic
su OK.

• Fare clic su Annulla per chiudere la finestra di dialogo senza effettuare
modifiche.

Utilizzo dell'area di lavoro Documenti 91



92 Operazioni con documenti TI-Nspire™

Operazioni con documenti TI-Nspire™
Tutto il lavoro creato e salvato con le applicazioni TI-Nspire™ viene memorizzato in un
documento, che può essere condiviso con altri che utilizzano il software TI-Nspire™ e
con quanti utilizzano i palmari. Esistono due tipi di documenti:

• Documenti TI-Nspire™ (file .tns)

• Documenti PublishView™ (file .tnsp)

Documenti TI-Nspire™.

Un documento TI-Nspire™ si compone di una o più attività. Ogni attività contiene una o
più pagine. Nell'area di lavoro viene visualizzata una pagina alla volta. Tutte le
operazioni si svolgono nelle pagine delle applicazioni.

Poiché il software TI-Nspire™ e i palmari condividono le medesime funzionalità, è
possibile trasferire documenti TI-Nspire™ tra computer e palmari. Quando si crea un
documento, si seleziona una delle due dimensioni di pagina.

• Palmare. Dimensione: 320 × 217 pixel. Questa dimensione consente di visualizzare
i documenti su tutte le piattaforme. Il contenuto sarà scalato quando viene
visualizzato su un tablet o uno schermo più ampio.

• Computer. Dimensione: 640 × 434 pixel. Il contenuto sarà scalato quando viene
visualizzato su una piattaforma più piccola. Alcuni contenuti potrebbero non essere
visibili su un dispositivo palmare.

È possibile convertire un documento da una dimensione di pagina a un'altra in
qualsiasi momento.

Documenti PublishView™

I documenti PublishView™ possono essere stampati su un normale foglio di carta o
pubblicati in un sito web o blog. I documenti PublishView™ possono includere testo
formattato, immagini e collegamenti ipertestuali oltre a tutte le applicazioni TI-
Nspire™.

Per ulteriori informazioni, vedere Operazioni con documenti PublishView™.

Creazione di un nuovo documento TI-Nspire™
Quando si apre per la prima volta il software, l'area di lavoro Documenti viene
visualizzata con un documento vuoto contenente un'attività. Aggiungendo applicazioni
e contenuto a questa attività si crea un documento.

Nota: lo schermo Benvenuto viene visualizzato quando si apre il software con l'opzione
"Mostra sempre all'avvio" selezionata. Fare clic sull'icona di un'applicazione per
inserire un'attività con un'applicazione attiva in un nuovo documento.

Per creare un nuovo documento, procedere come segue:

1. Sul menu File di TI-Nspire™,

• Selezionare Nuovo documento TI-Nspire™ - Dimensioni della pagina per
palmare.



Oppure

• Selezionare Nuovo documento TI-Nspire™ - Dimensioni della pagina per
computer.

Il nuovo documento viene aperto nell'area di lavoro Documenti con la richiesta di
selezionare un'applicazione.

2. Selezionare un'applicazione per inserire un'attività nel documento.

L'attività viene aggiunta al documento.

Apertura di un documento esistente
Per aprire un documento esistente:

1. Fare clic su File > Apri documento.

—oppure—

Fare clic su .

Viene visualizzata la finestra di dialogo Apri.
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2. Utilizzare la finestra di gestione file per individuare il file da aprire e fare clic su di
esso per selezionarlo.

3. Fare clic su Apri.

Il documento viene aperto nell'area di lavoro.

Nota: per effettuare la selezione dai 10 documenti più recenti, selezionare File >
Documenti recenti, quindi selezionare dall'elenco visualizzato.

Salvataggio di documenti TI-Nspire™
Per salvare un nuovo documento:

1. selezionare File > Salva documento oppure fare clic su .

Viene visualizzata la finestra di dialogo Salva documento TI-Nspire™.



2. Evidenziare la cartella in cui si desidera salvare il documento oppure creare una
cartella in cui archiviare il documento.

3. Digitare un nome per il documento.

4. Fare clic su Salva per salvare il documento.

Il documento si chiude e viene salvato con estensione .tns.

Nota: quando si salva un file, la cartella in cui si salva un file sarà la prima in cui il
software cercherà un qualsiasi file che si desidera aprire.

Salvataggio di un documento con un nuovo nome

Per salvare un documento già salvato in una nuova cartella e/o con un nuovo nome:

1. Fare clic su File > Salva con nome.

Viene visualizzata la finestra di dialogo Salva documento TI-Nspire™.

2. Evidenziare la cartella in cui si desidera salvare il documento oppure creare una
cartella in cui archiviare il documento.

3. Digitare un nuovo nome per il documento.

4. Fare clic su Salva per salvare il documento con un nuovo nome.

Eliminazione di documenti
I file eliminati dal computer vengono trasferiti nel Cestino e possono essere recuperati
da questo, se non è stato svuotato.

Nota: l'eliminazione di file dal palmare è un'operazione irreversibile e non può essere
annullata, pertanto occorre essere certi di voler eliminare i file selezionati.

1. Selezionare il documento da eliminare.

2. Fare clic suModifica> Elimina oppure premere Elimina.

Viene visualizzata una finestra di dialogo di avvertenza.

3. Fare clic su Sì per confermare l'eliminazione.

Il documento viene eliminato.

Chiusura di documenti
▶ Per chiudere un documento, selezionare File > Chiudi oppure fare clic sull'icona

Chiudi nella scheda del documento sul margine inferiore dello stesso.

▶ Se si utilizza la vista affiancata, fare clic sull'icona Chiudi nell'angolo in alto a
destra della finestra documento.
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Formattazione del testo in Documenti
Utilizzare lo strumento formattazione testo per formattare il testo nelle applicazioni
TI-Nspire™ che permettono l'inserimento di testi e per formattare un testo in
documenti PublishView™. Per impostazione predefinita, si apre la barra degli
strumenti formattazione nell'area superiore di un documento attivo. Le opzioni nella
barra degli strumenti sono attivate o disattivate a seconda dell'applicazione attiva.

Opzione Funzione

Fare clic su¤ per aprire il menu per
l'applicazione attiva. Questo strumento permette
di aprire il menu di un'applicazione
indipendentemente dall'opzione selezionata nella
casella degli strumenti Documenti.

Fare clic su¤ per scegliere un colore di sfondo
per mettere in risalto un testo o per scegliere un
colore di riempimento per una cella selezionata.

Fare clic su¤ per scegliere il colore della linea di
un oggetto. Ad esempio, in Grafici e geometria, è
possibile scegliere il colore per una forma
selezionata.

Fare clic su¤ per selezionare un colore per un
testo selezionato.

utilizzare questo strumento per scegliere un
carattere e dimensione del carattere.

• Fare clic su¤ per selezionare un carattere
differente dal menu a discesa.

• Per scegliere una dimensione specifica del
carattere, fare clic su¤ per selezionare una
dimensione dal menu a discesa.

• Fare clic su per aumentare le

dimensioni del carattere o fare clic su
per diminuire le dimensioni del carattere.

Fare clic sul pulsante corrispondente per
formattare il testo in grassetto, corsivo,
sottolineato, apice o pedice, o barrare il testo.



Opzione Funzione

In un documento PublishView™, utilizzare questi
strumenti per posizionare il testo
nell'intestazione o piè di pagine, o in una casella

testo. cliccando Viene visualizzata la finestra
di dialogo collegamento ipertestuale.
Per ulteriori informazioni, vedere Operazioni con
documenti di PublishView™.

Visualizzazione e occultamento della barra degli strumenti di formattazione

▶ Quando la barra degli strumenti di formattazione è visibile, fare clic su£ (situato
sotto la barra degli strumenti) per nasconderla.

▶ Fare clic su¤ per visualizzare la barra degli strumenti di formattazione quando è
nascosta.

Utilizzo dei colori nei documenti
Nelle applicazioni TI-Nspire™ che consentono una formattazione, è possibile utilizzare
il colore per le aree piene di un oggetto, o le linee e il testo, a seconda
dell'applicazione che si sta utilizzando e di come è stato selezionato l'elemento. Se
dopo aver selezionato un elemento, l'icona o la voce di menu che si desidera utilizzare
non è disponibile (grigia), la colorazione non è disponibile per l'elemento selezionato.

Il colore viene visualizzato sul computer e nei documenti aperti sul palmare TI-Nspire™
CX.

Nota: per ulteriori informazioni sull'utilizzo dei colori nell'applicazione TI-Nspire™,
vedere il capitolo appropriato.

Aggiunta di colore da un elenco

Per colorare un'area da riempire, una linea o testo, procedere come segue:

1. selezionare l'elemento.

2. Selezionare Modifica > Colore oppure selezionare dove si desidera aggiungere
colore (riempimento, linea o testo).

3. Selezionare il colore dall'elenco.

Aggiunta di colore da una tavolozza

Per aggiungere colore utilizzando la tavolozza, procedere come segue:

1. selezionare l'oggetto.

2. Fare clic sull'icona appropriata della barra degli strumenti.

3. Selezionare il colore dalla tavolozza.
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Impostazione delle dimensioni della pagina e anteprima del
documento
Quando si crea un documento, se ne specificano le dimensioni di pagina come Palmare
o Computer, in base all'uso previsto del documento. I documenti di entrambe le
dimensioni di pagina possono essere aperti su entrambe le piattaforme ed è possibile
cambiare dimensioni di pagina in qualsiasi momento.

• Palmare. Dimensione: 320 × 217 pixel, fissa. I documenti del palmare possono
essere visualizzati su tutte le piattaforme. È possibile ingrandire (zoom) il
contenuto quando lo si visualizza su un tablet o uno schermo più grande.

• Computer. Dimensione: 640 × 434 pixel, minimo. I documenti del computer si
ridimensionano automaticamente per adattarsi alle schermate di risoluzione più
alta. La dimensione minima è 640 × 434, quindi parte del contenuto potrebbe
essere troncato su dispositivi palmari.

Nota: è possibile visualizzare i documenti di entrambe le dimensioni di pagina
utilizzando l'anteprima per Palmare o Computer.

Conversione delle dimensioni di pagina del documento corrente

▶ Nel menu principale File di TI-Nspire™, selezionare Converti in, quindi selezionare
le dimensioni della pagina.

Il software salva il documento corrente e crea una copia che utilizza le dimensioni
di pagina richieste.

Visualizzazione del documento nell'anteprima Palmare

1. Sulla barra degli strumenti dell'applicazione, fare clic su Anteprima documento e
selezionare Palmare.

L'anteprima cambia. Questo non comporta modifiche alle dimensioni di pagina di
base del documento.

2. (Facoltativo) Regolare l'ingrandimento della visualizzazione:

- Fare clic sullo strumento Zoom sotto l'area di lavoro e selezionare un valore di
ingrandimento.

—oppure—

- Fare clic sul pulsante Adatta alla finestra per fare in modo che l'anteprima
del palmare si regoli automaticamente alle dimensioni della finestra.

Visualizzazione del documento nell'anteprima Computer

1. Sulla barra degli strumenti dell'applicazione, fare clic su Anteprima documento e
selezionare Computer.



L'anteprima cambia. Questo non comporta modifiche alle dimensioni di pagina di
base del documento.

2. (Facoltativo) Fare clic sullo strumento Nitidezza sotto l'area di lavoro e selezionare
un valore per aumentare o ridurre la nitidezza di testo e altri elementi.

Impostazione della dimensione predefinita degli assi per nuovi documenti

1. Nel menu principale File di TI-Nspire™, selezionare Impostazioni > Impostazioni
delle dimensioni della pagina.

2. Selezionare una dimensione della pagina predefinita, per palmare o per computer.

Le nuove dimensioni si applicano ai documenti creati (Windows®: Ctrl+C, Mac®:
Cmd+C) dopo aver impostato i valori predefiniti, incluso il documento vuoto creato
automaticamente ogni volta che si apre il software. La modifica delle impostazioni
predefinite non converte nessun documento correntemente aperto o altri
documenti esistenti.

Impostazione di un'anteprima predefinita

Per impostazione predefinita, quando si apre un documento, questo viene visualizzato
automaticamente utilizzando l'anteprima corrispondente alle sue dimensioni di
pagina. È possibile ignorare questa regola e specificare un'anteprima preferita.

1. Nel menu principale File di TI-Nspire™, selezionare Impostazioni > Impostazioni di
anteprima.

2. Selezionare l'anteprima che si desidera utilizzino i documenti alla loro apertura.

Operazioni con più documenti
Quando sono aperti più documenti contemporaneamente, i rispettivi nomi sono
visualizzati nelle schede nella parte inferiore dell'area di lavoro. È attivo un solo
documento alla volta, e solo il documento attivo è suscettibile ai comandi dei menu e
degli strumenti.

Per commutare tra documenti:

À Fare clic sulla scheda per visualizzare un documento nell'area di lavoro.
Questo documento diventa il documento attivo. Se è attiva la vista
Mostra i documenti affiancati le schede non sono visualizzate.

Á Utilizzare le frecce sinistra e destra per scorrere l'elenco di documenti.
Queste frecce sono attive solo quando ci sono molti documenti e non
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rientrano nella finestra.

Â Fare clic sull'icona Mostra elenco per elencare tutti i documenti aperti.
Ciò è utile quando ci sono numerosi documenti aperti e i loro nomi
sulle schede possono apparire troncati.

Operazioni con più documenti affiancati

Quando più documenti sono aperti contemporaneamente, le rispettive miniature sono
visualizzate nell'area di lavoro Documenti. Per modificare la vista:

▶ selezionare Finestra > Mostra documenti affiancati.

I documenti aperti sono visualizzati come miniature nell'area di lavoro e la barra di
scorrimento diventa attiva.

La barra di stato resta disponibile; tuttavia i nomi dei documenti ora appaiono nella
vista miniature. Fare clic su Seleziona finestra> Mostra documenti come schede per
visualizzare i documenti uno alla volta nell'area di lavoro.

Operazioni con le applicazioni
La prima volta che si apre un nuovo documento o si aggiunge una nuova attività a un
documento, selezionare un'applicazione da un menu.

La seguente illustrazione mostra come viene visualizzato nell'area di lavoro un
documento contenente l'applicazione Foglio elettronico.



À Nome documento. Le schede mostrano il nome di tutti i documenti aperti. Fare clic
su un nome per renderlo il documento attivo.

Á Dimensioni pagina. Mostra le dimensioni pagina del documento come Palmare o
Computer. È possibile utilizzare il menu File di TI-Nspire™ per convertire un
documento da una dimensione pagina a un'altra.

Â Contatore attività/pagina. Etichetta il numero dell'attività e il numero di pagina
della pagina attiva. Ad esempio, un'etichetta 1.2 identifica l'attività 1, pagina 2.

Ã Impostazioni. Fare doppio clic per visualizzare o modificare le impostazioni del
documento per il documento attivo o per modificare le impostazioni del documento
predefinite.

Ä Modalità angolo. Mostra un'abbreviazione della modalità angolo (Gradi, Radianti o
Gradi centesimali) in uso. Passare con il puntatore sull'indicatore per visualizzare il
nome completo.

Å Zoom. Attivo solo nell'anteprima Palmare (fare clic su Anteprima documento sulla
barra degli strumenti e selezionare Palmare). Fare clic su▼ e selezionare un valore
di ingrandimentooppure fare clic sul pulsante Adatta alla finestra per fare in
modo che l'anteprima del palmare si regoli automaticamente alle dimensioni della
finestra..

Æ Nitidezza. Attivo solo nell'anteprima Palmare (fare clic su Anteprima documento
sulla barra degli strumenti e selezionare Computer). Fare clic su▼ e selezionare un
valore per aumentare o ridurre la nitidezza del testo e di altri elementi.
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Operazioni con più applicazioni in una pagina

È possibile aggiungere sino a quattro applicazioni a una pagina. Quando si aggiungono
più applicazioni a una pagina, il menu dell'applicazione attiva appare nella Casella
degli strumenti Documenti. Per poter utilizzare più applicazioni contemporaneamente
in una stessa pagina occorre:

• modificare il layout di pagina per consentire la presenza simultanea di più
applicazioni.

• Inserire le applicazioni.

È possibile inserire più applicazioni contemporaneamente in una stessa pagina anche
se è già presente un'applicazione attiva.

Inserimento di più applicazioni in una pagina

Per impostazione predefinita, ogni pagina contiene uno spazio per inserire una
applicazione. Per inserire ulteriori applicazioni nella pagina, completare la procedura
seguente.

1. Fare clic suModifica > Layout pagina > Seleziona layout.

—oppure—

Fare clic su .

Viene aperto il menu del layout pagina.

Sono disponibili otto opzioni di layout pagina. Un'opzione selezionata viene visualizzata
in grigio.

2. Evidenziare il layout da inserire nell'attività o nella pagina, quindi fare clic per
selezionarlo.

Il nuovo layout viene visualizzato con la prima applicazione attiva.



3. Nell'anteprima Palmare, fare clic su Premere menu per selezionare un'applicazione
per ciascuna nuova sezione dell'attività o della pagina. In vista computer,
selezionare Fare clic qui per aggiungere un’applicazione.

Scambio di applicazioni

Per spostare alcune applicazioni in una pagina contenente più applicazioni, è possibile
"scambiare" le posizioni delle applicazioni.

1. Fare clic suModifica > Layout pagina > Scambia applicazioni.

Nota: l'ultima applicazione attiva in cui si è lavorato viene automaticamente
selezionata come la prima applicazione da scambiare.

2. Fare clic sulla seconda applicazione da spostare.

Così facendo si effettua lo scambio di posizione.

Nota: quando ci sono solo due aree di lavoro, l'applicazione selezionata viene
spostata automaticamente nella posizione dell'altra applicazione nell'area di
lavoro.

Per annullare lo spostamento, premere Esc.

Selezione e spostamento pagine
quando si aggiungono attività e pagine a un documento, è possibile sfruttare le
funzionalità per gestire le parti.
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À Ordinatore pagine. Elenca le attività inserite nel documento e mostra le immagini
miniaturizzate delle pagine in ogni attività. L'Ordinatore pagine permette di
ridisporre, copiare e spostare sia le attività che le pagine. Consente inoltre di
rinominare le attività.

Á Pagina attiva. Indica la pagina corrente evidenziandone l'immagine miniaturizzata.
Le miniature consentono di eseguire facilmente la scansione delle pagine in un
documento e selezionare una pagina specifica con cui lavorare.

Â Contatore attività/pagina. Mostra il numero di attività e il numero di pagina della
pagina attualmente selezionata.

Selezione di pagine

Utilizzare uno di questi metodi per spostarsi da una pagina all'altra.

▶ Nel menu Visualizza, selezionare Pagina precedente o Pagina successiva.

▶ Sulla tastiera, premere Ctrl+PgSu o Ctrl+PgGiù.
(Mac®: premere Fn+freccia su o Fn+freccia giù).

▶ Fare clic sul pulsante Pagina precedente o Pagina successiva sulla barra
degli strumenti principale.

▶ Fare clic sullo strumento Ordinatore pagine nella Casella degli strumenti
Documenti e quindi fare clic sulla miniatura della pagina con cui si desidera
lavorare.

Suggerimento: per ingrandire o comprimere l'elenco di miniature per un'attività,
fare doppio clic sul nome dell'attività.



Ridisposizione delle pagine con l'Ordinatore pagine

L'Ordinatore pagine facilita il riordinamento delle pagine all'interno di un'attività.

1. se necessario, fare clic sullo strumento Ordinatore pagine nella Casella degli
strumenti Documenti.

2. Nell'Ordinatore pagine, trascinare l'immagine miniaturizzata della pagina nella
posizione desiderata.

Copia di una pagina

È possibile copiare una pagina all'interno della stessa attività o copiarla in un'attività
diversa o in un altro documento.

1. se necessario, fare clic sullo strumento Ordinatore pagine nella Casella degli
strumenti Documenti.

2. Selezionare la miniatura della pagina da copiare.

3. Nel menuModifica, fare clic su Copia.

4. Fare clic nel punto in cui si desidera inserire la copia.

5. Nel menuModifica, fare clic su Incolla.

Spostamento di una pagina

È possibile spostare una pagina all'interno della stessa attività o spostarla in un'attività
diversa o in un altro documento.

1. Se necessario, fare clic sullo strumento Ordinatore pagine nella Casella degli
strumenti Documenti.

2. Selezionare la miniatura della pagina da spostare.

3. Nel menuModifica, fare clic su Taglia.

4. Fare clic sulla nuova posizione della pagina.

5. Nel menuModifica, fare clic su Incolla.

Eliminazione di una pagina

1. Selezionare la pagina nell'area di lavoro o nell'Ordinatore pagine.

2. Fare clic suModifica > Elimina.
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Raggruppamento di applicazioni in una pagina

È possibile combinare fino a quattro pagine di applicazioni consecutive in un'unica
pagina.

1. Selezionare la prima pagina della serie.

2. Fare clic suModifica > Layout pagina > Raggruppa.

La seconda pagina viene raggruppata con la prima. Il layout della pagina si
modifica automaticamente per visualizzare tutte le pagine del gruppo.

Separazione delle applicazioni in pagine separate

1. Selezionare la pagina raggruppata.

2. Fare clic suModifica > Layout pagina > Separa.

Le applicazioni vengono suddivise in singole pagine.

Eliminazione di un'applicazione da una pagina

1. Fare clic sull'applicazione da eliminare.

2. Fare clic suModifica > Layout pagina > Elimina applicazione.

Suggerimento: per annullare l'eliminazione, premere Ctrl + Z (Mac®: “+ Z).

Operazioni con le attività e le pagine
quando si crea un nuovo documento, questo è costituito da una singola attività con
un'unica pagina. È possibile inserire nuove attività e aggiungere pagine per ogni
attività.

Aggiunta di un'attività a un documento

Un documento può contenere fino a 30 attività. Le variabili di ciascuna attività non
sono influenzate dalle variabili in altre attività.

▶ Nel menu Inserisci, selezionare Attività.
—oppure—
Fare clic sullo strumento Inserisci nella barra degli strumenti principale e
selezionare Attività.

Nel documento viene inserita una nuova attività con una pagina vuota.



Aggiunta di una nuova pagina all'attività corrente

Ogni attività può contenere fino a 50 pagine. Ogni pagina è costituita da un'area di
lavoro in cui è possibile eseguire calcoli, creare grafici, acquisire e tracciare dati o
aggiungere note e istruzioni.

1. Fare clic su Inserisci > Pagina.
—oppure—
Fare clic sullo strumento Inserisci nella barra degli strumenti principale e
selezionare Pagina.

All'attività corrente viene aggiunta una pagina vuota e viene richiesto di scegliere
un'applicazione per la pagina.

2. Selezionare un'applicazione da inserire nella pagina.

Assegnazione di un nuovo nome a un'attività

Le nuove attività sono denominate automaticamente come Attività 1, Attività 2, ecc.
Per rinominare un'attività:

1. se necessario, fare clic sullo strumento Ordinatore pagine nella Casella degli
strumenti Documenti.

2. Fare clic sul nome dell'attività per selezionarla.

3. Nel menuModifica, fare clic su Rinomina.

4. Digitare il nuovo nome.

Ridisposizione delle attività con l'Ordinatore pagine

L'Ordinatore pagine consente di riordinare le attività all'interno di un documento. Se si
sposta un'attività che non è stata ridenominata, la parte numerica del nome
predefinito cambia per riflettere la nuova posizione.

1. se necessario, fare clic sullo strumento Ordinatore pagine nella Casella degli
strumenti Documenti.

2. Nell'Ordinatore pagine, ridisporre le attività trascinando ogni nome dell'attività
nella nuova posizione.

Suggerimento: per comprimere l'elenco di miniature delle pagine di un'attività, fare
doppio clic sul nome dell'attività.
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Copia di un'attività

È possibile copiare un'attività all'interno dello stesso documento o copiarla in un
documento diverso.

1. se necessario, fare clic sullo strumento Ordinatore pagine nella Casella degli
strumenti Documenti.

2. Fare clic sul nome dell'attività per selezionarla.

3. Nel menuModifica, fare clic su Copia.

4. Fare clic nel punto in cui si desidera inserire la copia.

5. Nel menuModifica, fare clic su Incolla.

Spostamento di un'attività

È possibile spostare un'attività all'interno dello stesso documento o spostarla in un
documento diverso.

1. se necessario, fare clic sullo strumento Ordinatore pagine nella Casella degli
strumenti Documenti.

2. Fare clic sul nome dell'attività per selezionarla.

3. Nel menuModifica, fare clic su Taglia.

4. Fare clic sulla nuova posizione dell'attività.

5. Nel menuModifica, fare clic su Incolla.

Eliminazione di un'attività

Per eliminare un'attività e le pagine corrispondenti da un documento:

1. se necessario, fare clic sullo strumento Ordinatore pagine nella Casella degli
strumenti Documenti.

2. Fare clic sul nome dell'attività per selezionarla.

3. Nel menuModifica, fare clic su Elimina.

Stampa di documenti
1. Fare clic su File > Stampa.

Viene visualizzata la finestra di dialogo Stampa.

2. Impostare le opzioni per il lavoro di stampa.

• Stampante: selezionarla dall'elenco di stampanti disponibili
• Cosa stampare:



- Stampa tutto: stampa ogni pagina su un foglio separato
- Schermo visibile: stampa le pagine selezionate con ulteriori opzioni di

formato (vedere Formato, di seguito)
• Intervallo di stampa: fare clic su Tutte le pagine o su Intervallo pagine e

impostare la pagina iniziale e la pagina finale.
• Formato:

- l'orientamento (verticale o orizzontale)
- Il numero di pagine (1, 2, 4, o 8) di TI-Nspire™ da stampare su ogni foglio

(disponibile solo per l'opzione Schermo visibile). Il valore predefinito è 2
pagine per foglio.

- Se lasciare spazio per i commenti sotto ogni pagina stampata di TI-Nspire™
(disponibile solo per l'opzione Schermo visibile)

- Margini (da 0,63 cm a 5 cm). Il margine predefinito è 1,27 cm su tutti i
bordi.

• Informazioni sulla documentazione da includere:
- Nome dell'attività, inclusa l'opzione per raggruppare le pagine fisicamente

per attività
- Etichetta pagina (come 1.1 o 1.2) sotto ogni pagina
- Titolo della pagina (fino a due righe)
- Nome documento nel piè di pagina

3. Fare clic su Stampa oppure su Salva come PDF.

Nota: per ripristinare le impostazioni predefinite per la stampa, fare clic su Ripristina.

Utilizzo dell'anteprima di stampa

• Fare clic sulla casella di controllo Anteprima per attivare/disattivare il riquadro di
anteprima.

• Fare clic sulle frecce in fondo al riquadro di anteprima per scorrere attraverso
l'anteprima.

Visualizzazione delle proprietà del documento e delle informazioni
sul copyright
Nota: la maggior parte delle presenti istruzioni si applica esclusivamente al Teacher
Software.

Controllo delle dimensioni di pagina

1. Nel Teacher Software, andare nel menu File di TI-Nspire™ e selezionare Proprietà
documento.

2. Fare clic sulla scheda Dimensioni pagina.

3. Un segno di spunta indica le dimensioni della pagina correnti del documento.
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Visualizzazione delle informazioni sul copyright

Il Teacher Software e lo Student Software permettono all'utente di visualizzare le
informazioni sul copyright che sono state aggiunte a un documento.

1. Nel menu File di TI-Nspire™, selezionare Visualizza informazioni sul copyright.

Viene aperta la relativa finestra di dialogo.

2. Fare clic su OK per chiudere la finestra.

Aggiunta di informazioni sul copyright a un documento

Utilizzando il Teacher Software, è possibile aggiungere informazioni sul copyright
singolarmente ai documenti creati oppure applicare le stesse informazioni sul
copyright a tutti i nuovi documenti.

1. Aprire il documento.

2. Nel menu File di TI-Nspire™, selezionare Proprietà documento.

3. Fare clic sulla scheda Copyright.

4. Modificare i seguenti campi per definire i dettagli del copyright:

• Autore

• Copyright (selezionare Dominio pubblico o Copyright).

• Anno (disabilitato se è stato selezionato Dominio pubblico)

• Proprietario (disabilitato se è stato selezionato Dominio pubblico)

• Commenti



5. Per aggiungere le informazioni specificate a tutti i nuovi documenti da un
particolare punto in poi, selezionare Applica questo copyright a tutti i nuovi
documenti.

6. Fare clic su OK per applicare le informazioni sul copyright al documento.

Protezione di un documento (impostazione sola lettura)

Gli insegnanti possono proteggere i documenti per creare un documento per la
distribuzione agli studenti o per altro uso. Se uno studente riceve un documento di sola
lettura e vi apporta modifiche, viene visualizzata una finestra di dialogo che chiede di
salvare il documento con un nuovo nome file.

1. Aprire il documento.

2. Nel menu File di TI-Nspire™, selezionare Proprietà documento.

3. Fare clic sulla scheda Protezione.

4. Selezionare la casella di controllo accanto a Imposta sola lettura.

5. Fare clic su OK.
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Operazioni con documenti PublishView™
Utilizzare la funzione PublishView™ per creare e condividere documenti interattivi con
insegnanti e studenti. È possibile creare documenti che includano testo formattato,
applicazioni TI-Nspire™, immagini, collegamenti ipertestuali, link a video e video
incorporati in un formato idoneo per la stampa cartacea, per la pubblicazione su un
sito web o un blog, oppure per l'uso in un foglio di calcolo interattivo.

PublishView™ offre funzioni di layout e modifica per la presentazione di concetti
matematici e scientifici in un documento, in cui applicazioni TI-Nspire™ possono essere
collegate interattivamente e dinamicamente con supporti che danno vita al
documento. Con PublishView™:

• Gli insegnanti possono creare attività e valutazioni interattive da visualizzare sullo
schermo.

• Gli insegnanti possono creare materiali stampati a complemento dei documenti
utilizzati nei palmari TI-Nspire™ CX II.

• Durante la pianificazione delle lezioni, gli insegnanti possono:

- Creare un progetto di lezione da documenti del palmare esistenti o convertire
piani di lezione in documenti del palmare.

- Creare link a piani di lezione o documenti correlati.
- Incorporare testo esplicativo, immagini, video e collegamenti a risorse web.
- Creare o interagire con applicazioni TI-Nspire™ direttamente dal progetto di

lezione.

• Gli studenti possono creare rapporti o progetti quali rapporti di laboratorio
contenenti riproduzioni di dati, adattamenti a curve, immagini e video —tutto nello
stesso foglio.

• Gli studenti possono stampare e consegnare elaborati su fogli standard.

• Gli studenti impegnati negli esami possono utilizzare un unico strumento per
creare un documento che contenga: tutte le attività dell'esame, testo, immagini,
collegamenti ipertestuali o video, applicazioni TI-Nspire™ interattive, screenshot e
opzioni di layout necessarie per stampare un documento.

Nota: I documenti di PublishView™ possono essere memorizzati nell'area di lavoro
Portfolio e le domande di TI-Nspire™ all'interno di un documento di PublishView™
possono essere valutate automaticamente dal sistema TI-Nspire™ Navigator™.

Creazione di un nuovo documento PublishView™.
1. Nell'area di lavoro Documenti, selezionare File > Nuovo documento PublishView™

—oppure—

Fare clic su e quindi su Nuovo documento PublishView™.

• Nell'area di lavoro Documenti viene aperto un documento vuoto (modello
lettera). L'orientamento del documento è verticale e non può essere
modificato.



• L'impostazione predefinita per i margini superiore e inferiore è 2,54 cm. Non ci
sono impostazioni per i margini laterali.

• Per impostazione predefinita, viene inserita un'attività nel documento.
• Per impostazione predefinita, il documento contiene il numero di pagina nel

formato "n. di n." nella parte inferiore del foglio.
• Le barre di scorrimento a destra e in fondo al foglio sono attive.

2. Aggiungere applicazioni TI-Nspire™ e oggetti PublishView™ secondo necessità per
completare il documento.

Informazioni sui documenti PublishView™

Quando si lavora con documenti PublishView™, è importante tenere presente quanto
segue:

• I documenti PublishView™ vengono salvati come file .tnsp, quindi in formato
diverso dai documenti TI-Nspire™ (file .tns).

• Quando si inseriscono oggetti PublishView™ in un documento, il testo, l'immagine,
il collegamento ipertestuale o il video incorporato sono contenuti in riquadri che
possono essere spostati e ridimensionati.

• Le applicazioni TI-Nspire™ che vengono inserite funzionano allo stesso modo delle
pagine di un documento TI-Nspire™.

• In un documento PublishView™, gli oggetti possono sovrapporsi ed è possibile
impostare l'oggetto da visualizzare in primo piano e quello sullo sfondo.
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• Gli oggetti possono essere inseriti e posizionati in un documento PublishView™
senza vincoli particolari.

• È possibile convertire un documento TI-Nspire™ esistente in un documento
PublishView™ (file .tnsp).

• Quando si converte un documento PublishView™ in un documento TI-Nspire™ (file
.tns) vengono convertite le applicazioni TI-Nspire™. Gli oggetti PublishView™
contenenti testo, collegamenti ipertestuali, video e immagini non vengono
convertiti.

• Non è possibile creare o aprire un documento PublishView™ su un palmare. Prima
di inviare un documento PublishView™ a un palmare, è necessario convertirlo in un
documento TI-Nspire™.

Esplorazione di un documento PublishView™

Il seguente esempio mostra come si possono usare applicazioni TI-Nspire™ e oggetti
PublishView™ per creare un documento PublishView™. In questo esempio, i bordi sono
attivati per mostrare i contorni degli oggetti. I bordi visibili consentono di lavorare
facilmente con gli oggetti mentre si crea un documento. Quando si è pronti per
stampare o pubblicare il documento sul web, è possibile nascondere i bordi.



À Intestazione In questo esempio, l'intestazione contiene il titolo del documento.
Quando l'area dell'intestazione è attiva, è possibile digitare e formattare il testo
come desiderato.

Á Interruzione e nome dell'attività. Nei documenti PublishView™, utilizzare le
interruzioni di attività per controllare il layout della pagina. Le interruzioni di attività
possono essere visualizzate o nascoste. Eliminando un'attività se ne rimuovono il
contenuto e lo spazio che la separa dalle altre attività, se presenti. Le interruzioni di
attività consentono inoltre di utilizzare variabili nei documenti PublishView™.
Variabili con lo stesso nome sono tra loro indipendenti se vengono utilizzate in
attività differenti.

Â Riquadri di testo. In questo esempio, il testo introduttivo e il testo nei riquadri 1, 2,
3 e 4 è contenuto in riquadri di testo. È possibile inserire testo e collegamenti
ipertestuali in un documento PublishView™ utilizzando un riquadro di testo. I
riquadri di testo possono essere ridimensionati e posizionati secondo necessità. I
riquadri di testo di PublishView™ non vengono mantenuti quando si converte un
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documento PublishView™ in un documento TI-Nspire™.

Ã Applicazioni TI-Nspire™. In questo esempio, l'autore utilizza Grafici e geometria per
mostrare le funzioni matematiche. Quando un'applicazione TI-Nspire™ è attiva in un
documento PublishView™, nella Casella degli strumenti Documenti viene aperto il
menu dell'applicazione appropriata. È possibile lavorare in un'applicazione TI-
Nspire™ così come si farebbe in un documento TI-Nspire™. Quando si converte un
documento PublishView™ in un documento TI-Nspire™, le applicazioni vengono
mantenute.

Ä Applicazione Notes. È possibile utilizzare anche l'applicazione Notes di TI-Nspire™
per aggiungere testo a un documento PublishView™. Poiché Notes è un'applicazione
TI-Nspire™, essa verrà mantenuta quando si converte il documento PublishView™ in
un documento TI-Nspire™. Notes consente di utilizzare un editor di equazioni in cui
inserire modelli matematici e simboli di TI-Nspire™.

Å Video. Questo è un esempio di un video incorporato in un documento PublishView™
all'interno di una cornice. Gli utenti possono avviare e arrestare il video tramite gli
appositi controlli. Le cornici contenenti video e immagini possono essere
ridimensionate e posizionate nel documento secondo necessità.

Æ Piè di pagina. Per impostazione predefinita, l'area del piè di pagina contiene il
numero di pagina, che non può essere modificato. È possibile aggiungere altro testo
sopra il numero di pagina, secondo necessità. Come per l'intestazione, è possibile
formattare il testo secondo necessità.

Utilizzo della barra di stato in un documento PublishView™

Quando un documento PublishView™ è aperto, le opzioni sulla barra di stato sono
diverse dalle opzioni visualizzate quando si lavora in un documento TI-Nspire™.

À I nomi dei documenti sono visualizzati come schede. Se sono aperti più documenti
contemporaneamente, i nomi dei documenti vengono elencati. È possibile avere
aperti contemporaneamente documenti TI-Nspire™ e PublishView™. In questo
esempio, Documento 1 è un documento TI-Nspire™ inattivo ( ). Documento 2 è il

documento PublishView™ attivo ( ). Fare clic sull'icona X per chiudere il

documento.



Á Dimensioni pagina. Mostra le dimensioni pagina del documento come Palmare o
Computer. È possibile utilizzare il menu File di TI-Nspire™ per convertire un
documento da una dimensione pagina a un'altra.

Â Fare clic su Impostazioni per cambiare le Impostazioni documento. È possibile
configurare impostazioni specifiche per il documento attivo oppure impostazioni
predefinite per tutti i documenti PublishView™. Quando si converte un documento
TI-Nspire™ in un documento PublishView™, le impostazioni del documento TI-
Nspire™ vengono convertite sulle impostazioni definite per i documenti
PublishView™.

Ã Usare la scala dello Zoom per ridimensionare il documento attivo da 10% a 500%. Per
impostare uno zoom, digitare un numero specifico, utilizzare i pulsanti + e - per
aumentare o diminuire con incrementi del 10%, o in alternativa utilizzare il menu a
tendina per scegliere le percentuali predefinite.

Ä Nelle applicazioni TI-Nspire™, utilizzare il cursore scorrevole Nitidezza per
aumentare o diminuire la nitidezza del testo e lo spessore di linea nelle applicazioni.
Per impostare la nitidezza, digitare un numero specifico, utilizzare i pulsanti + e - per
aumentare o diminuire con incrementi del 10%, o in alternativa utilizzare il menu a
tendina per scegliere le percentuali predefinite.

Per gli oggetti PublishView™, la nitidezza consente di far corrispondere il testo nelle
applicazioni TI-Nspire™ al testo nel foglio PublishView™. Può essere utilizzata inoltre
per aumentare la visibilità delle applicazioni TI-Nspire™ nella presentazione di un
documento alla classe.

Å Quando vi sono troppi nomi di documenti aperti per essere visualizzati sulla barra di

stato, fare clic sulle frecce avanti e indietro ( ) per spostarsi tra i documenti.

Æ Fare clic su per visualizzare un elenco di tutti i documenti aperti.

Salvataggio di documenti PublishView™
Salvataggio di un nuovo documento

1. Fare clic su File > Salva documento.

—oppure—

Fare clic su .

Viene visualizzata la finestra di dialogo Salva documento TI-Nspire™.
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2. Spostarsi sulla cartella in cui si desidera salvare il documento.

—oppure—

Creare una cartella in cui archiviare il documento.

3. Digitare un nuovo nome per il documento.

4. Fare clic su Salva.

Il documento si chiude e viene salvato con estensione .tnsp.

Nota: Quando si salva un file, il software utilizza la cartella in cui il file è stato salvato
per cercare il prossimo file da aprire.

Salvataggio di un documento con un nuovo nome

Per salvare un documento già salvato in una nuova cartella e/o con un nuovo nome:

1. Selezionare File > Salva con nome dal menu.

Viene visualizzata la finestra di dialogo Salva documento TI-Nspire™.

2. Spostarsi sulla cartella in cui si desidera salvare il documento.

—oppure—

Creare una cartella in cui archiviare il documento.

3. Digitare un nuovo nome per il documento.

4. Fare clic su Salva per salvare il documento con un nuovo nome.

Nota: È anche possibile utilizzare l'opzione Salva con nome per convertire documenti da
file TI-Nspire™ in file PublishView™ oppure per convertire file PublishView™ in file TI-
Nspire™.



Esplorazione dell'area di lavoro Documenti
Quando si crea o si apre un documento PublishView™, questo viene aperto nell'area di
lavoro Documents (Documenti). Utilizzare le opzioni di menu e la barra degli strumenti
allo stesso modo di come si utilizzerebbero in un documento TI-Nspire™ per effettuare
quanto segue:

• Spostarsi su cartelle e documenti esistenti utilizzando Esplora contenuto

• Aprire documenti esistenti

• Salvare documenti

• Utilizzare le opzioni Copia, Incolla, Annulla e Ripeti

• Eliminare documenti

• Accedere a menu specifici delle applicazioni TI-Nspire™

• Aprire il menu Variables (Variabili) nelle applicazioni TI-Nspire™ che accettano
variabili

• Accedere a modelli matematici, simboli, voci del catalogo ed elementi delle
librerie e inserirli in un documento PublishView™

Nota: Per ulteriori informazioni, consultareUtilizzo dell'area di lavoro Documenti.

Esplorazione della Casella degli strumenti Documenti

Quando un documento PublishView™ è attivo, la Casella degli strumenti Documenti
contiene gli strumenti necessari per lavorare con documenti PublishView™. È possibile
aggiungere applicazioni TI-Nspire™ a un'attività, inserire parti di documenti TI-Nspire™
esistenti in un'attività e inserire oggetti PublishView™.

La Casella degli strumenti Documenti viene aperta ogni volta che si crea un nuovo
documento PublishView™ oppure si apre un documento PublishView™ esistente.
Quando si lavora in un documento PublishView™, l'ordinatore pagine e l'emulatore TI-
SmartView™ non sono disponibili.
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À In un documento PublishView™:

• Fare clic su per aprire il menu e gli strumenti dell'applicazione necessari
per lavorare con applicazioni TI-Nspire™ e oggetti PublishView™.

• Fare clic su per aprire il riquadro Utilità da cui è possibile accedere a
modelli matematici, simboli, il Catalogo, operatori matematici e librerie.

• Fare clic su per aprire Esplora contenuto.

Nota: Per ulteriori informazioni, consultareUtilizzo dell'area di lavoro Documenti.

Á
Fare clic su per ridurre a icona il pannello di un menu. Fare clic su per
espanderlo.

Â Applicazioni TI-Nspire™. Spostare un'icona in un'attività per inserire un'applicazione:



Calcolatrice

Grafico

Geometria

Foglio elettronico

Dati e statistiche

Notes

Vernier DataQuest™

Domanda (disponibile solo in TI-Nspire™ CX Premium Teacher Software e TI-

Nspire™ Navigator™ NC Teacher Software).

Ã Documenti TI-Nspire™ Utilizzare questo strumento per individuare e inserire
documenti TI-Nspire™ (file .tns) in un'attività.

Ä Oggetti PublishView™. Utilizzare questo strumento per spostare i seguenti oggetti in
un'attività:

Immagine

Video

Riquadro di testo

Collegamento ipertestuale

Utilizzo di menu e barra degli strumenti

Quando si lavora in un documento PublishView™, selezionare opzioni dai menu o dalla
barra degli strumenti nell'area di lavoro Documenti per lavorare con il contenuto e gli
oggetti. Un oggetto inserito in un documento PublishView™ può essere manipolato con
gli stessi strumenti che si utilizzerebbero in un documento TI-Nspire™. Nei documenti
PublishView™ è possibile:

• Fare clic con il pulsante destro del mouse su un oggetto per aprire un menu
contestuale con le opzioni che possono essere applicate all'oggetto.
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• Utilizzare le opzioni Aggiungi, Inserisci e Incolla per aggiungere oggetti in un
documento PublishView™.

• Utilizzare le opzioni Elimina e Taglia per rimuovere oggetti da un documento
PublishView™.

• Spostare oggetti da un punto in un altro all'interno di un documento PublishView™.

• Copiare oggetti da un documento e incollarli in un altro documento PublishView™.

• Ridimensionare e scalare oggetti quali riquadri di testo e immagini.

• Modificare il carattere e la dimensione e applicare al testo formattazioni quali
corsivo, grassetto, sottolineato e colore.

Nota: Per ulteriori informazioni, consultareUtilizzo dell'area di lavoro Documenti.

Utilizzo dei menu contestuali

Nelle applicazioni TI-Nspire™ e nei documenti PublishView™, i menu contestuali
forniscono un elenco di opzioni specifiche per l'operazione che si sta eseguendo. Ad
esempio, quando si fa clic con il pulsante destro del mouse su una cella
nell'applicazione Foglio elettronico di TI-Nspire™, viene aperto un menu contestuale
con l'elenco delle azioni che si possono compiere su quella cella. Quando si fa clic con
il pulsante destro del mouse sul bordo di un riquadro di testo in un documento
PublishView™, il menu contestuale fornisce le azioni che possono essere eseguite sul
riquadro di testo.

Menu contestuali nelle applicazioni TI-Nspire™

Quando si aggiunge un'applicazione TI-Nspire™ in un documento PublishView™, il
menu dell'applicazione e i menu contestuali ad essa associati diventano disponibili e
funzionano allo stesso modo di un documento TI-Nspire™.

Menu contestuali nei documenti PublishView™

Nei documenti PublishView™, i menu contestuali forniscono delle scorciatoie per le
operazioni di uso frequente. I menu contestuali sono specifici di un oggetto o di
un'area:

• ll menu contestuale del foglio fornisce opzioni per lavorare con il layout del foglio e
del documento.

• I menu contestuali degli oggetti forniscono opzioni per manipolare gli oggetti
stessi.

• I menu contestuali sensibili al contenuto forniscono opzioni per lavorare con il
contenuto di un oggetto, ad esempio testo o un video.



Operazioni con oggetti PublishView™
In un documento PublishView™, il testo, i collegamenti ipertestuali e i video sono
contenuti in oggetti PublishView™. Inoltre, in un documento PublishView™ è possibile
spostare, ridimensionare, copiare, incollare ed eliminare un oggetto. Gli oggetti
possono essere anche riposizionati in modo da sovrapporsi.

In un documento, gli oggetti PublishView™ possono esistere in tre stati: non
selezionato, selezionato e interattivo.

Stato Descrizione

Non
selezionato

Quando non è selezionato, un
oggetto è privo di maniglie di
riposizionamento e
ridimensionamento. Per
deselezionare un oggetto, fare
clic con il pulsante sinistro o
destro del mouse fuori
dall'oggetto.
In questo esempio, i bordi
intorno all'oggetto sono
visualizzati.

Selezionato Quando è selezionato, un oggetto
è contornato da otto maniglie
quadrate. Per selezionare un
oggetto, fare clic sul suo bordo.
Quando è selezionato, l'oggetto
può essere spostato e
ridimensionato.

• Per spostare un oggetto,
fare clic su un bordo e
trascinare l'oggetto nella
nuova posizione.

• Per ridimensionare un
oggetto, afferrare una
maniglia.

• Fare clic con il pulsante
destro del mouse sul bordo
per aprire un menu
contestuale con le opzioni
per manipolare l'oggetto.
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Stato Descrizione

Interattivo Uno stato interattivo è indicato
da una cornice blu intorno
all'oggetto. Per attivare lo stato
interattivo, fare clic con il
pulsante sinistro o destro del
mouse su un punto qualsiasi del
corpo dell'oggetto. Quando
l'oggetto è in uno stato
interattivo, è possibile lavorare
con il suo contenuto. Ad
esempio, è possibile aggiungere o
modificare testo in un riquadro di
testo o completare funzioni
matematiche in un'applicazione
TI-Nspire™. In uno stato
interattivo, i menu contestuali
contengono opzioni specifiche al
contenuto di un oggetto.

Inserimento di un oggetto

1. Nella Casella degli strumenti Documenti, assicurarsi che il menu Oggetti
PublishView™ sia aperto.

2. Utilizzare il mouse per fare clic su un'icona e trascinarla nel documento.

3. Rilasciare il pulsante del mouse per inserire l'oggetto nel documento.



I riquadri di testo e le cornici selezionate possono
essere ridimensionati, spostati, copiati, incollati ed
eliminati.

4. Utilizzando il mouse, afferrare le maniglie per ridimensionare l'oggetto e
trascinarlo per posizionarlo nel documento secondo necessità.

Apertura dei menu contestuali degli oggetti

▶ Fare clic con il pulsante destro del mouse sul bordo di un oggetto in un documento
PublishView™.

Viene visualizzato il menu contestuale con le opzioni per eliminare,
copiare/incollare, tagliare e portare in primo piano/sullo sfondo l'oggetto.
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Ridimensionamento di un oggetto

1. Fare clic su un bordo dell'oggetto per selezionarlo. Il bordo si trasforma in una
linea blu spessa e le maniglie diventano attive.

2. Spostare il mouse su una delle maniglie per attivare lo strumento di
ridimensionamento.

3. Afferrare una delle maniglie e trascinare nella direzione desiderata per ingrandire
o rimpicciolire l'oggetto.

4. Fare clic fuori dall'oggetto per salvare le nuove dimensioni.

Spostamento di un oggetto

Per spostare un oggetto in un altro punto della pagina:

1. Fare clic su un bordo dell'oggetto per selezionarlo. Il bordo si trasforma in una
linea blu spessa e le maniglie diventano attive.

2. Spostare il cursore su uno dei bordi per attivare lo strumento di posizionamento.

3. Fare clic per afferrare l'oggetto. Le guide di allineamento orizzontali e verticali
diventano attive nella parte superiore e inferiore dell'oggetto. Utilizzare le linee
della griglia per posizionare l'oggetto nella pagina.



À guida di allineamento verticale

Á guida di allineamento orizzontale

4. Trascinare l'oggetto in una nuova posizione sulla pagina.

5. Rilasciare il pulsante del mouse per inserire l'oggetto nella nuova posizione.

Sovrapposizione di oggetti

È possibile posizionare gli oggetti in modo che si sovrappongano. È inoltre possibile
controllare l'ordine di sovrapposizione per specificare quale oggetto è posizionato
davanti o dietro all'altro. Gli oggetti sovrapposti hanno molteplici usi pratici nella
presentazione di informazioni alla classe. Ad esempio, è possibile creare un "controllo
a tenda" posizionando un riquadro di testo vuoto sopra altri oggetti. Successivamente,
è possibile spostare il riquadro di testo per rivelare gli elementi sottostanti, uno alla
volta.

Per modificare la posizione di un oggetto nell'ordine di sovrapposizione:

1. Fare clic sul bordo dell'oggetto da posizionare per selezionarlo, quindi fare clic con
il pulsante destro del mouse per aprire il menu contestuale.
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2. Fare clic su Invia in secondo piano o Porta in primo piano per portare l'oggetto
selezionato nella posizione desiderata.

Eliminazione di un oggetto

Per eliminare un oggetto da un foglio:

1. Fare clic su un bordo dell'oggetto per selezionarlo. Quando un oggetto è
selezionato, il bordo è blu e le maniglie sono attive.

2. Premere il tasto Canc per eliminare il riquadro di testo.

—oppure—

Fare clic con il pulsante destro del mouse e quindi fare clic su Elimina dal menu
contestuale.

Scelta di una cartella di lavoro per gli oggetti PublishView™

Utilizzare il campo Scegliere cartella di lavoro nel riquadro Oggetti PublishView™ per
selezionare una cartella per l'archiviazione dei documenti PublishView™ e dei file
correlati.

1. Accertarsi che il riquadro Oggetti PublishView™ sia aperto.



2. Fare clic su .

Viene visualizzata la finestra di dialogo Scegliere cartella di lavoro.

3. Spostarsi sulla cartella in cui si desidera memorizzare i file dei video e delle
immagini.

4. Fare clic su Apri per scegliere la cartella di lavoro.

La cartella selezionata diventa la cartella di lavoro e il suo nome appare nel campo
Scegliere cartella di lavoro. Le anteprime delle immagini supportate e dei file video
archiviati nella cartella vengono visualizzate nel riquadro Oggetti PublishView™.
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5. Per aggiungere un'immagine o un file video a un documento PublishView™,
selezionare il file, quindi spostarlo nel foglio attivo.

Operazioni con applicazioni TI-Nspire™
Nota: Per ulteriori informazioni, vedere il capitolo appropriato del presente manuale.

Aggiunta di un'applicazione in un'attività

Per inserire un'applicazione TI-Nspire™ in un'attività in un documento PublishView™:

1. Scegliere una delle seguenti operazioni per selezionare un'applicazione:

• Nel riquadro Applicazioni TI-Nspire™ nella Casella degli strumenti Documenti,
utilizzare il puntatore del mouse per puntare l'applicazione e trascinarla
nell'attività.

• Nella barra dei menu, fare clic su Inserisci e scegliere un'applicazione dal menu
a discesa.

• Fare clic con il pulsante destro del mouse all'interno del foglio per aprire il
menu contestuale, fare clic su Inserisci e scegliere un'applicazione dal menu a
discesa.

L'applicazione viene aggiunta al foglio.



2. Utilizzando il mouse, afferrare le maniglie per ridimensionare o posizionare
l'oggetto applicazione secondo necessità.

3. Fare clic all'esterno della cornice dell'applicazione per accettarne le dimensioni.

4. Per aprire il menu dell'applicazione TI-Nspire™ attiva, fare clic all'interno
dell'applicazione.

Il menu si apre all'interno della Casella degli strumenti Documenti, al di sopra del
riquadro Applicazioni TI-Nspire™.

Fare clic con il pulsante destro del mouse su un elemento dell'applicazione, ad
esempio una cella o una funzione, per aprire il menu contestuale relativo.
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5. Per lavorare nell'applicazione, fare clic su un'opzione dal menu applicazione. Fare

clic su per ridurre a icona il riquadro delle applicazioni.
Aggiunta di documenti TI-Nspire™ esistenti

Utilizzare il riquadro Documenti TI-Nspire™ per aprire un documento TI-Nspire™
esistente da inserire in un documento PublishView™. Quando si apre un documento TI-
Nspire™ esistente, tutte le pagine del documento vengono visualizzate nel riquadro di
anteprima. È possibile spostare intere attività o singole pagine nel foglio di
PublishView™.

Scelta di un documento di lavoro TI-Nspire™

Per scegliere un documento di lavoro:

1. Nella Casella degli strumenti Documenti, assicurarsi che il riquadro Documenti TI-
Nspire™ sia aperto.



2. Fare clic su .

Viene visualizzata la finestra di dialogo Scegliere documento di lavoro.

3. Selezionare la cartella in cui è memorizzato il documento TI-Nspire™:

• Fare clic su¤ nel campo Cerca in: per utilizzare una finestra di gestione file
per trovare una cartella.

• In una cartella aperta, fare clic su per spostarsi in alto di un livello nella

gerarchia delle cartelle.

• Fare clic su per tornare alla cartella principale predefinita.

• Fare clic su per aggiungere una nuova cartella alla cartella aperta sul

computer.

• Fare clic su per elencare le cartelle e i file. Per visualizzare i dettagli, fare

clic su .

4. Selezionare il file e fare clic su Apri

Il documento TI-Nspire™ viene aperto nel riquadro Documenti TI-Nspire™.
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5. Per inserire il documento TI-Nspire™ nel documento PublishView™, spostare una
pagina alla volta oppure un'attività alla volta nel foglio PublishView™.

Se si sta inserendo un'attività contenente più pagine, le pagine verranno impilate
una sopra l'altra nel foglio PublishView™. Spostare la pagina superiore per vedere
le altre pagine.

Operazioni con le attività
Allo stesso modo di un documento TI-Nspire™, un documento PublishView™ si
compone di una o più attività.

Le attività vengono utilizzate per controllare il layout di un documento PublishView™ in
modo da poter isolare le variabili. Quando si utilizzano variabili con lo stesso nome in
più attività, le variabili possono avere valori diversi. Per inserire un'attività in
documenti PublishView™, aprire il menu contestuale del foglio oppure utilizzare le
opzioni del menu Inserisci nell'area di lavoro Documenti. Quando si inseriscono attività,
occorre tenere presenti le linee guida seguenti:

• Per impostazione predefinita, un nuovo documento PublishView™ contiene una
attività.

• È possibile inserire un'attività alla fine di un'altra attività.

• Non è possibile inserire un'attività in mezzo a un'altra attività.

• Dopo l'attività selezionata viene sempre inserita una nuova interruzione di attività.

• Inserendo un'interruzione di attività si aggiunge uno spazio vuoto al di sotto
dell'interruzione.

• Qualsiasi oggetto tra due interruzioni di attività appartiene all'attività al di sopra
dell'interruzione.

• L'ultima attività include tutti i fogli e gli oggetti che si trovano al di sotto
dell'ultima interruzione di attività.



• Le interruzioni di attività non sono relative ad alcun oggetto, il che consente di
spostare oggetti all'interno di un'attività senza influire sulla posizione
dell'interruzione.

Inserimento di un'attività

Per inserire un'attività in un documento PublishView™ aperto:

1. Fare clic con il pulsante destro del mouse su un punto qualsiasi del foglio, quindi
selezionare Inserisci > Attività.

L'attività viene aggiunta al documento al di sotto delle attività esistenti.
L'interruzione di attività fornisce un ausilio visivo per individuare la separazione tra
le attività.

2. Per assegnare un nome a un'attività, evidenziare il testo predefinito, digitare un
nome, quindi fare clic all'esterno della casella di testo per salvarlo.

L'interruzione di attività viene salvata.

Se un documento contiene più attività, utilizzare la barra di scorrimento a destra
del documento per spostarsi in alto e in basso tra le attività.

Gestione delle interruzioni di attività

Le interruzioni di attività consentono di separare attività e gruppi di variabili.

• Tutte le attività hanno un'interruzione di attività.

• Un'interruzione di attività diventa visibile quando si aggiunge un'attività a un
documento.

• Un'interruzione di attività è rappresentata da una linea tratteggiata con il nome
dell'attività a sinistra del foglio.

• Per impostazione predefinita, il nome dell'attività appare come <Nome
dell'attività>. Evidenziare il testo predefinito per digitare un nuovo nome per
l'attività.

• I nomi delle attività possono non essere univoci. Due attività possono avere lo
stesso nome.

Visualizzazione e occultamento delle interruzioni di attività

In un documento PublishView™ è possibile selezionare di visualizzare o meno le
interruzioni di attività. Per impostazione predefinita, le interruzioni di attività sono
visualizzate.

1. Fare clic con il pulsante destro del mouse su un'area vuota del documento
(esternamente a qualsiasi oggetto) per aprire il menu contestuale del foglio.

2. Fare clic su Opzioni di layout.

Viene visualizzata la finestra di dialogo Opzioni di Mostra/Nascondi.
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Nota: È inoltre possibile selezionare Visualizza > Opzioni di layout PublishView™.

3. Deselezionare l'opzione Mostra interruzioni di attività per nascondere le
interruzioni di attività nel documento. Selezionare nuovamente l'opzione per
ripristinare l'impostazione predefinita e visualizzare le interruzioni di attività.

4. Fare clic su OK per chiudere la finestra.

Rinomina di un'attività

1. Fare clic sul nome già assegnato dell'attività sulla linea dell'interruzione di attività.

2. Digitare un nuovo nome per l'attività.

3. Fare clic fuori dal riquadro di testo per salvare il nuovo nome.

Eliminazione di un'attività

Per eliminare un'attività, completare una delle seguenti azioni:

▶ Selezionare l'interruzione di attività e fare clic su a destra nella linea di
interruzione.

▶ Selezionare Modifica >Elimina.

▶ Fare clic con il pulsante destro del mouse sull'interruzione di attività e selezionare
Elimina.

▶ Selezionare l'interruzione di attività e premere il tasto Canc o Backspace
(Arretramento).

Quando si elimina un'attività, tutti gli oggetti in essa contenuti vengono rimossi e
viene eliminato lo spazio tra l'interruzione dell'attività selezionata e l'interruzione di
quella successiva.

Organizzazione dei fogli di PublishView™
Un documento PublishView™ può essere composto da più fogli. Nell'area di lavoro
sullo schermo viene visualizzato un foglio alla volta. Tutto il lavoro si svolge negli
oggetti PublishView™ e nelle applicazioni TI-Nspire™ all'interno dei fogli.

Inserimento di fogli in un documento

Per aggiungere un foglio a un documento:



▶ Fare clic su Inserisci > Foglio.

Il foglio viene aggiunto al documento e la numerazione viene incrementata di
un'unità.

Apertura del menu contestuale del foglio

▶ Fare clic con il pulsante destro del mouse su un'area vuota (esternamente a
qualsiasi oggetto) in un foglio di PublishView™.

Viene visualizzato un menu contestuale con opzioni per inserire attività, pagine,
applicazioni e oggetti PublishView™, modificare opzioni per rimuovere spazi o
eliminare una pagina e opzioni per nascondere e visualizzare interruzioni di attività
e bordi degli oggetti.

Numerazione delle pagine

In un documento PublishView™, la numerazione delle pagine è visualizzata nel
margine inferiore (piè di pagina). Per impostazione predefinita, la numerazione appare
al centro del foglio di PublishView™ nel formato "n. di n.". Non è possibile modificare o
eliminare la numerazione delle pagine.

Operazioni con intestazioni e piè di pagina

I documenti PublishView™ presentano uno spazio nella parte superiore e nella parte
inferiore del foglio destinato all'inserimento di un'intestazione o di un piè di pagina.
Intestazioni e piè di pagina possono contenere la data, il nome del documento, il nome
del progetto di lezione, il nome della classe, il nome della scuola o qualsiasi altra
informazione necessaria per identificare un documento.

Per impostazione predefinita, intestazioni e piè di pagina non hanno contenuti e i loro
bordi sono nascosti. Per attivare un'intestazione o un piè di pagina per la modifica, fare
clic all'interno del margine superiore o inferiore. Una volta attivato, viene visualizzato
un riquadro di testo con un bordo grigio chiaro.

Inserimento e modifica di testo in intestazioni e piè di pagina

1. Fare clic all'interno del margine superiore o inferiore.

I bordi del riquadro di testo all'interno del margine diventano visibili e lo spazio
dell'oggetto viene disabilitato. Il cursore viene posizionato all'interno dello spazio
dell'intestazione o del piè di pagina e la barra degli strumenti di formattazione
diventa attiva.
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2. Digitare il testo.

• Il carattere predefinito è TI-Nspire™ true type, 12 pt, normale.
• Per impostazione predefinita, il testo è centrato orizzontalmente e

verticalmente.
• Il testo può essere allineato: a sinistra, al centro, a destra o giustificato.
• Il testo che non rientra orizzontalmente nel riquadro di testo viene inviato a

capo alla riga successiva.
• Il testo che non rientra verticalmente nel riquadro di testo non viene

visualizzato, ma rimane nel riquadro. (Se si elimina del testo, il testo non
visualizzato diventa visibile).

3. Completare una delle seguenti operazioni per salvare il testo:

• Fare clic su un punto qualsiasi all'esterno del riquadro di testo dell'intestazione
o del piè di pagina per salvare il testo.

• Premere Esc per salvare il testo.

Il foglio di PublishView™ diventa attivo e il menu di formattazione si chiude.

Visualizzazione e occultamento dei bordi

Per impostazione predefinita, i bordi vengono visualizzati quando si inserisce un
oggetto in un'attività. Se si seleziona di nascondere i bordi, la selezione viene applicata
a tutti gli oggetti del documento e agli oggetti che si inseriscono nel documento. Per
nascondere un bordo:

1. Fare clic con il pulsante destro del mouse su un'area vuota del foglio
(esternamente a qualsiasi oggetto) per aprire il menu contestuale.

2. Fare clic su Opzioni di layout.

Viene visualizzata la finestra di dialogo Opzioni di layout.

Nota: È inoltre possibile selezionare Visualizza > Opzioni di layout PublishView™.



3. Deselezionare l'opzione Mostra bordi degli oggetti per nascondere i bordi degli
oggetti dell'attività. Selezionare nuovamente l'opzione per ripristinare
l'impostazione predefinita e visualizzare i bordi.

4. Fare clic su OK per chiudere la finestra di dialogo.

Inserimento e rimozione di spazio

Per organizzare la visualizzazione degli oggetti PublishView™ in un foglio, è possibile
inserire o eliminare spazio tra gli oggetti.

Nota: È possibile inserire o rimuovere spazio verticale tra gli oggetti utilizzando il
seguente metodo. Per inserire o rimuovere spazio orizzontale tra gli oggetti, spostare
l'oggetto.

Inserimento di spazio

1. Fare clic con il pulsante destro del mouse esternamente a qualsiasi oggetto sul
punto in cui si desidera inserire spazio. Viene visualizzato il menu contestuale.

2. Selezionare Modifica> Aggiungi/Rimuovi spazio. Lo strumento Aggiungi/Rimuovi
spazio viene attivato.
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Strumento
Aggiungi/Rimuovi spazio

3. Utilizzare il mouse per posizionare lo strumento nel punto esatto in cui si desidera
inserire lo spazio.

4. Fare clic sullo strumento, quindi trascinare verso il basso per selezionare la
quantità di spazio da inserire. Mano a mano che si trascina verso il basso, lo spazio
selezionato viene indicato in verde.



5. Premere il tasto Invio per inserire lo spazio tra gli oggetti. È possibile regolare la
quantità di spazio trascinando verso il basso e verso l'alto prima di premere Invio.

Rimozione di spazio

1. Fare clic con il pulsante destro del mouse esternamente a qualsiasi oggetto nel
punto in cui si desidera rimuovere lo spazio.

Viene visualizzato il menu contestuale.

2. Selezionare Modifica > Aggiungi/Rimuovi spazio.

Lo strumento Aggiungi/Rimuovi spazio viene attivato.
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Strumento
Aggiungi/Rimuovi spazio

3. Utilizzare il mouse per posizionare lo strumento nel punto esatto in cui si desidera
rimuovere lo spazio.

4. Fare clic sullo strumento, quindi trascinare verso l'alto per selezionare la quantità
di spazio da rimuovere. Mano a mano che si trascina verso l'alto, lo spazio
selezionato viene indicato in rosso.



5. Premere il tasto Invio per rimuovere lo spazio tra gli oggetti. È possibile regolare la
quantità di spazio trascinando verso il basso e verso l'alto prima di premere Invio.

Nota: Se non vi è spazio sufficiente nel foglio per accogliere gli oggetti, questi non
verranno spostati quando lo spazio viene rimosso.

Eliminazione di fogli vuoti dalle attività

È possibile eliminare da un'attività un foglio che non contenga applicazioni TI-Nspire™
o oggetti PublishView™. Per eliminare un foglio vuoto da un'attività:

1. Eliminare tutte le applicazioni TI-Nspire™, gli oggetti PublishView™, spostare o
eliminare tutte le interruzioni di attività dal foglio.

2. Posizionare il cursore sul foglio da eliminare.

3. Fare clic con il pulsante destro del mouse sul foglio vuoto per aprire il menu
contestuale.

4. Fare clic suModifica >Elimina foglio.

Il foglio vuoto viene rimosso dall'attività.

Utilizzo di Zoom
La funzione zoom consente di ingrandire su qualsiasi oggetto o area nel documento
PublishView™ per la discussione e di rimpicciolire per avere una panoramica della
lezione. Lo zoom utilizza il centro dell'area visualizzabile per ingrandire.
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L'impostazione di default è 100%.

▶ Per modificare la percentuale di zoom, procedere in uno dei modi seguenti:

• Digitare il numero nella casella e premere Invio.
• Utilizzare i pulsanti - e + per ridurre o aumentare la percentuale in incrementi

del 10%.
• Utilizzare la freccia dell'elenco a discesa per selezionare una percentuale

prestabilita.

Le impostazioni dello zoom sono mantenute quando si salva il documento.

Inserimento di testo in un documento PublishView™
In un documento PublishView™, è possibile inserire testo in tre modi diversi:

• Inserire un riquadro di testo di PublishView™ per introdurre testo non formattato o
per copiare testo da altre fonti nel documento. Ad esempio, è possibile posizionare
un riquadro di testo PublishView™ accanto a un'immagine e digitarvi una
descrizione. È inoltre possibile copiare e incollare testo da file .doc, .txt, .rtf.
Utilizzare i riquadri di testo di PublishView™ per dare risalto a un testo e
formattarlo. I riquadri di testo di PublishView™ non vengono convertiti quando si
converte un documento PublishView™ in un documento TI-Nspire™. È possibile
utilizzare un riquadro di testo di PublishView™ per inserire del testo che gli utenti
dei palmari non devono vedere.

• Utilizzare l'applicazione Notes di TI-Nspire™. Si dovrebbe utilizzare l'applicazione
Notes ogni volta che occorre un editor di equazioni avanzato e occorre utilizzare
modelli matematici e simboli di TI-Nspire™. Le formattazioni in apice e in pedice
del testo sono più facili da usare in Notes. Si dovrebbe utilizzare Notes inoltre
quando si pianifica di convertire il documento PublishView™ in un documento TI-
Nspire™ per utilizzarlo su un palmare e si desidera che gli utenti del palmare
vedano il testo.

• Inserire testo in applicazioni TI-Nspire™ con gestione del testo allo stesso modo di
come si farebbe in un documento TI-Nspire™.

Inserimento di testo in un riquadro di testo

1. Accertarsi che il riquadro Oggetti PublishView™ sia aperto.



2. Utilizzare il mouse per fare clic su e trascinare l'icona nell'attività.
3. Rilasciare il pulsante del mouse per inserire il riquadro di testo nell'attività.

4. Utilizzando il mouse, afferrare le maniglie per ridimensionare il riquadro di testo o
per posizionarlo nell'attività secondo necessità.

5. Fare clic fuori dal riquadro di testo per salvare le dimensioni e la posizione.

6. Fare clic su "Digitare il testo qui."

La barra di formattazione diventa attiva. Lo stato del riquadro di testo è interattivo
per l'inserimento o la modifica del testo.

7. Digitare il nuovo testo.

—oppure—

Copiare e incollare testo da un altro file.

8. Applicare la formattazione secondo necessità.

9. Fare clic all'esterno del riquadro di testo per salvare il testo.
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Formattazione e modifica di un testo

Le opzioni per la modifica e la formattazione di un testo sono incluse nella barra degli
strumenti di formattazione nella parte superiore del documento attivo. Le opzioni di
formattazione per la modifica del testo includono:

• Modifica del carattere, della dimensione e del colore relativi.

• Applicazione della formattazione in grassetto, corsivo e sottolineato.

• Applicazione delle seguenti opzioni di allineamento orizzontale del testo: a sinistra,
a destra, al centro e giustificato.

• Inserimento di collegamenti ipertestuali.

Attivazione della modalità di modifica

▶ Fare clic all'interno del riquadro di testo per attivare la modalità di modifica.

• Viene visualizzato il menu contestuale.
• Il testo è selezionabile per la modifica.

Apertura del menu contestuale del contenuto

▶ Fare clic con il pulsante destro del mouse all'interno di un riquadro di testo
contenente del testo o un collegamento ipertestuale.

Vengono visualizzati il menu di formattazione e il menu contestuale con le opzioni
Taglia, Copia e Incolla.

Utilizzo dei collegamenti ipertestuali nei documenti PublishView™
Nei documenti PublishView™, utilizzare i collegamenti ipertestuali per:

• Collegare a un file

• Collegare a un sito web

È possibile inserire un collegamento ipertestuale in un documento aperto oppure
convertire qualsiasi testo all'interno di un riquadro di testo in un collegamento
ipertestuale. Una volta inserito, il testo del collegamento ipertestuale viene formattato
in blu sottolineato. È possibile modificare la formattazione di questo testo senza
perdere il collegamento.

Se si interrompe un link, facendo clic su di esso viene visualizzato un messaggio di
errore:

• Impossibile aprire il file specificato

• Impossibile aprire la pagina web specificata

Impossibile aprire la pagina web specificata

I collegamenti assoluti contengono il percorso completo del file collegato e non
dipendono dalla posizione del documento principale.



I collegamenti relativi contengono la posizione del file collegato relativo al documento
principale. In caso di più lezioni in una singola cartella e se queste sono tutte collegate
utilizzando l'indirizzo relativo, è possibile spostare la cartella in qualsiasi altra
posizione (un'altra cartella locale, datashare, unità di memoria flash, online) senza
rompere i collegamenti. I collegamenti possono inoltre rimanere intatti aggregando i
documenti in un'unità didattica o comprimendoli in un file zippato e condividendoli.

Nota: Il documento PublishView™ deve essere salvato prima di poter inserire un
collegamento ipertestuale relativo.

Creazione di un link a un file

È possibile creare un link a qualsiasi file presente sul computer. Se il tipo di file è
associato a un'applicazione sul computer, il file verrà avviato non appena si fa clic sul
link. Esistono due modi per creare un link a un file: digitando o incollando l'indirizzo del
file nel campo Indirizzo o selezionando un file.

Collegamento a un file utilizzando un indirizzo

1. Accertarsi che il riquadro Oggetti PublishView™ sia aperto.

2. Trascinare l'icona del collegamento ipertestuale sul documento.

Viene visualizzata la finestra di dialogo Collegamento ipertestuale.
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3. Digitare il nome del link nel campo Testo. Ad esempio, si potrebbe inserire lo
stesso nome del documento.

4. Copiare il percorso del file per cui si desidera creare il collegamento e incollarlo nel
campo Indirizzo.

—oppure—

Digitare il percorso del file nel campo Indirizzo.

Nota: Digitare ../ per designare le directory superiori. Ad esempio:
../../lessons/mathlesson2.tns.

5. Fare clic su OK per inserire il collegamento.

Nel documento PublishView™ viene inserito un riquadro di testo contenente il
collegamento ipertestuale.

Collegamento a un file selezionandolo

1. Accertarsi che il riquadro Oggetti PublishView™ sia aperto.

2. Trascinare l'icona del collegamento ipertestuale sul documento.



Viene visualizzata la finestra di dialogo Collegamento ipertestuale.

3. Digitare il nome del link nel campo Testo. Ad esempio, si potrebbe inserire lo
stesso nome del documento.

4. Fare clic su per selezionare Collegamento a un file sul computer o su un'unità
di rete.

Viene visualizzata la finestra di dialogo Seleziona file da inserire come
collegamento ipertestuale.

5. Evidenziare e selezionare il file oggetto del link, quindi fare clic su Inserisci.

Il nome di percorso viene inserito nel campo Indirizzo della finestra di dialogo
Collegamento ipertestuale.
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Se il software non è in grado di determinare se il collegamento è un indirizzo
relativo o assoluto, la finestra di dialogo Collegamento ipertestuale si apre per
poter modificare il tipo di collegamento.

Fare clic sull'opzione appropriata per cambiare il collegamento.

• Rendi assoluto l'indirizzo.
• Rendi relativo l'indirizzo.

6. Fare clic su OK per inserire il collegamento.

—oppure—

Fare clic su Reimposta per tornare alla finestra di dialogo Collegamento
ipertestuale e scegliere un file diverso per cui creare il collegamento o per
modificare i campi Testo o Indirizzo.

Nel documento PublishView™ viene inserito un riquadro di testo contenente il
collegamento ipertestuale.

7. Utilizzando il mouse, afferrare le maniglie per ridimensionare il riquadro di testo.

—oppure—

Afferrare un bordo per posizionare il riquadro di testo nel documento secondo
necessità.

Creare un collegamento a un sito web

Esistono due modi per creare un link a un sito web: digitando o incollando l'URL nel
campo Indirizzo o selezionando un file.

Collegamento a un sito web utilizzando un indirizzo

1. Accertarsi che il menu Oggetti PublishView™ sia aperto.

2. Trascinare l'icona nel documento per aprire la finestra di dialogo
Collegamento ipertestuale.

3. Digitare o incollare l'URL per cui si desidera creare il collegamento nel campo
Indirizzo.



4. Fare clic su OK.

Nel documento PublishView™ viene inserito un riquadro di testo contenente il
collegamento ipertestuale.

Collegamento a un sito web selezionandolo

1. Accertarsi che il menu Oggetti PublishView™ sia aperto.

2. Trascinare l'icona nel documento per aprire la finestra di dialogo
Collegamento ipertestuale.

3. Fare clic su per selezionare Collegamento a una risorsa Internet.

Il browser si apre sul sito web predefinito.

4. Spostarsi sul sito web o sul file nel sito web che si desidera collegare.

5. Copiare l'URL, quindi incollarlo nel campo Indirizzo della finestra di dialogo
Collegamento ipertestuale.

—oppure—

Digitare l'URL nel campo Indirizzo.

6. Fare clic su OK.

Nel documento PublishView™ viene inserito un riquadro di testo contenente il
collegamento ipertestuale.

7. Utilizzando il mouse, afferrare le maniglie per ridimensionare il riquadro di testo.

—oppure—

Afferrare un bordo per posizionare il riquadro di testo nel documento secondo
necessità.

Modifica di un collegamento ipertestuale

Per modificare il nome di un collegamento ipertestuale, il percorso o l'URL, completare
la procedura seguente.
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1. Utilizzando il mouse, fare clic con il pulsante destro sul testo del collegamento
ipertestuale, quindi selezionare Modifica collegamento ipertestuale.

Viene visualizzata la finestra di dialogo Collegamento ipertestuale.

2. Apportare le correzioni secondo necessità:

• Digitare le correzioni al nome del collegamento ipertestuale nel campo Testo.

• Fare clic su per aprire la finestra di dialogo Seleziona un file da
aggiungere come collegamento ipertestuale e utilizzare la finestra di
navigazione file per portarsi sulla cartella in cui è ubicato il file.

• Fare clic su per aprire un browser e accedere a un sito web per copiare e
incollare l'URL nel campo Indirizzo.

3. Fare clic su OK per salvare le modifiche.

Conversione di un testo esistente in un collegamento ipertestuale

1. Fare clic all'interno del riquadro di testo per attivare la modalità di modifica e
aprire il menu di formattazione.

2. Selezionare il testo da convertire in collegamento ipertestuale.

3. Fare clic su .

La finestra di dialogo Collegamento ipertestuale si apre con il testo selezionato nel
campo Testo.

4. Fare clic su per selezionare un link a un file.

—oppure—



Fare clic su per creare un link a una pagina di un sito web.

Rimozione di un collegamento ipertestuale

Utilizzare la seguente procedura per rimuovere un link dal testo di un riquadro di testo.
Il testo non viene rimosso dal documento.

1. Utilizzando il mouse, fare clic con il pulsante destro sul testo del collegamento
ipertestuale.

2. Fare clic su Rimuovi collegamento ipertestuale.

La formattazione del collegamento ipertestuale viene rimossa dal testo, che non è
più attivabile.

Nota: Per rimuovere il testo e la formattazione del collegamento ipertestuale,
eliminare direttamente il testo. Se un riquadro di testo contiene solo il testo collegato,
eliminare il riquadro di testo.

Operazioni con le immagini
Le immagini possono essere aggiunte a documenti PublishView™ come oggetti
PublishView™ oppure possono essere inserite in applicazioni TI-Nspire™ che
supportano immagini. I tipi di file supportati sono .bmp, .jpg, .png.

Nota: Se c'è un'applicazione TI-Nspire™ attiva nel documento PublishView™,
l'immagine viene inserita nella pagina di TI-Nspire™ selezionando Inserisci > Immagine
dalla barra dei menu o dal menu contestuale. Se non ci sono documenti TI-Nspire™
attivi, l'immagine viene inserita come oggetto PublishView™. Solo le immagini
contenute in applicazioni TI-Nspire™ vengono convertite in documenti TI-Nspire™ (file
.tns).

Inserimento di un'immagine

1. Accertarsi che il riquadro Oggetti PublishView™ sia aperto.

2. Fare clic su , quindi trascinare l'icona nel documento.

Operazioni con documenti PublishView™ 153



154 Operazioni con documenti PublishView™

Viene visualizzata la finestra di dialogo Scegli un'immagine da inserire in
PublishView™.

Nota: Per impostazione predefinita, viene visualizzata la cartella delle immagini
precaricate di Texas Instruments.

3. Aprire la cartella in cui si trova il file dell'immagine da caricare, quindi evidenziare
il nome del file.

4. Fare clic su Inserisci immagine.

L'immagine viene aggiunta al foglio di PublishView™.

5. Utilizzando il mouse, afferrare le maniglie per ridimensionare il riquadro di testo.

—oppure—



Afferrare un bordo per posizionare il riquadro di testo nel documento secondo
necessità.

Spostamento di immagini

1. Fare clic sulla cornice che delimita l'immagine per selezionarla.

2. Spostare il cursore sopra il bordo dell'immagine per attivare lo strumento di

posizionamento.
3. Spostare l'immagine nella nuova posizione nel foglio di PublishView™.

Nota: Gli oggetti possono sovrapporsi in un foglio di PublishView™.

Ridimensionamento di immagini

1. Fare clic sulla cornice che delimita l'immagine per selezionarla.

2. Spostare il mouse su una delle maniglie blu per attivare lo strumento di

ridimensionamento.
3. Trascinare la maniglia per rimpicciolire o ingrandire l'immagine.

Eliminazione di immagini

▶ Fare clic sull'immagine per selezionarla, quindi premere il tasto Canc.

—oppure—

▶ Fare clic su una maniglia con il pulsante destro del mouse per aprire il menu
contestuale, quindi selezionare Elimina.

Operazioni con file video
È possibile incorporare file video in un documento PublishView™ e riprodurre il video
direttamente dal documento stesso. I formati video supportati includono:

• File video Flash® (.flv) con video VP6 e audio MP3.

• MP4 (contenitore multimediale MPEG-4) con compressione video H264/AVC
(Advanced Video Coding) e audio AAC.

Nota: è possibile inoltre inserire un link a un video che verrà avviato in una nuova
finestra browser o in una finestra con un riproduttore di supporti. Per ulteriori
informazioni, vedere Operazioni con collegamenti ipertestuali.

Inserimento di un video

1. Accertarsi che il riquadro Oggetti PublishView™ sia aperto.

2. Fare clic su , quindi trascinare l'icona nel documento.

Viene visualizzata la finestra di dialogo Scegli un video da inserire in PublishView™.
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3. Aprire la cartella in cui si trova il file video da inserire e selezionare il nome del
file.

4. Fare clic su Inserisci video.

Un oggetto contenente un video incorporato viene inserito nel foglio di
PublishView™. Per impostazione predefinita, le maniglie di ridimensionamento e di
riposizionamento sono attive.

5. Utilizzando il mouse, afferrare le maniglie per ridimensionare l'oggetto oppure
afferrare un bordo per posizionare l'oggetto nel documento secondo necessità. Ad
esempio, è possibile riposizionare l'oggetto contenente il video sopra o sotto il
riquadro di testo contenente il testo di presentazione del video.

6. Per riprodurre il video, fare clic sulla freccia di avanzamento oppure in qualunque
punto nella finestra di visualizzazione.

Utilizzo della console video

La console video consente all'utente di controllare il video.



À Avvia o arresta il video.

Á Mostra il tempo trascorso durante la riproduzione del video.

Â Disattiva e annulla la disattivazione audio.

Conversione di documenti
È possibile convertire documenti PublishView™ (file .tnsp) in documenti TI-Nspire™
(file .tns) per la visualizzazione sui palmari. È anche possibile convertire documenti TI-
Nspire™ in documenti PublishView™.

Convertendo un documento si crea un nuovo documento: il documento originale rimane
intatto e non è collegato al nuovo documento. Se si apportano modifiche a un
documento, tali modifiche non vengono riflesse nell'altro.

Conversione di documenti PublishView™ in documenti TI-Nspire™

Non è possibile aprire un documento PublishView™ (file .tnsp) su un palmare. Tuttavia,
è possibile convertire il documento PublishView™ in un documento TI-Nspire™ che può
essere trasferito e aperto su un palmare. Quando si converte un documento
PublishView™ in un documento TI-Nspire™:

• Solo le applicazioni TI-Nspire™ diventano parte del documento TI-Nspire™.

• Gli oggetti PublishView™, quali per esempio riquadri di testo, immagini,
collegamenti ipertestuali e video, non vengono convertiti.

• Il testo contenuto nei riquadri di testo di PublishView™ non viene convertito;
tuttavia, viene convertito il testo in un'applicazione Notes di TI-Nspire™.

• Se sono contenute in un'applicazione TI-Nspire™, le immagini vengono convertite;
tuttavia, le immagini contenute in oggetti PublishView™ non vengono convertite.

Completare la procedura seguente per convertire un documento PublishView™ (file
.tnsp) in un documento TI-Nspire™ (file .tns).

1. Aprire il documento PublishView™ da convertire.

2. Fare clic su File > Converti in > Documento TI-Nspire™.

• Il nuovo documento TI-Nspire™ viene aperto nell'area di lavoro Documenti.
• Solo le applicazioni TI-Nspire™ supportante fanno parte del nuovo documento

TI-Nspire™.
• Partendo dall'alto in basso, quindi da sinistra a destra, il layout del documento

TI-Nspire™ si basa sull'ordine delle applicazioni TI-Nspire™ nel documento
PublishView™.
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- Nel documento TI-Nspire™ convertito ogni applicazione TI-Nspire™ in un
documento PublishView™ apparirà come una pagina. L'ordine delle pagine
nel documento TI-Nspire™ si basa sul layout delle applicazioni TI-Nspire™
nel documento PublishView™.

- Se due o più attività sono allo stesso livello, l'ordine è da sinistra a destra.
• Le interruzioni di attività sono mantenute.
• Il nuovo documento TI-Nspire™ non è collegato al documento PublishView™.

3. Una volta terminato il lavoro nel documento, fare clic su per salvare il
documento nella cartella corrente.

—oppure—

Fare clic su File > Salva con nome per salvare il documento in una cartella diversa.

Nota: Se il documento non è mai stato salvato, entrambe le opzioni Salva e Salva
con nome consentono di salvare in una cartella diversa.

Nota: È possibile usare l'opzione Salva con nome per convertire un documento
PublishView™ in un documento TI-Nspire™.

Nota: Se si tenta di convertire un documento PublishView™ che non contiene pagine o
applicazioni TI-Nspire™, viene visualizzato un messaggio di errore.

Conversione di documenti TI-Nspire™ in documenti PublishView™

È possibile convertire documenti TI-Nspire™ esistenti in documenti PublishView™ e
sfruttare così il layout e le funzioni di modifica potenziate per stampare, generare
report degli studenti, creare fogli di lavoro e valutazioni e pubblicare documenti su un
sito web o un blog.

Completare la procedura seguente per convertire un documento TI-Nspire™ in un
documento PublishView™.

1. Aprire il documento TI-Nspire™ da convertire.

2. Selezionare File > Converti in > Documento PublishView™.

• Il nuovo documento PublishView™ viene aperto nell'area di lavoro Documenti.
• Per impostazione predefinita, ci sono sei oggetti per ogni pagina.
• Una volta convertita, ogni attività del documento TI-Nspire™ avvierà un nuovo

foglio nel documento PublishView™.
• Le interruzioni di attività sono mantenute.

3. Una volta terminato il lavoro nel documento, fare clic su per salvare il
documento nella cartella corrente.

—oppure—

Fare clic su File > Salva con nome per salvare il documento in una cartella diversa.



Nota: È anche possibile usare l'opzione Salva con nome per salvare un documento
TI-Nspire™ come un documento PublishView™.

Stampa di documenti PublishView™
È possibile stampare report, fogli di lavoro e valutazioni create utilizzando la funzione
PublishView™. Per stampare un documento:

1. Selezionare File > Stampa.

Viene visualizzata la finestra di dialogo Stampa. A destra nella finestra di dialogo
viene visualizzata un'anteprima del documento.

2. Selezionare una stampante dal menu.

Nota: Il campo Stampa è disabilitato.

3. Selezionare Formato carta dal menu. Le opzioni disponibili sono:

• Letter (8.5 x 11")
• Legal (8.5 x 14")
• A4 (210 x 297 mm)

4. Selezionare il numero di Copie da stampare.

5. Nell'area Stampa intervallo, selezionare di stampare tutte le pagine del
documento, un intervallo di pagine o solo la pagina corrente.

Nota: Per impostazione predefinita, i margini superiore e inferiore sono impostati
su 2,54 cm e sono mantenuti tali anche per la stampa di un documento
PublishView™. Non ci sono margini laterali. I fogli di PublishView™ vengono
stampati così come appaiono nell'area di lavoro.

6. Se necessario, selezionare o deselezionare le caselle:

• Stampa interruzioni e nomi di attività.
• Stampa intestazioni
• Stampa piè di pagina
• Mostra bordi degli oggetti

7. Fare clic su Stampa oppure su Salva come PDF.

Operazioni con documenti PublishView™ 159



160 Operazioni con le unità didattiche

Operazioni con le unità didattiche
Molte lezioni o attività contengono diversi file. Ad esempio, gli insegnanti hanno
solitamente una versione del file per l'insegnante e una versione del file per lo
studente, file di valutazione e, a volte, file di supporto. Un'unità didattica è un
contenitore che consente di raggruppare tutti i file necessari per una lezione. Le unità
didattiche sono utilizzate per:

• Aggiungere qualsiasi tipo di file (.tns, .tnsp, .doc, .pdf, .ppt) a un'unità didattica.

• Inviare unità didattiche a palmari o laptop collegati; tuttavia, verranno inviati ai
palmari solo i file .tns.

• Visualizzare tutti i file di un'unità didattica utilizzando il software TI-Nspire™.

• Raggruppare tutti i file associati a una lezione in un'unica ubicazione.

• Inviare via e-mail un unico file dell'unità didattica a insegnanti o studenti anziché
cercare e allegare più file separati.

Creazione di una nuova unità didattica
Gli insegnanti e gli studenti possono creare nuove unità didattiche nell'area di lavoro
Documenti. Gli insegnanti possono inoltre creare nuove unità didattiche nell'area di
lavoro Contenuto.

Creazione di un'unità didattica nell'area di lavoro Documenti

Completare la seguente procedura per creare una nuova unità didattica. Per
impostazione predefinita, la nuova unità didattica non contiene file.

1. Nella Casella degli strumenti Documenti, fare clic su per aprire Esplora
contenuto.

2. Evidenziare la cartella in cui si desidera creare il file dell'unità didattica.

3. Fare clic su per aprire il menu e quindi fare clic su Nuova unità didattica.

Viene creato il file della nuova unità didattica con un nome predefinito e viene
inserito nell'elenco di file.

4. Digitare un nome per l'unità didattica.

5. Premere Invio per salvare il file.

Creazione di un'unità didattica nell'area di lavoro Contenuto

Nell'area di lavoro Contenuto, gli insegnanti hanno due opzioni per creare unità
didattiche:

• Quando i file richiesti per un'unità didattica sono posizionati in cartelle diverse,
creare un'unità didattica vuota e quindi aggiungere i file all'unità didattica.

• Se tutti i file richiesti sono posizionati nella stessa cartella, creare un'unità
didattica con i file selezionati.



Creazione di un'unità didattica vuota

Completare i seguenti passaggi per creare un'unità didattica che non contenga file.

1. Passare alla cartella sul computer in cui salvare l'unità didattica.

Nota: se è la prima volta che si utilizza il software, potrebbe essere necessario
creare una cartella sul computer prima di creare un'unità didattica.

2. Fare clic su oppure fare clic su File > Nuova unità didattica.

Viene creato il file della nuova unità didattica con un nome predefinito e viene
inserito nell'elenco di file.

3. Digitare un nome per l'unità didattica e premere Invio.

L'unità didattica viene salvata con il nuovo nome e i dettagli sono mostrati nel
riquadro Anteprima.

Creazione di un'unità didattica contenente file.

È possibile selezionare più file in una cartella e quindi creare l'unità didattica. Non è
possibile aggiungere una cartella a un'unità didattica.

1. Spostarsi sulla cartella che contiene i file da aggiungere all'unità didattica.

2. Selezionare i file. Per selezionare più file contigui, selezionare il primo file quindi
tenere premuto il tasto Shift e selezionare l'ultimo file dell'elenco. Per selezionare
file non contigui, selezionare il primo file quindi tenere premuto il tasto Ctrl e fare
clic sugli altri singoli file per selezionarli.

3. Fare clic su , e quindi fare clic su Unità didattiche > Crea nuova unità didattica
da selezionato.

Viene creata una nuova unità didattica e aggiunta alla cartella aperta. L'unità
didattica contiene le copie dei file selezionati.

4. Digitare un nome per l'unità didattica e premere Invio.

L'unità didattica viene salvata nella cartella aperta e i dettagli sono mostrati nel
riquadro Anteprima.

Aggiunta di file a un'unità didattica
Utilizzare uno dei metodi seguenti per aggiungere file a un'unità didattica:

• Trascinare ogni file in un'unità didattica selezionata. Questo metodo sposta il file
nell'unità didattica. Se si elimina l'unità didattica, il file viene eliminato dal
computer e può essere recuperato dal Cestino.

• Copiare e incollare un file in un'unità didattica selezionata.
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• Utilizzare l'opzione Aggiungi file a unità didattica. Questo metodo copia il file
selezionato nell'unità didattica. Il file non viene spostato dalla sua ubicazione
originale.

Utilizzo dell'opzione Aggiungi file a unità didattica

Utilizzare questa opzione per aggiungere file a un'unità didattica vuota o aggiungere
più file a un'unità didattica esistente.

1. Utilizzare una delle seguenti opzioni per selezionare il file di una unità didattica.

• Quando si lavora nell'area di lavoro Documenti, aprire Esplora contenuto e
quindi fare doppio clic sul nome del file dell'unità didattica.

• Quando si lavora nell'area di lavoro Contenuto, fare doppio clic sul nome
dell'unità didattica.

Nota: Nell'area di lavoro Contenuto, è possibile fare clic sul nome dell'unità
didattica per aprire la finestra di dialogo File nel riquadro Anteprima. L'opzione
Aggiungi file all'unità didattica è disponibile dalla finestra di dialogo File. Se
l'unità didattica contiene già dei file, il primo file nell'unità didattica viene
visualizzato nella finestra di dialogo File.

La finestra di dialogo dell'unità didattica viene aperta. Il nome riflette il nome
dell'unità didattica.

2. Fare clic su Aggiungi file all'unità didattica.

Viene visualizzata la finestra di dialogo Aggiungi.



3. Evidenziare e selezionare il file da aggiungere all'unità didattica.

• È possibile selezionare più file contemporaneamente se si trovano tutti nella
stessa cartella.

• Se i file sono ubicati in cartelle diverse, è possibile aggiungerli uno alla volta.
• Non è possibile creare una cartella all'interno di un'unità didattica o

aggiungere una cartella in un'unità didattica.

4. Fare clic su Aggiungi per aggiungere il file all'unità didattica.

Il file viene aggiunto all'unità didattica e il nome del file viene elencato nella
finestra di dialogo dell'unità didattica.

5. Ripetere questa procedura per aggiungere all'unità didattica tutti i file richiesti.

Apertura di un'unità didattica
Per visualizzare e lavorare con i file in un'unità di didattica, completare una delle
procedure seguenti per aprire il file dell'unità didattica.

▶ Fare doppio clic sul nome dell'unità didattica.

▶ Selezionare l'unità didattica e quindi fare clic con il pulsante destro del mouse e
fare clic su Apri.

▶ Selezionare l'unità didattica, fare clic su e quindi fare clic su Apri.

▶ Selezionare l'unità didattica e quindi premere Ctrl + O. (Mac®: “ + O).

Quando si apre un'unità didattica, i file che la compongono vengono visualizzati in una
finestra di dialogo separata.
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Nota: non è possibile aprire un'unità didattica in un software diverso da TI-Nspire™.
Per esempio, se si apre la cartella utilizzando il gestore file del computer e si fa doppio
clic sul nome dell'unità didattica, il software TI-Nspire™ non viene avviato
automaticamente.

Aprire File all'interno dell'unità didattica

È possibile aprire qualsiasi file di un'unità didattica sul computer se si dispone del
programma associato a quel tipo di file.

• Quando si apre un file .tns o .tnsp, il file viene aperto nell'area di lavoro Documenti
del software TI-Nspire™.

• Quando si apre un altro tipo di file, il file avvia l'applicazione o il programma ad
esso associato. Per esempio, se si apre un file .doc, si apre Microsoft® Word.

Utilizzare una delle seguenti operazioni per aprire un file di un'unità didattica:

▶ Fare doppio clic sull'unità didattica e quindi fare doppio clic su uno dei file che la
compongono.

▶ Nell'unità didattica, selezionare il file e quindi fare clic su ¢ oppure fare clic con il
pulsante destro del mouse sul nome del file e selezionare Apri.

Gestione di file in un'unità didattica
È possibile aprire, copiare/incollare, eliminare e rinominare i file di un'unità didattica
esistente. Per individuare i file di un'unità didattica esistente e lavorare con essi:

1. Selezionare una delle seguenti opzioni per individuare un'unità didattica esistente.

• Quando si lavora nell'area di lavoro Documenti, aprire Esplora contenuto (fare
clic su nella Casella degli strumenti Documenti) e quindi trovare la

cartella in cui è posizionata l'unità didattica.
• Nell'area di lavoro Contenuto, evidenziare la cartella nella quale si trova l'unità

didattica nel riquadro Contenuto.

Nota: Nell'area di lavoro Contenuto, è possibile fare clic sul nome dell'unità
didattica per aprire la finestra di dialogo File nel riquadro Anteprima.



Selezionare il file con cui si desidera lavorare e fare clic con il pulsante destro
del mouse per aprire il menu contestuale.

2. Fare doppio clic sull'unità didattica per aprire la finestra di dialogo Unità didattica.

3. Selezionare il file con cui si desidera lavorare e fare clic su ¢ per aprire il menu
contestuale.

4. Fare clic sull'azione da eseguire:
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• Fare clic su Apri. I documenti TI-Nspire™ e PublishView™ si aprono nell'area di
lavoro Documenti. Quando si apre un altro tipo di file, il file avvia l'applicazione
o il programma ad esso associato.

• Fare clic su Copia per inserire il file negli Appunti.
• Aprire una cartella del computer oppure selezionare un palmare o un laptop

collegato, quindi fare clic con il pulsante destro del mouse e selezionare Incolla
per inserire il file copiato in una nuova posizione.

• Fare clic su Elimina per eliminare un file dall'unità didattica. Prestare
attenzione quando si elimina un file da un'unità didattica. Eseguire sempre una
copia di backup dei file dell'unità didattica in caso di necessità per uso futuro.

• Fare clic su Rinomina per assegnare un nuovo nome al file. Per cancellare
questa azione, premere Esc.

• Fare clic su Aggiungi file a unità didattica per selezionare e aggiungere altri file
all'unità didattica.

• Fare clic su Aggiorna per aggiornare l'elenco dei file dell'unità didattica.
• Fare clic su Pacchetto da unità didattica per creare un file .tilb.
• Fare clic su Invia a palmari collegati per aprire lo Strumento Trasferimento e

inviare il file selezionato a palmari collegati. È possibile inviare solo file .tns e
file del sistema operativo.

5. Al termine dell'operazione, fare clic su Chiudi per chiudere la finestra di dialogo.

Gestione delle unità didattiche
Utilizzare il menu o il menu contestuale per copiare, eliminare, rinominare o inviare
un'unità didattica ai palmari o ai laptop collegati. Non è possibile aggiungere una
cartella a un'unità didattica.

Gestione di un'unità didattica nell'area di lavoro Documenti

1. In Esplora contenuto, fare clic con il pulsante destro del mouse sul nome dell'unità

didattica oppure fare clic su per aprire il menu contestuale.



2. Fare clic sull'azione da eseguire. Se un'azione non è disponibile appare disabilitata
(in grigio):

• Fare clic su Apri per aprire l'unità didattica.
• Fare clic su Su di un livello per spostarsi in alto di un livello nella gerarchia delle

cartelle.
• Non è possibile aggiungere una cartella a un'unità didattica. Se si fa clic su Apri

cartella, si aggiunge una nuova cartella alla cartella in cui è memorizzata
l'unità didattica.

• Fare clic su Nuova Unità Didattica per creare una Nuova unità didattica. La
nuova unità didattica non viene inserita nell'unità didattica esistente, ma viene
creata all'interno della stessa cartella.

• Fare clic su Rinomina per modificare il nome dell'unità didattica. Premere Esc
per cancellare questa azione.

• Fare clic su Copia per copiare l'unità didattica negli Appunti.
• Evidenziare un'altra cartella e quindi fare clic su Incolla per copiare l'unità

didattica in un'altra posizione.
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• Fare clic su Elimina per eliminare l'unità didattica. Prestare attenzione quando
si elimina un'unità didattica. Eseguire sempre una copia di backup dei file
dell'unità didattica in caso di necessità per uso futuro.

• Seleziona tutto evidenzia tutti i file nella cartella aperta. Questa opzione non è
applicabile alle unità didattiche.

• Fare clic su Pacchetto da unità didattica per creare un file .tilb.
• Fare clic su Aggiorna per aggiornare l'elenco dei file nella cartella aperta.

Gestione di unità didattiche nell'area di lavoro Contenuto

1. Fare clic su Contenuto del Computer nel riquadro Risorse.

2. Nel riquadro Contenuto, spostarsi sull'unità didattica con cui si desidera lavorare e
quindi fare clic con il pulsante destro del mouse per aprire il menu contestuale

oppure fare clic su per aprire il menu di opzioni.

3. Selezionare l'azione da eseguire:

• Fare clic su Apri per aprire l'unità didattica.
• Fare clic su Copia per inserire il file dell'unità didattica negli Appunti.
• Aprire una cartella del computer oppure selezionare un palmare collegato,

quindi fare clic con il pulsante destro del mouse e selezionare Incolla per
inserire il file copiato in una nuova posizione.



• Fare clic su Elimina per eliminare l'unità didattica. Prestare attenzione quando
si elimina un'unità didattica. Eseguire sempre una copia di backup dei file
dell'unità didattica in caso di necessità per uso futuro.

• Fare clic su Aggiorna per aggiornare l'elenco dei file dell'unità didattica.
• Fare clic su Rinomina per assegnare un nuovo nome all'unità didattica. Per

cancellare questa azione, premere Esc.
• Per spostarsi in alto di un livello nella gerarchia delle cartelle, fare clic su Su di

un livello.
• Per aggiungere un'unità didattica all'elenco dei collegamenti in Contenuto

locale, fare clic su Crea collegamento.
• Per aggiungere altri file all'unità didattica, fare clic su unità didattica >

Aggiungi file a unità didattica.
• Fare clic su Unità didattiche > Pacchetto da unità didattica per creare un file

.tilb.
• Fare clic su Invia ai palmari collegati per aprire lo Strumento Trasferimento e

inviare l'unità didattica al palmare collegato. Solo i file .tns vengono inviati al
palmare.

Pacchetto di unità didattiche
Quando si crea un pacchetto di un'unità didattica, si comprimono tutti i file di una
cartella in un file tilb. Questo file contiene tutti i file contenuti nell'unità didattica. È
necessario comprimere l'unità didattica in un pacchetto prima di inviarla (file. tilb) via
e-mail a colleghi o studenti. Per impostazione predefinita, l'unità didattica viene
salvata nella seguente cartella:
...\TI-Nspire\New Lesson Bundle1.tilb\package\...

Creazione di un pacchetto di unità didattiche nell'area di lavoro Documenti

1. Aprire Esplora contenuto.

2. Evidenziare la cartella in cui è ubicato il file dell'unità didattica.

3. Selezionare l'oggetto da modificare.

4. Fare clic con il pulsante destro del mouse per aprire il menu contestuale, quindi
fare clic su Pacchetto da unità didattica.

Viene visualizzata la finestra di dialogo Unità didattiche che conferma l'avvenuta
creazione del file .tilb e la corretta compressione del pacchetto dell'unità didattica.

5. Fare clic su Sì per aprire la cartella in cui è archiviata l'unità didattica. Fare clic su
No per chiudere la finestra di dialogo.
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Creazione di un pacchetto di unità didattiche nell'area di lavoro Contenuti

1. In Contenuto Computer, spostarsi sulla cartella che contiene l'unità didattica da
aggiungere al pacchetto.

2. Nel riquadro Contenuto, selezionare l'unità didattica. I dettagli dell'unità didattica
sono visualizzati nel riquadro Anteprima.

3. Utilizzare uno dei seguenti metodi per creare il pacchetto:

• Dal riquadro Anteprima, fare clic su ¢ nella finestra di dialogo File e quindi fare
clic su Pacchetto da unità didattica.

• Nel riquadro Contenuto, fare clic con il pulsante destro del mouse sul nome
dell'unità didattica e quindi selezionare Unità didattiche > Pacchetto da unità
didattica.

Viene visualizzata una finestra di dialogo Unità didattica che conferma la creazione
dell'unità didattica.

4. Fare clic su Sì per aprire la cartella in cui è archiviata l'unità didattica. Fare clic su
No per chiudere la finestra di dialogo.

Invio via e-mail di un'unità didattica
Dopo aver creato un pacchetto da un'unità didattica, è possibile inviare via e-mail il file
.tilb ad altri insegnanti o studenti. Per allegare l'unità didattica a un messaggio e-mail:

1. Nel programma e-mail, selezionare l'opzione per allegare un file, quindi
evidenziare la cartella del file .tilb.

2. Aprire la cartella e selezionare il file .tilb per allegarlo al messaggio e-mail. Non è
possibile inviare via e-mail la cartella in cui si trova il file .tilb.

Invio di unità didattiche a palmari collegati
1. Completare una delle seguenti azioni per selezionare un'unità didattica:

• Nell'area di lavoro Documenti, aprire Esplora contenuto e quindi selezionare
l'unità didattica che si desidera inviare.

• Nell'area di lavoro Contenuto, evidenziare l'unità didattica che si desidera
inviare nel riquadro Contenuto.

2. Trascinare il file dell'unità didattica su un palmare collegato. È anche possibile
copiare l'unità didattica e quindi incollarla su un palmare collegato.

L'unità didattica viene trasferita sul palmare come cartella avente lo stesso nome. Solo
i file .tns vengono trasferiti sul palmare.



Cattura di schermi
La Cattura di schermi permette:

• Cattura pagina

- Catturare la pagina attiva in un documento TI-Nspire™ dal software o
dall'emulatore TI-SmartView™ come immagine.

- Salvare immagini catturate come file .jpg, .gif, .png o .tif , che possono essere
inserite in applicazioni TI-Nspire™ che accettano immagini.

- Copiare e incollare immagini in un'altra applicazione, quale ad esempio
Microsoft® Word.

• Cattura delle immagini in modalità palmare

- Nell'area di lavoro documenti, utilizzare la funzione DragScreen per catturare
lo schermo dell'emulatore o lo schermo laterale quando TI-SmartView™
Emulator è attivo.

- Gli insegnanti possono utilizzare questa funzione per trascinare e incollare
l'immagine su strumenti di presentazione, come SMART® Notebook,
Promethean’s Flipchart, e le applicazioni Microsoft® Office tra cui Word e
PowerPoint®.

Accedere a Cattura schermo
Lo strumento Cattura schermo è disponibile da tutte le aree di lavoro. Per accedere a
Cattura schermo:

▶ Dalla barra menu, cliccare su Strumenti > Cattura schermo.

▶ Dalla barra degli strumenti, fare clic su .

Utilizzo di Cattura classe
Nella classe, utilizzare lo strumento Cattura schermo per visualizzare e catturare gli
schermi degli studenti. È possibile catturare lo schermo di uno studente selezionato, di
più studenti selezionati oppure di tutti gli studenti della classe.

Nota: per visualizzare e catturare gli schermi degli studenti, questi devono essere
connessi alla classe.

Cattura degli Schermi studenti

1. Se ancora non è stato fatto, iniziare la sessione della classe e chiedere agli
studenti di connettersi.

2. Cliccare su , quindi cliccare su Cattura classe.

Viene visualizzata la finestra di dialogo Seleziona studente/i). Se sono stati
selezionati degli studenti nell'area di lavoro Classe, i nomi di quegli studenti
appaiono evidenziati. Se non è stato selezionato alcuno studente, vengono
selezionati tutti i nomi degli studenti della classe.
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3. Per cambiare lo studente corrente o aggiungerne altri:

• Fare clic su per visualizzare gli schermi dei palmari di tutti gli studenti
nella classe. Se uno studente non è connesso, sullo schermo del palmare
appare "Non connesso." Non appena lo studente si connette, utilizzare
Aggiorna per aggiornare lo schermo.

• Fare clic su , quindi fare clic sul nome di ciascuno studente per visualizzare
gli schermi dei palmari dei singoli studenti. Per selezionare più studenti
consecutivi, mantenere premuto il tastoMaiusc. Per selezionare più studenti
non consecutivi, mantenere premuto il tasto Ctrl (Macintosh®: “) e cliccare sul
nome di ogni studente.

• Fare clic sulla casella di controllo Solo connessi sotto il riquadro di sinistra per
visualizzare solo gli schermi degli studenti correntemente connessi.
All'aggiornamento dello schermo, tutti gli studenti che si sono connessi dopo
che è stato catturato lo schermo iniziale verranno elencati nella parte inferiore
della finestra Cattura schermi della classe.

4. Fare clic su OK.

Gli schermi degli studenti selezionati vengono visualizzati nella finestra Cattura
schermi dello classe.

Nota: L'esempio seguente mostra gli schermi dei palmari di due studenti
selezionati che sono connessi. La vista predefinita è Affiancata, vale a dire che tutti
gli schermi catturati sono visualizzati nella finestra.



5. Decidere se visualizzare o meno i nomi degli studenti. Per visualizzare o
nascondere i nomi degli studenti, selezionare o deselezionare la casella di controllo
relativa nella barra degli strumenti oppure fare clic su Visualizza > Mostra nomi
studenti.

Nota: la selezione relativa alla visualizzazione o meno dei nomi degli studenti
rimane attiva fino a quando non la si modifica. Ad esempio, se si seleziona di
nascondere i nomi degli studenti, i nomi rimangono nascosti anche quando si
chiude la finestra Cattura schermi della classe e si ritorna all'area di lavoro Classe.
Se si seleziona di nascondere i nomi degli studenti nell'area di lavoro Classe, i nomi
rimangono nascosti anche quando si apre la finestra Cattura schermi della classe.

Impostazione delle preferenze dell'insegnante per Cattura classe
Utilizzare l'opzione Preferenze insegnante per impostare le preferenze relative all'uso
dell'opzioneOrdine casuale in Cattura schermo e alla visualizzazione del palmare
dell'insegnante. Creando un nome utente e una password si consente agli insegnanti di
connettersi a una classe attiva. È anche possibile selezionare di personalizzare la vista
dello schermo del palmare dell'insegnante quando è visualizzato. Per ulteriori
informazioni, vedere le guide del palmare su education.ti.com/guides.

1. Dalle finestra del TI-Nspire™ Navigator™ Teacher Software, selezionare File >
Impostazioni > Preferenze insegnante.

Viene visualizzata la finestra di dialogo Preferenze insegnante.
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2. Se non è ancora stato fatto, creare un nome utente e una password.

3. Selezionare "Aggiungi insegnante alla vista della classe" per visualizzare il palmare
dell'insegnante nella finestra Cattura schermi della classe.

4. Per catturare gli schermi in ordine casuale, selezionare "Ordine casuale in Cattura
schermo".

5. Selezionare l'opzione "Individua palmare insegnante in Cattura schermo" in modo
che nella finestra Cattura schermi della classe lo schermo catturato dal palmare
dell'insegnante appaia diversamente dagli schermi catturati dai palmari degli
studenti.

6. Fare clic su OK per salvare le impostazioni.

Impostazione delle opzioni di visualizzazione in Cattura classe
Il sistema offre numerose opzioni per l’ottimizzazione della vista degli schermi di
classe catturati, tra cui:

• Alternanza tra vista affiancata e vista galleria.

• Confronto di schermi selezionati in vista affiancata.

• Aggiornamento della vista secondo necessità o impostazione della funzione di
aggiornamento automatico per aggiornare automaticamente la vista a intervalli
prestabiliti.

• Ingrandimento o rimpicciolimento della vista per aumentare o diminuire le
dimensioni degli schermi catturati nella finestra. È inoltre possibile selezionare la
percentuale di ingrandimento o di riduzione delle dimensioni dello schermo.

• Visualizzazione o meno dei nomi degli studenti.

• Accesso alle opzioni di Presentatore dal vivo. Per ulteriori informazioni, vedere
Utilizzo di Presentatore dal vivo.

Alternanza tra vista affiancata e viste galleria

Quando si catturano gli schermi degli studenti, la vista predefinita della finestra



Cattura schermi della classe viene affiancata. Passare alla vista galleria per mostrare
una vista ingrandita di uno schermo selezionato. Nel riquadro di sinistra sono riportate
le miniature di tutti gli schermi catturati che consentono di trovare e selezionare
rapidamente gli schermi.

Per alternare tra vista affiancata e vista galleria:

▶ Fare clic su Visualizza , quindi su Galleria oppure su Affiancata.

-oppure-

▶ Dal menu Visualizza, selezionare Galleria o Affiancata.

-oppure-

▶ Per la vista galleria, premere Ctrl + G (Macintosh®: “ + G). Per la vista affiancata,
premere Ctrl + T (Mac®: “ + T).

Nella vista galleria, le miniature degli schermi catturati sono visualizzate in una
colonna nel riquadro di sinistra della vista. Nel riquadro di destra è mostrata una vista
ingrandita di uno schermo selezionato.

• Se si selezionano contemporaneamente più miniature per la visualizzazione nel
riquadro di sinistra, esse appariranno nel riquadro di destra.

• Se si selezionano più di quattro miniature, è possibile visualizzare gli ulteriori
schermi facendo scorrere verso il basso il riquadro di destra.

• Se si è selezionato di visualizzare il nome degli studenti, i nomi appariranno al
centro sotto lo schermo catturato di ciascuno studente.

• Le funzioni di Zoom sono disabilitate nella vista galleria.

• È possibile modificare l’ordine degli schermi nella vista galleria.
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• La larghezza della miniatura non può essere variata.

Ridisposizione di schermi catturati

La modifica dell’ordine degli schermi catturati in una vista (Affiancata o Galleria) ne
causa la modifica automatica anche nell’altra.

▶ Nella vista affiancata, trascinare lo schermo nella sua nuova posizione.

▶ Nella vista galleria, trascinare le miniature dello schermo fino alla loro nuova
posizione.

Durante questa operazione una barra verticale mostra il punto in cui sarà inserito
lo schermo.

Nota: per annullare lo spostamento, premere Esc prima di rilasciare il pulsante del
mouse.

Aggiornamento di schermi catturati

Mano a mano che gli studenti si connettono alla classe e lavorano sui palmari, può
essere necessario aggiornare gli schermi catturati.

Aggiornamento manuale degli schermi

▶ Fare clic su Aggiorna .

Nota: se il palmare di uno studente ha perso la connessione e non è stato possibile
aggiornarne lo schermo, lo schermo non aggiornato apparirà profilato di giallo.

Aggiornamento automatico degli schermi

La funzione di aggiornamento automatico cattura di nuovo gli schermi Classe a
intervalli di tempo prestabiliti. Per impostazione predefinita, la funzione di



aggiornamento automatico è disabilitata. Per abilitare la funzione di aggiornamento
automatico:

▶ Nel menu Visualizza, fare clic su Aggiornamento automatico e selezionare un
intervallo di tempo.

Ingrandimento e riduzione

Le viste degli schermi catturati possono essere ingrandite o ridotte solo nella vista
affiancata.

▶ Per selezionare un livello di ingrandimento compreso tra 50% e 400% con
incrementi del 50%:

fare clic su Ingrandisci o su Riduci nella barra degli strumenti.
-oppure-
Fare clic su Visualizza > Ingrandisci o su Visualizza > Riduci dal menu.

▶ Per passare a un livello di ingrandimento selezionato, fare clic su Visualizza >
Percentuale zoom e selezionare il livello desiderato.
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Creare Pile di schermi studenti
Questa funzione consente di raccogliere una cronologia di schermi di uno o più studenti
catturati nell'opzione Cattura classe. Queste raccolte sono chiamati pile, ed è possibile
aggiungere o rimuovere schermi dalla pila di ogni studente, così come di navigare
all'interno e attraverso le pile degli studenti. L'utilizzo di pile è un modo comodo per
verificare i progressi in una lezione, ritirare le presentazioni e i compiti degli studenti
per rivederli e valutarli in seguito, o per mostrare prestazioni e progressi nelle riunioni
genitore/insegnante.

È possibile aggiungere, rimuovere, navigare, e salvare le pile dalla finestra Cattura
classe, che diventa disponibile quando si utilizza l'opzione Cattura classe.

▶ Per aprire la finestra Cattura classe, cliccare su Finestra > Finestra Cattura classe.

Aggiungere schermi ad una Pila

▶ Dalla finestra Cattura classe, cliccare su Visualizza > Pile > Aggiungi a Pila, o

cliccare .

▶ Per aggiungere un'altra serie di schermi, cliccare prima su Aggiorna e quindi
aggiungere la pila.

Quando la prima serie di schermi è aggiunta ad una nuova pila, viene denominata
Frame1 Ogni successiva aggiunta aumenta il numero di una unità, per esempio:
Frame2, Frame3 e così via.



Rimuovere i Frame dalla Pila

1. Selezionare il file da rimuovere.

2. Cliccare su Visualizza > Pile > Rimuovere da Pila, o cliccare .

Come i Frame vengono rimossi da una pila, i loro nomi sono adeguati per rimanere
sequenziali e riflettere l'eliminazione. Per esempio, se Frame6 viene eliminato,
Frame7 viene rinominato Frame6 e tutti i successivi numeri di Frame vengono scalati
di una cifra.

Navigazione attraverso Pile

È possibile navigare una pila di frame sia dalla vista affiancata che dalla vista galleria.

▶ Per visualizzare frame differenti in una pila, utilizzare una di queste opzioni:

• Fare clic sulla freccia dell'elenco a discesa, quindi fare clic sul frame desiderato
dall'elenco.

• Visualizza > Pile > Prossimo Frame, o cliccare su .

• Visualizza > Pile > Frame precedente, o cliccare su .

Nota: Queste opzioni sono disponibili solo c'è un frame precedente o successivo da
visualizzare.

Salvare Pile

Quando si chiude la finestra Cattura classe, il software chiede se si desidera salvare le
pile.

1. Cliccare Sì per salvare le pile.

La finestra di dialogo Seleziona o Crea cartella per salvare Pile si apre.

2. Cliccare su Salva per salvare le pile nella cartella predefinita, oppure creare o
navigare su un'altra cartella e cliccare su Salva.
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Le pile vengono salvate come screenshot individuali con il nome dello studente,
numero immagine, data e ora. Ad esempio:

Laxmi Chopra_immagine1_21-10-2011_11-50

Laxmi Chopra_immagine2_21-10-2011_11-50

Utilizzare l'area di lavoro Contenuti nel sistema di gestione file del computer per
individuare ed aprire gli schermi salvati.

Gli schermi si aprono nel visualizzatore di foto predefinito del computer.

Confronto di schermi selezionati
Questa funzione consente di confrontare gli schermi degli studenti in modalità
affiancata.

1. Selezionare gli schermi degli studenti da confrontare. Per selezionare più schermi
consecutivi, mantenere premuto il tastoMaiusc. Per selezionare più schermi non
consecutivi, mantenere premuto il tasto Ctrl (Macintosh®: “) e cliccare su ogni
immagine che si desidera salvare. Quando si seleziona uno schermo, il bordo
cambia colore.

Nota: se si selezionano più di quattro schermi, sarà necessario far scorrere il
riquadro di visualizzazione per vederli.

2. Cliccare suModifica > Confronta selezionati.

Se è attiva la vista affiancata, viene attivata la vista galleria e gli schermi
selezionati appariranno nell'ordine selezionato.

Nota: questa opzione è disabilitata nella vista galleria.

3. Per uscire dalla modalità di confronto, fare clic all'esterno dello schermo nel
riquadro di sinistra della vista galleria.

Utilizzo di Dai la parola (Make Presenter)
Selezionare uno schermo catturato nella finestra Cattura schermi della classe, quindi
fare clic sull'opzione Dai la parola nella barra degli strumenti per avviare Presentatore
dal vivo (Live Presenter) e presentare lo schermo dello studente alla classe. È possibile
scegliere un solo studente alla volta per Presentatore dal vivo. Per ulteriori
informazioni, vedere Utilizzo di Presentatore dal vivo.

Salvataggio di schermi con Cattura classe
È possibile salvare schermi catturati per l'uso in altri documenti TI-Nspire™ che
accettano immagini oppure per l'uso in altre applicazioni, quale per esempio
Microsoft® Word. È possibile salvare le immagini dello schermo nei seguenti formati:
.jpg, .png, .gif. È possibile salvare un'immagine alla volta, selezionare più immagini da
salvare o salvare tutte le immagini catturate.



Salvataggio di immagini dello schermo

Per salvare immagini dello schermo catturate con Cattura classe, attenersi alla
procedura seguente.

1. Nella finestra Cattura schermi della classe, selezionare lo schermo o gli schermi da
salvare come file immagine.

• Per selezionare più schermi consecutivi, fare clic sulla prima immagine, quindi
mantenere premuto il tastoMaiusc e fare clic sulle ulteriori immagini. Per
selezionare più schermi non consecutivi, mantenere premuto il tasto Ctrl
(Macintosh®: “) e cliccare su ogni immagine che si desidera salvare.

• Per selezionare tutti gli schermi catturati, cliccare suModifica > Seleziona tutti.

2. Cliccare su File > Salva schermo/i selezionato/i o premere Ctrl + S (Mac®: “ + S).

Viene visualizzata la finestra di dialogo Salva.

3. Passare alla cartella sul computer in cui salvare il file o i file.

4. Digitare un nome per il file o i file nel campo Nome file.

Il nome file predefinito è Immagine.

5. Nel campo Tipo file, fare clic su¤, quindi selezionare il tipo di file: .jpg, .png, .gif.
Il tipo di file predefinito è .jpg.

6. Fare clic su Salva.

Il file o i file vengono salvati nella cartella designata.

• Se si salva una sola immagine, il relativo file viene salvato con il nome
specificato nel campo Nome file.
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• Se si salvano più immagini, i relativi file vengono salvati con il nome
specificato nel campo Nome file a cui viene aggiunto un numero per rendere
univoco ogni nome. Ad esempio, Immagine1, Immagine 2, ecc.

Stampa di schermi catturati
È possibile stampare gli schermi catturati utilizzando l'opzione Cattura classe. È
possibile stampare uno schermo alla volta, più schermi contemporaneamente o tutti
gli schermi catturati. Per ogni pagina, viene stampato il nome della classe
nell'intestazione della pagina e la data e il numero di pagina nel piè di pagina.

Nota: l'opzione Stampa non è disponibile con le opzioni Cattura pagina o Cattura
palmare selezionato.

Per stampare uno schermo catturato:

1. Selezionare lo schermo da stampare.

2. Cliccare su File > Stampa.

Viene visualizzata la finestra di dialogo Stampa.

3. Se sono stati selezionati più schermi, fare clic su Opzioni di stampa per selezionare
il numero di schermi catturati per pagina.

Viene visualizzata la finestra di dialogo Opzioni di stampa.



4. Selezionare le opzioni desiderate. È possibile selezionare di stampare uno solo
schermo per pagina, sei schermi per pagina o tutti gli schermi sulla pagina. È
inoltre possibile selezionare se stampare i nomi degli studenti.

5. Fare clic su OK per tornare alla finestra di dialogo Stampa.

6. Selezionare le opzioni per la stampante in uso.

7. Selezionare il numero di copie da stampare.

8. Fare clic su Stampa per inviare il lavoro di stampa alla stampante selezionata.

Utilizzo di Cattura pagina
Utilizzare l'opzione Cattura pagina per catturare un'immagine di una pagina attiva in
un documento TI-Nspire™ È possibile salvare le immagini nei seguenti formati file:
.jpg, .gif, .png, .tif. Le immagini salvate possono essere inserite in applicazioni TI-
Nspire™ che accettano immagini. L'immagine viene copiata anche negli Appunti e può
essere inserita in un'altra applicazione, quale ad esempio Microsoft® Word o
PowerPoint®.

Cattura di una pagina

Per catturare un'immagine in una pagina attiva attenersi alla procedura seguente.

1. Nell'area di lavoro Documenti, aprire un documento e portarsi nella pagina da
catturare per attivarla.

2. Fare clic su , quindi fare clic su Cattura pagina.

L'immagine viene copiata negli Appunti e nella finestra Cattura schermo. Al
termine della cattura, nell'angolo in basso a destra del desktop si apre la

finestra di dialogo.

3. Fare clic su Visualizza.
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Viene visualizzata la finestra Cattura schermo.

È anche possibile selezionare Finestra > Finestra Cattura schermo per aprire la
finestra Cattura schermo.

4. Per catturare ulteriori pagine, spostarsi in un'altra pagina del documento corrente
oppure aprire un nuovo documento per selezionare una pagina.

Mano a mano che si prosegue con la cattura, le immagini vengono copiate nella
finestra Cattura schermo, che ne può contenere diverse. L'ultima pagina catturata
sostituisce il contenuto degli Appunti.

Utilizzo di Cattura palmare selezionato
Utilizzare l'opzione Cattura palmare selezionato per catturare lo schermo attivo di un
palmare collegato.

1. In un palmare collegato, accedere al menu o a una pagina di un documento da
catturare.

2. Nel software, selezionare il palmare collegato:

• Nell'area di lavoro Contenuto, selezionare il palmare dall'elenco Palmari
collegati nel riquadro Risorse.

• Nell'area di lavoro Documenti, aprire Esplora contenuto dalla Casella degli
strumenti Documenti, quindi selezionare il palmare dall'elenco Palmari
collegati.

• Nell'area di lavoro Classe, selezionare uno studente connesso.



3. Cliccare su , quindi cliccare su Cattura palmare selezionato.

—Oppure—

Cliccare su , quindi cliccare su Cattura palmare selezionato.

Lo schermo viene copiato negli Appunti e nella finestra Cattura schermo di TI-
Nspire™. Al termine della cattura, nell'angolo in basso a destra del desktop si apre

la finestra di dialogo.

4. Fare clic su Visualizza.

Viene visualizzata la finestra Cattura schermo.

È possibile catturare ulteriori schermi da un documento aperto su un palmare
collegato oppure aprire un altro documento su un palmare collegato per catturare
schermi da esso.

Mano a mano che si prosegue con la cattura, le immagini vengono copiate nella
finestra Cattura schermo che ne può contenere diverse. L'ultimo schermo catturato
sostituisce il contenuto degli Appunti.

Visualizzazione di schermi catturati
Quando si cattura una pagina o uno schermo, questi vengono copiati nella finestra
Cattura schermo.
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Ingrandimento o riduzione della vista di schermi catturati

Nella finestra Cattura schermo, utilizzare le funzioni Zoom avanti e Zoom indietro per
ingrandire o ridurre le dimensioni degli schermi catturati.

▶ Dalla barra degli strumenti, fare clic su per ingrandire le dimensioni degli
schermi nella vista. E' possibile inoltre cliccare su Visualizza > Zoom avanti dal
menu.

▶ Dalla barra degli strumenti, fare clic su per ridurre le dimensioni degli
schermi nella vista. E' possibile inoltre cliccare su Visualizza > Zoom indietro dal
menu.

Salvataggio di pagine catturate e di schermi del palmare
È possibile salvare pagine e schermi catturati come immagini per l'uso in altri
documenti TI-Nspire™ che accettano immagini oppure per l'uso in altre applicazioni,
quale per esempio Microsoft® Word. È possibile salvare un'immagine alla volta,
selezionare più immagini da salvare o salvare tutte le immagini catturate.

Salvataggio di schermi selezionati

1. Nella finestra Cattura schermi, selezionare l'immagine dello schermo da salvare.

2. Fare clic su File > Salva schermo\i selezionato/i.

Nota: nella finestra Cattura schermo è anche possibile fare clic su .

Viene visualizzata la finestra di dialogo Salva con nome.

3. Passare alla cartella sul computer in cui salvare il file.

4. Digitare un nome per il file.

Nota: il nome file predefinito è GG-MM-YYYY Immagine ###.



5. Selezionare il tipo di file per il file immagine. Il tipo di file predefinito è .jpg.
Cliccare su ¤ per selezionare un altro formato: .gif, .tif, .png.

6. Fare clic su Salva.

Il file viene salvato nella cartella designata.

Salvataggio di più schermi contemporaneamente

1. Nella finestra Cattura schermo selezionare gli schermi da salvare.

Per selezionare più schermi consecutivi, fare clic sulla prima immagine, quindi
mantenere premuto il tastoMaiusc e fare clic sulle ulteriori immagini. Per
selezionare più schermi non consecutivi, mantenere premuto il tasto Ctrl
(Macintosh®: “) e cliccare su ogni immagine che si desidera salvare.

2. Cliccare su o selezionare File > Salva schermo/i selezionato/i. Per salvare
contemporaneamente tutte le immagini catturate, fare clic su File > Salva tutti gli
schermi.

Nota: l'opzione Salva tutti gli schermi non è disponibile con Cattura classe.

Viene visualizzata la finestra di dialogo Salva con nome.

3. Nel campo Salva in, passare alla cartella in cui si desidera salvare le immagini.

4. Nel campo Nome file digitare un nuovo nome di cartella. Il nome di cartella
predefinito è GG-MM-AAAA Immagine, dove GG-MM-AAAA è la data corrente.

5. Selezionare il tipo di file per i file immagine. Il tipo di file predefinito è .jpg.
Cliccare su ¤ per selezionare un altro formato: .gif, .tif, .png.

6. Fare clic su Salva.

Le immagini vengono salvate nella cartella specificata con i nomi assegnati dal
sistema che riportano la data corrente e un numero sequenziale. Ad esempio, GG-
MM-AAAA Immagine 001.jpg, GG-MM-AAAA Immagine 002.jpg, ecc.

Copiare e incollare uno schermo
È possibile selezionare uno schermo catturato e copiarlo negli Appunti per includerlo in
altri documenti o applicazioni. Gli schermi copiati possono essere anche stampati. Gli
schermi copiati sono catturati al livello di zoom 100% e vengono copiati nell'ordine in
cui sono selezionati.

copia di uno schermo

1. Selezionare lo schermo da copiare.

2. Cliccare su oModifica > Copia.

Lo schermo selezionato viene copiato negli Appunti.
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Inserimento di uno schermo

A seconda dell'applicazione che si sta incollando, fare clic suModifica > Incolla.

Nota: è anche possibile trascinare uno schermo catturato in un'altra applicazione. Il
trascinamento può essere utilizzato come "Copia e Incolla".



Operazioni con le immagini
Le immagini possono essere utilizzate nelle applicazioni TI-Nspire™ come riferimento,
come strumento di valutazione e per dare spiegazioni. È possibile aggiungere
immagini alle seguenti applicazioni TI-Nspire™:

• Grafici e geometria

• Dati e statistiche

• Notes

• Domanda, incluso Test rapido

Nelle applicazioni Grafici e geometria e Dati e statistiche, le immagini sono poste
nello sfondo dietro agli assi e altri oggetti. Nelle applicazioni Notes e Domanda,
l’immagine è posta in posizione del cursore in linea con il testo (in primo piano).

È possibile inserire i tipi di file immagine seguenti: .jpg, .png, or .bmp.

Nota: la funzione Transparency (Trasparenza) del tipo di file .png non è supportata. Gli
sfondi trasparenti sono mostrati in bianco.

Operazioni con immagini nel software
Quando si lavora con il software TI-Nspire™, è possibile inserire, copiare, spostare ed
eliminare immagini.

Inserimento di immagini

Nelle applicazioni Notes e Domanda e in Test rapido, è possibile inserire più di
un’immagine su una pagina. Nelle applicazioni Grafici e geometria e Dati e statistiche
è possibile inserire solo un’immagine su una pagina.

1. Aprire il documento in cui si vuole aggiungere un’immagine.

2. Fare clic su Inserisci > Immagine.

Si visualizza la finestra di dialogo Inserisci immagine.
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3. Cercare la cartella in cui si trova l’immagine e selezionare l’immagine.

4. Fare clic su Apri.

• Nelle applicazioni Grafici e geometria e Dati e statistiche, l’immagine è
inserita sullo sfondo dietro all’asse.

• In Notes, Domanda e Test rapido, l’immagine è inserita nella posizione del
cursore. È possibile digitare del testo sopra o sotto l’immagine e spostare
l’immagine in alto o in basso nelle pagine.

Nota: è possibile inserire le immagini copiando un’immagine negli Appunti e
incollandola nell’applicazione.

Spostamento di immagini

In applicazioni quali Notes e Domanda, dove l’immagine si trova nella posizione del
cursore, è possibile riposizionare l’immagine spostandola su una nuova linea, uno
spazio vuoto o collocandola all’interno di una linea di testo. Nelle applicazioni Grafici e
geometria e Dati e statistiche, le immagini possono essere spostate in qualsiasi
posizione della pagina.

1. Selezionare l’immagine.

• Nelle applicazioni Notes e Domanda, fare clic sull’immagine per selezionarla.
• Nelle applicazioni Grafici e geometria e Dati e statistiche, fare clic con il

pulsante destro del mouse e quindi fare clic su Seleziona > Immagine.

2. Fare clic sull’immagine selezionata e tenere premuto il pulsante del mouse.

• Se un’immagine è in primo piano, il cursore cambia in .

• Se un’immagine è sullo sfondo, il cursore cambia in .



3. Trascinare l’immagine nella nuova posizione e rilasciare il pulsante del mouse per
collocare l’immagine.

Se un’immagine è in primo piano, il cursore cambia in quando ci si sofferma
su una posizione in cui si trova una nuova linea o uno spazio. Le immagini sullo
sfondo possono essere spostate e posizionate ovunque nella pagina.

Ridimensionamento di immagini

Per mantenere le proporzioni di un’immagine, ridimensionare afferrando l’immagine a
uno dei suoi quattro angoli.

1. Selezionare l’immagine.

• Nelle applicazioni Notes e Domanda, fare clic sull’immagine per selezionarla.
• Nelle applicazioni Grafici e geometria e Dati e statistiche, fare clic con il

pulsante destro del mouse e quindi fare clic su Seleziona > Immagine.

2. Spostare il cursore su uno dei quattro lati dell’immagine.

Il cursore cambia in (una freccia direzionale a quattro punte).

Nota: trascinando il cursore su un bordo dell’immagine, questo cambia in (una
freccia direzionale a due punte). Se si trascina un’immagine da uno dei suoi bordi
per ridimensionarla, l’immagine risulta distorta.

3. Fare clic sull’angolo o sul bordo dell’immagine.

Si attiva lo strumento .

4. Trascinare verso l’interno per ridurre l’immagine o verso l’esterno per ingrandirla.

5. Rilasciare il mouse quando la dimensione dell’immagine è corretta.

Eliminazione di immagini

Per eliminare un’immagine da un documento aperto, completare i seguenti passaggi.

1. Selezionare l’immagine.

• Se un’immagine è in primo piano, fare clic su di essa per selezionarla.
• Se un’immagine è sullo sfondo, fare clic con il pulsante destro del mouse e

quindi fare clic su Seleziona > Immagina.

2. Premere Elimina.

L’immagine viene rimossa.
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Utilizzo dell'area di lavoro Classe
Utilizzare quest'area di lavoro per aggiungere e gestire classi e studenti e per
scambiare file con gli studenti.

À Registrazione della classe. Mostra le azioni relative ai documenti. È possibile aprire
un documento nell'Area di lavoro Revisione; salvare un documento nell'Area di
lavoro Portfolio; raccogliere file dall'Area di lavoro Registrazione della classe; inviare
ed eliminare file usando la barra degli strumenti e visualizzare le proprietà del
documento in Registra proprietà elemento.

Á Area Classe. Mostra gli studenti della classe, quelli che sono collegati e lo stato del
trasferimento dei file selezionati nella Registrazione della Classe. È possibile
visualizzare gli studenti in base alla vista Disposizione Studenti o alla vista Elenco
studenti.

Â Vista Studente. Consente di mostrare gli studenti nell'area Classe in base alla vista
Disposizione studenti o alla vista Elenco studenti.

Aggiunta di classi
Quando si inizia a usare il software TI-Nspire™, occorre per prima cosa creare le classi.
Accertarsi di creare una classe per ciascuno dei periodi di insegnamento previsti.

Se si sta compiendo questa operazione per la prima volta con il software TI-Nspire™,
l'area classe può essere vuota. Completare la procedura seguente ogni volta.

La Procedura Guidata Aggiunta di classi conduce l'utente attraverso il processo di
impostazione delle classi. Il software chiede di aggiungere una classe e di aggiungervi
gli studenti. E' possibile scegliere di aggiungere le classi manualmente o usando un file
CSV.

Aggiunta di classi manuale

1. Utilizzare il selettore dell'area di lavoro per selezionare l'Area di lavoro Classe.



2. Fare clic su Classe > Aggiunta di classi o su .

Viene visualizzata la finestra di dialogo Aggiunta di classi.

3. Selezionare Manualmente dalla finestra di dialogo Aggiunta di classi.

4. Fare clic su Avanti.

Viene visualizzata la finestra di dialogo Aggiunta di classi manuale.

5. Digitare il Nome della Classe. Se necessario, è possibile inserire una Sezione.
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Un nome della classe deve avere una lunghezza compresa tra 3 e 32 caratteri. Il
nome della classe non può contenere i caratteri speciali / \ : " | * ? < > , e non può
contenere queste parole:

lpt1, lpt2, lpt3, lpt4, lpt5, lpt6, lpt7, lpt8, lpt9, com1, com2, com3, com4, com5,
com6, com7, com8, com9, aux, con, prn, nul.

6. Fare clic su Aggiungi.

La finestra di dialogo Aggiunta di classi manuale mostra le classi elencate.

7. Continuare ad aggiungere classi e, al termine, fare clic su Avanti.

Una finestra di dialogo mostra la corretta creazione della classe e chiede se si
vuole aggiungere studenti.

8. Fare clic su Aggiungi studente.

Nota: fare clic su Fine per Aggiungere Studenti successivamente.

Aggiunta di classi caricando un file CSV

È possibile aggiungere classi caricando un file CSV e importare un elenco di studenti
nella classe. Usare l'opzione carica file CSV per importare le informazioni degli
studenti da un file con valori separati da virgola (CSV) o da un file di testo (.txt).

Il file CSV o .txt deve includere queste informazioni:



Nome della classe
Nome della sezione (facoltativo)
Nome dello studente
Cognome dello studente
Nome utente dello studente
ID dello studente (facoltativo)
Password (facoltativa).

1. Utilizzare il selettore dell'area di lavoro per selezionare l'Area di lavoro Classe.

2. Fare clic su Classe > Aggiunta di classi o su .

Viene visualizzata la finestra di dialogo Aggiunta di classi.

3. Selezionare Carica un file CSV dalla finestra di dialogo Aggiunta di classi

4. Fare clic su Avanti.

Viene visualizzata la finestra di dialogo Aggiunta di classi caricando un File CSV
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5. Fare clic su Sfoglia per individuare il file sul computer.

6. Selezionare il file contenente gli studenti da importare.

7. Fare clic su Apri.

Il file viene visualizzato nella finestra di dialogo Aggiunta di classi caricando un File
CSV.

8. Fare clic su Avanti.

Viene visualizzata la finestra di dialogo Campi di mappatura.



9. Fare clic su¤ e selezionare un campo dal menu a discesa per mappare i titoli nel
file con valori separati da virgola.

10. Fare clic su Avanti.

Viene visualizzata una finestra di dialogo che mostra lo stato di avanzamento.

11. Fare clic su OK per chiudere.

Nota: se alcuni studenti non sono stati correttamente importati, fare clic suMostra
dettagli per determinare il problema.

Aggiunta di studenti alle classi
Dopo aver creato le classi, è necessario aggiungervi gli studenti. È possibile aggiungere
studenti a una sessione della classe attiva oppure a qualsiasi classe in qualsiasi
momento.

Nota: le istruzioni seguenti spiegano come aggiungere studenti dopo aver creato una
classe.

1. Selezionare la classe a cui aggiungere gli studenti.

• Se è attiva una sessione della classe, lo studente verrà aggiunto alla classe
corrente. È comunque possibile aggiungere lo studente ad altre classi.

• Se non è attiva alcuna sessione della classe, utilizzare i comandi di Sessione
della classe per selezionare la classe a cui aggiungere lo studente.
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2. Fare clic su Classe > Aggiungi studente oppure fare clic su .

Viene visualizzata la finestra di dialogo Aggiungi studente.

3. Digitare il nome e il cognome dello studente.

4. Digitare un nome utente.

Nota: il nome utente scelto deve essere univoco. Non può esistere nella classe
corrente né in qualsiasi altra classe.

5. Se si desidera che lo studente crei la propria password, selezionare Sceglie lo
studente.

—oppure—

Se si desidera creare una password per lo studente, selezionare la casella vuota
della password e digitarvene una nuova.

6. (Facoltativo) Digitare un Nome visualizzato.

Nota: se non si inserisce un nickname, il software utilizza in sua vece il nome dello
studente.

7. (Facoltativo) Digitare un ID studente.

8. (Facoltativo) Assegnare lo studente ad altre classi:

• Fare clic su Assegna classi.

Viene visualizzata la finestra di dialogo Assegna classi.



• Selezionare le caselle di controllo accanto alle classi dello studente.
• Deselezionare le caselle di controllo delle classi di cui non fa parte lo studente.
• Fare clic su OK.

Viene visualizzata la finestra di dialogo Aggiungi studente.

9. Per aggiungere un altro studente, fare clic su Aggiungi studente successivo e
ripetere i passaggi da 3 a 8.

10. Dopo aver aggiunto tutti gli studenti, fare clic su Fine.

Rimozione di studenti dalle classi
Se necessario, è possibile rimuovere gli studenti dalle classi. In questo caso, il software
TI-Nspire™ rimuove gli studenti solo dalla classe selezionata. Se gli studenti sono
presenti anche in altre classi, continueranno ad essere presenti solo in quelle classi.

Note:

• Non è possibile rimuovere studenti che sono collegati alla rete TI-Nspire™
Navigator™.

• Non è possibile annullare la rimozione di studenti.

• È possibile accedere alle voci degli account degli studenti facendo clic con il
pulsante destro del mouse sull'icona dello studente nell'area Classe e scegliendo
un'opzione dal menu che appare.

Per rimuovere uno studente da una classe:

1. Fare clic sullo studente da rimuovere.
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2. Fare clic su Classe > Rimuovi Studente oppure su .

Viene chiesto di confermare l'operazione di rimozione.

3. Fare clic su Sì.

Il software rimuove lo studente.

Aggiornamento Registri classe
È possibile aggiornare un registro classe singolo o più registri classe con le nuove
informazioni sullo studente importando un file CSV contenente gli aggiornamenti.

Nota: non è possibile cambiare le informazioni sugli studenti esistenti o rimuovere gli
studenti già presenti nel database del TI-Nspire™ Navigator™.

È possibile importare un file con valori separati da virgola (CSV) o *.txt. Il file CSV o .txt
deve includere queste informazioni:

Nome della classe
Nome della sezione (facoltativo)
Nome dello studente
Cognome dello studente
Nome utente dello studente
ID dello studente (facoltativo)
Password (facoltativa).

1. Utilizzare il selettore dell'area di lavoro per selezionare l'Area di lavoro Classe.

2. Selezionare la classe per la quale si vuole aggiornare il registro.

Nota: Impossibile avviare la classe.

3. Fare clic su Classe>Aggiorna Registro Classe.

Viene visualizzata la finestra di dialogo Aggiorna Registro Classe.



4. Fare clic su Sfoglia per individuare il file sul computer.

5. Selezionare il file contenente i nuovi studenti che si vogliono importare.

6. Fare clic su Apri.

Il file viene visualizzato nella finestra di dialogo Aggiorna Registro Classe.

7. Fare clic su Avanti.

Viene visualizzata la finestra di dialogo Campi di mappatura.

8. Fare clic su¤ e selezionare un campo dal menu a discesa per mappare i titoli nel
file con valori separati da virgola.

9. Fare clic su Avanti.

Viene visualizzata una finestra di dialogo che mostra lo stato di avanzamento.
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10. Fare clic su OK per chiudere.

Nota: se alcuni studenti non sono stati correttamente importati, fare clic suMostra
dettagli per determinare il problema.

Gestione delle classi
Non è possibile cancellare classi e rimuovere tutte le informazioni della classe dal
database del TI-Nspire™ Navigator™. È possibile scegliere di nascondere o mostrare le
classi in tutti i menu e viste.

Rimozione di una classe

Quando si rimuove una classe, si rimuove la classe dal software e si rimuovono i file a
essa corrispondente dal disco rigido.

Nota: non è possibile annullare la rimozione di una classe

1. Se c'è una sessione in corso, terminarla

2. Fare clic su Classe > Gestisci Classi.

Viene visualizzata la finestra di dialogo Gestisci Classi.



3. Dall'elenco Classe, selezionare la classe da rimuovere.

4. Selezionare Elimina dalla lista delle Azioni.

5. Fare clic su Applica.

Il software chiede di confermare l'operazione di rimozione.

6. Fare clic su OK.

Nascondere una classe

Quando si nasconde una classe, la classe viene rimossa da tutte le viste dell'area di
lavoro e dai menù, tranne dalla finestra di dialogo Gestisci Classi.

Nota: le classi nascoste non vengono cancellate dal database del TI-Nspire™
Navigator™.

1. Fare clic su Classe > Gestisci Classi.

Viene visualizzata la finestra di dialogo Gestisci Classi.
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2. Dall'elenco Classe, selezionare la classe da nascondere.

3. Selezionare Nascondi dalla lista delle Azioni.

4. Fare clic su Applica.

Il software chiede se si è sicuri di voler nascondere la classe.

5. Fare clic su OK.

Nota: Selezionare Mostra dall'elenco delle Azioni quando si vuole visualizzare
nuovamente la classe.

Inizio e fine di una sessione della classe
Una sessione della classe è il periodo durante il quale il software TI-Nspire™ è attivo
per una data classe. Mentre la sessione è in corso, l'insegnante può utilizzare le
funzioni di comunicazione con la classe selezionata. Non è possibile utilizzare il
software per interagire con la classe fino a quando non si inizia una sessione della
classe; inoltre non è possibile iniziare un'altra classe fino a quando non si termina
quella corrente.

Inizio di una sessione della classe

1. Fare clic su Classe > Seleziona classe, oppure fare clic sull'elenco Sessione della
classe.

Viene aperto un elenco delle classi disponibili.

2. Selezionare la classe da avviare.

3. Fare clic su Inizio classe.



Fine di una sessione della classe

Quando una classe (lezione) è terminata, oppure prima di iniziarne un'altra, è
necessario terminare la sessione della classe corrente. Ciò comporta l'interruzione di
tutte le comunicazioni tra il computer dell'insegnante e i palmari o i computer degli
studenti. Gli studenti riceveranno un messaggio di notifica dell'interruzione della
classe e verranno automaticamente disconnessi.

▶ Per terminare una sessione della classe corrente, selezionare Termina Classe
dall'elenco a discesa Azioni classe.

Sospensione di una sessione della classe

Questa funzione è disponibile solo sul software TI-Nspire™ che supporta i palmari. È
possibile sospendere temporaneamente una classe. Se si sta usando il software TI-
Nspire™ che supporta i palmari, sospendere una classe comporta la sospensione di
tutte le attività sui palmari degli studenti che riceveranno un messaggio di notifica
della sospensione. Alla ripresa della classe, il messaggio verrà cancellato e gli studenti
saranno di nuovo in grado di utilizzare i loro palmari. Gli studenti rimangono collegati
anche quando la classe è sospesa.

1. Per sospendere temporaneamente una classe, fare clic su Pausa Classe.

2. Per riprendere la classe, fare clic su Ripresa Classe.

Modifica della vista Studenti
Nell'area Classe è possibile visualizzare gli studenti della classe selezionata nella vista
Elenco studenti o Disposizione studenti. La vista Elenco studenti mostra gli studenti in
una tabella contenente nickname, nome, cognome, nome utente e ID degli studenti. La
vista Disposizione studenti mostra gli studenti come icone con relativi nickname. È
possibile cambiare la vista della classe in qualsiasi momento.

In entrambe le viste, il simbolo di avviso accanto all'icona di uno studente indica che il
SO sul palmare dello studente non corrisponde alla versione del software sul computer
dell'insegnante. Quando si sposta il mouse sul simbolo di avviso, si apre una
descrizione comando che indica che è necessario un aggiornamento del SO.

Modifica della Vista della classe in Elenco studenti

▶ Fare clic su Visualizza > Elenco Studenti oppure fare clic su nella barra di stato.

La vista della classe cambia in Elenco studenti.

Utilizzo dell'area di lavoro Classe 205



206 Utilizzo dell'area di lavoro Classe

Modifica della vista della classe in Disposizione studenti

▶ Fare clic su Visualizza > Disposizione studenti oppure fare clic su nella barra di
stato.

La vista della classe cambia in Disposizione studenti.

Organizzazione della disposizione studenti
Inizialmente, gli studenti sono mostrati nella vista Disposizione studenti nell'ordine in
cui sono stati aggiunti. È comunque possibile ridisporre gli studenti in modo che
abbiano nell'area di lavoro classe la stessa posizione che occupano nell'aula. La
Disposizione studenti può essere modificata in qualsiasi momento.

Organizzazione della disposizione studenti

1. Selezionare la classe dall'elenco Sessione dalla classe.

2. Fare clic su Visualizza > Disposizione studenti.

Viene mostrata l'area Classe con la vista Disposizione studenti attiva per la classe
corrente.

3. Nell'area Classe, trascinare l'icona di ogni studente nella posizione desiderata.

Il software sposta le icone degli studenti nelle nuove posizioni.

Queste posizioni vengono mantenute anche al successivo riavvio della classe.

Nota: non posizionare l'icona di uno studente sopra l'icona di un altro studente
onde evitare di vedere solo una delle due icone.



Verifica dello stato di accesso degli studenti
È possibile visualizzare lo stato di accesso degli studenti dalla vista Disposizione
studenti. Il colore dell'icona accanto al Nome visualizzato dello studente ne indica lo
stato di accesso e segnala anche lo stato della classe:

Icona Stato della classe Stato dello studente Colore

Sessione della
classe non
cominciata.

N/D Grigio

Sessione della
classe
cominciata.

Studente non connesso. Azzurro

Sessione della
classe
cominciata.

Studente connesso. Blu

Sessione della
classe
cominciata.

Il SO dello studente non corrisponde alla
versione del software sul computer
dell'insegnante.

Blu

Ordinamento delle informazioni sugli studenti
La vista Elenco studenti dell'area Classe mostra le informazioni relative agli studenti
della classe selezionata, vale a dire Nome visualizzato, nome, cognome, nome utente
e ID degli studenti. In questa vista è possibile ordinare le informazioni sugli studenti in
base a ciascuna di queste categorie. Le informazioni sono ordinate alfabeticamente
dalla A alla Z o dalla Z alla A e numericamente da 1-9 o da 9-1. È possibile ordinare le
informazioni sugli studenti in qualsiasi momento.

Ordinamento delle informazioni sugli studenti

1. Fare clic su Classe > Seleziona classe e selezionare la classe contenente le
informazioni da ordinare.

Nota: se c'è una sessione in corso, terminarla per poter selezionare la classe.

2. Nel menu, fare clic su Visualizza > Elenco Studenti.

3. Fare clic sull'intestazione di colonna in base alla quale ordinare l'elenco.

L'elenco selezionato viene ordinato.

4. Per ordinare le informazioni selezionate in senso opposto, fare nuovamente clic
sull'intestazione di colonna.

Modifica delle classi (lezioni) assegnate a uno studente
A volte gli studenti possono spostarsi in un'altra classe oppure possono partecipare a
più classi diverse. È possibile modificare le classi degli studenti se necessario.
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Nota: non è possibile cambiare le classi di studenti che sono connessi alla rete TI-
Nspire™ Navigator™.

Modifica della classe di uno studente

1. Selezionare una classe a cui appartiene lo studente.

2. Fare clic sullo studente da modificare.

3. Fare clic su Classe > Modifica studente oppure fare clic .

Viene visualizzata la finestra di dialogo Proprietà studente.

4. Fare clic su Assegna classi.

Viene visualizzata la finestra di dialogo Assegna classi.



5. Selezionare le caselle di controllo accanto alle classi dello studente.

6. Deselezionare le caselle di controllo delle classi di cui non fa parte lo studente.

7. Fare clic su OK.

8. Nella finestra di dialogo Proprietà studente, fare clic su OK.

Modifica dei nomi e degli identificatori degli studenti
Una volta aggiunti gli studenti, può accadere di doverne modificare i nomi o gli
identificatori. Ci sono cinque nomi e identificatori diversi associati agli studenti:

• Nome

• Cognome

• Nome utente

• Nome visualizzato

• ID studente

Questo capitolo descrive come modificare questi tipi di nomi e identificatori.

Nota: non è possibile cambiare le informazioni degli account degli studenti che sono
connessi alla rete TI-Nspire™ Navigator™.

Nota: è possibile accedere a molte informazioni degli account degli studenti facendo
clic con il pulsante destro del mouse sullo studente e scegliendo un'opzione dal menu
che appare.
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Modifica dei nomi e degli identificatori degli studenti

1. Selezionare una classe a cui appartiene lo studente.

Nota: se c'è una sessione in corso, terminarla per poter selezionare la classe.

2. Fare clic sullo studente da modificare.

3. Fare clic su Classe > Modifica studente oppure fare clic .

Viene visualizzata la finestra di dialogo Proprietà studente.

4. Fare clic sul campo del nome o identificatore da modificare.

5. Apportare le modifiche necessarie.

6. Ripetere i passaggi 4 e 5 per qualsiasi altro nome o identificatore da modificare.

7. Fare clic su OK.

Spostamento di uno studente in un'altra classe
Se uno o più studenti passano a una classe diversa, tale passaggio può essere replicato
anche nel software TI-Nspire™.

Nota: non è possibile spostare studenti che sono connessi alla rete TI-Nspire™
Navigator™.

Nota: è possibile accedere a molte informazioni degli account degli studenti facendo
clic con il pulsante destro del mouse sullo studente e scegliendo un'opzione dal menu
che appare.

Spostamento di uno studente in un'altra classe

1. Selezionare una classe a cui appartiene lo studente.

Nota: se c'è una sessione in corso, terminarla per poter spostare lo studente.



2. Fare clic sullo studente da spostare.

3. Fare clic suModifica > Taglia oppure fare clic .

Il software rimuove lo studente dalla classe e sposta negli Appunti le informazioni
del relativo account studente.

4. Dall'elenco a discesa Sessione della classe, selezionare la classe in cui spostare lo
studente.

5. Fare clic suModifica > Incolla oppure fare clic su .

Il software sposta lo studente nella classe selezionata.

Copia di studenti in un'altra classe
Quando alcuni studenti sono presenti in più classi, può essere utile copiarli da una
classe a un'altra. Questo metodo consente di risparmiare tempo in quanto non occorre
ripetere l'inserimento delle informazioni.

Nota: non è possibile copiare studenti che sono connessi alla rete TI-Nspire™
Navigator™.

Nota: è possibile accedere a molte informazioni degli account degli studenti facendo
clic con il pulsante destro del mouse sullo studente e scegliendo un'opzione dal menu
che appare.

Copia di uno studente in un'altra classe

1. Selezionare una classe a cui appartiene lo studente.

Nota: se c'è una sessione in corso, terminarla per poter selezionare la classe.

2. Fare clic sullo studente da copiare.

3. Fare clic suModifica >Copia oppure fare clic su .

Il software copia lo studente negli Appunti.

4. Dall'elenco a discesa Classe corrente, selezionare la classe in cui copiare lo
studente

5. Fare clic suModifica > Incolla oppure fare clic su .

Il software copia lo studente nella classe selezionata.

Esplorazione della Registrazione della classe
Dalla Registrazione della classe, è possibile aprire un documento nell'Area di lavoro
Revisione; salvare un documento nell'Area di lavoro Portfolio; raccogliere file dall'Area
di lavoro Registrazione della classe; inviare ed eliminare file usando la barra degli
strumenti e visualizzare le proprietà del documento in Registra proprietà elemento per
tutti i documenti TI-Nspire™, ad eccezione dei file Test Rapido.

Per impostazione predefinita, sono elencate 100 registrazioni. Per visualizzare più
registrazioni, fare clic su Carica prossimi 100 oppure Carica tuttele voci.
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À Azione compiuta sul file. Le icone indicano lo stato di un file.

Inviato alla classe

Ritirato dalla classe



Salvato in Portfolio

Ridistribuito alla classe

Test rapido

Non sollecitato

Eliminato

Á Nome file. I nomi dei file utilizzati in questa classe.

Â Stato. Indica la progressione di un'azione. Ad esempio, “23 di 25” indica che 23
studenti su 25 hanno ricevuto un file.

Ã Opzioni di menu. Fare clic su ¢ per accedere rapidamente ad alcune opzioni di
menu. Questa icona fornisce accesso alle stesse opzioni del menu di scelta rapida
(clic destro del mouse).

Invio di file a una classe
I file e le cartelle possono essere inviati all'intera classe, ai membri della classe che
sono connessi o a singoli studenti La sessione della classe deve essere attiva per
inviare i file.

Quando si invia un file a tutta la classe, tutti gli studenti correntemente collegati
riceveranno immediatamente il file. Gli studenti che non sono collegati lo riceveranno
non appena effettueranno il collegamento.

Note:

• solo i tipi di file di TI-Nspire™ (.tns) e PublishView™ (.tnsp) si aprono nel software
TI-Nspire™.

• Altri tipi di file (se supportati) come per esempio immagini, elaborazione di testo,
oppure file di foglio elettronico si aprono nell'applicazione che il sistema operativo
ha associato al tipo di file.

Invio di file

1. Fare clic su Strumenti >Invio alla classe oppure fare clic .

Viene visualizzata la finestra di dialogo Seleziona file da inviare.
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2. Fare clic sulla scheda File per scegliere i file, oppure fare clic sulla scheda Cartelle
per scegliere le cartelle.

Nota: È possibile inviare solo file o cartelle, non una combinazione dei due.

• TI-Nspire™ CX Premium Teacher Software per palmari trasferisce solo i file.tns.

3. Per scegliere i file o le cartelle da inviare, eseguire una delle seguenti operazioni:

• Andare al file o alla cartella da inviare e farvi clic sopra. Per selezionare più file
o cartelle contemporaneamente, premere e mantenere premuto il tasto Ctrl
(Mac®: “) mentre si fa clic su ogni singolo nome file.

• Digitare il nome del file o della cartella nella casella Nome file o Nome
cartella. I nomi delle cartelle possono utilizzare caratteri alfanumerici ma non
possono contenere i caratteri speciali / \ : " | * ? < > , e non possono contenere
queste parole:

lpt1, lpt2, lpt3, lpt4, lpt5, lpt6, lpt7, lpt8, lpt9, com1, com2, com3, com4, com5,
com6, com7, com8, com9, aux, con, prn, nul.

Nota: in alternativa è possibile trascinare i file per inviarli da una finestra di
gestione file al record della classe.

4. Fare clic su Avanti.

Viene visualizzata la finestra di dialogo Seleziona studente/i.



5. Selezionare lo studente o gli studenti a cui inviare il file:

• Per inviare il file all'intera classe, fare clic su Classe . Per inviare il file solo ai
membri della classe che sono attualmente connessi, selezionare la casella Solo
studenti connessi.

• Per inviare il file a un solo studente, fare clic su Studenti , quindi fare clic
sullo studente interessato.

Nota: se sono già stati selezionati studenti nella scheda Classe, il software ne
mantiene la selezione.

• Utilizzare l'elenco a discesa Invia a cartella del palmare per selezionare dalla
cartella della classe in corso, la cartella principale sul palmare o le ultime 10
cartelle a cui sono stati inviati i file. (Disponibile solo nel software TI-Nspire™
che supporta i palmari.)

- È inoltre possibile inserire un percorso cartella nell'elenco a discesa.

6. Fare clic su Fine.

Il trasferimento del file appare nella Registrazione della classe.
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Invio di file mancanti

La funzione Invio mancante diventa attiva dopo che si è concluso il trasferimento
originale. Questa funzione rimanda i file solamente a quegli studenti che non erano
connessi o indirizzati per il trasferimento originale.

1. Dalla Registrazione della classe, scegliere l'azione invia del file che è stato inviato
alla classe.

Nota: L'azione invia non può essere attiva.

2. Cliccare File> Invia mancanti.

Ridistribuzione di file selezionati alla classe

La funzione Ridistribuisci quanto selezionato alla classe permette di rivedere,
modificare e rinviare gli elaborati agli studenti.

1. Dalla Registrazione della classe, selezionare l'azione raccogli del file/dei file
originale/i modificato/i.

2. Fare clic su File >Ridistribuisci quanto selezionato alla classe.

Nota: Rinvierà solamente i file agli studenti ai quali sono stati ritirati.

Ritiro di file dagli studenti
È possibile ritirare qualsiasi file precedentemente inviato posto nelle cartelle della
classe di studenti utilizzando la Registrazione della classe. Inoltre è possibile ritirare
file dagli studenti digitando il nome completo del file.

Quando si utilizzano il menu o l'icona per il ritiro dei file, è possibile anche eliminare
file ritirati da cartelle della classe di studenti.

Nota: se uno studente cancella, rinomina o archivia un file in una posizione diversa, il
file non può essere ritirato.

Per ritirare i file, la sessione della classe deve essere attiva. Se ci sono studenti non
connessi, i file ritirati vengono automaticamente trasferiti al computer dell'insegnante
non appena gli studenti effettuano il collegamento.

Ritiro di file dalla Registrazione della classe

1. Nella Registrazione della classe, scegliere il file o i file che sono stati inviati alla
classe.

Nota: per impostazione predefinita, sono elencate le prime 100 registrazioni. Per
visualizzare altre registrazioni, fare clic su Carica prossimi 100 oppure Carica
tutte le voci.



2. Fare clic su ¢ accanto a uno dei file evidenziati e scegliere Ritira selezionati dalla
classe.

Il trasferimento del file appare nella Registrazione della classe.

Ritiro di file tramite il menu o l'icona

1. Fare clic su Strumenti > Ritira dalla classe oppure fare clic .

Viene visualizzata la finestra di dialogo Seleziona file da ritirare.

2. Per scegliere i file o le cartelle da ritirare, eseguire una delle seguenti operazioni:

• Fare clic su File recenti, quindi evidenziare e fare clic sul file da ritirare. Per
selezionare più file o cartelle contemporaneamente, premere e mantenere
premuto il tasto Ctrl (Mac®: “) mentre si fa clic su ogni singolo nome file.

• Fare clic su Inserisci nome file e digitare il nome del file nella casella Nome
file, quindi fare clic su Aggiungi.

3. Fare clic su Avanti.

Viene visualizzata la finestra di dialogo Seleziona studente/i.
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4. Selezionare lo studente o gli studenti da cui ritirare il file:

• Per ritirare il file dall'intera classe, fare clic su Classe . Per ritirare il file solo
dagli studenti della classe che sono connessi, selezionare la casella Solo
connessi.

• Per ritirare il file da un solo studente, fare clic su Studenti , quindi fare clic
sullo studente interessato.

Nota: se sono già stati selezionati studenti nella scheda Classe, il software ne
mantiene la selezione.

5. Per rimuovere il file dalle cartelle degli studenti dopo averlo raccolto, selezionare
la casella di spunta accanto all'opzione per eliminare il file dopo la raccolta.

6. Fare clic su Fine.

Il file ritirato appare nella Registrazione della classe.

Ritiro di file mancanti

La funzione Ritira file mancanti si attiva per quei file che non sono stati ricevuti dagli
studenti.

1. Dalla Registrazione della classe, scegliere l'azione ritira file che è stato inviato alla
classe.

2. Fare clic su File > Ritira file mancanti.



Nota: l'azione di ritiro non può essere attiva.

Gestione di azioni non sollecitate
Quando uno studente connesso a una sessione della classe invia all'insegnante un file
che non rientra in un ritiro, viene creata un'azione non sollecitata.

Questi file, che vengono archiviati in un database, sono mostrati nella Registrazione
della classe fino alla loro rimozione.

Revisione e apertura di azioni non sollecitate

Il nome delle azioni non sollecitate viene assegnato automaticamente combinando la
dicitura "Unprompted" ("Non sollecitato") con il mese e il giorno correnti. Per ogni
sessione della classe esiste una cartella Non sollecitati contenente tutti i file .tns e
tnsp. inviati dagli studenti.

L'ultima azione non sollecitata viene visualizzata in cima alla Registrazione della
classe e contiene i file più recenti inviati da uno studente durante una sessione della
classe. Durante la successiva sessione della classe, le azioni non sollecitate più recenti
appariranno nella Registrazione della classe sopra l'azione precedente.

Per aprire l'azione non sollecitata:

1. Fare doppio clic sull'azione oppure fare clic con il pulsante destro del mouse e
scegliere Registra proprietà elemento.

Viene visualizzata la finestra di dialogo Non sollecitati. Per impostazione
predefinita, in questa finestra di dialogo non ci solo elementi selezionati.

2. Nella finestra di dialogo Non sollecitati, è possibile visualizzare uno o più elementi,
salvare gli elementi nell'Area di lavoro Portfolio, rimuovere gli elementi, esportare
gli elementi in un'altra cartella oppure non eseguire alcuna azione.

Visualizzazione di elementi di un'azione non sollecitata

1. Dalla finestra di dialogo Non sollecitati, selezionare la casella di controllo a sinistra
dell'elemento o degli elementi da visualizzare.

Nota: è inoltre possibile fare clic sull'icona Visualizza accanto all'elemento per
accedere rapidamente ad esso.

2. Fare clic su Visualizza.

Gli elementi vengono aperti come file di sola lettura.
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Rimozione di singoli elementi da un'azione non sollecitata

Le azioni non sollecitate rimangono nella Registrazione della classe fino a quando non
vengono rimosse. Anche dopo averne esportato o salvato gli elementi, l'azione non
sollecitata continua a rimanere visibile fino a quando non viene rimossa. Per rimuovere
elementi da un'azione non sollecitata:

1. Nella Registrazione della classe, fare doppio clic sull'azione non sollecitata per
aprirla.

2. Dalla finestra di dialogo Non sollecitati, selezionare la casella di controllo a sinistra
dell'elemento o degli elementi da rimuovere.

3. Fare clic su Rimuovi.

Esportazione di elementi di un'azione non sollecitata

È possibile esportare elementi dal database al file di sistema. Per esportare elementi
da un'azione non sollecitata:

1. Nella Registrazione della classe, fare doppio clic sull'azione non sollecitata per
aprirla.

2. Selezionare i file da esportare.

3. Fare clic su Esporta.

Viene visualizzata una finestra di gestione file.

4. Selezionare la cartella per l'esportazione.

5. Fare clic su Seleziona cartella.

Salvataggio di file in un record di Portfolio
È possibile salvare file ritirati e non sollecitati in un record di Portfolio.

1. Selezionare i file nella Registrazione della classe.

2. Fare clic su ¢ e selezionare Salva selezionati in Portfolio.

Viene visualizzata la finestra di dialogo Salva in Portfolio.

3. È possibile salvare i file in una nuova colonna di Portfolio oppure inserirli in una
colonna di Portfolio esistente.

• Per inserire i file in una nuova colonna, fare clic su Aggiungi come nuova
colonna di Portfolio e digitare il nome della nuova colonna.

• Per salvare i file in una colonna di Portfolio esistente, fare clic su Aggiungi a
colonna esistente di Portfolio e selezionare il nome della colonna desiderata
dall'elenco a discesa.

4. Fare clic su Salva.



Nota: i file salvati nell'area di lavoro Portfolio vengono visualizzati nel record della
classe e vi rimangono fino a quando non li si rimuove con il comando Rimuovi.

Eliminazione di file da cartelle della classe
Se necessario, è possibile eliminare i file dalle cartelle della classe di studenti che sono
stati inviati alla classe o ritirati dalla classe. La sessione della classe deve essere attiva
per poter eliminare i file.

Nota: l'eliminazione di un file rimuove unicamente il file specificato dalla cartella
classe. Se lo studente ha salvato una copia con un altro nome, o copiato il file in
un'altra posizione, il file sarà ancora accessibile.

1. Fare clic su Strumenti > Elimina dalla classe o fare clic su .

Viene visualizzata la finestra di dialogo Seleziona file da eliminare.

2. Per scegliere i file o le cartelle da eliminare, eseguire una delle seguenti
operazioni:

• Fare clic su File recenti, quindi evidenziare e fare clic sul file da eliminare. Per
selezionare più file o cartelle contemporaneamente, premere e mantenere
premuto il tasto Ctrl (Mac®: “) mentre si fa clic su ogni singolo nome file.

• Fare clic su Inserisci nome file e digitare il nome del file nella casella Nome
file, quindi fare clic su Aggiungi.

3. Fare clic su Avanti.

Viene visualizzata la finestra di dialogo Seleziona studente/i.

4. Selezionare gli studenti di cui si desiderano eliminare i file.
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• Per ritirare il file dall'intera classe, fare clic su Classe . Per eliminare i file
solo dai membri della classe che sono connessi, selezionare la casella di
controllo Solo connessi.

• Per eliminare il file da un solo studente, fare clic su Studenti , quindi fare clic
sullo studente interessato.

Nota: se sono già stati selezionati studenti nella scheda Classe, il software ne
mantiene la selezione.

5. Fare clic su Fine.

L'eliminazione dei file appare nella Registrazione della classe.

Verifica dello stato dei trasferimenti di file
Durante l'invio, il ritiro o l'eliminazione di file, è possibile verificare quali studenti
hanno ricevuto o inviato i propri file.

▶ Nel record della classe, fare clic sul file di cui si desidera verificare lo stato.

Nell'area Classe, il software indica lo stato degli studenti come segue:

• Lo sfondo verde indica che lo studente ha inviato/ricevuto/eliminato il file

• Lo sfondo giallo indica che gli studenti hanno ricevuto l'azione di ritiro o
eliminazione, ma il file non è presente nella loro cartella classe.

• Lo sfondo rosso indica che lo studente non ha ancora
inviato/ricevuto/eliminato il file.

Nota: in alternativa è possibile verificare lo stato del trasferimento di un file nella
finestra di dialogo Proprietà del file.

Eliminazione di trasferimenti di file
È possibile annullare il trasferimento di file dalla Registrazione della classe.
L'operazione di annullamento interrompe il trasferimento di altri file da parte del
software. Qualunque file trasferito prima dell'annullamento rimane nella cartella
classe di studenti.

1. Nella Registrazione della classe, fare clic sul file di cui si desidera annullare il
trasferimento.

2. Fare clic suModifica> Rimuovi dalla Registrazione della classe.

Viene chiesto di confermare l'operazione di rimozione.

3. Fare clic su Rimuovi.

Il software interrompe il trasferimento e rimuove il file dall'elenco della
Registrazione della classe.



Visualizzazione delle proprietà dei file
Ogni file inviato o ritirato possiede una serie di proprietà visualizzabili, ad eccezione
dei file Test Rapido. Le proprietà del file includono il nome, la dimensione, la data di
invio e lo stato. È possibile visualizzare le proprietà di un file in qualsiasi momento.

1. Selezionare il file nella Registrazione della classe.

2. Fare clic con il pulsante destro del mouse sul nome del file e selezionare Registra
> proprietà elemento.

Viene visualizzata la finestra di dialogo Proprietà statistiche con le proprietà del
file.

Azzeramento delle password degli studenti
Poiché il software TI-Nspire™ mantiene la privacy delle password dello studente, non è
possibile recuperare le password per gli studenti che le hanno dimenticate. Tuttavia, è
possibile azzerare le password dello studente. È possibile resettare le password di
singoli studenti o di tutti gli studenti di una classe.

Nota: non è possibile azzerare le password degli studenti che sono connessi alla rete
TI-Nspire™ Navigator™.

Azzeramento delle password di tutti gli studenti di una classe

1. Selezionare la classe.
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Nota: lo studente deve essere selezionato per azzerare correttamente la password.

2. Fare clic su Classe > Azzera password studente.

Viene visualizzata la finestra di dialogo Conferma azzeramento password studenti.

3. Fare clic su OK.

4. Al prossimo accesso degli studenti, chiedere di digitare una nuova password.

Azzeramento delle password di singoli studenti

1. Fare clic sullo studente da modificare.

2. Fare clic su Classe > Modifica studente, oppure fare clic , oppure fare clic con il
pulsante destro del mouse sul nome studente e scegliere Modifica studente dal
menu che appare.

Viene visualizzata la finestra di dialogo Proprietà studente.

3. Fare clic sul pulsante Azzera accanto a Password.



4. Se si desidera che lo studente crei la propria password, selezionare Sceglie lo
studente.

—oppure—

Se si desidera creare una password per lo studente, selezionare la casella vuota
della password e digitarvene una nuova.

5. Fare clic su OK.

Il software azzera la password dello studente.

6. La prossima volta che lo studente effettua l'accesso:

• Se è stato selezionato Sceglie lo studente, lo studente dovrà digitare una
password.

• Se la password dello studente è stata creata dall'insegnante, sarà compito
dell'insegnante comunicargliela.
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Utilizzo di Presentatore dal vivo
In TI-Nspire™ CX Premium Teacher Software, Presentatore dal vivo consente agli
insegnanti di proiettare e presentare operazioni in tempo reale su un palmare
selezionato. di proiettare lo schermo del proprio palmare o quello di qualsiasi studente
per mostrare il lavoro mano a mano che viene svolto e di spiegare il procedimento
passo passo alla classe. Durante la presentazione dal vivo, è possibile mostrare il
palmare TI-Nspire™ corrispondente allo schermo mostrato e i tasti mano a mano che
vengono premuti dal presentatore.

Gli insegnanti possono anche impostare ciò che viene visualizzato sullo schermo della
presentazione: il nome dello studente, lo schermo del palmare o la cronologia dei tasti
premuti. Inoltre possono registrare la sessione di Presentatore dal vivo e salvare il file
come filmato per riutilizzarlo in seguito.

Mentre Presentatore dal vivo è attivo, i palmari di tutti gli altri studenti non sono
coinvolti nella presentazione e possono essere utilizzati.

Nota: Presentatore dal vivo può essere utilizzato con un palmare non connesso a una
classe. In questa sezione si suppone che il palmare non sia connesso a una classe, ma
eventuali differenze verranno notate secondo necessità.

Visualizzazione e occultamento dei nomi degli studenti
Se ne è impostata la visualizzazione, il nome dello studente appare sotto lo schermo
del palmare in Presentatore dal vivo.

Il nome dello studente viene visualizzato nello stesso formato selezionato in Cattura
classe. Se si seleziona di visualizzare o di nascondere i nomi degli studenti in Cattura
classe, il nome dello studente verrà visualizzato o nascosto in Presentatore dal vivo.



Nota: Se il palmare non è connesso a una classe, verrà visualizzato l'ID palmare.

Per nascondere il nome dello studente in Presentatore dal vivo:

▶ Deselezionare la casella Show Student Names (Mostra nomi studenti).

Il nome dello studente viene nascosto.

Visualizzazione e occultamento del palmare del presentatore
Per impostazione predefinita, il palmare viene visualizzato all'avvio di Presentatore dal
vivo. Il palmare visualizzato consente alla classe di vedere i tasti che vengono premuti
durante la presentazione. Quando il palmare è visualizzato:

• Il tasto diventa rosso nel display in modo che la classe possa seguire il
presentatore mentre preme il tasto.

• L'ultimo tasto premuto rimane evidenziato fino a quando non ne viene premuto un
altro.

• Non è possibile premere o fare clic sui tasti nel display del palmare. Questo display
riproduce solo le pressioni dei tasti che il presentatore effettua sul proprio
palmare.

Occultamento del display del palmare

▶ Per nascondere il palmare, deselezionare Visualizza palmare nella barra Opzioni di
visualizzazione.

Il palmare viene nascosto e nel riquadro di sinistra viene mostrata la cronologia tasti.
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Visualizzazione del palmare

▶ Se il palmare è nascosto, selezionare Visualizza palmare per visualizzare il palmare
del presentatore nel riquadro di sinistra.

Il palmare viene visualizzato nel riquadro di sinistra e sotto lo schermo del palmare
viene visualizzato il riquadro Cronologia tasti, se selezionato.

Visualizzazione della Cronologia tasti
Per impostazione predefinita, il riquadro Cronologia tasti viene visualizzato sotto lo
schermo del palmare all'avvio di Presentatore dal vivo.

• Mano a mano che vengono premuti durante la presentazione dal vivo, i tasti
appaiono nel riquadro Cronologia tasti.

• I tasti premuti vengono visualizzati da sinistra a destra, quindi dall'alto in basso.

• Se il presentatore preme più volte lo stesso tasto, ogni ripetizione del tasto appare
anche nel riquadro Cronologia tasti. Se il presentatore preme e mantiene premuto
un solo tasto (per esempio quando si sposta il cursore), quel tasto viene registrato
una sola volta.

• È possibile copiare negli Appunti i tasti catturati nel riquadro Cronologia tasti e
successivamente incollarne le immagini in un altro documento. È anche possibile
cancellare il contenuto del riquadro Cronologia tasti. (Questa operazione non può
essere eseguita dagli studenti).

• Durante sessioni particolarmente lunghe di Presentatore dal vivo, i tasti premuti
possono estendersi oltre l'area di visualizzazione. In questi casi, appare una barra
di scorrimento che consente di rivedere tutti i tasti premuti durante la sessione.

Occultamento della Cronologia tasti

▶ Per nascondere il riquadro Cronologia tasti, deselezionare Visualizza cronologia
tasti.

Il riquadro Cronologia tasti viene chiuso.



Visualizzazione della Cronologia tasti

▶ Se il riquadro Cronologia tasti è nascosto, fare clic sulla casella di controllo per
selezionare Visualizza Cronologia tasti.

• Se il palmare è visualizzato, il riquadro Cronologia tasti viene aperto sotto lo
schermo del palmare del presentatore.

• Se il palmare non è visualizzato, il riquadro Cronologia tasti viene aperto a
sinistra dello schermo del palmare del presentatore.

Copia della Cronologia tasti

È possibile copiare negli Appunti i tasti catturati nel riquadro Cronologia tasti, quindi
copiare le immagini dei tasti in un documento di Microsoft® Word o in una
presentazione di PowerPoint.

1. Nel riquadro Cronologia tasti, selezionare i tasti da copiare.

2. Selezionare Modifica > Copia oppure Ctrl + C (Macintosh®: “ + C).

Le immagini dei tasti vengono copiate negli Appunti.

Cancellazione della Cronologia tasti

Per cancellare il contenuto del riquadro Cronologia tasti:

▶ Selezionare Visualizza > Presentatore dal vivo > Cancella Cronologia tasti.

I tasti visualizzati nel riquadro Cronologia tasti vengono rimossi.

Visualizzazione solamente dello schermo del palmare
Per visualizzare solo lo schermo del palmare del presentatore durante la sessione di
Presentatore dal vivo:
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▶ Deselezionare le opzioni Visualizza palmare e Visualizza Cronologia tasti.

I riquadri Palmare e Cronologia tasti vengono chiusi e nella finestra appare lo
schermo del palmare.

Registrazione della presentazione dal vivo
È possibile registrare e salvare come filmato (file .avi) la presentazione dal vivo. I
filmati sono utili per presentare dimostrazioni alla classe, per fornire ulteriori dettagli
su concetti difficili oppure per offrire la possibilità di vedere la lezione agli studenti che
non erano presenti. Quando si registra la presentazione, viene catturato solamente lo
schermo del palmare. Non vengono registrati il display del palmare e i tasti premuti.
Quando si salva una presentazione registrata, il file viene salvato con l'estensione .avi
(Audio Video Interleave).

Avvio della registrazione

▶ Fare clic sul pulsante Avvia registrazione.

-oppure-

Fare clic su Visualizza > Presentatore dal vivo > Avvia registrazione.

La registrazione inizia. Una volta premuto, il pulsante si modifica in Interrompi
registrazione. Tutto il lavoro del presentatore sullo schermo del palmare viene
registrato fino a quando non si interrompe la registrazione.



Interruzione e salvataggio della registrazione

Completare la procedura seguente per interrompere la registrazione e salvare il file del
filmato.

1. Fare clic sul pulsante Stop Recording (Interrompi registrazione).

-oppure-

Fare clic su View (Visualizza) > Live Presenter (Presentatore dal vivo) > Stop
Recording (Interrompi registrazione).

Viene visualizzata la finestra di dialogo Salva. Il nome predefinito per il filmato è
"presentation" e la cartella predefinita per il salvataggio è la cartella della classe
attiva. È possibile modificare sia il nome del file sia la cartella di salvataggio. se
non si desidera salvare la registrazione, fare clic su Cancel (Annulla).

Nota: Se il palmare non è connesso a una classe, il nome del filmato predefinito è
"[data] Recording[numero].avi" e il percorso di salvataggio predefinito è "[utente
Windows]\Documents\TI-Nspire\Live Presenter Recordings".

2. Evidenziare la cartella in cui si desidera salvare il file .avi, se diversa dalla cartella
predefinita.

3. Digitare un nuovo nome per il file.

4. Fare clic su Salva.

Il file viene salvato nella cartella designata.

Riproduzione e condivisione della registrazione

Dopo aver salvato la registrazione come file .avi, è possibile riprodurla sul computer. È
anche possibile inviare il file come allegato email.

Per riprodurre la registrazione sul computer:

1. Utilizzando la finestra di gestione file, accedere alla cartella in cui è stato salvato il
file (.avi) della presentazione.

2. Fare doppio clic sul nome del file .avi.

Viene aperto il riproduttore predefinito e viene riprodotto il filmato.

Nota: se il formato file .avi non è compatibile con il riproduttore predefinito, viene
visualizzato un messaggio di errore.

Interruzione di Presentatore dal vivo
▶ Per interrompere Presentatore dal vivo, fare clic sul pulsante Interrompi Presenter.
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-oppure-

Fare clic su Visualizza > Presentatore dal vivo > Interrompi Presenter.

La finestra della presentazione viene chiusa e viene visualizzata l'area di lavoro
Classe. La classe è sempre attiva. Quando si è pronti per terminare la classe, fare
clic sul pulsante Fine classe.

Nota: Se il palmare non è connesso a una classe, viene visualizzata l'area di lavoro
Contenuto.



Utilizzo di Domanda nel software per insegnanti
L'applicazione Question (Domanda) nel Software per insegnanti consente di creare
domande a scelta multipla, risposta aperta, equazioni, espressioni, punti di coordinate,
liste, immagini e domande di chimica.

Gli studenti non possono creare domande, ma possono aprire documenti contenenti
domande, rispondere alle domande e verificare il proprio lavoro in modalità Controllo-
automatico.

L'applicazione Question (Domanda) si trova nel menu Inserisci nell'area di lavoro
Documenti.

À Menu Inserisci. Fare clic su Inserisci e selezionare Domanda per aggiungere una
domanda o selezionare Immagine per aggiungere un'immagine a una domanda.

Á Strumenti documento. Fare clic su questa icona per aprire il riquadro casella degli
strumenti.

Â Strumento Domanda. Contiene gli strumenti disponibili per lavorare con
l'applicazione Domanda.

Ã Strumento Configurazione. Permette di impostare alcune proprietà per ogni
domanda inserita.

Ä Area Domanda. Il luogo in cui vengono digitate le domande e visualizzate le risposte
dello studente.

Å Barra degli strumenti di formattazione. Consente di applicare la formattazione al
testo.

Æ Anteprima documento. Visualizzare il documento in modalità Palmare o Computer.
L'anteprima cambia ma non le dimensioni della pagina. Per maggiori informazioni
sull'anteprima del documento, vedere Operazioni con i documenti di TI-Nspire™.
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Nozioni fondamentali sulla barra degli strumenti di Domanda
Quando si aggiunge una domanda, si apre l'applicazione Domanda. Se necessario, fare

clic su Strumenti Domanda per aprire il menu degli strumenti.

Nota: La Tavolozza strumenti dell'insegnante non sarà disponibile per gli studenti.

Nome Strumento Descrizione Strumento

Cancella le
risposte

Consente all'insegnante o allo studente di eliminare le
risposte nella domanda o nel documento corrente.

Controlla
risposta

Se si seleziona Controllo automatico (Autovalutazione) come
tipo di documento nella finestra di dialogo Proprietà
domanda, gli studenti possono verificare la risposta alla
domanda.

Inserisci Consente all'insegnante o allo studente di inserire una
casella di espressione o di equazione chimica nella domanda
o nella risposta.

Formato Consente all'insegnante o allo studente di formattare il testo
selezionato come apice o pedice. (Il riquadro equazione
chimica utilizza il suo strumento di formattazione, quindi
questo strumento Formato non funziona nella finestra di
equazione chimica.)

Tavolozza
strumenti
dell'insegnante

Consente di aggiungere le informazioni sul copyright e
imposta il tipo di documento come Controllo-automatico
(Autovalutazione) o Esame.

Utilizzo del menu Inserisci

Il menu Inserisci negli strumenti Documento consente di aggiungere riquadri di

espressioni matematiche e di equazione chimica all'area Domanda, Risposta
suggerita o Correggi risposta di alcuni tipi di domande. Nei tipi di domande che
consentono espressioni matematiche o equazioni chimiche, posizionare il cursore nel
punto in cui si desidera inserire la casella e quindi seguire i passaggi seguenti.

1. Aprire lo strumento Domanda.

2. Fare clic su Inserisci > Riquadro espressione o Riquadro chimica.

Il software inserisce una casella vuota nel punto in cui è posizionato il cursore.

3. Digitare l'espressione matematica o l'equazione chimica desiderata e quindi fare
clic all'esterno della casella per continuare a digitare il testo.



Utilizzo della Tavolozza strumenti dell'Insegnante
La Tavolozza strumenti dell'insegnante consente di aggiungere le informazioni sul
copyright e impostare il tipo di documento come Controllo automatico
(Autovalutazione) o Esame.

Aggiunta di informazioni sul copyright

Utilizzare la finestra di dialogo Proprietà domande per aggiungere le informazioni
relative al copyright sulla domanda corrente.

1. Fare clic sull'icona Tavolozza strumenti dell'insegnante > Proprietà domande.

Viene visualizzata la finestra di dialogo Proprietà domande.

2. Digitare il nome dell'autore e spostarsi sul campo Copyright.

Nota: Il software TI-Nspire™ consente di utilizzare domande formulate da più di un
autore nello stesso documento. Di conseguenza, le informazioni immesse
sull'autore e sul copyright non sono globali. È necessario immettere informazioni
rilevanti per ogni domanda diversa.

3. Selezionare se la domanda è di dominio pubblico o dispone di un copyright
assegnato e passare al campo Anno.

4. Digitare l'anno nel quale la domanda è stata protetta dai diritti d'autore e passare
al campo Proprietario. Se si sta proteggendo con i diritti d'autore una nuova
domanda, digitare l'anno corrente (esempio: 2012).

5. Digitare il nome della persona o l'ente che tutela il copyright.

6. Fare clic su OK.

Impostare Tipi di documento Controllo automatico ed Esame

Quando si definisce un documento come Controllo automatico o Esame, tutte le
domande in quel documento vengono segnalate come Controllo automatico o Esame.
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• Quando viene definito il tipo di documento come Controllo automatico, gli studenti
possono verificare le risposte confrontandole con quelle fornite dall'insegnante.

• Nella modalità Esame, quando viene immessa una risposta suggerita a una
domanda, gli studenti non possono verificare le risposte. È possibile utilizzare la
modalità Esame per valutare automaticamente le risposte degli studenti.

1. Fare clic sull'icona Tavolozza strumenti dell'insegnante > Proprietà domande.

2. Nel campo Tipo di documento, fare clic su Esame o Controllo automatico
(Autovalutazione).

3. Fare clic su OK.

Nozioni fondamentali sullo strumento Configurazione
Lo strumento Configurazione consente di impostare alcune proprietà specifiche per
ogni tipo di domanda inserita. Le proprietà includono il tipo di risposta, il numero delle
risposte (se applicabile), la risposta corretta e altre opzioni.

Ad esempio, è possibile specificare la risposta corretta a una domanda, impostare la
scala, gli assi e la griglia su un grafico. È possibile aggiungere un'espressione
matematica bidimensionale alle tipologie di domande che contengono un campo
Risposta corretta.

Ogni tipologia di domanda dispone di un set di opzioni univoco. Le opzioni per ogni tipo
di domanda sono spiegate nella sezione Aggiunta di domande.

Le impostazioni di configurazione rimangono inalterate quando si copia e incolla una
domanda da un documento all'altro.

Aggiunta di opzioni di configurazione

1. Fare clic sulla freccia giù nella barra di Configurazione nella casella degli strumenti
Documenti per aprire lo strumento Configurazione.

2. Fare clic sulla freccia giù accanto alle scelte che si desidera modificare e digitare il
testo applicabile.



3. Chiudere il pannello di configurazione. Le opzioni scelte vengono salvate nel
momento in cui viene salvato il documento.

Formattazione di Testo e Oggetti
Utilizzare gli strumenti di formattazione del testo per formattare il testo nelle sezioni
delle domande che consentono l'immissione di testo.

La barra degli strumenti di formattazione contiene inoltre l'icona Strumenti del

documento per fornire un facile accesso agli strumenti Domanda e
Configurazione.

Per ulteriori informazioni sulla formattazione di testi e oggetti, vedere Operazioni con
documenti di TI-Nspire™.

Aggiunta di  immagini alle domande
È possibile aggiungere immagini nell'area di testo Domande della maggior parte delle
domande. Per alcune tipologie di domande, è possibile aggiungere un'immagine
nell'area Risposte studenti o Risposte suggerite di una domanda.

È possibile aggiungere immagini come supporto visivo al fine di spiegare il contesto
della domanda o come sfondo di un grafico.

Scegliere l'immagine da una selezione presente sul computer o copiare e incollare
un'immagine da un'applicazione diversa nell'area di testo Domande. Per ulteriori
informazioni, vedere Operazioni con immagini.

Tipi di immagini disponibili

Le seguenti tipologie di file possono essere utilizzate nell'applicazione Domande:

• .jpg
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• .jpeg

• .bmp

• .png

Nota: La funzione Transparency (Trasparenza) dei file .png non è supportata.
Qualsiasi sfondo .png trasparente verrà visualizzato come bianco

Aggiunta di immagini utilizzando il comando Inserisci

1. Fare clic su Inserisci > immagine.

Si visualizza la finestra di dialogo Inserisci immagine.

2. Spostarsi nella posizione dell'immagine e selezionarla.

3. Fare clic su Apri.

L'immagine viene visualizzata nella domanda.

Aggiunta di immagini utilizzando gli Appunti

Per copiare un'immagine negli Appunti da un documento TI-Nspire™, file immagine, o
un altro programma, premere Ctrl + C (Mac®: “ + C).

Per incollare l'immagine alla domanda, premere Ctrl + V (Mac®: “ + V).

Aggiunta di domande
È possibile aggiungere le seguenti tipologie di domande:

• Scelta multipla

- Personalizzato
- ABCD
- Vero/Falso
- Sì/No
- Sempre/A volte/Mai
- D’accordo/In disaccordo
- Totalmente d'accordo...Totalmente in disaccordo

• Risposta aperta

- Spiegazione (non valutata in automatico)
- Corrispondenza del testo (valutata in automatico)

• Equazioni ed espressioni

- y=
- f(x)=
- Espressione

• Coordinate di punti e liste

- input numerico (x,y)



- Indica punto/i
- Lista/Liste

• Immagine

- Etichetta
- Punto su

• Chimica

Quando si seleziona un tipo di domanda, nella parte inferiore della finestra di dialogo
Scegli tipo di domanda viene visualizzata una breve descrizione della domanda.

Quando viene aperto un modello di domanda, il cursore si trova nell'Area di testo della
domanda.

Aggiunta di una domanda a scelta multipla

Questo esempio mostra come aggiungere una domanda a scelta multipla
personalizzata. Una domanda a scelta multipla personalizzata consente di specificare
risposte che gli studenti possono selezionare. È possibile selezionare una o più risposte
corrette per una valutazione più semplice o facilitare gli studenti nella verifica delle
domande in modalità Controllo automatico.
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Per aggiungere una domanda a scelta multipla personalizzata:

1. Fare clic su Inserisci > Domanda.

Si apre la finestra di dialogo Scegli tipo di domanda.

2. Fare clic su Scelta personalizzata sotto il titolo Scelta multipla .

3. Fare clic su Inserisci.

Il modello Scelta personalizzata viene aperto con il cursore nell'Area testo
domanda.

Per impostazione predefinita sono presenti due opzioni nel modello.

4. Digitare la domanda.

• È possibile digitare qualunque combinazione di testo, espressione matematica
ed equazione chimica nell'Area domanda e nell'Area risposta suggerita.

• È possibile aggiungere un'immagine nell'area testo domanda.

5. Premere Enter per aggiungere un'altra domanda o Tab per andare al primo
pulsante di scelta Risposta corretta.

6. Digitare le opzioni di risposta. Aggiungere un'immagine, se lo si desidera.

7. Premere Enter per aggiungere altre opzioni di risposta e aggiungere il testo di
risposta.

• Premere il tasto Canc (Elimina) per cancellare o eliminare una risposta.
• Utilizzare il tasto di arretramento (Backspace) per eliminare una risposta.

8. Se si desidera, fare clic sull'opzione accanto alla risposta suggerita.

Nota: Nella modalità Controllo automatico (Autovalutazione), lo studente può
verificare la propria risposta confrontandola con la risposta suggerita.

9. Aprire lo strumento Configurazione. Scegliere il tipo di risposta e fare clic
sull'opzione che corrisponde alla risposta corretta.



Aggiunta di una domanda a risposta aperta

Una domanda a risposta aperta richiede allo studente di scriverne la risposta. Una
tipologia di domanda a spiegazione consente agli studenti di rispondere senza risposte
predefinite. Una tipologia di domanda a corrispondenze consente all'insegnante di
specificare le risposte tra cui lo studente dovrà optare per quella corretta. Le domande
a corrispondenza sono valutate automaticamente; le domande a risposta aperta non
sono valutate automaticamente.

Questo esempio mostra come aggiungere una domanda a risposta aperta.

1. Fare clic su Inserisci > Domanda.

Si apre la finestra di dialogo Scegli tipo di domanda.

2. Fare clic su Spiegazione sotto a Risposta aperta.

3. Fare clic su Inserisci.

Il modello Risposta aperta viene aperto con il cursore nell'Area testo domanda.

4. Digitare la domanda.

• È possibile digitare qualunque combinazione di testo, espressione matematica
ed equazione chimica nell'Area domanda e nell'Area risposta suggerita.

• È possibile aggiungere un'immagine nell'area testo domanda.
• Utilizzare il tasto Tab o il cursore del mouse per passare da un campo all'altro.

5. Aprire lo strumento Configurazione. Selezionare la tipologia di risposta come
Explanation (Spiegazione) o Text Match (Corrispondenza di testo) e digitare la
risposta corretta.

• La tipologia di risposta Spiegazione consente allo studente di fornire le risposte
che si avvicinano alla risposta suggerita.

• La tipologia di risposta Corrispondenza di testo richiede allo studente di
abbinare esattamente le risposte suggerite. Selezionare la casella Ignore case
(Ignora maiuscole) se le maiuscole non sono importanti.

• È possibile digitare qualsiasi combinazione di testo, espressione matematica
ed equazione chimica nell'area Risposta corretta.
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Aggiunta di un'equazione

Un'equazione richiede allo studente di scrivere un'equazione nella forma y= o f(x)=, o
di rispondere con un numero o un'espressione.

Questo esempio mostra come aggiungere una domanda y= .

1. Fare clic su Inserisci > Domanda.

Si apre la finestra di dialogo Scegli tipo di domanda.

2. Selezionare y= sotto Equazioni ed espressioni.

3. Fare clic su Inserisci.

Il modello di equazione viene aperto con il cursore nell'Area testo domanda.

4. Digitare la domanda.

• È possibile digitare qualunque combinazione di testo, espressione matematica
ed equazione chimica nell'area Domanda.

• È possibile aggiungere un'immagine nell'area testo domanda.
• Utilizzare il tasto Tab o il cursore del mouse per passare da un campo all'altro.

5. Se lo si desidera, immettere una risposta suggerita.

6. Premere Enter per aggiungere altre opzioni di risposta e aggiungere il testo di
risposta.

• Premere il tasto Canc (Elimina) per cancellare o eliminare una risposta.
• Premere il tasto di arretramento (Backspace) per eliminare una risposta.

7. Aprire lo strumento di configurazione per impostare il numero di risposte, la
risposta corretta e se gli studenti devono visualizzare il lavoro. Inoltre, è possibile
aggiungere un grafico che verrà visualizzato nell'area Domanda.



• Il numero delle risposte può variare da 1 a 5.
• L'opzione Mostra il tuo lavoro include le aree per gli studenti al fine di scrivere

il loro punto di partenza, il loro percorso e la risposta finale. L'opzione per
visualizzare il lavoro viene disabilitata se sono consentite le risposte multiple.

• Per aggiungere un grafico all'area Domanda, selezionare la casella Includi
anteprima grafico. L'area testo Domanda viene divisa per mostrare un grafico a
destra.

• Per aggiungere funzioni, nel grafico è disponibile la casella degli strumenti
Grafici e geometria.

Nota: solo l'insegnante può modificare il grafico. Gli studenti possono solo
visualizzare ed eseguire lo zoom del grafico.

• Fare clic su per aggiungere ulteriori campi per risposte multiple corrette.
Ad esempio, è possibile accettare sia y=(x+1)(x+2) e y=(x+2)(x+1) come
risposte corrette.

• Selezionare se accettare o meno risposte equivalenti come corrette.
- Se Accetta le risposte equivalenti come corrette non è contrassegnata, la

risposta dello studente è contrassegnata corretta se c'è un'esatta
corrispondenza di testo con una delle risposte accettate inserite.

- Se Accetta le risposte equivalenti come corrette è contrassegnata, la
risposta dello studente è valutata corretta se è equivalente a qualsiasi
risposta accettata inserita. Per esempio, se si digitato x+2 come risposta
corretta e lo studente invia 2+x, questa risposta equivale alla risposta
accettata e viene automaticamente valutata corretta. Vengono ignorati gli
spazi, le differenze tra maiuscole e minuscole, le parentesi in più quando il
software valuta le risposte dello studente. Per esempio, y=2x+1 viene
valutato come Y = 2X + 1.
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Aggiunta di una domanda Espressione

Una domanda Espressione avvisa lo studente di rispondere con un valore numerico o
un'espressione.

1. Fare clic su Inserisci > Domanda.

Si apre la finestra di dialogo Scegli tipo di domanda.

2. Fare clic su Espressione sotto Equazioni ed espressioni.

3. Fare clic su Inserisci.

Il modello Espressione viene aperto con il cursore nell'Area testo Domanda.

4. Digitare la domanda.

• È possibile digitare qualunque combinazione di testo, espressione matematica
ed equazione chimica nell'area Domanda.

• È possibile aggiungere un'immagine nell'area Domanda.

5. Se lo si desidera, inserire un'espressione iniziale nella risposta tipo di Espressione.
Lo studente visualizza l'espressione iniziale.

6. Se lo si desidera, immettere una risposta suggerita.

• Se si stabilisce che il tipo di risposta sia Numero, i campi della risposta saranno
caselle matematiche e accetteranno solo valori numerici quali 1/3.

• Se si imposta il tipo di risposta come Espressione, i campi di risposta sono
caselle di espressioni e accettano solo inserimenti di espressioni quali 2(3+5).

7. Aprire lo strumento Configurazione per impostare il tipo di risposta come Numero
o Espressione, la risposta corretta e se gli studenti devono o meno visualizzare il
lavoro. È inoltre possibile impostare una tolleranza per i tipi di Numero o risposte
equivalenti per i tipi di Espressione.



• L'opzione Mostra il tuo lavoro include le aree per gli studenti al fine di scrivere
il loro punto di partenza, il loro percorso e la risposta finale.

• Nella risposta di tipo Numero, inserire la risposta numerica accettata e la
tolleranza. Qualsiasi riposta dello studente è contrassegnata come corretta se
rientra nell'intervallo di tolleranza specificato.

• Specificare una tolleranza pari a zero indica che si sta cercando la risposta del
numero esatto. Non specificare una tolleranza è uguale a specificare una
tolleranza pari a zero.

• Le risposte degli studenti sono considerate corrette se equivalgono
numericamente alla risposta corretta. Vengono ignorati gli spazi, le differenze
tra maiuscole e minuscole, le parentesi in più quando il software valuta le
risposte dello studente.

• Nella risposta di tipo Espressione, è possibile aggiungere ulteriori campi (fino a
10) per risposte multiple corrette.

• Nella risposta di tipo Espressione, fare clic su per aprire il catalogo Modelli
e simboli, che consente di immettere le espressioni di matematica
bidimensionali.

• Nella risposta di tipo Espressione, è possibile selezionare se accettare o meno
risposte equivalenti come corrette.
- Se Accetta le risposte equivalenti come corrette non è contrassegnata, la

risposta dello studente è contrassegnata corretta se c'è un'esatta
corrispondenza di testo con una delle risposte accettate inserite.

- Se Accetta le risposte equivalenti come corrette è contrassegnata, la
risposta dello studente è valutata corretta se è equivalente a qualsiasi
risposta accettata inserita. Per esempio, se si digitato x+2 come risposta
corretta e lo studente invia 2+x, questa risposta equivale alla risposta
accettata e viene automaticamente valutata corretta. Vengono ignorati gli
spazi, le differenze tra maiuscole e minuscole, le parentesi in più quando il
software valuta le risposte dello studente. Ad esempio, x+2 viene valutato
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come X + 2.

Importante: gli studenti possono inserire l'espressione iniziale fornita e far
valutare automaticamente questa risposta come corretta. Per esempio, se
si è chiesto agli studenti di fattorizzare x2-7x+12 e viene impostato (x-3)(x-
4) come risposta corretta, lo studente può inviare una risposta di x2-7x+12.
Questa risposta equivale alla risposta accettata e sarà automaticamente
valutata corretta. È necessario contrassegnare manualmente questa
risposta errata dello studente nelle aree di lavoro Revisione o Portfolio.
Vedere i capitoli per queste aree di lavoro per maggiori informazioni su
come contrassegnare e valutare le risposte.

Aggiunta di una domanda a input numerico (x,y)

Una domanda a input numerico (x,y) avvisa gli studenti di rispondere con una
coordinata.

1. Fare clic su Inserisci > Domanda.

Si apre la finestra di dialogo Scegli tipo di domanda.

2. Fare clic su input numerico (x,y) sotto Coordinate di punti e liste.

3. Fare clic su Inserisci.

Il modello viene aperto con il cursore nell'Area testo domanda.

4. Digitare la domanda.

• È possibile digitare qualunque combinazione di testo, espressione matematica
ed equazione chimica nell'area Domanda.

• È possibile aggiungere un'immagine nell'area Domanda.
• Utilizzare il tasto Tab o il cursore del mouse per passare da un campo all'altro.

5. Se lo si desidera, immettere una risposta suggerita.

• I campi di risposta sono caselle di espressioni e accettano solo gli input delle
espressioni.

6. Premere Enter per aggiungere altre opzioni di risposta (fino a cinque) e aggiungere
il testo di risposta.



• Premere il tasto Canc (Elimina) per cancellare o eliminare una risposta.
• Utilizzare il tasto di arretramento (Backspace) per eliminare una risposta.

7. Aprire lo strumento Configurazione per impostare il numero di punti, aggiungere
un'anteprima di un grafico, immettere la risposta corretta e stabilire le risposte
equivalenti corrette.

• Il numero di punti può variare da 1 a 5.

• Fare clic su per aggiungere ulteriori campi per risposte multiple corrette.
È possibile digitare qualsiasi combinazione di testo, espressione matematica
ed equazione chimica nei campi di risposta corretti.

• Fare clic su per aprire il catalogo Modelli e simboli, che consente di
immettere le espressioni di matematica bidimensionali.

• Per aggiungere un grafico all'area Domanda, selezionare la casella Includi
anteprima grafico. L'area testo Domanda viene divisa per mostrare un grafico a
destra e l'area di prompt dello studente a sinistra. Per cambiare la posizione
del grafico, fare clic sulla freccia giù accanto a Posizione del prompt e scegliere
la posizione desiderata per il grafico nell'area di prompt dello studente.

• Per aggiungere funzioni, nel grafico sono disponibili gli strumenti Grafici e
geometria.

Nota: solo l'insegnante può modificare il grafico. Gli studenti possono solo
visualizzare ed eseguire lo zoom del grafico.

• Selezionare se accettare o meno risposte equivalenti come corrette.
- Se Accetta le risposte equivalenti come corrette non è contrassegnata, la

risposta dello studente è contrassegnata corretta se c'è un'esatta
corrispondenza di testo con una delle risposte accettate inserite.
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- Se Accetta le risposte equivalenti come corrette è contrassegnata, la
risposta dello studente è valutata corretta se è equivalente a qualsiasi
risposta accettata inserita. Per esempio, se si è digitato (-0,5, ,75) come
risposta corretta e lo studente invia (-,5, ,75) o (-1/2, 3/4) e così via, questa
risposta equivale alla risposta accettata e sarà automaticamente valutata
corretta.

Aggiungere una domanda Indica punti

Una domanda indica punti inserisce un grafico e avvisa gli studenti di indicare i punti
sul grafico nella risposta alla domanda.

1. Fare clic su Inserisci > Domanda.

Si apre la finestra di dialogo Scegli tipo di domanda.

2. Seleziona Indica punti sotto Coordinate punti e Liste.

3. Fare clic su Inserisci.

Il modello indica punti viene aperto con il cursore nell'area testo Domanda.

Il grafico si trova nell'area di risposta studente.

• Per aggiungere funzioni, nel grafico sono disponibile gli strumenti Grafici e
geometria.

Nota: solo l'insegnante può modificare il grafico. Gli studenti possono solo
visualizzare, eseguire lo zoom o posizionare punti nel grafico.

4. Digitare la domanda.

• È possibile digitare qualunque combinazione di testo, espressione matematica
ed equazione chimica nell'area Domanda.

• È possibile aggiungere un'immagine nell'area Domanda.
• Utilizzare il tasto Tab o il cursore del mouse per passare da un campo all'altro.

5. Aprire lo strumento di configurazione per impostare il numero di punti, nascondere
o mostrare le coordinate e immettere una risposta corretta.

• Il numero di punti può variare da 1 a 5.



• La visualizzazione delle coordinate viene disattivata per impostazione
predefinita. Selezionare la casella di controllo per visualizzare le coordinate nel
grafico.

• Fare clic su per aggiungere ulteriori campi per risposte multiple corrette.
È possibile digitare qualsiasi combinazione di testo, espressione matematica
ed equazione chimica nei campi di risposta corretti.

• Fare clic su per aprire il catalogo Modelli e simboli, che consente di
immettere le espressioni di matematica bidimensionali.

Aggiunta di una domanda Liste

Una domanda Liste inserisce una lista e avvisa gli studenti di inserire dati nelle liste in
risposta alla domanda.

1. Fare clic su Inserisci > Domanda.

Si apre la finestra di dialogo Scegli tipo di domanda.

2. Selezionare Lista/liste alla domanda Coordinate di punti e liste dalla finestra di
dialogo Scegli tipo di domanda.

3. Fare clic su Inserisci.

Il modello Liste viene aperto con il cursore nell'area testo Domanda.

4. Digitare la domanda.

• È possibile aggiungere colonne e righe, modificare il nome delle liste e inserire
dati nelle liste, utilizzando le stesse funzioni consentite nell'applicazione Foglio
elettronico.

5. Se lo si desidera, immettere i dati iniziali nelle liste.

6. Aprire lo strumento Configurazione per impostare il numero di liste per le risposte
dello studente.

• Il numero delle liste può variare da 1 a 5.
• Le liste devono avere un nome. Questi nomi predefiniti sono List1, List2 e così

via.
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Aggiunta di un'immagine: Domanda etichetta

Un'immagine: La domanda etichetta inserisce un'immagine. È possibile aggiungere
degli spazi vuoti all'immagine e chiedere agli studenti di riempire gli spazi vuoti con la
risposta.

1. Fare clic su Inserisci > Domanda.

Si apre la finestra di dialogo Scegli tipo di domanda.

2. Selezionare Etichetta sotto Immagine.

3. Fare clic su Inserisci.

L'Immagine: Il modello Etichetta viene visualizzato con uno sfondo bianco e
un'etichetta. Questo è il punto in cui l'immagine per la domanda viene inserita.

4. Digitare la domanda.

• È possibile digitare qualunque combinazione di testo, espressione matematica
ed equazione chimica nell'area Domanda.

• Premere Tab o usare il cursore del mouse per passare da un campo all'altro.

5. Inserire un'immagine nella parte inferiore del modello della domanda.

6. Aprire lo strumento Configurazione per impostare il numero di risposte e inserire le
risposte per ogni etichetta.



• Il numero di risposte determina il numero di etichette sull'immagine. Ogni
nuova risposta dà all'etichetta un identificatore unico, quale per esempio A, B,
C, e così via. Trascinare le etichette nella posizione desiderata sull'immagine.

Nota: se si impostano più di 26 risposte, le etichette sono identificate con
numeri, partendo da 1. È possibile inserire un massimo di 35 etichette.

• Nell'area della risposta, fare clic su per aprire il catalogo Modelli e simboli,
che consente di immettere le espressioni di matematica bidimensionali.

• Se il testo dell'etichetta è troppo grande per adeguarsi alle dimensione
dell'etichetta predefinite, afferrare e trascinare i bordi dell'etichetta per
ridimensionarla.

7. Se lo si desidera, digitare una risposta suggerita nelle etichette. Selezionare la
casella Ignora maiuscole se le maiuscole non sono importanti.

• È possibile digitare qualunque combinazione di testo, espressione matematica
ed equazione chimica nell'area Risposta.

• Quando si digita una risposta suggerita, un'immagine "fantasma" della
risposta appare nella rispettiva etichetta sull'immagine. Se la risposta
suggerita è troppo grande per adeguarsi alle dimensione dell'etichetta
predefinite, afferrare e trascinare i bordi dell'etichetta per ridimensionarla.

Aggiunta di un'immagine: Domanda punto su

Un'immagine: La domanda punto su inserisce un'immagine. Aggiungere una casella di
controllo all'immagine e fare inserire un segno di spunta agli studenti nelle caselle
corrette in risposta alla domanda.

1. Fare clic su Inserisci > Domanda.

Si apre la finestra di dialogo Scegli tipo di domanda.

2. Selezionare Punto su sotto Immagine.

3. Fare clic su Inserisci.

L'Immagine: Il modello Punto su si visualizza con uno sfondo vuoto e un punto.
Questo è il punto in cui l'immagine per la domanda viene inserita.

4. Digitare la domanda.
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• È possibile digitare qualunque combinazione di testo, espressione matematica
ed equazione chimica nell'area Domanda.

• Premere Tab o usare il cursore del mouse per passare da un campo all'altro.

5. Aprire lo strumento Configurazione per impostare la tipologia di risposta, il numero
di risposte e la risposta corretta.

• La Tipologia di risposta trasforma il punto in un cerchio per Risposta singola e
cambia in un quadrato per Risposte multiple per indicare agli studenti la
possibilità di selezionare più caselle.

• Il numero di risposte determina il numero di punti sull'immagine. Ogni nuova
risposta dà al punto un identificatore unico, quale per esempio A, B, C e così
via. Trascinare i punti nella posizione desiderata sull'immagine.

Nota: se si impostano più di 26 risposte, i punti sono identificati con numeri,
partendo da 1. È possibile inserire un massimo di 35 punti.

6. Se lo si desidera, fare clic su uno o più punti come risposta suggerita.

Aggiunta di una domanda sulla Chimica

Quando si aggiunge una domanda sulla Chimica, gli studenti rispondono con una
formula chimica o un'equazione.

1. Fare clic su Inserisci > Domanda.

Si apre la finestra di dialogo Scegli tipo di domanda.

2. Fare clic su Chimica.

3. Fare clic su Inserisci.

Il modello Chimica viene aperto con il cursore nell'area testo Domanda.

4. Digitare la domanda.

• È possibile digitare qualunque combinazione di testo, espressione matematica
ed equazione chimica nell'area Domanda.

• È possibile aggiungere un'immagine nell'area Domanda.

5. Se lo si desidera, immettere una risposta suggerita.

6. Aprire lo strumento Configurazione per immettere la risposta corretta.



Fare clic su per aggiungere ulteriori campi per risposte multiple corrette. È
necessario inserire tutte le possibili risposte. Il software non valuta l'equivalenza
per le risposte sulla Chimica.
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Risposta alle Domande
L'insegnante può inviare una domanda in diversi tipi di formato. Questo capitolo
mostra come rispondere ai vari tipi di domanda.

Nozioni fondamentali sulla Barra degli Strumenti di Domanda
Quando si apre un documento con una domanda, appare una barra degli strumenti con
quattro opzioni. Accedere alla Barra degli Strumenti utilizzando il metodo seguente.

▶ Nella Casella degli strumenti Documenti, fare clic su .

Palmare: premereb.

Nome Strumento Descrizione Strumento

Cancella
le
risposte

Consente di cancellare le risposte nella domanda corrente o nel
documento.

Controlla
risposta

Se l'insegnante ha abilitato la modalità Controllo automatico per la
domanda, fare clic qui per visualizzare la risposta corretta.

Inserisci Consente di inserire un riquadro espressione matematica o
equazione chimica nella risposta.

Formato Fare clic su questo strumento per formattare il testo selezionato
nella risposta in formato pedice o apice. (Il riquadro equazione
chimica utilizza il suo strumento di formattazione, quindi questo
strumento Formato non funziona nella finestra di equazione
chimica.)

Tipi di Domande
Esistono diversi tipi di domande. Possono esistere varianti all'interno di uno stesso
tipo, ma la modalità di risposta rimane sostanzialmente la stessa per ciascuno di essi.

• Scelta multipla

- Personalizzato
- ABCD
- Vero/Falso
- Sì/No
- Sempre/A volte/Mai
- D’accordo/In disaccordo
- Totalmente d'accordo...Totalmente in disaccordo

• Risposta aperta



- Spiegazione (non valutata in automatico)
- Corrispondenza del testo (valutata in automatico)

• Equazioni ed espressioni

- y=
- f(x)=
- Espressione

• Coordinate di punti e liste

- (x,y) Inserimento numerico
- Indica punto/i
- Lista/Liste

• Immagine

- Etichetta
- Punto su

• Chimica

Risposta alle Domande di test Rapido
Quando gli insegnanti inviano delle domande di Test rapido, si apre un nuovo
documento in primo piano rispetto a qualsiasi documento aperto. E' possibile accedere
ad altre applicazione per effettuare calcoli, controllare o cancellare le risposte prima
d'inviare le risposte alle domande o test rapido.

Nota: sui palmari TI-Nspire™ CX o TI-Nspire™ CX CAS, le domande vengono visualizzate
a colori se l'insegnante ha applicato il colore durante la digitazione della domanda.
Anche se è possibile vedere il colore nelle domande ricevute, non è possibile
aggiungere colore alle risposte che si inviano.

Accesso ad altre applicazioni

Se l'insegnante lo autorizza, lo strumento Test rapido consente di uscire
momentaneamente dalla domanda per eseguire calcoli o per accedere ad altri
documenti al fine di rispondere alla domanda. Ad esempio, è possibile accedere a
Appunti per eseguire un calcolo, oppure è possibile accedere a Foglio elettronico e
copiare dati dall'applicazione in un tipo di domanda Lista. In una domanda lista, è
possibile inserire collegamenti alle variabili dalle applicazioni Vernier DataQuest™ o
Foglio elettronico.

Accedere ad altre applicazioni nello schermo Test rapido:

1. aprire un nuovo documento.

Palmare: premerec per aprire lo schermo principale.

2. Scegliere un'applicazione

Palmare: per tornare a Test rapido senza accedere ad alcun documento, scegliere
C: Test rapido.
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3. Al termine, fare clic sull'icona di Test rapido.

Quando si risponde a un test, la risposta viene inviata immediatamente al computer
dell'insegnante e l'insegnante può tenere traccia in tempo reale delle risposte degli
studenti.

Mostra lavoro

L'insegnante può richiedere di mostrare il lavoro effettuato per giungere alla risposta.
Se così, l'area risposta include un'area per gli studenti al fine di scrivere il loro punto di
partenza, il loro percorso e la risposta finale.

Risposta a tipi diversi di domande

▶ Per domande a scelta multipla, premere Tab per evidenziare la risposta. Premere
Invio per contrassegnare una risposta.

▶ Per domande a risposta aperta, digitare una risposta.

▶ Per domande su equazioni, digitare una risposta. Se nella domanda è incluso un
grafico, il grafico si aggiorna premendo Invio. Le funzioni inserite appaiono sul
grafico, e il cursore rimane nella casella di risposta. Non è possibile manipolare il
grafico in quanto tale.

▶ Per domande su Espressioni, digitare una risposta. Se il tipo di risposta è un
Numero, la risposta deve essere in formato numerico. Se il tipo di risposta è una
Espressione, la risposta deve essere in formato espressione. Ad esempio, x+1

▶ Per Coordinate di punti: domande (x,y), digitare una risposta nella casella campo-x,
e premere Tab per spostare il cursore sulla casella di risposta del campo y. Digitare
una risposta.

Se nella domanda è incluso un grafico, il grafico viene aggiornato quando viene
inserita una funzione e premendo Invio.

È possibile accedere alle funzioni Finestra e fare Zoom mentre si lavora nel grafico.

▶ Per Punti di coordinate: domande Rilascia punti, premere Tab per spostare il
cursore su un punto nel grafico. Premere Invio per rilasciare un punto in quella
posizione.

Per eliminare un punto, premere Ctrl + Z per annullare l'azione.

▶ Per domande Lista, premere Tab per spostare il cursore sulla prima cella della
lista. Digitare una risposta, quindi premere Tab per passare alla cella successiva.
Digitare una risposta.

Per collegare una colonna ad una variabile esistente, selezionare la colonna e fare
clic su var. Fare clic su Collega a, quindi fare clic sulla variabile da collegare.

Il comportamento nelle domande Liste è del tutto simile al comportamento
dell'applicazione Foglio elettronico, con le seguenti eccezioni. In una domanda
Liste, non è possibile:

• aggiungere, inserire o eliminare colonne.
• Modificare la riga del titolo.



• Introdurre formule.
• Passare a una tabella.
• Creare grafici.

▶ Per domande di Chimica, digitare una risposta.

▶ Per Immagine: domande etichetta, premere Tab per spostare il cursore su
un'etichetta dell'immagine. Digitare una risposta nel campo etichetta.

▶ Per Immagine: punto su domande, premere Tab per spostare il cursore su un punto
dell'immagine. Premere Invio per contrassegnare una risposta.

Controllo delle Risposte

Se la domanda è a controllo automatico, è disponibile l'opzione Controlla risposta.

1. Fare clic su .

Palmare: premereb.

2. Fare clic su Controlla risposta.

Cancellazione delle risposte

Dopo aver risposto a un test rapido, lo studente può modificare la risposta prima di
inviarla all'insegnante.

▶ Fare clic suMenu > Cancella risposte > Domanda corrente oppure Documento.

• Domanda corrente cancella le risposte alla domanda attiva.
• Documento cancella le risposte a tutte le domande contenute nel documento

attivo.

—Oppure—

Se si è risposto alla domanda, si ha ancora il tempo per cancellare la risposta prima di
inviarla all'insegnante.

▶ Fare clic su Elimina risposta per eliminare la risposta e riprovare.

Palmare: premere~ e selezionare Elimina risposta.

Invio delle risposte
Per inviare una risposta finale all'insegnante:

▶ fare clic su Invia risposta.

Palmare: premere~ e selezionare Invia risposta.

La risposta viene inviata all'insegnante e viene visualizzato l'ultimo schermo in uso.
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La risposta viene visualizzata sul computer dell'insegnante. L'insegnante può
configurare il test in modo che lo studente invii più di una riposta. In questo caso, è
possibile continuare a rispondere al test e a inviare la risposta fino al momento in cui
l'insegnante interrompe il test.



Test degli studenti
Lo strumento di test rapido abilita il test degli studenti Un test è un questionario
mandato agli studenti che viene ricevuto in tempo reale sui loro palmari o portatili.
Una volta ricevuto il test, gli studenti possono mandare risposte al computer. Test
rapido è disponibile in tutte le aree di lavoro. Quando l'insegnante riceve le risposte
degli studenti, può utilizzare l'area di lavoro Revisione per controllarle.

Quando si fa clic sull'icona del Test rapido da qualsiasi area di lavoro, l'area di
lavoro Documenti si apre e si può cominciare il test rapido. Cominciare il test rapido
apre l'area di lavoro Revisione Si può cambiare l'area di lavoro mentre si sta
completando il test, ma si può fermare il test solo dalle aree di lavoro Documenti o
Revisione.

È possibile inviare i seguenti tipi di domande:

• Scelta multipla

- Risposta personalizzata
- ABCD
- Vero / Falso
- Sì / No
- Sempre / A volte / Mai
- D’accordo / In disaccordo
- Totalmente d'accordo...Totalmente in disaccordo

• Risposta aperta

- Spiegazione (non valutata in automatico)
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- Corrispondenza del testo (valutata in automatico)

• Equazioni ed espressioni

- y=
- f(x)=
- Espressione

• Coordinate di punti e liste

- (x, y) Input numerico
- Colloca punti
- Lista/(liste)

• Immagine

- Etichetta
- Punto su

• Chimica

Quando si seleziona una tipologia di domanda, viene visualizzata una breve
spiegazione della domanda in fondo alla finestra di dialogo Scegli tipo di domanda.

Apertura dello strumento Test rapido
Si può aprire lo strumento di test rapido da qualsiasi area di lavoro. Si può mandare un
test da un documento esistente o se ne può aprire uno nuovo per iniziare un test.

Prima di cominciare, accertarsi che per la classe ci sia una sessione attiva.

1. Fare clic su Strumenti > Test Rapido o click .

Si apre la finestra di dialogo Scegli tipo di domanda.



2. Selezionare un tipo di domanda e fare clic su Inserisci.

Viene aperto un nuovo documento con il modello di domanda ed il cursore
posizionato nella casella di testo della domanda.
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Viene assegnato un nome ai documenti di test rapido <Nome della classe, #di
gruppo del test rapido, mm-dd.tns>. Ad esempio: Algebra1 - Mrs. Smith QP2 10-
26.tns. Questi documenti possono essere rinominati in fase di salvataggio.

Nota: Tutti i test rapidi per una sessione di classe sono contenuti su una scheda
nell'area di lavoro Documenti Una nuova scheda viene iniziata quando il numero di
domande in un test è superiore a 30 o quando si inizia una nuova sessione di
classe.

Nota: Per ulteriori informazioni a riguardo dei tipi di domande e della creazione e
configurazione di domande, fare riferimento a Uso di domande nel software
dell'insegnante.

Invio di un Test rapido
Dopo aver selezionato la domanda di Test rapido ed aver inserito i dati e le eventuali
opzioni, si è pronti per inviare il test agli studenti.

▶ Per inviare la domanda di Test rapido, fare clic su Avvia test .

Il test viene mandato agli studenti immediatamente. Quando si invia un Test rapido
agli studenti, questo interrompe il documento TI-Nspire™ attivo e il Test rapido diventa
il documento attivo.

È possibile interrompere un test e riavviarlo in qualsiasi momento.

Utilizzo delle Opzioni Test rapido

Quando il test rapido è attivo, il menu Strumenti > Opzioni test Rapido sono attivati.

• Consente accesso documenti Consente di concedere o negare agli studenti
l'accesso agli Appunti ed a tutti i documenti presenti sul loro palmare. Gli studenti
possono accedere a un documento, svolgere alcuni calcoli matematici e copiare i
risultati nel test.

Nota: se al computer o al palmare viene collegato un sensore per l'acquisizione di
dati durante un Test rapido in cui l'opzione Consenti accesso ai documenti è
disabilitata, il Test rapido viene chiuso e viene avviata l'acquisizione dei dati.



• Consenti nuovo invio. Permette agli studenti di inviare diverse volte le loro risposte.

Arresto Test
È possibile interrompere i test in qualsiasi momento. Gli studenti non devono fare
nulla sui loro palmari o computer per interrompere il test. Una volta interrotto il test,
gli studenti non possono più inviare le risposte.

▶ Per interrompere un test, cliccare su Interrompi Test .

Nota: se si sospende una lezione durante l'esecuzione di Test rapido, il test rimane nei
palmari degli studenti, ma gli studenti non posso rispondere o inviare il test fino a
quando non viene ripresa la lezione.

Reinvio Test
Si può inviare di nuovo un test dall'area di lavoro Revisione, senza cambiare area di
lavoro o iniziare una nuova domanda.

Il software tratta il test reinviato come un nuovo test. Gli studenti ricevono un nuovo
test sulla parte superiore del documento aperto nel loro portatile o palmare.

I dati del test vengono trattati come nuovi dati, e non sovrascrivono i dati del test
originale.

▶ Per reinviare il test appena mandato, cliccare su Inizia test .

▶ Per reinviare il test precedente, cliccare sul test nell'ordinatore di pagine e quindi

cliccare su Inizia Test .

Il test viene aggiunto all'ordinatore di pagine nell'ordine in cui è stato inviato.
L'indicatore di pagine indica che è stato reinviato.
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Invio di Test agli studenti mancanti
È possibile inviare il test più recente agli studenti che non erano connessi prima
dell'interruzione del test.

Nota: L'opzione Invia a mancanti può essere utilizzata solo con l'ultimo test inviato.

1. Nell'ordinatore di pagine, cliccare sull'ultimo test inviato.

2. Cliccare File > Invia a mancanti.

Il test viene immediatamente inviato agli studenti che non erano connessi quando il
test è stato inviato in precedenza, ma che sono attualmente connessi.

I dati raccolti dagli studenti mancanti sono aggiunti ai dati dell'ultimo test.

Salvataggio Test
È possibile salvare i risultati del Test rapido all'area di lavoro Portfolio, mentre il test è
ancora in corso, oppure è possibile salvare una serie completa di documenti Test
rapido come un file. tns.

È possibile salvare l'area di lavoro Portfolio dalle aree di lavoro Classe e Revisione.

Quando si salvano i risultati nell'area di lavoro Portfolio, i test inviati in una sola
sessione di classe vengono salvati in una colonna.

Una nuova colonna viene iniziata quando un test supera le 30 domande, o quando si
avvia una nuova sessione di classe.



▶ Per salvare un Test rapido nell'area di lavoro Portfolio, cliccare su File > Salva in
Portfolio.

Nota: dopo il primo salvataggio, le successive modifiche al test vengono aggiornate
automaticamente in Portfolio fino a quando non si interrompe il test.

E' possibile inoltre salvare una serie di Test rapidi come documento master (file .tns).
Un documento master contiene informazioni che possono essere utilizzate come
chiave di riscontro per la valutazione delle risposte raccolte dagli studenti.

▶ Per salvare un Test rapido come documento master, cliccare su File > Salva Test
rapido impostato come documento.

Nota: dopo aver salvato come file .tns, le eventuali modifiche successive che
vengono apportate al test non sono aggiornate nel documento .tns.

Visualizzazione Risultati Test
I risultati di Test rapido vengono visualizzati nell'area di lavoro Revisione

I test inviati in una sessione di classe sono contenuti in una scheda Test rapido
nell'area di lavoro Revisione. Ogni nuova domanda è aggiunta come nuova attività
nell'ordinatore pagine, ed il software apre automaticamente l'ultima domanda che è
stata inviata. Una nuova scheda è avviata quando il test supera le 30 domande.

I risultati possono essere visualizzati come diagramma a barre, grafico o tabella. I
risultati vengono aggiornati automaticamente mano a mano che gli studenti inviano le
risposte, fino a quando non si interrompe il test.

L'esempio seguente mostra i risultati del test presentati in forma tabellare.
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Per ulteriori informazioni sulla visualizzazione e l'ordinamento dei risultati dei test,
vedere Utilizzo dell'area di lavoro Revisione.



Utilizzo dell'area di lavoro Revisione
Utilizzare quest'area di lavoro per rivedere un gruppo di documenti ritirati, gestire le
risposte degli studenti, eseguire attività in tempo reale e organizzare dati.

À Casella degli strumenti Revisione. Contiene gli strumenti di revisione, l'Ordinatore
pagine e gli strumenti di risposta degli studenti. Fare clic su ciascuna icona per
accedere agli strumenti disponibili. Visualizza inoltre le opzioni dello strumento
selezionato.

Á Riquadro Visualizza dati. Visualizza i dati e le opzioni del test o del documento che
è stato selezionato nella casella degli strumenti Revisione. È possibile commutare la
vista dati tra diagramma a barre, tabella e grafico (se disponibile).
Il software mantiene la visualizzazione dei dati a cui era stato impostato per ogni
domanda quando si chiude e si riapre l'area di lavoro Revisione. Tutti i dati nascosti
e non nascosti, le impostazioni di visualizzazione grafici, tabelle e diagrammi a barre
e Mostra lavoro vengono mantenute quando si chiude l'area di lavoro Revisione.

Utilizzo della Casella degli strumenti Revisione
La casella degli strumenti Revisione contiene gli strumenti necessari per lavorare con i
documenti ritirati e con i risultati di Domanda e di Test rapido.

Icona Descrizione

Strumenti
di

revisione

Gli Strumenti di revisione consentono di organizzare i dati delle
risposte, utilizzare strumenti grafici, mostrare o nascondere risposte e
segnare le risposte di Domanda e Test rapido come corrette o sbagliate.

Ordinatore
pagine

Visualizza tutte le attività di un documento o Test rapido, tutte le
pagine di ciascuna attività e le risposte dello studente per ciascuna
domanda del documento.
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Icona Descrizione

Riquadro
Studenti

Visualizza i nomi e le risposte degli studenti nel riquadro Vista dati.

Esplorazione degli Strumenti di revisione

À Organizza. Fare clic su ¢ per organizzare i dati in viste diverse.

Á Strumenti Grafico. Fare clic su ¢ per accedere agli Strumenti Grafico nella vista
grafico cartesiano.

Â Mostra selezionati. Mostra le risposte selezionate per la revisione nel riquadro Vista
dati.

Ã Nascondi selezionati. Nasconde le risposte selezionate nel riquadro Vista dati.

Ä Segna le risposte come corrette. Selezionare una risposta nel riquadro Vista dati e
fare clic su Segna le risposte come corrette per contrassegnarla come risposta
esatta. È possibile contrassegnare più di una risposta come risposta esatta.

Å Segna le risposte come non corrette. Selezionare una risposta nel riquadro Vista dati
e fare clic su Segna le risposte come non corrette per contrassegnarla come risposta
sbagliata. È possibile contrassegnare più di una risposta come risposta sbagliata.

Esplorazione dell'Ordinatore pagine

Utilizzare l'Ordinatore pagine per visualizzare le risposte dello studente alle domande
nel documento.



À Fare clic sul segno meno (-) per comprimere la vista. Fare clic sul segno più (+) per
espandere la vista e visualizzare tutte le pagine di un'attività e tutte le attività di un
documento.

Á Pagine di un'attività. Fare clic su una pagina per aprirla nel riquadro Vista dati.

Â Risposte dello studente. Accanto a ogni domanda del documento è visualizzata
un'icona dati dello studente. Fare clic sull'icona per visualizzare le risposte dello
studente relative alla domanda nel riquadro Vista dati.
Nei Test rapidi, l'icona mostra il numero di studenti che hanno effettuato l'accesso
quando il test è iniziato, il numero di quelli che hanno risposto e il numero di coloro
che hanno inviato la loro risposta. Nell'esempio che segue, nove studenti hanno
ricevuto il test, sette studenti hanno risposto al test e nessuno studente ha inviato la
risposta.
Nota: Se si invia un test agli studenti che mancavano, i numeri potrebbero cambiare.

Ã Barra di scorrimento. La barra di scorrimento è attiva quando ci sono più pagine di
quante ne possa mostrare il pannello.
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Ä Numeri di pagina. Fare clic su un numero di pagina per aprire la pagina nel riquadro
Vista dati.

Esplorazione del riquadro Studenti

Utilizzare il riquadro Studenti per:

• Visualizzare gli studenti a cui è stato inviato il file

• Visualizzare gli studenti che hanno risposto

• Mostrare le risposte degli studenti

• Contrassegnare le risposte come corrette o non corrette

• Ordinare le risposte in base allo studente o alla risposta oppure in base al tempo
nei Test rapidi

À Visualizza le risposte degli studenti. Selezionare questa casella per mostrare le
risposte di ogni studente. Deselezionare questa casella per nascondere le risposte
dello studente.

Á Studente, Risposta, e Tempo Colonne. La colonna Tempo è disponibile solo nelle
revisioni di Test rapidi.

• Fare clic sulla colonna Studente per elencare gli studenti in ordine alfabetico.
Fare nuovamente clic per elencare gli studenti in ordine alfabetico inverso.

• Fare clic sulla colonna Risposta per elencare le risposte in ordine alfabetico o
numerico. Fare nuovamente clic per elencare le risposte in ordine inverso.

• Per aggiungere la colonna Tempo nelle revisioni di Test rapido, fare clic sul

menu Opzioni e scegliere Tempo.
• Fare clic sulla colonna Tempo per elencare le risposte nell'ordine temporale



in cui sono state fornite (prima risposta in alto). Fare nuovamente clic per
invertire l'ordine delle risposte (prima risposta in basso).

Â Nomi studenti. Elenca tutti gli studenti nella classe associata al documento
correntemente aperto per la revisione. I nomi degli studenti vengono visualizzati in
base alla selezione effettuata nel menu Classe > Formato nome studente.
I nomi degli studenti in rosso segnalano gli studenti che non hanno ricevuto il file o
che non hanno risposto al Test rapido.
Deselezionare la casella accanto a un nome per nascondere la risposta di quello
studente.

Ã Risposte. Elenca tutte le risposte accanto al nome dello studente. Uno studente può
essere elencato diverse volte se ha fornito più risposte. La colonna delle risposte
può variare se il documento rivisto è un documento attivo di Test rapido o di
Domanda che non è ancora stato salvato.

• Se lo studente ha risposto, viene mostrata una risposta.

• Se lo studente non ha risposto, l'area delle risposte è vuota.

• Se lo studente ha risposto e le risposte sono nascoste, si visualizza la dicitura
"Risposta".

• Se lo studente non ha ancora risposta alla domanda aperta o al test rapido
attivo, si visualizza "Nessuna risposta".

• Se lo studente ha modificato la propria risposta a un Test rapido ma non l'ha
ancora inviata, si visualizza "In corso".

Ä Menu opzioni. Cliccare su¤ per aprire il menu delle opzioni che si possono
applicare alle risposte dello studente:

• Visualizza le risposte degli studenti.

• Visualizza solo i nomi degli studenti.

• Visualizza solo le risposte.

• Visualizza una colonna Tempo per i risultati di Test rapido.

• Seleziona tutti gli elementi nell'elenco.

• Visualizza l'elemento selezionato.

• Nascondi l'elemento selezionato.

• Contrassegna una o più risposte come corrette.

• Contrassegna una o più risposte come non corrette.
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Esplorazione del riquadro Vista dati

À Mostra risposta corretta. Selezionare questa casella per visualizzare la risposta
contrassegnata come corretta nel riquadro Vista dati. La risposta corretta è
evidenziata in verde.

Á Risposte. Mostra le informazioni scelte nell'Ordinatore pagine. Questo esempio
mostra le risposte ottenute selezionando un'icona Risposte degli studenti. È
possibile visualizzare o nascondere le risposte e contrassegnarle come corrette o
sbagliate.

Â Vista dati. Fare clic su un'icona per visualizzare i dati in forme diverse. diagrammi a
barre, grafici o tabelle. Una opzione "Mostra lavoro" è disponibile per domande su
espressioni ed equazioni.

Nozioni fondamentali su Vista dati

Il riquadro Vista dati visualizza la domanda nel documento aperto e le relative risposte.
In questo riquadro è possibile visualizzare i risultati in tempo reale. I dati sono
aggiornati mano a mano che gli studenti rispondono alle domande di Test rapido e
Risposta aperta, rappresentano graficamente le funzioni o spostano punti in un grafico.

Le icone di Vista dati consentono di visualizzare le risposte nel riquadro Vista dati in
forma di diagramma a barre, grafico o tabella. Ogni vista visualizza le risposte degli
studenti e la frequenza di ciascuna risposta.

Le viste diagramma a barre e tabella sono disponibili per tutti i tipi di domanda e nei
documenti di Test rapido. La vista grafico è disponibile nelle domande Equazione, Punti
di coordinate e Lista.



Le domande su espressioni ed equazioni dispongono di un'ulteriore vista dati "Mostra
lavoro", se la domanda per gli studenti è stata contrassegnata in tal senso. La
visualizzazione dati "Mostra lavoro" viene mantenuta quando si chiude e si riapre
l'area di lavoro di Revisione.

Gli esempi seguenti mostrano gli stessi dati visualizzati nelle diverse viste dati.

Cliccare su per visualizzare i dati in un diagramma a barre.

Cliccare su per visualizzare i dati in un grafico.
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Nella vista grafico, sono disponibili gli Strumenti Grafico per lavorare con il grafico. Le
impostazioni nel grafico vengono mantenute quando si chiude e si riapre l'area di
lavoro di Revisione.

Nelle viste diagramma a barre e grafico, soffermare il puntatore sopra una risposta
per visualizzare un elenco di studenti che l'hanno indicata.

Cliccare su per visualizzare i dati in una tabella.

La vista tabella è disponibile come tabella delle frequenze o come tabella degli
studenti.

▶ Per visualizzare i dati in viste diverse, fare clic sullo strumento Organizza nella
Casella degli strumenti Revisione, quindi scegliere Tabella delle frequenze oppure
Tabella degli studenti.



Una tabella delle frequenze mostra le risposte e il numero delle relative occorrenze.
Fare clic sulla intestazione Risposta per ordinare le risposte in ordine ascendente o
discendente o in base alle domande. Fare clic sulla intestazione Frequenza per
ordinare in base alla frequenza di risposta.

Una tabella degli studenti mostra i nomi degli studenti con le relative risposte. Fare
clic sulla intestazione Studente per ordinare le risposte in ordine alfabetico ascendente
o discendente. Fare clic sulla intestazione Risposta per ordinare le risposte in ordine
ascendente o discendente o in base alle domande.

Le impostazioni per l'ordinamento e il dimensionamento delle colonne sono
mantenute per ogni documento quando si chiude e si riapre l'area di lavoro di
Revisione.

Apertura di documenti per la revisione
È possibile rivedere un documento che è stato ritirato dalla classe, un Test rapido in
corso o un Test rapido salvato. Non è possibile rivedere un documento privo di
domande.

Quando si avvia un Test rapido, viene attivata automaticamente l'area di lavoro
Revisione dove è possibile rivedere i dati mano a mano che gli studenti rispondono. Se
si arresta e si salva il test, è possibile aprirlo nell'area di lavoro Revisione per rivedere
le risposte salvate.

Se si utilizza il software per la prima volta, il riquadro Vista dati potrebbe essere vuoto.
Completare la procedura seguente per aprire un documento per la revisione.

Apertura di un documento dall'area di lavoro Classe

Per aprire un documento per la revisione dall'area di lavoro Classe:

1. Utilizzare il selettore dell'area di lavoro per selezionare l'area di lavoro Classe.

2. Fare clic con il pulsante destro del mouse su un file nel record della classe e
selezionare Apri in area di lavoro Revisione.
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Viene automaticamente visualizzata l'area di lavoro Revisione con il documento
selezionato aperto.

Nota: è possibile aprire i documenti ritirati  contenenti le domande e i Test

rapidi  per la revisione nel record della classe.

Apertura di un documento dall'area di lavoro Portfolio

Per aprire un documento per la revisione dall'area di lavoro Portfolio, attenersi alla
procedura seguente:

1. Utilizzare il selettore dell'area di lavoro per selezionare l'area di lavoro Portfolio.

2. Fare clic con il pulsante destro del mouse su una cella di colonna o su una cella
nella riga dello studente, quindi fare clic su Apri nell'area di lavoro Revisione.



Viene automaticamente visualizzata l'area di lavoro Revisione con il documento
selezionato aperto.

Visualizzazione dei dati
È possibile visualizzare dati nel riquadro Studenti o dal riquadro Vista dati. È possibile
scegliere uno studente per visualizzarne le risposte oppure scegliere una risposta per
visualizzare gli studenti che l'hanno indicata.

Visualizzazione dei dati dal riquadro Studenti

▶ Fare clic su un nome di studente nel riquadro Studenti per visualizzarne la risposta
nel riquadro Vista dati. È possibile selezionare più studenti contemporaneamente.

Il nomi degli studenti selezionati sono evidenziati in blu.
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Se si commuta tra le viste diagramma a barre, grafico e tabella, vengono mantenute le
informazioni selezionate e le risposte degli studenti selezionati rimangono evidenziate.

Nota: poiché le risposte degli studenti possono variare per le domande Lista, non
vengono visualizzate le risposte Lista degli studenti selezionati nel riquadro Vista dati.

Visualizzazione dei dati dal riquadro Vista dati

▶ Fare clic su una risposta nel riquadro Vista dati per visualizzare gli studenti che
l'hanno indicata nel riquadro Studenti. È possibile selezionare più risposte
contemporaneamente.

Il nomi degli studenti corrispondenti sono evidenziati in blu.

Se si commuta tra le viste diagramma a barre, tabella e grafico, vengono mantenute le
informazioni selezionate e gli studenti che hanno indicato la risposta selezionata
rimangono evidenziati.

Nota: se le domande A scelta multipla hanno risposte multiple, sono indicate da uno
spazio blu accanto a tutte le risposte dello studente selezionato.

Nota: per le domande Lista, fare clic con il pulsante destro del mouse su un punto
qualsiasi della vista tabella e fare clic suMostra colonna studenti per visualizzare i
nomi degli studenti accanto alla risposte.



Modifica delle Proporzioni
L'area di lavoro Revisione visualizza i grafici in un'applicazione domanda come
appaiono sui palmari o sui computer degli studenti. A volte i grafici possono apparire
allungati dal momento che il grafico potrebbe avere le proporzioni modificate per
adattarsi al palmare.

È possibile scegliere di visualizzare i grafici così come arrivano dagli studenti, oppure è
possibile mantenere le proporzioni del grafico come si presentava quando è stato
inserito nell'applicazione domanda.

Per impostazione predefinita, l'area di lavoro Revisione visualizza i grafici in
un'applicazione domanda come appaiono quando gli studenti li inviano.

Per mantenere le proporzioni di un grafico come si presentava quando è stato inserito
nella domanda, attenersi alla seguente procedura:

1. Visualizzare i dati in vista grafico.

2. Cliccare con il tasto destro del mouse sul grafico nel riquadro di Visualizzazione
dati e quindi fare clic su Strumenti grafico > Proporzioni.

— Oppure —

3. Cliccare su nella casella degli strumenti Revisione, quindi cliccare su Strumenti
grafico > Proporzioni.

Quando la casella Proporzioni è selezionata, le proporzioni sono conservate.
Quando la casella non è selezionata, le proporzioni possono variare.

Organizzazione delle risposte
È possibile configurare una lista di grafici per domande Lista, organizzare viste di dati
in diagrammi a barre e in tabelle, individuare le risposte degli studenti e organizzare
domande A scelta multipla con risposte multiple in gruppi di risposte, risposte
separate o risposte equivalenti.
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Configurazione di una lista di grafici

Le impostazioni della lista di grafici consentono di impostare figure diverse per i vari
grafici per aiutare a seguire linee o riposte separate in un grafico.

Per regolare le impostazioni della lista di grafici, attenersi alla procedura seguente.

1. Nella vista grafico, fare clic su Strumenti Grafico nella Casella degli strumenti
Revisione.

2. Fare clic su Impostazioni elenco diagramma.

Si apre la finestra di dialogo Configura grafico/i.



3. Fare clic sulla freccia in basso accanto a una figura per scegliere la lista da
rappresentare (lista 1, lista 2, ecc.) per la lista X e la lista Y.

Nota: è possibile scegliere più di una figura per ogni lista.

4. Fare clic su OK.

La vista grafico viene aggiornata con le figure selezionate.

Quando si modifica l'impostazione nella lista grafici dalla vista grafico e
successivamente si passa alla vista diagramma a barre, viene chiesto di scegliere le
liste da mostrare nel diagramma a barre. È possibile scegliere una sola lista oppure
una lista per la categoria e una per la frequenza.

Utilizzo dell'area di lavoro Revisione 281



282 Utilizzo dell'area di lavoro Revisione

5. Selezionare le opzioni applicabili e fare clic su OK.

Se si fa clic su Annulla, viene mostrato il diagramma a barre come diagramma di
una sola lista, per impostazione predefinita lista1.

È possibile configurare la lista grafici in qualsiasi momento dalla vista diagramma
a barre.

Nota: Per configurare la lista grafici dalla vista diagramma a barre, fare clic su
Organizza nella Casella degli strumenti Revisione, quindi fare clic su Impostazioni
lista grafici.

Personalizzazione delle risposte degli studenti

È possibile cambiare il colore delle risposte di ogni studente in un grafico in modo da
poterne identificare le risposte. Ciò è utile quando si esegue un'attività in tempo reale;
è possibile visualizzare l'andamento dei singoli studenti mano a mano che
rappresentano graficamente le funzioni, spostano punti in un grafico o rispondono a
domande di Test rapido.

▶ Per cambiare il colore delle risposte degli studenti, fare clic su Strumenti Grafico
nella Casella degli strumenti Revisione e selezionare Personalizza risposte degli
studenti.

Il riquadro Vista dati visualizza le risposte in colori diversi.



Organizzazione dei dati di lista

Nella vista diagramma a barre, è possibile organizzare i dati di lista in base a
Frequenza, Valore numerico o Alfabeticamente.

Per organizzare i dati di lista, attenersi alla procedura seguente.

1. Nella vista diagramma a barre, fare clic sulla barra Strumenti Grafico.

2. Selezionare l'opzione desiderata per ordinare le barre in base a Frequenza, Valore
numerico o Alfabeticamente.

La vista diagramma a barre viene aggiornata nel riquadro Vista dati.
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Organizzazione dei dati del diagramma a barre

Organizzando i dati come risposte separate vengono visualizzati i risultati di ogni
singola risposta. Ad esempio, tutte le risposte A, tutte le risposte B, tutte le risposte C,
ecc. Organizzando i dati come risposte raggruppate vengono visualizzate tutte le
risposte multiple fornite dagli studenti. Ad esempio, tutte le risposte A più B, tutte le
risposte A più C, ecc.

Organizzando i dati per equivalenza vengono combinati risultati simili in una stessa
barra. Per esempio, y=4Mx, y= Mx+4, e y= M(xM4) sarebbero tutti combinati in un'unica
barra o riga di tabella.

Per impostazione predefinita, le risposte multiple sono visualizzate come risposte
separate nella vista diagramma a barre.

Le impostazioni per l'organizzazione di risposte separate o di gruppo e per
l'organizzazione di equivalenza vengono mantenute quando si chiude e si riapre l'area
di lavoro Revisione.

Per organizzare i dati come risposte raggruppate, attenersi alla procedura seguente.

1. Fare clic sullo strumento Organizza nella Casella degli strumenti Revisione.

2. Fare clic su Mostra le risposte dello studente raggruppate insieme.

Il riquadro Vista dati mostra le risposte raggruppate.



3. Per ripristinare la vista predefinita, fare clic sullo strumento Organizza e
selezionare Mostra le risposte degli studenti separate.

Il riquadro Vista dati mostra i dati come risposte separate.

Organizzazione dei dati per equivalenza

Organizzando i dati per equivalenza vengono raggruppate tutte le risposte simili in
un'unica barra o riga. Nella vista diagramma a barre, è sempre possibile vedere le
risposte separate facendo clic sulla barra.

Per organizzare i dati per equivalenza, attenersi alla procedura seguente.

1. Fare clic sullo strumento Organizza nella Casella degli strumenti Revisione.
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2. Cliccare su Raggruppa risposte per equivalenza.

Il riquadro Vista dati mostra le risposte raggruppate.

3. Per ripristinare la vista predefinita, fare clic sullo strumento Organizza e
selezionare Forma barre per corrispondenze esatte.

Il riquadro Vista dati mostra i dati come risposte separate.

Nascondere e Visualizzare risposte
È possibile nascondere una o più risposte di studenti dal riquadro Studenti o dal
riquadro Vista dati. Quando si nasconde una risposta, i dati corrispondenti vengono
aggiornati e il riquadro Vista dati non mostra i dati nascosti. Le impostazioni per
nascondere o mostrare i dati vengono mantenute quando si chiude e si riapre l'area di
lavoro Revisione.

Quando si nascondono le risposte, nelle diverse viste si producono i seguenti effetti.

• Vista diagramma a barre. Il diagramma a barre viene aggiornato e ri-ordinato
utilizzando i dati correnti.

• Vista tabella. La tabella viene aggiornata e ri-ordinata utilizzando i dati correnti.

• Vista grafico. Il grafico viene aggiornato e ri-ordinato utilizzando i dati correnti.
Qualsiasi regressione inserita viene automaticamente ricalcolata e i nuovi valori
vengono visualizzati.

• Mostra lavoro. Il lavoro dello studente selezionato viene nascosto.

Occultamento delle risposte dal riquadro Studenti

Per nascondere le risposte, attenersi alla procedura seguente.

1. Nel riquadro Studenti, selezionare gli studenti di cui si desiderano nascondere le
risposte.



Le risposte degli studenti selezionati vengono evidenziate in blu nel riquadro Vista
dati.

2. Fare clic sul menu delle Opzioni e quindi selezionare Nascondi selezionati,
oppure deselezionare la casella di controllo accanto al nome dello studente.

Nel riquadro Vista dati vengono nascoste le risposte degli studenti selezionati e
vengono mostrate le risposte dei restanti studenti.

I nomi degli studenti selezionati appaiono in grigio.

Nota: se una risposta è nascosta, fare clic sul nome di uno studente per
visualizzare la risposta. La risposta appare in blu nel riquadro Vista dati. Tutte le
viste diagramma a barre, tabella e grafico vengono aggiornate con i dati
selezionati. La risposta rimane visibile fino a quando non si seleziona un altro
studente.
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Occultamento delle risposte dal riquadro Vista dati

È possibile nascondere le risposte nelle viste diagramma a barre, grafico o tabella.
Quando si nascondono le risposte, il riquadro Vista dati aggiorna i dati e non visualizza
le risposte nascoste. Nella vista Studenti, i nomi degli studenti appaiono in grigio.
Nella vista Ordinatore pagine, i documenti o le icone rimangono invariati.

Per nascondere le risposte, attenersi alla procedura seguente.

1. Nel riquadro Vista dati, selezionare le risposte da nascondere.

Gli studenti selezionati vengono evidenziati in blu nel riquadro Studenti.

2. Fare clic con il pulsante destro del mouse sulla risposta e selezionare Nascondi
selezionati.

Nel riquadro Vista dati vengono nascoste le risposte selezionate e vengono
mostrate le risposte dei restanti studenti.

I nomi degli studenti che corrispondono alle risposte selezionate appaiono in grigio.



Visualizzazione delle risposte

Per visualizzare le risposte nascoste, attenersi alla procedura seguente.

1. Nel riquadro Studenti, selezionare gli studenti di cui si desiderano visualizzare le
risposte.

2. Fare clic sul menu delle Opzioni e quindi selezionare Mostra selezionati.

I nomi degli studenti appaiono in nero e le risposte degli studenti vengono
visualizzate nel riquadro Vista dati.

Contrassegnare le risposte come corrette o non corrette
È possibile utilizzare l'area di lavoro Revisione per contrassegnare le risposte
selezionate come corrette o non corrette. Se si sta rivedendo un documento con una
risposta corretta già contrassegnata, la risposta corretta può essere modificata. In una
domanda A scelta multipla con più risposte, è possibile aggiungere altre risposte
corrette.

Se la casella Mostra risposta corretta è selezionata, le risposte contrassegnate come
corrette vengono evidenziate in verde.

I dati vengono ricalcolati sulla base delle risposte corrette e il riquadro Vista dati viene
aggiornato per riflettere le modifiche.

Per contrassegnare una risposta come corretta:

▶ Nel riquadro Studenti, fare clic con il pulsante destro del mouse su uno studente e
scegliere Segna come corretta.

▶ Nel riquadro Vista dati, fare clic con il pulsante destro del mouse su una risposta e
fare clic su Segna la risposta selezionata come corretta.

▶ Nel riquadro Vista dati, fare clic su una risposta e selezionare Segna la risposta
selezionata come corretta nel riquadro Strumenti Revisione.
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Nelle domande A scelta multipla con più risposte, i segni di spunta sono visualizzati
accanto alle risposte.

▶ Fare clic su un segno di spunta per contrassegnare una risposta come corretta.

Quando si contrassegna una risposta come non corretta, l'evidenziazione verde viene
rimossa.

Per contrassegnare una risposta come non corretta:

▶ Nel riquadro Studenti, fare clic con il pulsante destro del mouse su uno studente e
scegliere Rimuovi come corretta.

▶ Nel riquadro Vista dati, fare clic con il pulsante destro del mouse su una risposta e
fare clic su Segna la risposta selezionata come non corretta.

▶ Nelle domande A scelta multipla con più risposte, fare clic sul segno di spunta
verde.

Nota: se si modifica una risposta come corretta o non corretta, gli eventuali punteggi
già assegnati manualmente agli studenti per le risposte corrette o non corrette non
verranno cambiati.

Quando si contrassegnano le risposte, nei diversi tipi di domanda si producono i
seguenti effetti.

Tipi di domanda matrice

Scelta multipla, Risposta singola
Immagine Etichetta, Risposta singola
Immagine Punto su, Risposta singola

Risposta singola - Inserendo una nuova
risposta si sostituisce la risposta
corrente. Rimuovendo una risposta si
lascia la domanda senza risposte
corrette.

Scelta multipla, risposte multiple
Immagine Etichetta, Risposte multiple
Immagine Punto su, Risposte multiple

Inserendo una nuova risposta si
aumenta l'insieme delle risposte
corrette. Ad esempio, una risposta "A e
B" diventa "A e B e C." Rimuovendo
una risposta si riduce l'insieme delle
risposte corrette.

Risposta aperta: Descrizione
Risposta aperta: Corrispondenza di testo
Equazione: f(x) e y=
Per Punti di coordinate:
Espressione: Variabile
Chimica

Inserendo una nuova risposta si
aumenta l'insieme delle risposte
corrette. Rimuovendo una risposta si
lascia la domanda senza risposte
corrette.

Espressione: Numerica L'aggiunta di una nuova risposta, con o
senza tolleranza, sostituisce la risposta



Tipi di domanda matrice

corrente. Rimuovendo una risposta si
lascia la domanda senza risposte
corrette.

Gli esempi che seguono mostrano risposte contrassegnate come corrette in diverse
viste dati.

Vista diagramma a barre, domanda A scelta multipla conpiù risposte e due risposte corrette,
organizzata in base aMostra le risposte degli studenti separate e nessuno studente selezionato nel
riquadro Studenti.
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Vista diagramma a barre, domanda A scelta multipla conpiù risposte e due risposte corrette,
organizzata in base aMostra le risposte degli studenti separate e uno studente selezionato nel
riquadro Studenti.

Vista diagramma a barre, domanda A scelta multipla conpiù risposte e due risposte corrette,
organizzata in base aMostra le risposte degli studenti raggruppate e nessuno studente selezionato
nel riquadro Studenti.



Vista diagramma a barre, domanda A scelta multipla conpiù risposte e due risposte corrette,
organizzata in base aMostra le risposte degli studenti raggruppate e uno studente selezionato nel
riquadro Studenti.

Vista tabella delle frequenze, domanda A scelta multipla conuna risposta corretta e nessuno
studente selezionato nel riquadro Studenti.
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Vista tabella degli studenti, domanda A scelta multipla conuna risposta corretta e uno studente
selezionato nel riquadro Studenti.

Vista grafico, domanda Equazione y= conuna risposta corretta e nessuno studente selezionato nel
riquadro Studenti.



Vista grafico, domanda Equazione y= conuna risposta corretta e uno studente selezionato nel
riquadro Studenti.

Inserimento di dati dell'insegnante
A volte può accadere di voler inserire dati personali in un grafico che si sta rivedendo in
classe. Gli Strumenti Grafico consentono di inserire in un grafico punti ed equazioni
dell'insegnante, di regolare le impostazioni di lista grafici e di personalizzare le
risposte degli studenti.

I dati dell'insegnante appaiono più grandi e di colore diverso rispetto ai dati degli
studenti.

Quando si inseriscono dati dell'insegnante, i dati vengono ricalcolati e il riquadro Vista
dati viene aggiornato per riflettere le modifiche.

È possibile nascondere o visualizzare i dati dell'insegnante ma non è possibile
contrassegnare le risposte dell'insegnante come corrette o non corrette.

Inserimento di punti dell'insegnante

1. Fare clic sugli Strumenti Grafico nella Casella degli strumenti Revisione.
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2. Fare clic su Aggiungi punto insegnante.

Si apre la finestra di dialogo Aggiungi punto insegnante.

3. Digitare le informazioni nei campi.

Fare clic su per aprire i modelli matematici e i simboli che si possono
introdurre nei campi.

4. Fare clic su OK.

Il punto viene visualizzato nel grafico e il nome Insegnante viene aggiunto ai nomi
del riquadro Studenti.

Nota: L'insegnante può avere più voci.



Inserimento di equazioni dell'insegnante

1. Fare clic sugli Strumenti Grafico nella Casella degli strumenti Revisione.

2. Fare clic su Aggiungi equazione insegnante.

Si apre la finestra di dialogo Aggiungi equazione insegnante.

Utilizzo dell'area di lavoro Revisione 297



298 Utilizzo dell'area di lavoro Revisione

3. Digitare le informazioni nel campo.

Fare clic su per aprire i modelli matematici e i simboli che si possono
introdurre nei campi.

4. Fare clic su OK.

La linea viene visualizzata nel grafico e il nome Insegnante viene aggiunto ai nomi
del riquadro Studenti.

Nota: L'insegnante può avere più voci.

Salvataggio nell'area di lavoro Portfolio
È possibile salvare documenti che contengono domande e Test rapidi nell'area di
lavoro Portfolio, dove è possibile rivedere e analizzare le singole risposte e assegnare o
modificare la valutazione di uno studente.

Quando si salvano Test rapidi in Portfolio, gli studenti possono continuare a inviare
risposte al Test rapido fino a quando il test non viene terminato. Il Test rapido salvato
in Portfolio si aggiorna automaticamente senza doverlo nuovamente salvare.

Note: se il file è stato aperto dall'area di lavoro Portfolio, oppure se è già stato salvato
in Portfolio, non viene richiesto di specificare un nome file. Il file viene salvato
nell'area di lavoro Portfolio con il nome file esistente e vengono aggiornate tutte le
valutazioni assegnate agli studenti. È possibile accedere all'area di lavoro Portfolio e
modificare una valutazione in qualsiasi momento.

Per salvare un file nell'area di lavoro Portfolio:

1. Fare clic su File > Salva in Portfolio, oppure fare clic su .

Si apre la finestra di dialogo Salva in Portfolio. Per default, il nome del file è
visualizzato nella casella Nome Portfolio. Se il file è un Test rapido non ancora
salvato, il nome predefinito è <Nome classe, Test rapido n. serie , gg-mm.tns>. Ad
esempio: Algebra1 - sig.ra Smith, T.r. serie 2, 26-10.tns.



• Per aggiungere una nuova colonna di Portfolio, selezionare Aggiungi come
nuova colonna di Portfolio. È possibile utilizzare il nome esistente oppure
digitarne uno nuovo.

• Per aggiungere i file in una colonna di Portfolio esistente, selezionare Aggiungi
a colonna di Portfolio esistente. Fare clic sulla freccia giù per selezionare la
colonna desiderata.

Nota: i test rapidi non possono essere aggiunti a colonne esistenti.

2. Fare clic su Salva.

Il file viene salvato nell'area di lavoro Portfolio.

Salvataggio dati come nuovo documento
E' possibile prendere i dati raccolti dagli studenti, vederli in formato tabella, e salvarli
come documento di Foglio elettronico. Questo documento può essere utilizzato come
aiuto didattico o può essere inviato agli studenti per ulteriori analisi.

Nota: Se i dati provengono da una domanda Liste, i titoli di colonna nella
Visualizzazione tabella vengono utilizzati come nomi per le variabili della lista. Se i
nomi delle variabili non sono utilizzabili, il software li rinomina. Per esempio, se il
nome ha uno spazio il software lo sostituisce con un underscore (segno di
sottolineatura).

1. Per salvare i dati in un nuovo documento Foglio elettronico, assicurarsi che si sta
visualizzando i dati in formato tabella.

2. Cliccare con il tasto destro del mouse su qualsiasi punto della tabella e quindi
cliccare su Invia tabella ad un nuovo documento.

Nota: I dati nascosti non sono inviati. Se i dati sono ordinati, l'ordine stabilito viene
mantenuto nel nuovo documento.

Il documento Foglio elettronico viene aperto nell'area di lavoro Documenti.
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Utilizzo dell'area di lavoro Portfolio
Utilizzare quest'area di lavoro per salvare, rivedere, modificare valutazioni, e gestire
elaborati degli studenti.

À Riquadro Compiti. Selezionare i compiti per visualizzare gli studenti e i voti. È
possibile ridistribuire, rinominare o rimuovere un compito.

Á Area di Lavoro. Elenca gli studenti nella classe selezionata e mostra i voti ricevuti
per ogni compito. Consente di visualizzare i compiti di uno studente o della classe;
ordina per compito, voto o studente e modifica i voti dei compiti.

Esplorazione del riquadro Compiti

À Riepilogo compiti. Elenca i nomi dei compiti salvati nell'area di lavoro Portfolio.
Mostra una media dello studente e della classe nell'area di lavoro.
Fare clic sul segno meno (–) per comprimere l'elenco dei compiti dello studente e
visualizzare solo il Riepilogo compiti.
Fare clic sul segno più (+) per mostrare l'elenco dei compiti dello studente.

Á Compiti dello studente. Fare clic su un compito per visualizzare i voti dello
studente per quel compito.

Â Menu opzioni. Disponibile quando si seleziona un compito dello studente. Fare clic
su per aprire un menu che permette di:



• Aprire il documento nell'area di lavoro Revisione.

• Ridistribuire il compito alla classe corrente.

• Rimuovere il compito dall'area di lavoro Portfolio. Il compito esiste ancora in
altre aree di lavoro.

• Rinominare il compito

Esplorazione delle viste dell'Area di lavoro
L'aspetto dell'area di lavoro dipende da ciò che è stato selezionato nel riquadro
Compiti.

Vista Riepilogo compiti

Questa area di lavoro si apre quando si seleziona Riepilogo compiti nel riquadro
Compiti.

À Azioni colonna. Consente di eseguire determinate azioni su una colonna. Fare clic
sull'icona di un file su questa riga per:

• Aprire un elaborato per la revisione nell'area di lavoro Revisione.

• Ordinare gli elaborati in ordine alfabetico ascendente o discendente in base
allo studente.

• Aprire il documento master nell'area di lavoro Revisione.

• Rimuovere da Portfolio

• Rinominare il compito

Á Media della classe. Mostra il voto medio della classe per il compito in quella
colonna.

Â Data. Mostra la data in cui il file è stato ritirato. La data dell'ultimo ritiro viene
mostrata nella prima colonna a sinistra.
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Ã Studenti. Elenca tutti gli studenti nella classe.

Ä Intestazione di colonna. Mostra il nome del compito salvato nell'area di lavoro
Portfolio. Nell'intestazione di colonna è possibile effettuare le stesse azioni
consentite sulle azioni colonna. Fare clic con il pulsante destro del mouse per aprire
il menu.
L'intestazione colonna Punteggio Mediomostra il punteggio medio di tutti i compiti
e il punteggio medio di tutti i compiti di uno studente. Fare clic con il pulsante
destro del mouse sulla colonna Punteggio Medio per ordinare i voti in ordine
ascendente o discendente.

Å Icona File. Mostra il tipo di file. I tipi di file visualizzati sono:
Test rapido

TI-Nspire™

Æ Voti dello studente. Se una domanda viene valutata automaticamente, i voti
vengono visualizzati qui. È possibile modificare un voto di uno studente per un
compito.

Vista Compito dello studente

Questa area di lavoro si apre quando si seleziona un singolo compito nel riquadro
Compiti. Per visualizzare quest'area di lavoro, il compito da aprire deve essere un file
tns. che contiene una o più domande.

À Nome del compito selezionato.

Á Totale possibile. Questa riga mostra i punti per queste categorie:

• i Punti possibili complessivi per ogni domanda nel compito. È possibile
modificare questo numero.

• Il numero totale di punti extra possibili per il compito. È possibile modificare
questo numero.



• I punti totali per il compito.

• Punteggio grezzo in base al numero di punti che lo studente ha ricevuto
diviso per il totale punti possibili.

• Percentuale finale. Questo numero si aggiorna quando si modificano i punti
possibili o i punti extra. È possibile modificare questo voto. Il voto finale è lo
stesso del voto non elaborato, se questo non viene modificato.

• Se si modifica il voto finale, questo non si aggiornerà più se gli altri punti
cambiano.

Â Nomi studenti. Tutti gli studenti che hanno ricevuto il compito selezionato. Fare
clic con il pulsante destro del mouse e modificare il documento nell'area di lavoro
Documenti oppure aprire il documento per la revisione nell'area di lavoro
Revisione.

Ã Media. Mostra il voto medio per tutti gli studenti, così come la media dei punti
totali, voto grezzo e voto finale.

Ä Domande nel compito. Se il compito conteneva più domande, ogni domanda viene
visualizzata in quest'area insieme al voto totale possibile per quella domanda.

Å Voti. Elenca il voto ricevuto da ogni studente per il compito selezionato. Ogni
pagina nel compito può avere un voto separato. Fare clic con il pulsante destro del
mouse per modificare il voto, aprire il compito nell'area di lavoro Documenti
oppure aprire il documento nell'area di lavoro Revisione.

Æ Barra di scorrimento. Appare quando sono presenti più domande da visualizzare in
un compito oppure più studenti da visualizzare.

Salvataggio di un elemento nell'area di lavoro Portfolio
Se si sta utilizzando il software TI-Nspire™ per la prima volta, l'area di lavoro Portfolio
potrebbe essere vuota. È necessario salvare i file nell'area di lavoro Portfolio per
visualizzare e modificare i voti ed eseguire altre operazioni sul file.

È possibile salvare file ritirati, non sollecitati e di Test rapido nell'area di lavoro
Portfolio. È possibile salvare l'area di lavoro Portfolio dalle aree di lavoro Classe e
Revisione.

Quando si salvano Test rapidi in Portfolio, gli studenti possono continuare a inviare
risposte al Test rapido fino a quando il test non viene terminato. Il Test rapido salvato
si aggiorna automaticamente senza doverlo nuovamente salvare.

Nota: se il file è stato aperto dall'area di lavoro Portfolio, oppure se è già stato salvato
nell'area di lavoro Portfolio, non viene richiesto di specificare un nome file. Il file viene
salvato nell'area di lavoro Portfolio con il nome file esistente e vengono aggiornate
tutte le valutazioni assegnate agli studenti. È possibile modificare una valutazione
nell'area di lavoro Portfolio in qualsiasi momento.

Per salvare un file nell'area di lavoro Portfolio, attenersi alla procedura seguente.
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1. Selezionare i file da salvare.

• Dalla Registrazione della classe nell'area di lavoro Classe, fare clic su , e
quindi fare clic su Salva selezionati in Portfolio.

• Da un file aperto nell'area di lavoro Revisione, fare clic su File > Salva in
Portfolio, oppure fare clic su .

Viene visualizzata la finestra di dialogo Salva in Portfolio.

2. Salvare i file in una nuova colonna di Portfolio oppure inserirli in una colonna di
Portfolio esistente.

• Per aggiungere i file in una nuova colonna di Portfolio, selezionare Aggiungere
come nuova colonna di Portfolio. È possibile utilizzare il nome esistente oppure
digitarne uno nuovo.

• Per salvare i file in una colonna di Portfolio esistente, selezionare Aggiungi a
colonna di Portfolio esistente. Fare clic sulla freccia verso il basso per
selezionare la colonna desiderata dall'elenco a discesa.

Nota: i test rapidi non possono essere aggiunti a colonne esistenti.

3. Fare clic su Salva.

Il file viene salvato nell'area di lavoro Portfolio.

Nota: i file salvati nell'area di lavoro Portfolio rimangono nella Registrazione della
classe fino a quando non li si rimuove con il comando Rimuovi.

Se un file viene eliminato dalla Registrazione della classe, l'eliminazione non ha
effetto sulla copia salvata nell'area di lavoro Portfolio. La copia rimane nell'area di
lavoro Portfolio fino a quando non viene eliminata.

Importazione di un elemento nell'area di lavoro Portfolio
È possibile importare un file .tsn dal computer a una cella del Portfolio di uno studente.

1. Fare clic su Riepilogo compiti.

2. Evidenziare una cella nella riga dello studente in cui si desidera importare il file.

Nota: è possibile importare un file per un solo studente alla volta.

3. Fare clic su File > Importa elemento.

Viene visualizzata la finestra di dialogo Apri



4. Evidenziare e fare clic sul file da importare.

5. Fare clic su Importa.

Se in quella cella esiste già un file, viene richiesto di confermare la sostituzione del
file.

• Per sovrascrivere il file esistente con quello nuovo, fare clic su Sostituisci.
• Fare clic suMantieni esistente per mantenere il file esistente e cancellare la

funzione di importazione file.

Modifica dei voti
Potrebbe essere necessario modificare il voto di uno studente. Per esempio, un
compito a risposta aperta contiene una domanda che richiede la parola "Autumn"
(Autunno) come risposta corretta. Uno studente ha inserito "Fall." (Autunno) Se si
desidera assegnare allo studente un credito parziale o pieno, sarà necessario cambiare
il voto dello studente per la domanda.

Oltre a modificare il voto di uno studente individuale, è possibile modificare i punti
totali possibili per ogni domanda, i punti extra e la percentuale finale.

▶ Utilizzare numeri interi per modificare i voti. Per esempio, digitare 75 per dare un
voto del 75%, digitare 100 per dare un voto del 100%, e così via.

Nota: se si digita un voto e non si preme Invio, la modifica non viene effettuata e
rimane effettivo il voto precedente.

Anteprima Risposta Studente

E' possibile visualizzare l'anteprima della risposta di uno studente ad una domanda nel
Riquadro Anteprima. Questo consente di rivedere le domande, risposte e modifica dei
voti in modo rapido, semplice ed efficiente.

Nota: il compito da aprire deve contenere almeno una domanda per poter visualizzare
l'anteprima.

1. Fare clic sul compito di uno studente nell'elenco Riepilogo compiti.

2. Selezionare la cella della domanda di cui si desidera visualizzare l'anteprima.

Le informazioni seguenti vengono visualizzate nel Riquadro Anteprima.

• D# Domanda. Domanda originale con un'icona che segnala la risposta corretta
o sbagliata

• Risposta dello studente. Risposta dello studente
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• Risposta corretta Risposta corretta dell'insegnante (vuoti se non c'è risposta
corretta)

Nota: in relazione alla domanda inviata, potrebbero essere visualizzate altre
informazioni,

Modifica un voto di uno studente per un compito.

È possibile modificare il voto per un compito dalla vista Riepilogo compiti oppure è
possibile modificare il voto per domande individuali in un compito dalla vista Compiti
dello studente. Questi passaggi descrivono il modo per modificare un voto dalle viste.

1. Nella riga dello studente, selezionare il voto che si desidera modificare.

2. Fare clic con il pulsante destro del mouse sulla cella e fare clic suModifica voto.

3. Digitare il voto sostitutivo e premere Invio. Per cancellare, premere Esc.

Modifica dei punti totali possibili per una domanda

È possibile modificare il voto totale possibile per le domande di uno studente o per
punti extra.

1. Selezionare una cella nella riga Totale possibile.

2. Fare clic con il pulsante destro del mouse sulla cella e fare clic suModifica voto.

3. Digitare i punti per la domanda o per i punti extra e premere Invio.

Il software chiede se si vogliono mantenere i voti dello studente per la domanda, o
rivalutare i voti per ogni studente. L'impostazione predefinita rivaluta i voti per
ogni studente.

• Per mantenere i voti degli studenti senza effettuare modifiche, selezionare
Lascia intatto il credito assegnato allo studente per questa domanda.

• Per stimare nuovamente il voto di ogni studente, selezionare Rivaluta domanda
per ogni studente.

4. Fare clic su OK.

Modifica del voto finale in percentuale

1. Nella vista Compiti dello studente, selezionare lo studente di cui si vuole
modificare il voto.

2. Fare clic con il pulsante destro del mouse sulla cella nella colonna Finale e fare clic
suModifica voto.

3. Digitare il voto sostitutivo e premere Invio. Per cancellare, premere Esc.



Nota: se si modifica il voto finale, si conserva il valore modificato e non viene più
aggiornato se si modificano altri valori nella riga.

Esportazione dei risultati
Se l'insegnante o il distretto scolastico utilizzano reportistica e archiviazione di
valutazioni elettroniche, potrebbe essere necessario esportare le valutazioni a questi
programmi. E' possibile esportare i risultai dall'area di lavoro Portfolio tramite un file
CSV. L'azione di esportazione include tutti i voti per tutti gli studenti per il compito
selezionato o per tutti i compiti.

Il file .csv contiene tutte le colonne e le righe nell'area di lavoro a eccezione della riga
Azioni colonna. Se uno studente presenta una cella vuota senza voti, il file .cvs
visualizza una cella vuota.

Esporta vista corrente

Questo permette di esportare tutti i dati presenti nell'area di lavoro Portfolio per un
singolo compito.

1. Selezionare un compito dall'elenco.

2. Fare clic su File > Esporta Dati oppure fare clic su .

3. Selezionare Esporta vista corrente.

Viene visualizzata la finestra di dialogo Esporta dati.

• La cartella predefinita è Documenti.
• Il nome predefinito è il nome del compito.

4. Aprire la cartella in cui si desidera salvare il file.

5. Fare clic su Salva.

Esportazione personalizzata

L'Esportazione Personalizzata permette di esportare i voti finali per uno o più compiti.
E' utile per segnalare i punteggi in un intervallo di date con solo l'esportazione del
nome dello studente e il punteggio finale.

1. Fare clic su File > Esporta Dati oppure fare clic su .

2. Selezionare Esportazione personalizzata.
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Viene visualizzata la finestra di dialogo Esportazione personalizzata.

3. Selezionare il compito che si intende esportare.

• Selezionare la casella di controllo secondo il nome del compito.
• Fare clic su Seleziona tutto Per selezionare tutti i compiti
• Fare clic su Annulla tutto per annullare le selezioni.

4. Fare clic su Esporta.

Viene visualizzata la finestra di dialogo Esporta.

• La cartella predefinita è Documenti.
• Il nome predefinito è il nome del compito.

5. Aprire la cartella in cui si desidera salvare il file.

6. Fare clic su Salva.

Ordinamento delle informazioni nell'area di lavoro Portfolio
1. Fare clic sull'intestazione di colonna in base alla quale ordinare l'elenco.

L'elenco selezionato viene organizzato in ordine ascendente, discendente o per
nome studente.

2. Fare clic di nuovo sull'intestazione della colonna per ordinare in un altro modo.

Apertura di un elemento Portfolio in un'altra area di lavoro
È possibile aprire il file .tns nell'area di lavoro Documenti per modificarlo oppure è
possibile aprire un file .tns o Test Rapido nell'area di lavoro Revisione per visualizzare
le risposte dello studente nelle viste diagramma a barre, tabella o grafico.

Apertura di un elemento nell'area di lavoro Documenti

1. Fare clic sul file da aprire.

Per aprire un file per tutti gli studenti:

• dall'elenco Riepilogo compiti, fare clic sul file.



• Dalla vista Riepilogo compiti, fare clic sull'icona nella riga Azioni colonna
oppure fare clic sull'Intestazione colonna.

Per aprire un file per studenti selezionati:

• dalla vista Riepilogo compiti, selezionare una cella in una riga dello studente
selezionato. È possibile aprire più di un file in una colonna ma non è possibile
aprire più file da colonne diverse.

• Dalla vista Compiti dello studente, selezionare una cella nella riga dello
studente selezionato.

2. Fare clic su File > Apri per modifica oppure fare clic con il pulsante destro del
mouse e cliccare Apri per modifica.

Il file viene aperto nell'area di lavoro Documenti.

Apertura di un elemento nell'area di lavoro Revisione

1. Fare clic sul file che si desidera aprire utilizzando uno dei seguenti metodi:

• dall'elenco Riepilogo compiti, selezionare il file.
• Dalla vista Riepilogo compiti, fare clic sull'icona nella riga Azioni colonna

oppure fare clic sull'Intestazione colonna.
• Dalla vista Riepilogo compiti, fare clic su una cella in una riga dello studente

selezionato. È possibile aprire più di un file in una colonna ma non è possibile
aprire più file da colonne diverse.

• Dalla vista Compiti dello studente, fare clic su una cella nella riga dello
studente selezionato.

Nota: ogni metodo selezionato per aprire il file nell'area di lavoro Revisione apre il
file con tutte le risposte dello studente. Non è possibile aprire un file solo per uno
studente. Tuttavia, è possibile rivedere le riposte per uno studente individuale
nell'area di lavoro Revisione.

2. Fare clic su File > Apri nell'area di lavoro Revisione oppure fare clic con il pulsante
destro del mouse e selezionare Apri nell'area di lavoro Revisione.

Il file viene aperto nell'area di lavoro Revisione.

Apertura di un documento master
Un Documento master è il documento originale inviato agli studenti e contiene la
soluzione delle risposte per valutare le risposte ritirate dagli studenti. Quando si salva
un documento in una colonna nell'area di lavoro Portfolio, generalmente un
Documento master è associato a quel file.

È possibile aprire il Documento master dall'area di lavoro Portfolio nella vista Riepilogo
Compiti. Il Documento master viene aperto come file di sola lettura nell'area di lavoro
Documenti.

1. Nella riga Azioni colonna, fare clic sull'icona corrispondente al file che si desidera
aprire.
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2. Fare clic con il pulsante destro del mouse sull'icona e quindi fare clic su Apri
Documento master.

Il documento viene aperto come file di sola lettura nell'area di lavoro Documenti.

Aggiunta di un documento master
In alcune occasioni potrebbe essere necessario sostituire un Documento master
esistente oppure aggiungere un Documento master a un compito che ne è privo. Per
esempio, una domanda è stata contrassegnata con una risposta errata e gli studenti
non hanno ricevuto alcun credito per quella risposta. È possibile dare un credito agli
studenti cambiando la risposta a quella domanda e conservando il Documento master
come registrazione permanente della risposta corretta.

Nota: è possibile aggiungere o sostituire un Documento master per un file .tns ma non
per un file Test rapido.

Il nuovo Documento master viene utilizzato per valutare i voti dello studente. La
valutazione avviene nel modo seguente:

• se una domanda è stata cambiata, le risposte degli studenti sono valutate per la
nuova domanda.

• Se il nuovo Documento master ha delle domande non presenti nel vecchio
Documento master, vengono valutate queste domande. Gli studenti potrebbero
ricevere un credito pari a zero per quelle domande se non sono state visualizzate.

Per aggiungere o sostituire un Documento master, seguire questi passaggi:

1. nella riga Azioni colonna, fare clic sull'icona corrispondente al file .tns da aprire.

2. Fare clic su File > Aggiungi Documento master.

Si apre una finestra di dialogo in cui è possibile selezionare un file.

3. Selezionare il file .tns che si desidera usare come nuovo Documento master e fare
clic su Apri.

Il software visualizza un messaggio che avverte che la sostituzione del Documento
master provocherà una rivalutazione dei voti degli studenti da parte del software.

4. Fare clic su Aggiungi/Sostituisci Master per assegnare il nuovo Documento master
oppure fare clic su Cancella per cancellare l'azione.

Ridistribuzione di un elemento di Portfolio
La ridistribuzione di un file alla classe è un modo utile per restituire i compiti valutati o
per restituire i compiti per ulteriori attività. La classe deve essere in corso per
ridistribuire un file.

Nota: non è possibile ridistribuire un file di Test rapido.

1. Fare clic con il pulsante destro del mouse sull'elemento che si desidera
ridistribuire.

2. Fare clic su Ridistribuisci alla classe oppure fare clic su .



A ciascuno studente connesso alla rete TI-Nspire™ Navigator™ viene inviato il file
relativo.

Ritiro di file mancanti dagli studenti
Può accadere, in fase di archiviazione nell'area di lavoro Portfolio, che un gruppo di file
degli studenti sia incompleto perché al momento del ritiro alcuni studenti non erano
presenti, o non avevano il file pronto per il ritiro o non erano connessi. La sessione
della classe deve essere attiva per poter ritirare un file.

1. Selezionare un singolo file, oppure fare clic su un'icona di file nella riga Azioni
colonna per selezionare tutti i file della colonna.

Nota: è possibile ritirare solo una colonna di file alla volta.

2. Fare clic su Ritira mancanti.

I file mancanti vengono ritirati dagli studenti che sono connessi alla rete e i cui file
non erano stati inizialmente ritirati.

Invio di file mancanti agli studenti
Può accadere, in fase d'invio di un gruppo di file agli studenti, che l'invio sia incompleto
perché al momento dell'invio alcuni studenti non erano presenti o non erano connessi o
era stato aggiunto un nuovo studente alla classe. La sessione della classe deve essere
attiva per poter inviare un file mancante.

1. Selezionare un singolo file, oppure fare clic su un'icona di file nella riga Azioni
colonna per selezionare tutti i file della colonna.

Nota: è possibile inviare solo una colonna di file alla volta.

2. Fare clic su Invia mancante.

I file mancanti vengono inviati agli studenti che sono connessi alla rete e i cui file
non erano stati inizialmente ricevuti.

Modifica del nome di un elemento di Portfolio
È possibile modificare il nome di un compito dal riquadro Compiti o dall'intestazione
colonna.

1. Fare clic sul nome del compito o sull'intestazione della colonna per modificare il
nome.

2. Fare clic con il pulsante destro del mouse e fare clic su Rinomina.

La finestra di dialogo Rinomina colonna Portfolio si apre.

3. Digitare il nuovo nome.

4. Fare clic su Rinomina. Fare clic su Cancella per annullare la richiesta.

La colonna si visualizza nell'intestazione colonna e nel riquadro Compiti con il
nuovo nome.
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Rimozione di colonne da Portfolio
Può accadere di voler eliminare dei file da Portfolio. Ad esempio, un file sbagliato che
è stato inviato o ritirato da una classe. È possibile rimuovere un compito dal riquadro
Compiti o dall'intestazione colonna.

1. Fare clic sul nome del compito o sull'intestazione della colonna per rimuovere.

2. Fare clic con il pulsante destro del file e fare clic su Rimuovi da Portfolio.

La finestra di dialogo Rimuovi da Portfolio si apre.

3. Fare clic su Rimuovi per eliminare il file. Fare clic su Cancella per annullare la
richiesta.

Nota: se un file viene salvato nell'area di lavoro Portfolio e successivamente eliminato
dalla Registrazione della classe, l'eliminazione non ha effetto sulla copia salvata in
Portfolio. La copia rimane nell'area di lavoro Portfolio fino a quando non viene
eliminata.

Rimozione di file dello studente da Portfolio
In alcuni casi potrebbe essere necessario eliminare un singolo file o alcuni file, ma non
tutti i file, da un elenco colonne. Ad esempio, un file sbagliato che è stato ritirato da
uno studente. Rimuovere i file dello studente dall'area di lavoro nella vista Riepilogo
Compiti.

1. Fare clic sul file o sui file all'interno di una singola colonna da eliminare.

2. Premere Elimina.

La finestra di dialogo Rimuovi documento/i selezionato/i si apre.

3. Fare clic su Rimuovi per eliminare i file. Fare clic su Non rimuovere per annullare
l'operazione.

PRiepilogo delle opzioni del tipo di file

.tns .tns con
domande

.tnsp Test
rapido

Altri tipi
di file

Salva in Portfolio Ÿ Ÿ Ÿ Ÿ Ÿ

Salva selezione nel
Portfolio

Ÿ Ÿ Ÿ Ÿ Ÿ

Modifica voto Ÿ Ÿ Ÿ Ÿ

Apri nell'area di
lavoro Revisiona

Ÿ Ÿ

Apri per modifica Ÿ Ÿ Ÿ Ÿ*

Ridistribuisci alla
classe

Ÿ Ÿ Ÿ Ÿ

Apri documento Ÿ Ÿ Ÿ Ÿ Ÿ



master

Aggiungi documento
master

Ÿ Ÿ

Esporta dati Ÿ** Ÿ** Ÿ** Ÿ** Ÿ**

Invia/Ritira mancanti Ÿ Ÿ Ÿ Ÿ

Rinomina la colonna
Portfolio di File

Ÿ Ÿ Ÿ Ÿ Ÿ

Rimuovi la colonna
Portfolio di File

Ÿ Ÿ Ÿ Ÿ Ÿ

Ÿ* Il file si apre nel programma che il sistema operativo ha
associato al tipo di file.

Ÿ** Vuoto, non valutato e "Altri tipi di file" mostrano "Nessun
voto" nella cella quando esportati.
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Applicazioni
Tutto il lavoro creato e salvato con le applicazioni TI-Nspire™ viene memorizzato in un
documento che può essere condiviso con altri che utilizzano il software TI-Nspire™, un
palmare TI-Nspire™ CX II o l’app TI-Nspire™ per iPad®. Questi documenti di TI Nspire™
possono essere salvati come file .tns.

Un’applicazione è un documento .tns salvato nella cartella MyWidgets.

Le applicazioni possono essere utilizzate per:

• Accedere facilmente a file di testo

• Inserire ed eseguire script (come l’applicazione precaricata di esempio
Stopwatch.tns)

• Inserire rapidamente un problema salvato in un documento

Quando si aggiunge un’applicazione, TI-Inspire™ CX estrae solo la prima pagina del file
.tns selezionato e lo inserisce nel documento aperto.

Creazione di un’applicazione
Un documento è considerato un’applicazione quando viene salvato o copiato nella
cartella MyWidgets designata. L’ubicazione predefinita è:

• Windows®: My Documents (Documenti)\TI-Nspire\MyWidgets.

• Mac®: Documents (Documenti)/TI-Nspire/MyWidgets.

• Palmare: MyWidgets

• App TI Nspire™ per iPad® e app TI Nspire™ CAS per iPad®: MyWidgets

Se la cartella MyWidgets è stata eliminata per errore, è necessario ricrearla prima di
cercare di utilizzare un’applicazione.

Nota: quando si aggiunge un’applicazione, TI-Inspire™ CX estrae solo la prima pagina
del file .tns selezionato e lo inserisce nel documento aperto.

Aggiunta di un’applicazione
Aggiunta di un’applicazione a un nuovo documento

1. Aprire un nuovo documento.



2. Fare clic su Aggiungi applicazione.

3. Localizzare e selezionare un file .tns nella casella.

4. Fare clic su Aggiungi.
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Nota: Stopwatch è un file .tns precaricato. Nell’elenco appaiono tutti i file .tns
salvati.

Aggiunta di un’applicazione a un documento esistente

1. Fare clic su Doc > Insert > Widget (Documento > Inserisci > Applicazione).

2. Fare clic su Aggiungi.



Nota: le applicazioni possono essere aggiunte a documenti nuovi o esistenti anche
mediante il menu Inserisci.

Salvataggio di un’applicazione

1. Fare clic su .
2. Passare a MyDocuments (Documenti) > MyWidgets.

3. Digitare il nome dell’applicazione.

4. Fare clic su Salva.
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Librerie
Che cos’è una libreria?
Una libreria è un documento di TI-Nspire™ contenente un insieme di variabili, funzioni
e/o programmi che sono stati definiti come oggetti libreria.

Diversamente dalle variabili, dalle funzioni e dai programmi abituali, che possono
essere utilizzati all’interno di una sola attività (l’attività in cui sono definiti), gli oggetti
libreria sono accessibili da qualsiasi documento. È anche possibile creare oggetti
libreria pubblica che vengono elencati nel Catalogo di TI-Nspire™.

Ad esempio, si supponga di aver creato un documento libreria matrix contenente la
funzione libreria pubblica diagwithtrace() e una funzione libreria privata errmsg().

La funzione diagwithtrace() visualizza la diagonale di una matrice quadrata e calcola la
traccia della matrice. Se l’argomento non è una matrice quadrata, la funzione chiama
errmsg(), che dovrebbe restituire una stringa di errore appropriata.

Quindi si potrebbe utilizzare la seguente sintassi per visualizzare la diagonale e
calcolare la traccia della matrice m definita nell’attività corrente:

matrix\trace(m).

Creazione di librerie e oggetti libreria
Un documento è considerato una libreria quando viene salvato o copiato nella cartella
librerie designata. L’ubicazione predefinita è:

• Windows®: Documenti\TI-Nspire\MieLibrerie.

• Macintosh®: Documenti\TI_Nspire\MieLibrerie.

• Palmare:MieLibrerie



Se la cartella è stata eliminata per errore, è necessario ricrearla prima di cercare di
utilizzare le librerie.

È possibile definire oggetti libreria utilizzando l’Editor di programmi o l’applicazione
Calcolatrice. Gli oggetti libreria devono essere definiti con un comando Define e
devono risiedere nella prima attività di un documento libreria.

Nota: se si utilizza l’Editor di programmi per definire una funzione o un programma
libreria, occorre memorizzare l’oggetto e salvare anche il documento. Salvando il
documento non si salva automaticamente l’oggetto. Per ulteriori informazioni, vedere
il capitolo “Programmazione” nella documentazione.

Per l’attribuzione di nomi a documenti e oggetti libreria valgono restrizioni particolari.

• Un nome di documento libreria deve essere un nome valido di variabile composto
da 1 a 16 caratteri, non deve contenere punti e non deve iniziare con un trattino
basso.

• Un nome di oggetto libreria deve essere un nome valido di variabile composto da 1
a 15 caratteri. Non deve contenere punti e non deve iniziare con un trattino basso.

Oggetti libreria privata e pubblica
Quando si definisce un oggetto libreria, lo si designa come libreria privata (LibPriv) o
libreria pubblica (LibPub).

Define a=5
    a non è un oggetto libreria.

Define LibPriv b={1,2,3}
    b è un oggetto libreria privata.

Define LibPub func1(x)=x^2 - 1
    func1 è un oggetto libreria pubblica.

Un oggetto libreria privata non viene mostrato nel Catalogo, ma è possibile accedervi
digitandone il nome. Questi oggetti sono utili come blocchi integrati che eseguono
operazioni base di basso livello. In genere, gli oggetti libreria privata vengono chiamati
da funzioni e programmi pubblici.

Un oggetto libreria pubblica viene mostrato nella scheda librerie del Catalogo dopo che
le librerie sono state aggiornate. È possibile accedere a un oggetto libreria pubblica dal
Catalogo oppure digitandone il nome.

Macintosh®: Nella versione 1.4 del software, un documento libreria non può contenere
caratteri estesi, quali Ö, á oppure ñ.

Nota: in programmi e funzioni libreria pubblica, viene visualizzata automaticamente
una riga di commento (©) subito dopo la riga Prgm o Func come guida nel Catalogo. Ad
esempio, vi si potrebbe visualizzare un promemoria della sintassi.
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Utilizzo di abbreviazioni e nomi estesi

Per accedere a un oggetto dalla stessa attività in cui esso è stato definito, è possibile
introdurne l’abbreviazione (il nome assegnato all’oggetto nel relativo comando
Define). Ciò è valido per tutti gli oggetti definiti, compresi gli oggetti libreria pubblica,
libreria privata e non libreria.

È possibile accedere a un oggetto libreria da qualsiasi documento digitandone il nome
esteso. Un nome esteso contiene il nome del documento libreria dell’oggetto seguito
da una barra retroversa “\” e dal nome dell’oggetto. Ad esempio, il nome esteso
dell’oggetto definito come func1 nel documento libreria lib1 è lib1\func1. Per digitare
il carattere “\” sul palmare, premeregp.

Nota: se non si riesce a ricordare il nome esatto o l’ordine degli argomenti richiesti per
un oggetto libreria privata, è possibile aprire il documento libreria oppure utilizzare
l’Editor di programmi per visualizzare l’oggetto. È inoltre possibile utilizzare getVarInfo
per visualizzare un elenco di oggetti in una libreria.

Utilizzo di oggetti libreria
Prima di utilizzare una variabile, una funzione o un programma libreria, accertarsi di
aver eseguito questi passaggi:

• L’oggetto è stato definito con il comando Define che specifica inoltre l’attributo
LibPriv o LibPub.

• L’oggetto risiede nella prima attività di un documento libreria. Il documento deve
risiedere nella cartella librerie designata e deve soddisfare i requisiti di
attribuzione dei nomi.

• Se l’oggetto è stato definito utilizzando l’Editor di programmi, esso è stato
memorizzato utilizzando Controlla sintassi e salva (Check Syntax & Store) dal menu
dell’Editor di programmi.

• Le librerie sono state aggiornate.

Aggiornamento delle librerie

▶ Aggiornare le librerie per rendere gli oggetti libreria disponibili per i documenti.

- Dal menu Strumenti (Tools), selezionare Aggiorna librerie (Refresh Libraries).

Palmare: Premere/b e selezionare Aggiorna librerie.

Utilizzo di un oggetto libreria pubblica

1. Aggiornare le librerie.

2. Aprire l’applicazione di TI-Nspire™ in cui si desidera utilizzare la variabile, la
funzione o il programma.

Nota: Tutte le applicazioni possono calcolare funzioni, tuttavia solo le applicazioni
Calcolatrice e Notes possono eseguire programmi.

3. Aprire il Catalogo e utilizzare la scheda librerie per trovare e inserire l’oggetto.



4. Se il programma richiede di specificare degli argomenti, digitarli all’interno delle
parentesi.

Utilizzo di un oggetto libreria privata

1. Aggiornare le librerie.

2. Aprire l’applicazione di TI-Nspire™ in cui si desidera utilizzare la variabile, la
funzione o il programma.

Nota: Tutte le applicazioni possono calcolare funzioni, tuttavia solo le applicazioni
Calcolatrice e Notes possono eseguire programmi.

3. Digitare il nome dell’oggetto, come ad esempio lib1\func1().

Nel caso di una funzione o di un programma, terminare sempre il nome con una
parentesi aperta e una chiusa. Per digitare il carattere “\” sul palmare, premere
gp.

4. Se il programma richiede di specificare degli argomenti, digitarli all’interno delle
parentesi.

Creazione di collegamenti ad oggetti libreria
È possibile rendere più accessibili gli oggetti di una libreria utilizzando il comando
libShortcut() per creare collegamenti con essi. In questo modo si crea una gruppo di
variabili nell’attività corrente che contiene i riferimenti a tutti gli oggetti nel
documento libreria specificato. È possibile scegliere di includere o di escludere gli
oggetti libreria privata.

Ad esempio si supponga che il documento libreria linalg contenga le funzioni
denominate clearmat, cofactor, gausstep, help, inversestep, kernelbasis, rank e
simultstep. Eseguendo libShortcut(“linalg”,“la”) si creerà un gruppo di variabili
contenente i seguenti membri:

la.clearmat
la.cofactor
la.gausstep
la.help
la.inversestep
la.kernelbasis
la.rank
la.simultstep

È possibile fare riferimento a questi oggetti libreria all’interno dell’attività corrente
digitando i loro nomi di variabile oppure selezionandoli dal menu Variables (Variabili).

Per ulteriori informazioni e un esempio sull’uso di libShortcut(), vedere la Guida di
riferimento.

Librerie incluse
Per semplificare l’apprendimento dell’uso delle librerie, l’installazione di TI-Nspire™
include un documento libreria con utili funzioni di algebra lineare. La libreria è
denominata linalg o linalgCAS e viene installata nella cartella librerie designata.
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Nota: l'aggiornamento del sistema operativo del palmare o la reinstallazione del
software per computer colloca tutte le librerie incluse nella cartella predefinita. Se si è
modificato un oggetto in una libreria inclusa o si è sostituita una libreria inclusa con il
proprio documento con lo stesso nome, l'aggiornamento o la reinstallazione del
sistema operativo del palmare sovrascriveranno queste modifiche. Questo può
avvenire anche quando si sostituiscono le batterie o si ripristina il sistema del palmare.

Ripristino di una libreria inclusa
Se una libreria inclusa viene elimina o sovrascritta per errore, è possibile ripristinarla
dal DVD di installazione.

1. Aprire il DVD e spostarsi sulla cartella libs.

2. Identificare il file libreria da ripristinare, come ad esempio linalg o linalgCAS per la
libreria di algebra lineare.

3. Copiare il file.

- Windows®: Copiare il file nella cartella librerie designata. La cartella
predefinita è Documenti \TI-Nspire\MyLib (My Documents\TI-Nspire\MyLib).

- Macintosh®: Copiare il file nella cartella librerie designata. La cartella
predefinita è Documenti/TI-Nspire/MyLib (Documents/TI-Nspire/MyLib).

- Palmare: Collegare il palmare al computer, aprire il software per il
collegamento al PC TI-Nspire™ e copiare il file libreria nella cartella MyLib sul
palmare.

4. Attivare i nuovi oggetti libreria.

- Dal menu Strumenti del software TI-Nspire™, selezionare Aggiorna librerie
(Refresh Libraries).

Palmare: Premere/b e selezionare Aggiorna librerie (Refresh Libraries).



Utilizzo dell'Emulatore TI-SmartView™
Con le tre opzioni di layout tra cui scegliere, gli insegnanti possono constatare che
l'emulatore agevola le presentazioni in classe. Nel software per gli insegnanti, le
opzioni di layout sono:

• Solo palmare

• Tastiera + Schermo affiancato

• Palmare + Schermo affiancato

Nel software per lo studente, TI-SmartView™ emula la tastiera e con la visualizzazione
del palmare dà agli studenti la possibilità di usare il software come se fosse un
palmare.

Apertura dell'Emulatore TI-SmartView™
L'emulatore TI-SmartView™ si trova nell'Area di Lavoro Documenti. Per aprire la
visualizzazione dell'emulatore:

1. Aprire l'Area di Lavoro Documenti.

2. Cliccare su , che si trova nella Casella degli Strumenti Documenti.

Nel software per insegnanti, il palmare viene visualizzato con i pannelli del
Palmare e Schermo Affiancato aperti in modalità computer come mostrato
nell'illustrazione seguente. È possibile utilizzare la tastiera sul palmare emulato,
ma il documento non viene visualizzato sullo schermo del palmare emulato fino al
momento in cui non si passi alla modalità Palmare.
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Nel software dello studente, la tastiera TI-Nspire™ CX viene visualizzata con lo
schermo affiancato aperto in modalità computer. Si può usare la tastiera sul palmare
emulato per occuparsi del documento sullo schermo affiancato sia in modalità
computer che palmare.

3. Cliccare su Visualizza > Palmare.

—oppure—

Cliccare sulla barra di stato per passare alla modalità palmare.

Scelta di una Tastiera
Il cambio di tastiera non influisce su un documento aperto. È possibile cambiare tra
tastiere in qualsiasi momento. Per selezionare una tastiera:

1. Nel pannello dell'emulatore, cliccare su per aprire il menu e selezionare tra
una delle opzioni seguenti:

• TI-Nspire™ CX II o TI-Nspire™ CX II CAS

2. Cliccare su ¢ per selezionare un'opzione di pannello frontale:

• Scuro
• Luce
• Profilo



Scelta di Opzioni di visualizzazione
Nel software degli insegnanti, utilizzare questa opzione per scegliere come
visualizzare l'emulatore nella finestra del software.

1. Sul pannello dell'emulatore, cliccare .

—oppure—

Cliccare File > Impostazioni > TI-SmartView™.

2. Scegliere tra una delle opzioni seguenti:

• Solo palmare. Visualizza il palmare emulato e nasconde l'area di lavoro e gli
altri pannelli.

Nota: Per mantenere la visualizzazione Solo palmare davanti alle altre finestre
di applicazione, cliccare su Sempre in primo piano in alto a destra del pannello
TI-SmartView™.

• Tastiera + Schermo Affiancato. Apre una visualizzazione ingrandita della
tastiera con lo schermo affiancato.

• Palmare + Schermo Affiancato. Apre l'intero palmare emulato con lo schermo
affiancato.

Modifica della larghezza del pannello TI-SmartView™

Per modificare la larghezza del pannello dell'emulatore TI-SmartView™:

▶ Cliccare sul bordo destro del pannello e trascinarlo fino a quando non si arriva alla
larghezza desiderata.

Modifica della Dimensione dello Schermo nell'Area di lavoro

Se si sceglie la modalità palmare, utilizzare la Scala per modificare la dimensione
dello schermo.

▶ Trascinare il cursore fino a quando non si arriva alla percentuale di scala adeguata.
Il cursore della scala si trova all'estrema destra della barra di stato, in basso nella
finestra di TI-Nspire™. Le percentuali di scala variano tra il 100% e il 200%. La scala
predefinita è di 150%.

Nota: Se si sceglie la modalità computer, è impossibile modificare la dimensione
dell'area di lavoro.

Operazioni in modalità Palmare Emulato
Per inserire dati e lavorare con i file sull'emulatore, è possibile utilizzare la tastiera del
computer, la tastiera in TI-SmartView™, i menu e le icone in TI-Nspire™ oppure
qualsiasi combinazione degli stessi.
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Nota: Con uno stesso comando, non è possibile utilizzare una combinazione sia del
tastierino che della tastiera. Ad esempio, non è possibile premere Ctrl sulla tastiera e
cliccareb sull'emulatore per aprire un menu contestuale.

In generale, sull'emulatore TI-SmartView™ è possibile eseguire qualsiasi funzione che
possa essere fatta sul palmare. I tasti e le applicazioni funzionano allo stesso modo.

Nota: Se si passa alla modalità computer, è ancora possibile utilizzare la maggior
parte dei tasti sul palmare emulato o sulla tastiera e tutte le battute di tasto appaiono
sullo spazio di lavoro. Tuttavia, alcune combinazioni di tasti possono funzionare solo in
modalità Palmare.

Cliccando sui tasti dell'emulatore oppure premendo i tasti sulla tastiera con ulteriore
attivazione dei tasti sull'emulatore, gli stessi tasti cambiano colore e consentono al
pubblico di destinazione di seguire facilmente la procedura. L'ultimo tasto selezionato
rimane evidenziato.

Nel software dell'insegnante, lo schermo dell'emulatore e lo schermo affiancato sono
entrambi interattivi. È possibile cliccare sulle icone e sugli articoli del menu su
entrambi gli schermi. Inoltre è possibile cliccare con il pulsante destro del mouse per
visualizzare i menu su entrambi gli schermi.

Tutti i tasti di scelta rapida e la funzionalità delle frecce vanno bene sulla tastiera del
computer. Ad esempio, per salvare un documento, è possibile fare clic/ S sul
tastierino dell'emulatore oppure premere Ctrl + S sulla tastiera del computer. Quando
viene utilizzato il Macintosh®, premere “ + S.

Utilizzo del Touchpad
È possibile usare il Touchpad sul tastierino in TI-Nspire™ Touchpad e usare o il
touchpad su un laptop oppure il mouse per cliccare sul Touchpad. Se si clicca sui settori
delle frecce, le aree del touchpad vengono evidenziate.

• Cliccando sui tasti ¡, ¢,£, o¤ sul Touchpad ci si sposta da una voce all'altra del
menu.

• Cliccando e tenendo premuta una freccia sul Touchpad consente il movimento
continuo nella direzione selezionata.

• Cliccare e fare scorrere il mouse nell'area del Touchpad consente di spostare il
puntatore del mouse.



• Cliccare al centro del Touchpad permette la selezione dell'opzione del menu
evidenziata.

Utilizzo di Impostazioni e Stato
Quando si lavora con l'emulatore TI-SmartView™, è possibile modificare le
Impostazioni Generali e le Impostazioni del Documento. Per ulteriori informazioni,
consultare Utilizzo dell'area di lavoro Documenti.

È possibile visualizzare tutte le altre impostazioni, ma non si può modificarle
nell'ambito dell'emulatore TI-SmartView™. Ad ogni modo, la possibilità di visualizzare
queste opzioni offre agli insegnanti uno strumento per mostrare agli studenti come
configurare un palmare.

Visualizzare le impostazioni e lo stato:

1. Cliccare suc per accedere allo schermo Home.

2. Cliccare su Impostazioni.

Impostazione
o
Impostazioni

Descrizione

Lingua È possibile visualizzare il menu delle lingue e selezionarne una, ma
non è possibile salvare le modifiche. Per passare ad un altra lingua,
usare l'opzione -File Impostazioni > Cambia Lingua > dal menu TI-
Nspire™.

Impostazione
del Palmare

È possibile aprire i menu e selezionare le voci per mostrare quali
elementi scegliere, ma non è possibile salvare le modifiche.

Stato del
Palmare

È consentito l'accesso allo schermo. Il simbolo # sostituisce i valori
numerici che si vedrebbero sul palmare.

Informazioni
(About)

È possibile visualizzare lo schermo Informazioni (About) per vedere la
versione del software. Le altre informazioni che riguardano
esclusivamente l'hardware del palmare appaiono contrassegnate "Non
disponibili".

Login È possibile visualizzare lo schermo Connessione alla classe (Login to
Class) e completare i campi User Name e Password. Il Login non è
disponibile.

Modifica delle Opzioni TI-SmartView™
È possibile modificare le opzioni dell'emulatore, anche nel caso in cui il pannello
dell'emulatore sia chiuso.

1. Nel software dell'insegnante, cliccare su File > Impostazioni > Opzioni TI-
SmartView™.

La finestra di dialogo Opzioni TI-SmartView™ si apre.
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Nel software dello studente, cliccare su File > Impostazioni > Opzioni Tastiera.

La finestra di dialogo Opzioni Tastiera si apre.

2. Cliccare su Sfoglia per cambiare la cartella dove vengono salvati i documenti che si
possono aprire nella cartella Documenti quando viene utilizzato l'emulatore.

Importante: Se si cambia il percorso di TI-SmartView™, è anche necessario copiare
o spostare la cartella MyLib ed incollarla sul nuovo percorso per vedere gli oggetti
della libreria.

L'ubicazione predefinita è

• Windows®: Documents\TI-Nspire\MyLib
• Mac®: Documents/TI-Nspire/MyLib

Nota: Chiudere e riaprire l'applicazione TI-Nspire™ affinché le librerie riflettano il
cambiamento.

3. Cliccare su¤ per aprire il menu e selezionare il frontalino.

4. Nel software dell'insegnante, cliccare su¤ per aprire il menu e selezionare una
vista. Se si seleziona Solo palmare, scegliere Sempre in primo piano (Always in
Front) per mantenere la finestra in alto rispetto alle altre applicazioni aperte.

5. Cliccare su OK per salvare le impostazioni.



Operazioni con i Documenti
È possibile aprire numerosi documenti nell'area di lavoro selezionando File > Aprire
Documento dal menu oppure utilizzando i tasti di scelta rapida. Quando si passa da un
documento all'altro, il palmare emulato mostra soltanto il documento corrente. È
possibile inserire pagine e attività utilizzando i menu e le icone di TI-Nspire™, i tasti di
scelta rapida o i menu e i tasti di scelta rapida di TI-SmartView™.

Nota: Non è possibile lavorare con i documenti PublishView™ usando l'emulatore TI-
SmartView™. Quando si crea o si apre un documento PublishView™, lo stesso viene
aperto in modalità Computer.

Apertura di un Documento

È possibile aprire un documento navigando sull'emulatore allo stesso modo in cui si
apre un documento sul palmare oppure cliccando su File > Apri Documento.

Quando si apre un documento utilizzando l'emulatore, è possibile aprire soltanto i
documenti che si trovano nella cartella visualizzata sull'emulatore (di solito la cartella
Documenti, a meno che nelle impostazioni in TI-SmartView™ non sia stata specificata
una cartella diversa). Quando si apre un documento dal percorso del menu, è possibile
sfogliare e trovare qualsiasi documento TI-Nspire™ nel computer o in rete. Se si apre
un documento utilizzando il palmare emulato, lo stesso sostituisce il documento
aperto in precedenza.

Nota: Il documento non può essere aperto e viene visualizzato un messaggio di errore,
qualora il nome del percorso del file per il documento superi 256 caratteri. Per evitare
che si verifichi questo errore, è bene scegliere dei nomi corti per i file e le cartelle
oppure trasferire i file avanti nel percorso del file.

Salvataggio di un Documento

Il documento viene salvato con lo stesso percorso da dove era stato aperto il file,
quando lo stesso documento è stato salvato dal menu File > Salva Documento , o
tramite l'icona corrispondente, i tasti di scelta rapida della tastiera, o il tastierino
emulato o i menu dell'emulatore. Per salvare il file in un altro percorso o con un nome
diverso, cliccare su File > Salva con nome.

Utilizzo di Cattura Schermo (Screen Capture)
Per catturare lo schermo corrente, premere su Ctrl + J (Mac®: ì“+ J) sulla tastiera
oppure sul palmare emulato. L'immagine viene automaticamente posta negli Appunti
e nella finestra di Cattura Schermo di TI-Nspire™. È possibile incollare l'immagine in
un'altra applicazione senza dover eseguire un'ulteriore procedura. Questa funzione è
disponibile solo quando il pannello TI-SmartView™ è attivato e l'area di lavoro si trova
in modalità Palmare.

Tutte le altre funzioni di cattura dello schermo funzionano nello stesso modo in cui
operano in altre aree del software TI-Nspire™. Per ulteriori informazioni, consultare
Cattura Schermo.
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Scrittura di script Lua
L'Editor di script consente di creare e presentare simulazioni collegate in modo
dinamico, utilità flessibili ed efficaci e altri contenuti formativi per esplorare concetti
matematici e scientifici. Quando si apre un documento contenente uno script, gli script
si avviano automaticamente come programmato. Per visualizzare l'applicazione dello
script in funzione, la pagina contenente l'applicazione dello script deve essere attiva.

L'Editor di script è concepito per insegnanti e altri autori che hanno familiarità con le
operazioni in un ambiente di scripting Lua. Lua è un linguaggio di scripting efficace,
veloce, leggero pienamente supportato dai documenti TI-Nspire™ e PublishView™. I
documenti contenenti applicazioni di script possono essere aperti su palmari TI-
Nspire™ CX II. L'applicazione di script funziona su un palmare ma non è possibile
visualizzare o modificare lo script.

Fare riferimento a queste risorse per utilizzare l'Editor di script e creare degli script:

• Premere F1 per accedere alla guida TI-Nspire™ che include la guida all'Editor di
script.

• Premere F2 per ulteriori risorse TI-Nspire™ quali campioni di script e un link alla
Libreria di scripting API di TI-Nspire™. (Queste informazioni sono inoltre disponibili
su education.ti.com/nspire/scripting).

• Visitare lua.org per maggiori informazioni su Lua.

Descrizione dell'Editor di script
Con l'Editor di script, è possibile inserire, modificare, salvare, eseguire ed eseguire il
debug delle applicazioni di script nei documenti TI-Nspire™ (file .tns) e Publishview™
(file .tnsp).

• Le applicazioni di script funzionano all'interno di documenti, attività e pagine allo
stesso modo delle altre applicazioni di TI-Nspire™.

• Quando si crea un nuovo documento o se ne apre uno esistente, è possibile inserire
o modificare un'applicazione di script all'interno di una pagina o all''interno di
un'area di lavoro di una pagina suddivisa.

• Nel layout della pagina suddivisa, è possibile aggiungere un'applicazione di script a
ogni area di lavoro di una pagina. Una pagina può essere suddivisa in un massimo
di quattro quadranti.

• È possibile aggiungere immagini ad applicazioni di script. Vedere il capitolo
Inserimento di immagini.

• Se si chiude il documento di TI-Nspire™ o PublishView™ senza salvarlo, tutto il
lavoro effettuato con l'Editor di script viene perso.

Esplorazione dell'interfaccia dell'Editor di script
La finestra dell'Editor di script si visualizza quando si apre una nuova applicazione di
script o se ne modifica una esistente in un documento TI-Nspire™ o PublishView™.

https://education.ti.com/nspire/scripting


Selezionare le opzioni per creare nuovi script o modificare script esistenti dal menu
Inserisci nell'area di lavoro Documenti quando un documento è aperto.

Nota: anche se non è etichettata, in TI-Nspire™ CX Student Software e TI-Nspire™ CX
CAS Student Software, l'area di lavoro Documenti è l'area di lavoro predefinita.

La figura seguente mostra l'Editor di script con uno script esistente.

À Barra dei menu. Contiene opzioni per lavorare con l'Editor di script.

Á Barra degli strumenti. Fornisce gli strumenti per le funzioni comuni dell'Editor di
script. Vedere il capitolo Utilizzo della barra degli strumenti.

Â Titolo script. Mostra il titolo dello script. Fare clic con il pulsante destro del mouse
sul titolo per cambiarlo oppure fare clic su Modifica > Imposta Titolo script.

Ã Casella di testo. Fornisce uno spazio per digitare il testo dello script.

Ä Pannello degli strumenti. Mostra i dati dello script. Vedere il capitolo Utilizzo del
pannello degli strumenti.

Å Barra di stato. Visualizza lo stato operativo dello script. Vedere il capitolo Utilizzo
della barra di stato.

Utilizzo della barra degli strumenti
La tabella seguente spiega le opzioni della barra degli strumenti.
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Nome Strumento Descrizione Strumento

Sospendi lo
script

Sospende l'esecuzione dello script.

Riprendi lo
script.

Riprende l'esecuzione dello script.
Durante l'esecuzione del debug, lo script continua a
essere eseguito fino al punto di interruzione successivo o
la fine dello script.

Imposta lo
script

Inizia l'esecuzione dello script

Metti a fuoco
lo script

Imposta il fuoco sulla pagina nel documento a cui
l'applicazione dello script è allegata.

• In un documento TI-Nspire™, imposta il fuoco sulla
pagina.

• In un documento PublishView™, imposta il fuoco
sulla cornice della pagina.

Accedere a Durante l'esecuzione del debug, esegue l'istruzione
corrente. Se l'istruzione chiama una qualsiasi funzione, il
debugger si ferma alla prima linea di ogni funzione.

Oltrepassare Durante l'esecuzione del debug, esegue l'istruzione
corrente.
Se l'istruzione chiama una qualsiasi funzione, il debugger
non si ferma all'interno della funzione a meno che questa
non contenga un punto di interruzione.

Abilita i punti
di
interruzione

Passa dalla modalità normale alla modalità di debug.

Disabilita i
punti di
interruzione

Ripassa dalla modalità di debug alla modalità normale e
riprende lo script.

Imposta
autorizzazioni

Imposta i livelli di autorizzazione su Protetto, Solo
visualizzazione o Non protetto e consente di impostare
una password per lo script.

Utilizzo del Pannello strumenti

Nella parte inferiore della finestra, il Pannello strumenti mostra i dati dello scripting.
Per ulteriori informazioni, consultare il capitolo Esecuzione del debug degli script.



Tabulazione Visualizzazione della finestra

Console Gli errori dello script vengono stampati qui.
Anche le istruzioni di stampa incorporate nello script sono stampate
qui.

Globali Si visualizzano le variabili globali selezionate.
Per selezionare una variabile globale per la visualizzazione, fare clic su
Clicca per aggiungere una nuova variabile di visualizzazione in fondo
al Pannello degli strumenti.

Stack di
chiamate

Visualizza la struttura delle chiamate per la funzione attualmente in
esecuzione.

Locali Sono visualizzate le variabili locali nell'ambito della funzione.

Risorse Caricare, inserire e gestire le immagini.

Utilizzo della barra di stato

La barra di stato in fondo alla finestra mostra i dati di base dello script, come descritto
nell'esempio seguente: stopwatch, 1.1,  4:1,  In esecuzione.

• Nome del documento a cui è allegata l'applicazione dello script (stopwatch)

• Numero di attività e di pagina (1.1)

• Riga e carattere dello script, (4:1 riga di descrizione 4 e carattere 1)

• Stato operativo dello script (In esecuzione). Notare i possibili stati:

- Modalità Normale: In esecuzione, In pausa o Errore
- Modalità Debugging In esecuzione (debugging), In pausa o Errore

Inserimento di nuovi script
Per inserire una nuova applicazione di script e nuovi script, seguire i passaggi
successivi.

1. Aprire il documento in cui si vuole aggiungere lo script. Può essere un documento
nuovo o esistente.

2. Fare clic su Inserisci > Editor di script > Inserisci script.

Viene inserita un'applicazione di script e visualizzata la finestra di dialogo Titolo
dello script.

Nota: TI-Nspire™ CX Student Software e TI-Nspire™ CX CAS Student Software si
aprono automaticamente nell'area di lavoro Documenti.

3. Digitare un titolo dello script. (La lunghezza massima di questo campo è 32
caratteri)

4. Fare clic su OK.
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La finestra dell'Editor di script si apre mostrando uno script vuoto.

5. Digitare il testo nelle righe dello script.

Nota: alcuni caratteri "wide" UTF-8 non standard potrebbero non essere
visualizzati correttamente. Per questi caratteri, si raccomanda vivamente di
utilizzare la funzione string.uchar.

6. Quando lo script è completo, fare clic su Imposta script per eseguirlo.

• In un documento TI-Nspire™, l'applicazione di script viene inserita in una nuova
pagina. Quando la pagina che contiene l'applicazione dello script è attiva, la
Casella degli strumenti Documenti è vuota.

• In un documento PublishView™, una cornice contenente l'applicazione dello
script viene aggiunta alla pagina attiva. È possibile spostare o ridimensionare
questa cornice allo stesso modo di un oggetto di PublishView™ e aggiungere
altri oggetti di PublishView™ alla pagina.

7. Per visualizzare l'applicazione di script, fare clic su Metti a fuoco lo script.

Zoom del testo nell'Editor di script

È possibile regolare le dimensioni del testo nello script e in ciascuno dei pannelli degli
strumenti.

Metodo Menu

1. Fare clic nell'area del testo su cui effettuare lo zoom.

2. Nel menu Visualizza, selezionare Zoom, quindi selezionare Zoom avanti, Zoom
indietro, o Ripristina.

Si noti che il menu mostra anche le scelte rapide da tastiera per i comandi Zoom.

Metodo Mouse

1. Posizionare il puntatore del mouse sopra l'area su cui effettuare lo zoom.

2. Mantenere premuto Ctrl, e ruotare la rotellina del mouse in avanti o indietro.

Modifica degli script
Completare la seguente procedura per modificare uno script esistente.

1. Aprire il documento di TI-Nspire™ o PublishView™ che contiene lo script. La pagina
che contiene lo script deve essere attiva.

2. Selezionare la pagina e l'area di lavoro che contiene lo script.

3. Fare clic su Inserisci > Editor di script > Modifica script.

L'Editor di script si apre mostrando lo script. Se l'area di lavoro selezionata nella
pagina non contiene uno script, Modifica script viene visualizzata in grigio.

Se lo script è protetto da password, la finestra di dialogo Protetto da password si
apre richiedendo una password.

4. Apportare le modifiche desiderate.



• Per indicare commenti, utilizzare trattini doppi (--) all'inizio di ogni riga di
commento.

• Per modificare il titolo, fare clic suModifica > Imposta titolo dello script oppure
fare clic con il pulsante destro del mouse sul titolo e selezionare Imposta titolo
dello script.

Note:

• alcuni caratteri UTF-8 non standard potrebbero non essere visualizzati
correttamente. Per questi caratteri, si raccomanda vivamente di utilizzare la
funzione string.uchar.

• La funzione di stampa potrebbe produrre risultati inattesi per caratteri non–
UTF-8.

• Alcuni caratteri non stampabili restituiti dalla funzione on.save saranno
scartati.

5. Per eseguire lo script, fare clic su Imposta script.

Eventuali errori sono visualizzati nell'area Console nel Pannello strumenti.

6. Per visualizzare l'applicazione dello script (script in esecuzione), fare clic suMetti a
fuoco lo script.

Modifica delle opzioni di visualizzazione
Per cambiare le opzioni di visualizzazione:

▶ Per eliminare i dati di scripting nel Pannello degli strumenti e ripristinare i valori
predefiniti dell'editor, fare clic su Visualizza > Ripristino delle impostazioni
predefinite di Editor.

▶ Per visualizzare il titolo dello script nel documento e prima di ogni istruzione di
stampa nella Console, fare clic su Visualizza > Titolo in Vista Documento.

▶ Per nascondere o mostrare le etichette della barra degli strumenti, fare clic su
Visualizza > Barra degli strumenti etichette di testo.

▶ Per nascondere o mostrare il Pannello degli strumenti o le sue aree, fare clic su
Visualizza > Pannello degli strumenti e selezionare l'opzione appropriata.

▶ Per creare gruppi di schede quando più script sono aperti, fare clic con il pulsante
destro del mouse su un titolo e selezionare Nuovo gruppo orizzontale o Nuovo
gruppo verticale.

Impostazione del livello API minimo
Ogni versione del software T-Nspire™ include un supporto API per un set specifico di
funzionalità di script Lua. L'impostazione del livello API minimo per uno script consente
di specificare un set minimo di funzionalità necessarie per uno script.

Se un utente cerca di eseguire uno script su un sistema che non soddisfa il livello API
minimo dello script, riceve una notifica e l'esecuzione dello script non può essere
effettuata.
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Per impostare il livello API minimo per uno script:

1. Determinare il livello minimo richiesto dallo script.

- L'impostazione di un livello troppo basso per il set di funzionalità dello script
può comportare un errore di script su una versione software precedente.

- L'impostazione di un livello troppo alto può far sì che lo script si rifiuti di
avviarsi su una versione software precedente che supporta il set di funzionalità.

2. Nel menu File Editor di script, selezionare Imposta livello API minimo.

3. Nella finestra di dialogo, digitare il livello minimo utilizzando il formato
principale.secondario. Per esempio, è possibile digitare 2.3.

Per eseguire lo script sarà necessario questo livello API o un livello superiore.

Salvataggio delle applicazioni di script
Selezionando Imposta script si ripristina (aggiorna) un'applicazione di script in un
documento TI-Nspire™ o PublishView™. Tuttavia, lo script e l'applicazione di script non
vengono salvati fino al salvataggio del documento. Se si chiude il documento o il
software TI-Nspire™ senza salvare, il documento sullo script viene perso.

Per accertarsi che l'applicazione di script svenga salvata al termine del lavoro, seguire i
passaggi seguenti.

1. Dalla finestra dell'Editor di script, fare clic su Imposta script per reimpostare
(aggiornare) l'applicazione di script nel documento.

2. Da un documento aperto, fare clic su File > Salva documento per salvare le
modifiche al documento TI-Nspire™ o PublishView™.

Nota: per accertarsi che venga eseguito il back-up dello script, impostare lo script e
salvare il documento frequentemente.

Gestione delle immagini
Per inserire un'immagine in un'applicazione di script, seguire i passaggi seguenti.

Aggiungere un'immagine a Risorse

1. Fare clic sulla scheda Risorse.

2. Fare clic sul pulsante .

3. Fare clic sul nome del file immagine.

4. Fare clic su Apri.

5. Accettare il nome predefinito dell'immagine o rinominare l'immagine digitando un
nuovo nome nella casella. (Ad es: nuovaimmagine)

6. Fare clic su OK.

Nota: la miniatura dell'immagine sarà visualizzata nell'angolo in basso a destra
dello schermo. Il nome del file immagine apparirà in un elenco di immagini nella
parte inferiore sinistra dello schermo.



7. Fare clic con il pulsante destro del mouse sul nome di un'immagine per
rinominare, copiare il nome, visualizzare un'anteprima o rimuovere l'immagine. È
anche possibile fare clic sul pulsante per rimuovere un'immagine.

Aggiungere più immagini a Risorse

1. Fare clic sulla scheda Risorse.

2. Fare clic sul pulsante .

3. Selezionare Valori separati da virgola (*.csv) dal menu Tipo di file.

4. Selezionare il file .csv desiderato.

Nota: il formato .csv è costituito da due colonne separate da virgola. La prima
colonna si riferisce al nome locale della risorsa immagine utilizzata nel codice. La
seconda colonna si riferisce al percorso assoluto all'immagine sul sistema
corrente.

Esempio per Windows®:

bridge,C:\images\bridge.jpg

house,C:\images\house.jpg

5. Fare clic su Apri.

6. Fare clic con il pulsante destro del mouse sul nome di un'immagine per
rinominare, copiare il nome, visualizzare un'anteprima o rimuovere l'immagine. È
anche possibile fare clic sul pulsante per rimuovere un'immagine.

Creare uno script per richiamare un'immagine

1. Digitare uno script nella casella della riga dello script nel modo seguente:

myimage = image.new(_R.IMG.img_1)

function on.paint (gc)

gc:drawImage (myimage, 30, 30)

end

Nota: sostituire img_1 (sopra) con il nome della propria immagine.

2. Per salvare lo script, fare clic su Imposta script. L'immagine sarà visualizzata nella
schermata Anteprima documento.

3. Fare clic suMetti a fuoco lo script per impostare lo stato attivo per la pagina nel
documento dove si desidera fissare l'applicazione di script.

Nota: un documento TI-Nspire™ imposta lo stato attivo per la pagina; un
documento PublishView™ imposta lo stato attivo per la cornice della pagina.
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Creare uno script per richiamare più immagini

1. Digitare uno script nella casella della riga dello script nel modo seguente:

myimg = { }

for name, data in pairs (_R.IMG)

myimg [name] = image.new(data)

end

function on.paint (gc)

gc:drawImage (myimg[imagename], 30, 30)

end

2. Per salvare lo script, fare clic su Imposta script. L'immagine sarà visualizzata nella
schermata Anteprima documento.

3. Fare clic suMetti a fuoco lo script per impostare lo stato attivo per la pagina nel
documento dove si desidera fissare l'applicazione di script.

Nota: un documento TI-Nspire™ imposta lo stato attivo per la pagina; un
documento PublishView™ imposta lo stato attivo per la cornice della pagina.

Impostazione delle autorizzazioni per gli script
È possibile impostare i livelli di autorizzazione per uno script e specificare una
password per proteggere uno script. Utilizzare i seguenti passaggi.

1. Nella finestra Editor dello script, fare clic su File > Imposta autorizzazioni.

Viene visualizzata la finestra di dialogo Imposta autorizzazioni.

2. Nell'area Livello di autorizzazione, selezionare il livello di sicurezza appropriato.

• Protetto. Lo script può essere eseguito ma non visualizzato o modificato.
• Sola visualizzazione. Lo script può essere visualizzato ma non modificato.
• Non protetto. Lo script può essere visualizzato e modificato.

3. Per proteggere uno script, indicare una password nell'area Sicurezza.

Nota: prestare attenzione nell'impostare le password perché non possono essere
recuperate.

4. Fare clic su OK.

Facendo clic successivamente su Inserisci > Editor di script > Modifica script, una
finestra di dialogo Protetto da password si aprirà richiedendo la password. Fare clic su
una di queste opzioni:

• Per modificare lo script, inserire la password e fare clic su OK.



• Per la sola visualizzazione dello script, non inserire la password e fare clic su
Visualizza.

Esecuzione del debug degli script
È possibile eseguire il debug degli script per individuare errori runtime e tracciare il
flusso dell'esecuzione. Durante l'esecuzione del debug, i dati sono visualizzati nel
Pannello degli strumenti.

▶ Per abilitare la modalità debugging o disabilitarla tornando a quella normale, fare
clic su Debug > Abilita i punti di interruzione o Disabilita i punti di interruzione.

Nota: quando si disabilitano i punti di interruzione, l'esecuzione dello script viene
sempre ripresa.

▶ Durante l'esecuzione del debug, fare clic su Accedere a e Oltrepassare come
appropriato. Vedere il capitolo Esplorazione dell'interfaccia dell'Editor di script.

▶ Per impostare i punti di interruzione, fare doppio clic nello spazio all'estrema
sinistra del numero della riga. I punti di interruzione sono disabilitati fino a quando
non viene selezionato Abilita punti di interruzione.

▶ Fare attenzione a questi fattori durante l'esecuzione del debug:

• I punti di interruzione nei programmi collaterali non sono supportati.
• Se un punto di interruzione è impostato in una funzione che è una richiamata, il

debugger potrebbe non fermarsi nel punto di interruzione.
• Il debugger potrebbe non fermarsi in funzioni quali per esempio on.save,

on.restore e on.destroy.

Nella barra degli strumenti, Accedere a e Oltrepassa sono attivi quando i punti di
interruzione sono abilitati.

▶ Per sospendere e riprendere l'esecuzione dello script, fare clic su Sospendi lo script
e Riprendi script. Quando lo script viene ripreso, viene eseguito fino al punto di
interruzione successivo riscontrato o fino alla fine dello script. Uno script può
essere sospeso in modalità normale o debugging.
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Informazioni sulla normativa
Affermazioni di avviso
Avvertenza Installare il punto di accesso a TI-Nspire™ Navigator™ o il punto di accesso
a TI-Nspire™ CX Navigator™ in modo tale da mantenere una distanza minima di 20 cm
(7,9 pollici) tra l'elemento o gli elementi di radiazione e le persone. Questo avviso di
sicurezza è conforme ai limiti di esposizione della frequenza radio FCC.

Avvertenza Non toccare o spostare il punto di accesso a TI-Nspire™ Navigator™ o il
punto di accesso a TI-Nspire™ CX Navigator™ quando le antenne trasmettono o
ricevono.

Avvertenza Il punto di accesso a TI-Nspire™ Navigator™, alloggiamento wireless TI-
Nspire™ Navigator™, la scheda di rete wireless TI-Nspire™ CX, il punto di accesso a TI-
Nspire™ CX Navigator™ e la scheda di rete wireless TI-Nspire™ CX - v2 si intendono
esclusivamente per uso in ambienti chiusi. Non installare o utilizzare il dispositivo
all'aperto.

Avvertenza I radiatori intenzionali, come il punto di accesso a TI-Nspire™ Navigator™,
l'alloggiamento wireless TI-Nspire™ Navigator™, la scheda di rete wireless TI-Nspire™
CX. Il punto di accesso a TI-Nspire™ CX Navigator™ e la scheda di rete wireless TI-
Nspire™ CX - v2non sono operativi con antenna/e diversa/e da quelle fornite da Texas
Instruments. Un radiatore intenzionale può essere operativo esclusivamente con
antenna/e autorizzata/e.

Avvertenza I punti di accesso radio a TI-Nspire™ Navigator™ e i punti di accesso radio a
TI-Nspire™ CX Navigator™ vengono disabilitati per impostazione predefinita e possono
essere abilitati esclusivamente tramite l'amministratore di sistema utilizzando
l'applicazione software di gestione.

Avvertenza La banda di frequenza radio, i canali operativi e la potenza di trasmissione
dipendono dal Paese in cui vengono specificate le operazioni dall'amministratore di
sistema durante l'installazione e la configurazione tramite il software di gestione.

Avvertenza L'installazione deve essere eseguita esclusivamente da personale
qualificato. Leggere e seguire tutte le avvertenze e le istruzioni presenti sul prodotto o
incluse nella documentazione.

Importante per il funzionamento sicuro di un adattatore CA
Oltre alla particolare attenzione dedicata agli standard di qualità nella realizzazione
del prodotto TI, la sicurezza è un fattore determinante nella progettazione di ogni
prodotto. Tuttavia, sicurezza significa anche responsabilità dell'utente. Questa sezione
elenca informazioni importanti utili per assicurare la fruizione e l'uso corretto di
questo prodotto TI e delle apparecchiature accessorie. Leggere attentamente prima di
far funzionare e utilizzare il prodotto.

Installazione

• Leggere e seguire le istruzioni: È necessario leggere tutte le istruzioni per il
funzionamento e di sicurezza prima di mettere in funzione il prodotto. Seguire
tutte le istruzioni per il funzionamento.



• Conservare le istruzioni: È necessario salvare tutte le istruzioni per il
funzionamento e di sicurezza per farvi riferimento in futuro.

• Attenzione: Osservare tutte le avvertenze sul prodotto e nelle istruzioni per il
funzionamento.

• Utilizzare l'adattatore CA consigliato. È necessario utilizzare l'adattatore in
dotazione con il prodotto.

• Verificare le sorgenti di alimentazione: L'adattatore CA per il prodotto TI deve
essere utilizzato con una presa di alimentazione AC100V-230 V 50 Hz/60 Hz. Se
non si è sicuri del tipo di alimentazione erogata nella propria abitazione, consultare
il fornitore o la società di energia locale.

• Attenzione al sovraccarico: Non sovraccaricare le prese a muro o le prolunghe,
poiché questo potrebbe comportare un rischio di incendio o scossa elettrica. Il
sovraccarico di prese CA, prolunghe, cavi di alimentazione consumati, cavi
danneggiati e prese rotte sono pericolosi. Esaminare con cadenza periodica il cavo
e qualora vi siano segni di danno o deterioramento, provvedere alla sostituzione a
opera di un tecnico della manutenzione.

• Proteggere i cavi di alimentazione: Disporre i cavi di alimentazione in modo che
non vengano calpestati o schiacciati da elementi collocati intorno o contro di essi.
Prestare particolare attenzione ai cavi collegati a spine e connettori ed esaminare
il punto in cui il cavo di alimentazione si collega al prodotto TI.

• Verificare la ventilazione: Le fessure e le aperture nella custodia sono fornite per la
ventilazione così da assicurare il funzionamento affidabile del prodotto TI e a
proteggerlo dal surriscaldamento. Non bloccare o coprire tali aperture. Non
bloccare mai queste aperture posizionando il prodotto TI su un letto, un divano, un
tappeto o altre superfici simili. Non collocare mai il prodotto TI accanto o sopra un
radiatore o un diffusore di aria calda o su qualsiasi altra sorgente di calore (inclusi
amplificatori). Non collocare il prodotto Ti in un'installazione incassata, come una
libreria o una scaffalatura in assenza di un'adeguata ventilazione.

• Non utilizzare gli accessori: Non utilizzare attacchi, salvo quando raccomandato da
TI, poiché potrebbero causare rischi di incendio e scossa elettrica.

• Non utilizzare vicino all'acqua: Non utilizzare il prodotto TI vicino all'acqua, per
esempio, vicino a una vasca da bagno, un lavandino o un lavello, in un seminterrato
umido o nei pressi di una piscina.

• Non collocare vicino a una sorgente di alta temperatura: Non utilizzare il prodotto
TI vicino a una sorgente di calore come un fornello, un caminetto o un calorifero.

• Prestare attenzione durante il montaggio del Prodotto TI: Non collocare il prodotto
TI su una superficie instabile. Il prodotto TI potrebbe cadere, provocare ferite gravi
a bambini o adulti nonché gravi danni al prodotto TI.

• Non utilizzare accanto a attrezzature mediche: Non mettere in funzione il prodotto
accanto ad attrezzature che potrebbero essere soggette a interferenza elettrica o
utilizzate per finalità mediche. Non utilizzare il prodotto accanto a un pacemaker o
a un'area di assistenza sanitaria in un ospedale.
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InfoImportanti

• Attendere almeno 10 secondi tra lo scollegamento e il ricollegamento del prodotto
TI con l'adattatore CA.

• Scollegare il prodotto dalla presa a muro prestando attenzione; l'adattatore CA
potrebbe essere caldo.

Uso e manutenzione

• Scollegare l'alimentazione prima di effettuare la pulizia: Non utilizzare detergenti
liquidi o spray. Utilizzare un panno umido per la pulizia.

• Allontanare gli oggetti dalle aperture: Non spingere mai oggetti di alcun tipo
all'interno del prodotto TI attraverso le aperture come i fori di ventilazione, poiché
potrebbero entrare in contatto con circuiti dell'alta tensione e provocare un
cortocircuito in altri componenti causando incendi o scosse elettriche. Non versare
mai sostanze liquide sul prodotto TI.

• Proteggere dai fulmini: Scollegare il prodotto TI durante temporali o quando viene
lasciato incustodito o inutilizzato per un lungo periodo. Rimuovere l'adattatore
dalla presa a muro e scollegare il sistema di cavi. Ciò previene eventuali danni a
causa di fulmini e sovraccarichi di voltaggio. Fare attenzione a non toccare la parte
metallica del prodotto TI o i cavi durante un temporale.

Manutenzione

• La manutenzione deve essere effettuata da personale qualificato addetto alla
manutenzione nelle condizioni sottoelencate:

- Se il cavo di alimentazione è danneggiato.
- Se è stato versato del liquido o se degli oggetti sono caduti all'interno del

prodotto.
- Se il prodotto è stato esposto a pioggia o acqua.
- Se il prodotto non funziona normalmente seguendo le istruzioni per l'uso.
- Se il prodotto è caduto o la custodia è stata danneggiata.
- Quando il prodotto mostra evidenti variazioni nelle prestazioni, come

l'incapacità di completare il suo controllo automatico.

• Controllo di sicurezza: Al termine di ogni servizio di manutenzione o riparazione del
prodotto, richiedere al servizio assistenza di effettuare i controlli di sicurezza
necessari al fine di valutare se il prodotto sia in condizioni operative adeguate.



Informazioni Generali
Guida online
education.ti.com/eguide

Selezionare il proprio Paese per maggiori informazioni sul prodotto.

Contattare l’assistenza TI
education.ti.com/ti-cares

Selezionare il proprio Paese per assistenza tecnica e altre risorse.

Informazioni su servizi e garanzia
education.ti.com/warranty

Selezionare il proprio Paese per informazioni sulla durata e sui termini della garanzia o
sull’assistenza ai prodotti.

Garanzia limitata. La presente garanzia non pregiudica i diritti spettanti per legge.
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